Contents

1 Introduction 15
- About Workforce Management 15
- Organization 17
- Intended Audience 18
- Features in WFM 19
- Documentation 20

2 Workforce Management Overview 21
- Introduction 21
- Running Cisco Unified CCX with WFM 23
  Managing Configuration Changes in WFM and Unified CCX 23
  Understanding Synchronization between Unified CCX and WFM 25
  Creating Agents, Teams, and CSQs in Unified CCX 25
  Understanding Sync Service and Teams 26
  Understanding Sync Service and Agents 27
  Understanding Sync Service and CSQs 28
- Administering Users in WFM 29
  Understanding Roles, Views, and Privileges 29
  Understanding Roles 29
  Understanding Views 31
  Understanding Privileges and Scope 31
  Creating an Agent User Account 32
  Creating a User with Dual Roles 32
  Creating a Non-agent User 33
  Managing Users in WFM 33
  Managing Users for Unified CCX 33
- Understanding CSQ Mappings 36
- Understanding Contact Service Queues 37
  Scheduling Multiple CSQs as a Virtual CSQ 37
  Maintaining CSQ Attributes 38
- Understanding Scheduling Order 41
- Understanding Work Shifts 43
Contents

Using Daily Volume Estimation Methods  71
  Previous Year Equivalent Day  71
  Average of Equivalent Days  71
  Guideline for Estimating Daily Volume  72
Using Contact Handling Estimation Methods  72
Handling Email Options  73
  Handling Email Received During Business Hours  73
  Handling Email Received After Business Hours  73
  Handling Email Examples  74
Modifying Forecasts  78
  ■ Understanding Special Events  79
    Understanding the Impact of a Special Event  79
    Impact on Distribution Requests  80
    Impact on Forecast Requests  80
    Assigning Special Events  80
  ■ Understanding Firm Dates  82
  ■ Understanding Closed Days  83
  ■ Understanding Scheduling  84
    Configuration Requirements for Scheduling an Agent  84
    Understanding Closed Days and Fixed Work Shifts  86
    Maintaining a Schedule Intraday  86
  ■ Scheduling Multimedia Activities  87
    Scheduling Agents to Respond to Email  87
    Scheduling Agents to Support Chat Services  88
    Scheduling Agents to Support Calls  89
  ■ Using Multiple Time Zones  90
    Scheduling Agents in Multiple Time Zones  91
  ■ Using Real-Time Comparisons  93
  ■ Viewing Real-Time Coverage of Requirements  94
  ■ Monitoring Real-Time Adherence  95
    Adherence and Conformity  95
  ■ Understanding What-Ifs  96
    Understanding Resource Requirements Calculations  96
    Understanding Distribution Scenarios  96
Contents

Selecting a CSQ from the Context Pane 119
■ Selecting a Team from the Context Pane 120
■ Selecting a CSQ Mapping from the Context Pane 121

4 Managing the Environment 123
■ Introduction 123
■ Managing CSQ Mappings 124
  Creating a CSQ Mapping 125
  Editing a CSQ Mapping 126
  Assigning Agents to a CSQ Mapping 127
  Assigning CSQs to CSQ Mapping 128
  Deleting a CSQ Mapping 129
■ Managing CSQs 130
  Creating a CSQ for Calls 130
  Creating a CSQ for Email 138
  Editing a CSQ 140
  Assigning CSQ Mappings to a CSQ 141
  Creating a Virtual CSQ 142
  Entering Scheduling Order 145
  Deleting a CSQ 147
■ Managing Exception Types 148
  Creating an Exception Type 148
  Editing an Exception Type 150
  Deleting an Exception Type 152
■ Managing Time Zones 154
  Adding CSQs to a Time Zone 155
  Adding Agents to a Time Zone 157

5 Managing Agents 159
■ Introduction 159
Contents

- Managing Teams  160
  Creating a Team  160
  Editing a Team  162
  Assigning Agents to a Team  163
  Deleting a Team  165

- Managing Agents  166
  Configuring an Agent  167
  Assigning Teams to an Agent  172
  Assigning CSQ Mappings to an Agent  173
  Displaying an Agent’s Work Shift Rotation  174
  Displaying an Agent’s Exceptions  174
  Editing an Agent’s Exception  175
  Deleting an Agent’s Exceptions  176
  Deleting an Agent  177

- Managing Work Shifts  178
  Creating a Work Shift  179
  Editing a Work Shift  184
  Displaying Agents Associated with a Selected Work Shift  186
  Associating Work Conditions with a Work Shift  187
  Deleting a Work Shift  188

- Managing Work Conditions  189
  Creating a Work Condition  189
  Editing a Work Condition  193
  Assigning Work Shifts to a Work Condition  194
  Deleting a Work Condition  196

- Assigning Work Shifts  197
  Creating a Work Shift Rotation  197
  Creating a Split Work Shift  199
  Assigning a Work Shift Rotation to an Agent  200
    Creating a New Work Shift Rotation  201
    Replacing an Existing Work Shift with a New Work Shift  201
    Inserting a New Work Shift after an Existing Work Shift  201
    Inserting New Work Shift before an Existing Work Shift  202
    Deleting Assigned Work Shifts  202
Contents

Deleting a Special Event 259

Assigning Special Events 261
Assigning a Special Event 261
Editing an Assigned Special Event 264
Deleting an Assigned Special Event 265

Managing Firm Dates 266
Creating and Editing a Firm Date Association 266
Copying a Firm Date Association 267
Deleting a Firm Date Association 267

Managing Closed Days 269
Updating a CSQ Calendar 269
Copying Open and Closed Days to another CSQ 270

Managing Schedules 271

Introduction 271
Creating Schedules 272
Creating a Schedule 272
Editing Schedules 275
Editing a Schedule 275
Editing an Agent’s Schedule 278
Interpreting the Schedule Maintenance Pane 279
Interpreting Coverage of Requirements 280

Displaying Schedules 282
Using the Schedule Viewer 282

Managing Intraday Functions 287

Introduction 287
Post-Production Planning 288
Planning Non-Service Activities 288
Interpreting the Analysis Results Table 291
Contents

Assigning a Post-Production Exception 291

■ Contact Statistics and Productivity Data 293
  Displaying Contact Statistics and Productivity Data 293
  Interpreting Numerical Data in the Left Pane 295
  Interpreting Graphical Data in the Middle Pane 297
  Interpreting Statistical Data in the Right Pane 298

■ Displaying Supervisor Data Views 304
  Displaying a Supervisor Data View 304

■ Managing Coverage of Requirements 306
  Interval Display Options 306
  Displaying Coverage of Requirements 307
  Interpreting the Coverage of Requirements 308

■ Managing Schedule Trades 310
  Trading Schedules on the Same Day 310
  Trading Schedules for Different Days 311
  Copy Selected Intervals to Other Agents 312

■ Managing Adherence 315
  Monitoring Schedule Adherence 315
  Displaying an Adherence Report for a Specific Agent 316
  Displaying Historical Adherence Data 318
  Using the Automatic Refresh Timer 318
  Adjusting Schedule Times 319
  Displaying Agent Configuration Data 319
  Displaying Schedule Details 319
  Interpreting Adherence Data 320

■ Managing Your Inbox 323
  Accessing Your Inbox 323
  Approving Exception Requests 324
  Approving or Denying a Schedule Trade Request 326

9 Managing Reports 329

■ Introduction 329
Contents

12 Managing Special Functions 355
   ■ Introduction 355
   ■ Compiling Historical Data 356
   ■ Merging Historical Data 358
   ■ Entering Historical Data Manually 360
      Entering Historical Data Manually 361
      Editing Historical Data Manually 363

13 Managing Administration 367
   ■ Introduction 367
   ■ Managing Roles 368
      Displaying a Role 368
      Displaying a Role’s Privileges 369
      Assigning Users to a Role 370
   ■ Managing Views 371
      Creating a View 371
      Editing an Existing View 372
      Assigning Users to a View 373
      Assigning CSQs to a View 373
      Assigning Teams to a View 374
      Assigning Projects to a View 375
      Assigning Work Conditions to a View 376
      Assigning Work Shifts to a View 377
      Assigning Exception Types to a View 378
      Assigning CSQ Mappings to a View 379
      Deleting a View 380
   ■ Managing Users 381
      Creating a New User 381
      Editing an Existing User Account 385
      Assigning a Role to a User 386
      Assigning Views to a User 387
      Deleting a User 388
Contents

■ Managing the Default System Configuration  389
  Configuring System-Level Defaults  389
  Configuring the Dashboard  389
  Configuring the Default Schedule Format  392
■ Managing Requests to the Server  394
  Displaying a Server Request  394
  Deleting Server Requests  396
■ Managing Compilation Requests  397
  Displaying Compilation Requests  397
  Deleting Compilation Requests  399
■ Managing Generic Exceptions  400
  Creating a Generic Exception  400
  Editing a Generic Exception  401
  Deleting a Generic Exception  401

13  Glossary  403

Index  419
Introduction

About Workforce Management

Workforce Management (WFM) is a browser application that can be accessed by any user (agent, supervisor, scheduler, and administrator) who has the Internet Explorer browser. WFM does not use a thick client (which would require installation programs) and therefore, is ideally suited to an environment where the workforce is highly distributed.

WFM allows the scheduling of multiple CSQs and sites. A single WFM implementation may be used worldwide. It also allows the managing of key performance indicators, and real-time adherence to schedules.

WFM retrieves historical call volume information from the ACD system and uses this information to define the contact center call distribution for a CSQ. You can alter the call distribution if you think a special event (for example a public holiday or advertising campaign) might artificially affect the historically anticipated call volume. See "Editing Distributions" on page 227 for more information.

WFM allows the contact center to define the work conditions for agents and teams. An unlimited number of working conditions may be created through the WFM interface to take into account the different work conditions required by the contact center.

Call center managers can track forecasts throughout the day to see if there is any risk of understaffing or overstaffing based on contact activity levels.

Agents can use My Page to check their inbox, trade work shifts, view their schedules, post trades on the bulletin board, review their productivity and statistics, and request vacations. They can monitor their own productivity indicators on a daily basis to keep their performance on track.

IT managers do not need to deal with deployment and support issues on each individual user’s PC. Administration and maintenance of WFM is isolated to the central servers.
This chapter contains the following topics:

- Organization (page 17)
- Intended Audience (page 18)
- Features in WFM (page 19)
- Documentation (page 20)
Organization

This guide is organized as follows:

- **Workforce Management Overview (page 21)** provides the information you need to know to start using WFM, including general features, concepts, and processes that need to be completed.

- **Getting Started (page 105)** provides information on logging into WFM and using the Administrator interface.

- **Managing the Environment (page 123)** provides information on managing CSQ mappings, CSQs, exception types, and time zones.

- **Managing Agents (page 159)** provides information on editing agents, creating works shifts, creating work conditions, assigning work shifts, managing exceptions, and managing projects.

- **Managing Forecasts (page 223)** provides information on creating distribution scenarios, creating forecasts, assigning special events, managing firm dates, and managing closed days.

- **Managing Schedules (page 271)** provides information on generating and editing schedules.

- **Managing Intraday Functions (page 287)** provides information on daily schedule management.

- **Managing Reports (page 329)** provides information on generating Agent Productivity reports, Team Productivity reports, Agent Report Cards, and Schedule reports.

- **Managing What-If Scenarios (page 339)** provides information on generating resource requirement calculations, editing existing resource requirement calculations, creating distribution scenarios, creating forecast scenarios.

- **Displaying Historical Data (page 351)** provides information on displaying historical data.

- **Managing Special Functions (page 355)** provides information on compiling historical data, merging historical data, and entering historical data manually.

- **Managing Administration (page 367)** provides information on administering users, setting the default configuration, monitoring server and compilation requests, and creating generic exceptions.

- **Glossary (page 403)** provides a list of terms and acronyms used in this document.
Intended Audience

This document is written for contact center managers, administrators, schedulers, and supervisors who develop schedules for one or multiple sites, manage key performance indicators, and manage real-time adherence to schedules.
Features in WFM

Contact center managers can use WFM to perform the following tasks:

- Generate forecasts
- Manage schedules for sites in different locations and time zones
- Manage schedules for alternative media sources (for example, chat or email)
- Manage multiple skill scheduling, project scheduling, and assignment scheduling
- Manage real-time adherence, historical adherence, intraday activities, and scenario analysis (including what-ifs, distributions, and forecasts)
- Generate reports
The following documents contain additional information about Workforce Management 8.3(4).

- *Cisco Unified Workforce Optimization Workforce Management Installation Guide*
- *Cisco Unified Workforce Optimization Workforce Management Agent User Guide*
- *Cisco Unified Workforce Optimization Workforce Management Troubleshooting Guide*
- *Cisco Unified Workforce Optimization Workforce Management Reports Reference Guide*
- *Release Notes for Workforce Management for Cisco Unified Workforce Optimization*
Introduction

This chapter covers the following topics.

- Running Cisco Unified CCX with WFM (page 23)
- Administering Users in WFM (page 29)
- Understanding CSQ Mappings (page 36)
- Understanding Contact Service Queues (page 37)
- Understanding Scheduling Order (page 41)
- Understanding Work Shifts (page 43)
- Understanding Work Conditions (page 48)
- Understanding Generic Exceptions and Exception Types (page 49)
- Understanding Projects (page 52)
- Understanding Multi Skill Agent Queuing (page 53)
- Understanding Distributions (page 60)
- Understanding Forecasting (page 63)
- Understanding Special Events (page 79)
- Understanding Firm Dates (page 82)
- Understanding Closed Days (page 83)
- Understanding Scheduling (page 84)
- Scheduling Multimedia Activities (page 87)
- Using Multiple Time Zones (page 90)
- Using Real-Time Comparisons (page 93)
- Viewing Real-Time Coverage of Requirements (page 94)
- Monitoring Real-Time Adherence (page 95)
■ Understanding What-Ifs (page 96)
■ Planning Workforce Management Tasks (page 98)
■ Generating Reports (page 100)
Running Cisco Unified CCX with WFM

This section covers the following topics.

- Managing Configuration Changes in WFM and Unified CCX (page 23)
- Understanding Synchronization between Unified CCX and WFM (page 25)

Managing Configuration Changes in WFM and Unified CCX

If you are running Unified CCX, use the Environment task in the Navigation menu to manage the following components:

- Contact service queues (CSQs)

**NOTE:** If you are using Unified CCX, the Sync Service automatically loads all CSQs from Unified CCX into WFM. You cannot change a CSQ that was created by the Sync Service.

To add a new CSQ, you must create it in Unified CCX, and assign it a name. Unified CCX assigns a unique identity number to the CSQ that can never change. The Sync Service extracts the name and identity information from Unified CCX, and generates the CSQ in WFM. For more information on the Sync Service, see *Cisco Unified Workforce Optimization Workforce Management Installation Guide*.

**NOTE:** Any CSQs created exclusively in WFM cannot be modified in Unified CCX. If you create any of these entities in WFM, they will have no effect on Unified CCX. If Sync Service has already loaded all the CSQs from Unified CCX to WFM, and you try to create a CSQ in WFM with the same designated number as a CSQ imported from Unified CCX, an error message will appear. Each number assigned to a CSQ must be unique.

**NOTE:** In WFM, agents must be assigned to the same CSQ mapping they are assigned to in Unified CCX, and you must capture the historical data for the CSQ associated with the CSQ mapping. If the historical data is not captured, WFM will not display the correct information on the Supervisor Dashboard (Intraday > Dashboard). See "Managing Special Functions" on page 355 for more information on capturing historical data.

- CSQ mappings between agents and CSQs
- Exception types (for example, sick leave, vacation, meetings, or training)
- Time zones
Use Unified CCX to add, modify, and delete agents. The Sync Service extracts the agent identity information from Unified CCX into WFM. For more information, see "Understanding Synchronization between Unified CCX and WFM" on page 25. The following table shows the name of each attribute extracted from Unified CCX and its equivalent attribute in WFM.

<table>
<thead>
<tr>
<th>Attribute in Unified CCX</th>
<th>Equivalent Attribute in WFM Agent Identity Attribute</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>Employee number</td>
<td>The Unified CCX User ID is the initial value for this field. This value must be unique for each agent. You can modify the value. Changes made to this field in WFM have no effect on the User ID value in Unified CCX.</td>
</tr>
<tr>
<td>First Name</td>
<td>First Name</td>
<td>The Unified CCX first name is the initial value for this field. Any changes made to this field in Unified CCX are copied to WFM through the Sync Service.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Last Name</td>
<td>The Unified CCX last name is the initial value for this field. Any changes made to this field in Unified CCX are copied to WFM through the Sync Service.</td>
</tr>
<tr>
<td></td>
<td>Login Name</td>
<td>This is the login name the agent uses to log into WFM.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>NOTE:</strong> This field must be manually configured in WFM as part of user configuration. This is also the login name used in the Active Directory, if Active Directory is enabled.</td>
</tr>
<tr>
<td>Agent User ID</td>
<td>Log ID</td>
<td>The Unified CCX user ID is the initial value for this field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>NOTE:</strong> The login name entered in the User Code field must match the Active Directory login name.</td>
</tr>
</tbody>
</table>
Understanding Synchronization between Unified CCX and WFM

This section describes how the Sync Service imports agents, teams, and CSQs from Unified CCX into WFM.

This section covers the following information.

- Creating Agents, Teams, and CSQs in Unified CCX (page 25)
- Understanding Sync Service and Teams (page 26)
- Understanding Sync Service and Agents (page 27)
- Understanding Sync Service and CSQs (page 28)

Creating Agents, Teams, and CSQs in Unified CCX

NOTE: Any teams, relationships, or CSQs created exclusively in WFM cannot be modified in Unified CCX. If you create any of these entities in WFM, they will have no effect on Unified CCX.
The Sync Service automatically extracts the following information from Unified CCX and loads it into WFM:

- Teams
- Agents (including schedules and supervisors)
- Relationships between agents and teams
- CSQs

Once this information is extracted to WFM, you can then configure WFM to generate forecasts and schedules for CSQs.

**Understanding Sync Service and Teams**

When the Sync Service detects a new team in Unified CCX, it:

- Adds a new team to WFM. When the WFM synchronization adds a new team, it sets the WFM team name to the Unified CCX team name.
- Makes any agent, who is already a member of the team in Unified CCX, a member of the same team in WFM and designates the team as the agent’s main team in Unified CCX. The main team has the following functions in My Page:
  - The agent can see performance statistics for the main team. The agent does not have access to performance statistics for other teams.
  - The agent can request a shift trade or time off with other members of the agent’s main team. Only a supervisor for the main team can approve the agent’s request if the supervisor and agents are assigned the same view.

When the Sync Service detects:

- A change to the team name in Unified CCX, it changes the team name in WFM.
- A new agent in a team in Unified CCX, it adds the new agent to the team in WFM and designates the team as the agent’s main team in WFM.
- The removal of an agent from the team in Unified CCX, it does nothing.
- The deletion of a team in Unified CCX, it does nothing.

You can create additional teams in WFM and assign agents to these teams. Teams created in WFM do not exist in Unified CCX. In Unified CCX, an agent can belong to only one team. In WFM, there is a many-to-many relationship between agents and teams. Assigning an agent to a team in WFM has no effect on the agent’s team assignment in Unified CCX. You might want an agent in multiple teams in WFM for the following reasons:

- Some reports are organized by team. Placing agents in a team allows you to see reporting for all of them as a group.
Changes are more easily applied by team, rather than individual agents. WFM allows you to filter agent lists by team.

Understanding Sync Service and Agents

**NOTE:** WFM assumes every user imported from Unified CCX is an agent. Before you activate agents, review the list of agents (Agents > Agents) and identify any supervisors or schedulers who appear in the list that are not agents. If the user is not an agent you must create a new non-agent user manually, and assign a new role and view to the user.

**IMPORTANT:** If the user is a supervisor, do not activate the existing user in WFM associated with the supervisor. Create a new user manually for the supervisor, and assign a supervisor role and view to the new user.

When the Sync Service detects a new agent or supervisor in Unified CCX, it:

- Adds a new agent to WFM and:
  - Applies the Unified CCX first and last name to the WFM first and last name.
  - Applies the Unified CCX login ID to the WFM Employee Number and Log ID. These values can be changed in WFM. Any changes to WFM have no effect on the Unified CCX Log ID value.
  - Sets the WFM start dates for the company and contact center to the current date.
  - Loads the team assigned to an agent in Unified CCX and assigns that team as the agent’s main team in WFM.
  - Assigns the agent to the team in WFM that corresponds to the agent’s team in Unified CCX and designates this team in WFM as the agent’s main team.
  - Assigns the agent to the default and new agent teams in WFM.

- Adds a new user to WFM and:
  - Applies the Unified CCX first and last name to the WFM first and last name.
  - Creates a link between the user and the user’s agent identity.
  - Sets the status of the user to inactive.
When the Sync Service detects:

- A change to the agent’s first or last name in Unified CCX, it updates the first or last name in WFM.
- The deletion of an agent from Unified CCX, it sets the agent’s status in WFM to inactive.

Understanding Sync Service and CSQs

When the Sync Service detects a CSQ in Unified CCX, it:

- Adds a new CSQ to WFM and:
  - Applies the Unified CCX CSQ name to the WFM CSQ description.
  - Applies the Unified CCX CSQ ID to the WFM CSQ number.
- Adds a new CSQ mapping to WFM and:
  - Applies the Unified CCX CSQ name to the WFM CSQ mapping name.
  - Applies the Unified CCX CSQ ID to the WFM CSQ mapping number.
- Creates a one-to-one mapping in WFM between the Unified CCX CSQ mapping and the WFM CSQ mapping.

When the Sync Service detects a changed name for a CSQ in Unified CCX, it:

- Applies the new Unified CCX CSQ name to the WFM CSQ description.
- Applies the new Unified CCX CSQ name to the WFM CSQ mapping name.

When the Sync Service detects the deletion of a CSQ in Unified CCX, it does nothing.
Administering Users in WFM

This section contains the following topics.

- Understanding Roles, Views, and Privileges (page 29)
- Creating an Agent User Account (page 32)
- Creating a User with Dual Roles (page 32)
- Creating a Non-agent User (page 33)
- Managing Users in WFM (page 33)

Understanding Roles, Views, and Privileges

WFM controls access to functions through roles, views, and privileges.

- Understanding Roles (page 29)
- Understanding Views (page 31)
- Understanding Privileges and Scope (page 31)

Understanding Roles

A role is a collection of privileges. A user can have one or many roles. The user has the collective privileges across all roles assigned to the user. If multiple roles are assigned to a user, the user will see a combination of topics on the Navigation menu that reflect the roles assigned to the user. There are four roles with specific limitations.

- Administrator: This role can access Environment, Agents, Forecasting, Schedules, Intraday, Reports, What-Ifs, Historical, Special Functions, and Administration in the Navigation menu. An administrator can be assigned any combination of the following roles: administrator, scheduler, and supervisor.

- Scheduler: This role can access Environment, Agents, Forecasting, Schedules, Intraday, Reports, What-Ifs, and Historical in the Navigation menu. A scheduler can be assigned any combination of the following roles: administrator, scheduler, and supervisor.

- Supervisor: Usually the person who has first-line responsibility for the management of a group of agents. Often has special telephone or computer terminal for monitoring agents and the system performance. In WFM, the supervisor has access to Schedules, Intraday, Reports, and What-Ifs in the Navigation menu.

- Agent: This role can access My Page in the Navigation menu. The agent role cannot be assigned to users to whom you have already assigned other roles.

**NOTE:** WFM does not support assigning multiple roles to an agent.
Table 1 lists the privileges for each WFM roles.

Table 1. WFM roles and privileges

<table>
<thead>
<tr>
<th>Role</th>
<th>Privilege</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>All functions on all data</td>
</tr>
<tr>
<td>Agent</td>
<td>Functions available from My Page to manage agent’s own information only</td>
</tr>
<tr>
<td>Scheduler</td>
<td>Manage CSQs, CSQ mappings, and exception types within the scheduler’s view</td>
</tr>
<tr>
<td></td>
<td>Manage teams (and agents assigned to those teams), work shifts, breaks, exceptions, and projects within the scheduler’s view</td>
</tr>
<tr>
<td></td>
<td>For CSQs, CSQ mappings, teams, projects, work conditions, work shifts, and exceptions within the scheduler’s view:</td>
</tr>
<tr>
<td></td>
<td>• Create distributions and forecasts</td>
</tr>
<tr>
<td></td>
<td>• Create, display, and edit schedules</td>
</tr>
<tr>
<td></td>
<td>• Perform post-production planning, display intraday information, and trade agent schedules</td>
</tr>
<tr>
<td></td>
<td>• Generate reports</td>
</tr>
<tr>
<td></td>
<td>• Perform what-if analysis</td>
</tr>
<tr>
<td></td>
<td>• Display historical data</td>
</tr>
<tr>
<td></td>
<td>• Manage server requests</td>
</tr>
<tr>
<td>Supervisor</td>
<td>For CSQs, CSQ mappings, teams and the agents assigned to them, projects, work conditions, work shifts, and exceptions within the supervisor’s view:</td>
</tr>
<tr>
<td></td>
<td>• Display and edit schedules</td>
</tr>
<tr>
<td></td>
<td>• Perform post-production planning, display intraday information, and trade agent schedules</td>
</tr>
<tr>
<td></td>
<td>• Generate reports</td>
</tr>
</tbody>
</table>

Table 2 lists the modules that each WFM role has access to.

Table 2. WFM roles and modules

<table>
<thead>
<tr>
<th>Navigation Module</th>
<th>Administrator</th>
<th>Scheduler</th>
<th>Supervisor</th>
<th>Agent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agents</td>
<td>x</td>
<td>x</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Understanding Views

A view controls the scope of accessibility a user has in WFM. A user assigned to a view only has access to the entities assigned to that view (for example, the CSQs, CSQ mappings, teams, projects, work conditions, work shifts, and exceptions assigned to the view) and the privileges assigned to their role.

You can assign one or more views to a user who is assigned to any of the following roles: administrator, scheduler, or supervisor. The user can only perform tasks against entities in the view or views you assigned to the user. For example, the scheduler can only create schedules for CSQs within the scheduler’s view. A view restricts the scope of information that a user can see or change to the entities assigned to the view. If you assign multiple views to a user, the user has simultaneous access to all entities within each of the views.

**NOTE:** Views do not include agents directly. Views include teams. To assign a user access to information or tasks associated with an agent, you assign a view that is associated with a team to which that agent belongs.

A WFM entity can be included in one or multiple views. A user can be assigned to one or multiple views.

Enterprise is the default view in WFM. You can use this as your primary view in Work Management or create new views to suit your needs.

Understanding Privileges and Scope

A privilege is the permission to perform a transaction. For example, the ability to accept schedule trades or delete CSQs.
A scope is a set of boundaries in which privileges apply. WFM sets scope by role, privilege, and view. Some transactions have no scope restriction (for example, setting preferences). A scheduler can only create schedules for agents who are assigned to the teams associated with the view assigned to the scheduler.

Creating an Agent User Account

This topic describes how to create an agent user account.

After the Sync Service imports an agent from Unified CCX, you must:
1. Select the Active check box when configuring an agent (Agents > Agents).
2. Assign a team to the agent.
3. Assign a CSQ mapping to the agent.
4. Assign work shifts to the agent.
5. If needed, assign exceptions to the agent.
6. Select the Active check box when configuring an agent user account (Administration > Users).

**NOTE:** If you do not select this check box, WFM cannot schedule the agent and the agent cannot log into My Page.

7. Assign the agent role to the agent user account.

See the following topics for more information.
- Managing Agents (page 166)
- Editing an Existing User Account (page 385)

Creating a User with Dual Roles

This topic describes process for creating a user with dual roles.

After the Sync Service imports an agent from Unified CCX, you must:
1. Select the Active check box when configuring an agent (Agent > Agents).
2. Assign a team to the agent.
3. Assign a CSQ mapping to the agent.
4. Assign work shifts to the agent.
5. If needed, assign exceptions to the agent.
6. Select the Active check box when configuring an agent user account (Administration > Users).
NOTE: If you do not select this check box, WFM cannot schedule the agent and the agent cannot log into My Page.

7. Assign the agent role to the user User1.
8. Create a second user using the following settings.
   ■ Last Name = User1’s Last Name
   ■ First Name = User1’s First Name
   ■ Login Name = Must be different from User1’s Login Name
   ■ View = User1’s View
   ■ Role = Supervisor

See the following topics for more information.
   ■ Managing Agents (page 166)
   ■ Creating a User with Dual Roles (page 32)

Creating a Non-agent User

This topic describes how to create a non-agent user account.

1. Select the Active check box when creating a non-agent user account (Administration > Users).
   
   NOTE: If you do not select this check box, the user cannot log into WFM.

2. Assign any role but agent to the non-agent user account.
3. Assign a view to the non-agent user account.

See "Creating a New User" on page 381 for more information.

Managing Users in WFM

This section contains the following topic.
   ■ Managing Users for Unified CCX (page 33)

Managing Users for Unified CCX

The Sync Service automatically creates a user for each agent and supervisor in Unified CCX.

NOTE: The Sync Service must be running as the NT authenticated user for WFM to retrieve agents and supervisors from Unified CCX. For more
information on the Sync Service, see the Cisco Unified Workforce Optimization Workforce Management Installation Guide.

When the Sync Service extracts a user identity from Unified CCX, the user identity in WFM initially has the following values:

- **Last name**: This is the last name used in Unified CCX.
- **First name**: This is the first name used in Unified CCX.

**NOTE:** If the last name or first name changes in Unified CCX, the Sync Service will change them in WFM.

- **Login Name**: This is the user’s Active Directory login name. This is the login name the user uses to log into WFM.

**IMPORTANT:** This field is required and must be manually configured in WFM as part of user configuration.

**NOTE:** The name entered in the Login Name field must match the Active Directory login name.

- **Password**: Initially the password has a null value if you are not using Active Directory. If you are not using Active Directory, you must assign a password to the user. If you are using Active Directory, the Password field does not appear and the user automatically uses the password associated with their username.

- **Linked To Agent**: The Sync Service automatically creates the association between the user and the user’s agent identity in WFM.

You can add, update, and delete users in WFM. WFM allows you to create users for the following roles: administrator, scheduler, supervisor, and agent. See "Managing Users" on page 381 for more information.

**NOTE:** The best practice is to manage agent and supervisor identities through Unified CCX and allow the Sync Service to automatically create a user identity for each agent and supervisor in Unified CCX. You need to create administrators and schedulers in WFM. An administrator or scheduler might have a user identity in Unified CCX. If that is the case, delete the user imported from Unified CCX and create a new user with the same name and apply the appropriate role and view. If you are using Active Directory, you must specify the correct username for the user in the Login Name field.
When you add an active user, you select the Active Check box and assign at least one role to the user before you can save your changes. If you assign the administrator, scheduler or supervisor role to a user, you must assign at least one view to the user.

- **Active**: WFM only allows users to log on if the Active check box on the User Details pane is selected (Figure 1).

**NOTE**: If you do not select this check box, the user cannot log into WFM.

**Figure 1. User Details: General tab**
Understanding CSQ Mappings

**NOTE:** A CSQ mapping provides links between CSQs and agents. You can create a CSQ mapping when you want to create a link between a group of agents and specific CSQs. WFM can schedule an agent for a CSQ only if the agent is assigned to the CSQ mapping for the CSQ.

To schedule an agent to support a CSQ, you must assign the agent to the CSQ mapping associated with the CSQ. You can assign an agent to more than one CSQ mapping.

A CSQ mapping is a mechanism used by Unified CCX to link agents to a CSQ. It usually reflects an agent’s skill within the contact center. A CSQ mapping has no other purpose or effect. The Sync Service extracts a CSQ identity from Unified CCX, and loads it into WFM and also creates a CSQ mapping for it in WFM. WFM uses the CSQ mapping when creating schedules.

**NOTE:** Sync Service does not create a CSQ mapping for any CSQ or virtual CSQ that you create in WFM. If you create a CSQ or virtual CSQ in WFM, you must also create a CSQ mapping for the new virtual CSQ.
Understanding Contact Service Queues

A CSQ is a group of agents to which contacts are routed. It is generally associated with a specific skill.

In WFM, you schedule agents to support the CSQ call or email requirements. For this reason, WFM makes CSQs the focal point for schedules and forecasts.

Use WFM to generate a schedule for a CSQ. There are some instances when you might not want to create a schedule for a CSQ. These instances are:

- There are only a couple of agents
  If a CSQ always requires the support of the same agents, and there are only one or two agents who provide this support, you might decide that a schedule is unnecessary for these agents. Consider your options carefully before you make this decision. If you do not include these agents in a schedule, you will lose reporting information on adherence to the schedule. The agents also lose their own adherence dashboard.

- The CSQ exists only to identify backup agents for work overflow situations
  If you schedule both the primary and backup CSQ to manage call requirements, you double the schedule. Use WFM to keep your staffing level on target for the primary CSQ.

- You are scheduling multiple CSQs as a virtual CSQ
  You can group multiple CSQs with the same CSQ type into a virtual CSQ for scheduling purposes. Consider creating a virtual CSQ if you have several groups of agents who all support the same type of contacts (calls or email). For more information, see "Scheduling Multiple CSQs as a Virtual CSQ" on page 37.

For more information on CSQs, see "Managing CSQs" on page 130.

This section covers the following topics.

- Scheduling Multiple CSQs as a Virtual CSQ (page 37)
- Maintaining CSQ Attributes (page 38)

Scheduling Multiple CSQs as a Virtual CSQ

WFM allows the creation of a virtual CSQ. A virtual CSQ is a collection of CSQs unified (or merged) into a single CSQ. It can be associated with multiple skills. Combining individual CSQs into a single virtual CSQ allows you to create a single schedule for multiple CSQs. If you do not create a virtual CSQ, you must create a separate schedule for each CSQ.
Consider creating a virtual CSQ if you have a group of agents who all support similar types of contacts (calls or email). The following examples describe situations in which you might want to create a virtual CSQ.

- Premium and regular customer service CSQs
  
  In this example, a contact center has one CSQ for premium customers and another CSQ for regular customers. Premium customers are routed through the premium CSQ. Premium customers reach an agent faster and receive higher value services from the agent. However, the same group of agents handles both the premium and regular customer service calls. Creating a virtual CSQ that includes both the premium and regular CSQ simplifies scheduling.

- CSQs for multiple locations that all provide the same service
  
  In this example, an organization has IT help desks in multiple locations. The contact center configuration includes a CSQ for each location, to account for multiple time zones, and allow reporting by location. The contact center routing consolidates the agents from each location into a single pool. It distributes the call to an available agent regardless of location. By grouping the CSQs into a single virtual CSQ, WFM can schedule the agents as a single group in a pattern that is consistent with the routing and time zones.

**Maintaining CSQ Attributes**

WFM requires that you assign values to a CSQ that are unique to WFM.

**NOTE:** These attributes do not exist in Unified CCX.

You can specify the order in which WFM uses these attributes to determine which agents to schedule first. For example, you can specify WFM to consider company seniority (Company Start Date) first, rank second, and availability for the week third. You can also determine whether the scheduling feature uses an attribute in ascending or descending order. For example, you can specify that WFM should schedule agents with the most seniority first. See "Entering Scheduling Order" on page 145 for more information.

These attributes appear on the General and Scheduling Order tabs in the CSQ Details pane. The WFM attributes are described as follows.

- **CSQ type**
  
  WFM needs to know the type of contacts (calls or email) a CSQ handles. This information is used when WFM generates forecasts.

  **NOTE:** Historical email volume is not available for a CSQ of type Email. It must be entered manually.
A CSQ of type Email differs from a CSQ of type Calls in the following ways:

— Time to meet the Service Level Objective: A CSQ of type Email specifies time to meet the service level objective in hours and a CSQ of type Calls specifies time to meet the service level objective in minutes.

— Contact received during closed hours: When generating a forecast, WFM considers email received during closed hours (closed hours are not considered in the Service Level Objective). WFM does not consider calls received after business hours.

■ CSQ priority
Assigning priorities to each CSQ allows WFM to resolve scheduling conflicts when an agent is assigned to multiple CSQs. 1 is the highest priority. See "Understanding Multi Skill Agent Queuing" on page 53 for more information.

To generate a schedule for a CSQ, WFM locates the agents with a CSQ mapping to the desired CSQ. WFM then determines which agents have a work shift with available hours on the specified day. See "Managing Work Shifts" on page 178 for more information. If the agent supports multiple CSQs, WFM uses CSQ priority to determine which CSQ will be assigned to the agent for this schedule. See "Entering Scheduling Order" on page 145 for more information.

For example, you designate some of your agents to support two CSQs, and assign a priority to each CSQ in WFM. (If WFM generates the schedules for the two CSQs, and discovers there are not enough agents to support all forecast requirements across both CSQs, it compares the priority value for the two CSQs. WFM then schedules agents for the CSQ with the highest priority first. See "Assigning CSQs to CSQ Mapping" on page 128 for more information on CSQ priority.

■ CSQ mapping priority
Assigning priorities to each CSQ mapping allows WFM to resolve scheduling conflicts when agents with multiple skills are belong to multiple CSQs. See "Understanding Multi Skill Agent Queuing" on page 53 for more information.

■ Standard talk time and standard work time
WFM needs to know the typical call duration for a CSQ to determine the number of agents needed. You can enter standard talk time and standard work time for each CSQ in WFM. Alternatively, you can let WFM generate these values automatically based on historical data. See "Managing Forecasts" on page 223 for more information.

■ Service level objective
WFM needs to know the service level objective. A service level objective often expressed as the speed of answer to be attained or as some percentage of calls to be answered within some number of seconds or emails answered within a number of hours (for example, 80 percent of call answered within 20
seconds or 80 percent of email answered within 24 hours). A more demanding quality objective requires a higher staffing level. The forecast feature uses the specified service level objective to project the need for agents.

- Opening and closing hours

The hours during which a contact center accepts calls for the CSQ.

Agents might be scheduled for additional hours to perform work that is not related to a contact center (for example, training, meetings or set up work).

- CSQ parameters

If WFM finds multiple agents available for the CSQ, WFM uses the order of the following CSQ parameters to decide which agents to schedule first.

- Maximum Hours Available: The maximum number of hours that the agent is available during the work shift. It is the sum of maximum availability for each day across all the days of the week. See "Managing Work Shifts" on page 178 for more information on maximum hours available.

- Minimum Hours Available: The minimum number of hours that the agent is available during the work shift. It is the sum of minimum availability for each day across all the days of the week. This parameter is configured in the Work Shift Detail pane. See "Managing Work Shifts" on page 178 for more information on minimum hours available.

- Maximum Hours per Week: The maximum number of hours that the agent can work each week. This parameter is configured in the Work Shift Detail pane. See "Managing Work Shifts" on page 178 for more information on maximum hours per week.

- Minimum Hours per Week: The minimum number of hours that the agent can work each week. This parameter is configured in the Work Shift Detail pane. See "Managing Work Shifts" on page 178 for more information on minimum hours per week. Your work shift is variable if there a difference between minimum and maximum hours per week.

- Company Start Date: The agent’s seniority within the company based on the date when the agent started working for the company. This parameter is configured in the Agent Details pane. See "Managing Agents" on page 166 for more information on company start date.

- Department Start Date: The agent’s seniority within the contact center based on the date when the agent started working in the contact center. This parameter is configured in the Agent Details pane. See "Managing Agents" on page 166 for more information on department start date.

- Rank: The agent’s seniority based on their knowledge and expertise. WFM uses this value to define scheduling priorities. This parameter is configured in the Agent Details pane. See "Managing Agents" on page 166 for more information on company rank.
Understanding Scheduling Order

WFM allows contact centers to define the scheduling order for a specific CSQ by availability, seniority, or ability. This allows the contact center to fully manage their customer contact operations while maximizing the available workforce for the most important activities.

Depending on your contact center's policies, you can set the seven different priorities to meet the desired scheduling order. The scheduling order indicates the order in which agents in the CSQ will be scheduled (Figure 2).

The first four parameters in the Criteria column are related to work shifts. For instructions, see "Managing Work Shifts" on page 178), and the last three parameters are related to the agents. For instructions, see "Managing Agents" on page 166. You can schedule agents based on availability for a work shift by ranking one of the following criteria as the highest priority:

- Maximum Hours Available
- Minimum Hours Available
- Maximum Hours per Week
- Minimum Hours per Week

For example, to schedule agents first by minimum hours per week, enter 1 in the Minimum Hours per Week field.
Or you can schedule agents based on seniority by ranking one of the following criteria as the highest priority.

- Company Start Date
- Department Start Date
- Rank

For example, to schedule agents first by seniority in a CSQ, enter 1 in the Company Start Date field. For more information on scheduling order, see "Maintaining CSQ Attributes" on page 38.

Assigning a priority number to a CSQ allows WFM to resolve scheduling conflicts when agents are assigned to multiple CSQs. 1 is the highest priority.

To generate a schedule for a CSQ, WFM locates the agents with a CSQ mapping to the desired CSQ. WFM then determines which agents have a work shift with available hours on the specified day. See "Managing Work Shifts" on page 178 for more information. If the agent supports multiple CSQs, WFM uses CSQ priority to determine which CSQ will be assigned to the agent for this schedule. See "Entering Scheduling Order" on page 145 for more information.

For example, you designate some of your agents to support two CSQs, and assign a priority to each CSQ in WFM. If WFM generates the schedules for the two CSQs, and discovers there are not enough agents to support all forecast requirements across both CSQs, it compares the priority value for the two CSQs. WFM then schedules agents for the CSQ with the highest priority first. See "Assigning CSQs to CSQ Mapping" on page 128 for more information on CSQ priority.
Understanding Work Shifts

WFM allows you to create work shifts that match agents’ availability, preferred days off, start time, and length of work day. A work shift identifies the hours and days when an agent can work. You can create a work shift for an individual agent or an entire CSQ. WFM will then schedule agents to best match their work shift preferences and business requirements. There is no limit to the number of work shifts you can create, and WFM retains the previous schedule history for each agent in the WFM database.

When configuring a work shift you need to determine whether the work shift is variable or fixed. You can assign agents and work conditions to a work shift for specific weeks. WFM allows you to manage the following work shift types.

- Fixed Work Shift (page 43)
- Assignment Work Shift (page 44)
- Variable Work Shift (page 44)

You can create multiple work shifts and then assign it to an agent’s work shift rotation. If you use work shift rotations in which an agent works different shifts over a several weeks, you must define the shifts and rotation sequence. For additional information on work shifts, see the following topics.

- Managing Work Shifts (page 178)
- Assigning Work Shifts (page 197)

WFM also allows agents to swap (trade) work shifts. The supervisor can approve or deny each schedule trade request. For instructions, see "Approving or Denying a Schedule Trade Request" on page 326. The supervisor can also perform ad hoc schedule trades based on business requirements and the needs of the contact center. For instructions, see "Managing Schedule Trades" on page 310 for more information.

Additional information on submitting a schedule trade request can be found in the Cisco Unified Workforce Optimization Workforce Management Agent User Guide.

Fixed Work Shift

A fixed work shift is a work shift that covers requirements for fixed hours and days. Use this work shift type to schedule agents for phone and email-related activities for entire days or weeks. A fixed work shift has the following characteristics:

- Work days during the week are fixed
- Hours worked each day are fixed, but do not have to be the same for each day
- The shift start time each day is fixed, but does not have to be the same for each day
The number of hours per week specified for the work shift (Hours per Week) must equal the number total number of hours scheduled for the days of the week in the work shift (Total Hours).

If you assign a fixed work shift to an agent, the agent’s schedule never changes. If you assign fixed work shifts to all agents, you cannot optimize schedules to ensure adequate coverage at all times. A fixed schedule never varies.

Assignment Work Shift

An assignment work shift is a type of fixed work shift that does not cover requirements. Use this work shift type to schedule agents or supervisors for non-phone and non-email related activities for entire days or weeks.

Variable Work Shift

A variable work shift is a work shift that covers requirements for variable hours and days. Use this work shift type to schedule agents for call or email-related activities for variable days and weeks. In contrast to a fixed work shift, a variable work shift offers flexibility in at least one of the following ways:

- Assign at least one day a week as an optional work day. You can choose whether or not to schedule an agent for an optional work day based on the contact center’s requirements.
- Assign the total work hours for one or more days per week as variable.
- Assign the arrival time for at least one day a week as variable.

One or more of the following characteristics are different in a variable work shift.

- Minimum and Maximum Days per Week and Hours per Day (page 44)
- Earliest and Latest Start Times (page 45)
- Optimization (page 45)

Minimum and Maximum Days per Week and Hours per Day

With a variable work shift, you might want to limit the maximum number of days and hours per week to limit overtime and guarantee a reasonably rested employee. You might also need to commit a minimum number of hours per day and days per week for the agent. You specify the minimum and maximum number of days per week and hours per week for the work shift. Then you specify the minimum and maximum number of hours for each day of the week that the agent can work for the day. You might also specify the days of the week that are potential days off for the agent.
Earliest and Latest Start Times

Determine the earliest time you might want the agent to start work. Also determine when the agent can start work. Once you know the earliest and latest possible start times, you configure the earliest and latest start times for an agent in WFM for each day in a work shift.

Optimization

The Optimization feature determines how WFM schedules agents with variable work shifts. This feature has no effect on agents with fixed work shifts, because those agents are scheduled to work at fixed times. You must select one of the following optimization options:

■ Multilinear: WFM schedules all agents with fixed work shifts first. Then it examines requirements starting at the beginning of the day to identify any requirements not already covered by agents with fixed work shifts. If an agent with a variable work shift is available and a requirement exists for an agent, WFM schedules the agent without considering if there might be a greater need for an agent later in the day. Multilinear scheduling results in more consistent arrival times for agents and is generally preferred by agents.

■ Optimum: WFM schedules all agents with fixed work shifts first. Then it schedules the remaining available agents to best meet the forecast requirements throughout the remainder of the day. Choose Optimum if you want to schedule agents according to the contact center’s requirements. Agents assigned to this work shift will be scheduled according to coverage requirements, and not necessarily their preferences. Optimum scheduling generates the best service levels and is generally preferred by call center management.

Optimum scheduling generates the best service levels. Multilinear scheduling generally results in more consistent arrival times for agents and, therefore, is generally preferred by agents.

Figure 3 on page 46 displays a multilinear schedule for a contact center with:

■ Three agents who have a fixed 8 hour schedule and arrive at 7:00 AM.

■ Five agents with a 5 hour shift and variable arrival times between 7:00 AM and 14:00 PM.

The multilinear schedule in this example provides earlier arrival for three of the agents and schedules complete coverage for the morning requirements, but lacks adequate
coverage in the afternoon. The curve represents the volume of calls that occurs during the day.

Figure 3. Multilinear: Agents are schedule when they are first required
Figure 4 displays an optimum schedule. The optimum schedule makes a better match of agent time to customer call requirements, but pushes arrival times for most agents into the afternoon. The optimum schedule can cause significant variability in day-to-day arrival times for agents with variable work shifts that allow arrival time flexibility.

Figure 4. Optimum: Agents are scheduled to best meet requirements

If your agents have variable work shifts, the choice between multilinear and optimum does make a difference. The best way to understand the difference is to run a schedule once with each option and compare the results.
Understanding Work Conditions

WFM differentiates between routine and non-routine activities. WFM categorizes activities, such as breaks and lunches, that occur during every work shift as routine. These routine activities are called work conditions. A work condition is a set of rules used to identify a routine activity that prevents the agent from answering contacts.

A work condition might be linked to fixed or variable work shifts. If the agent can work 4.5 to 6 hours during that work shift and scheduling is in half hour increments, you must configure work conditions for 4.5, 5, 5.5 and 6 hours and assign them to the agent’s work shift. You can set up to 28 different work conditions for the same block of hours. A block of hours is the duration of a work shift (for example, six hours).

**NOTE:** If you do not assign any work conditions WFM schedules the agent’s schedule will not include breaks.

For each work condition, you must identify the following information:

- Name of the work condition (for example, Lunch or Break)
- Duration
- Minimum and maximum time that can elapse between the start of the work shift and the work condition
- Minimum and maximum time between the start of the previous work condition and the next work condition
- The increment in minutes that WFM uses to schedule the work condition. Possible values are 5, 10, 15, 20, and 30.

For more information on work conditions, see “Managing Work Conditions” on page 189.

This section covers the following topic.

- **Understanding Legal Requirements (page 48)**

Understanding Legal Requirements

WFM uses work conditions and scheduling order parameters to apply work time regulations for a country or industry to work shifts.
Understanding Generic Exceptions and Exception Types

Generic exceptions and exception types are non-routine planned or unplanned activities that take agents away from responding to calls or email. Generic exceptions are requested by agents and include general activities such as Absence, Sick leave, and Vacation. Exception types are assigned to agents by schedulers and are more specific. Examples of exception types are Meeting, Training, Paid time off (PTO), Lateness, Holiday, and Unscheduled break. Agents cannot specify exception type when requesting time off.

Kinds of Exceptions

Creating an exception type is one of the functions available in the Environment module (Environment > Exception Types). Exception types are typically created when WFM is initially configured. After the initial configuration, you can create additional exception types as needed to accurately track non-phone activities for agents. You can assign an exception type to an agent for part of a day or all day. You can also specify whether an agent is paid for an exception type. For more information about exception types, see "Assigning Exception Types" on page 207.

NOTE: When you create an exception type you must compile historical data for the new exception type. See "Compiling Historical Data" on page 356 for more information.

Creating a generic exception is one of the functions available in the Administration module (Administration > Generic Exceptions). A generic exception is a general or high-level kind of exception that agents select when requesting time off. If an agent has a doctor’s appointment, the agent would select the Sick leave generic exception (or its equivalent), and then would type a comment indicating that the request was for a doctor’s appointment. For more information on generic exceptions, see "Managing Generic Exceptions" on page 400.

If you believe that your agents will select the correct exception type, create a group of generic exceptions that are an appropriate subset of your exception types. If you do not believe that agents will select the correct exception type, configure a small number of broadly-defined generic exceptions and ask your agents to enter a descriptive comment when they request time off.

Assigning Exceptions and Schedule Production

When an exception is known well in advance, a scheduler can assign an exception to an agent on a particular date (Agents > Assign Exceptions) before a schedule is produced for that date. Then when the scheduler generates a schedule for the agent’s CSQ, WFM automatically applies the exception to the agent’s work shift. As part of the schedule production process, WFM will also attempt to schedule another agent to
work on that date to ensure that the requirements for the CSQ are covered. For more information about assigning exceptions before a schedule has been produced, see "Assigning Exception Types" on page 207.

**NOTE:** If you need to assign an exception to an agent on a date after you have produced the schedule for that date, you should use the Post-Production Planning function. If you do not, you will have to update the schedule manually.

Schedulers can also add unplanned exceptions to a schedule after it has been produced. Doing so ensures that the schedule accurately reflects current conditions. It also ensures that a history of exceptions is saved to the database. For more information about adding unplanned exceptions to a schedule, see "Post-Production Planning" on page 288.

**Exceptions and Scheduling**

WFM uses the CSQ forecast, work shift assignments, and exception assignments to generate a schedule for the CSQ. If the agents assigned to the CSQ have planned vacations, holidays, or any other non-phone activities for a week that you want to include in a schedule, assign the exceptions to the agents before generating the schedule. Assigning exceptions to agents before you create a schedule save times and creates more accurate schedules. Also, WFM fills any gaps in the schedule, due to an absent agent, with another available agent when possible.

**NOTE:** If the CSQ is closed on a specific day (for example, a holiday) that is usually open, WFM schedules the agents to work that day because the schedules are not affected by closed days. To schedule a day off for the agents on a day that is usually scheduled as a work day, create a Holiday exception type and assign this exception to the CSQ whenever the contact center is closed. See "Managing Closed Days" on page 269 for more information.

When applying an exception to a schedule, WFM modifies the exception to conform to the following rules:

- An exception must appear within the agent’s work shift.
- The maximum length of the exception is automatically adjusted to the maximum availability of the agent if the duration of the exception is greater than the agent’s availability.
- WFM ignores an exception that overflows outside of the availability period. The exception is restricted to boundaries specified by the availability period.
- An exception is applied exactly on the dates and times specified unless it occurs on an unscheduled day. The length of a partial exception (an exception that occurs less than the maximum number of work hours) is deducted from
the maximum number of work hours for the work shift. For example, if the work shift is a maximum of 8 hours and the exception for that day is 4 hours, the agent is scheduled for a maximum of 4 hours.
Understanding Projects

A project is an activity that prevents agents from responding to contacts. Projects are generally assigned to optimize use of agent idle time when contact volume is low. These activities occur each work shift and can be assigned for periods of a day or a week. They can be activities that are internal to the customer contact center efforts, such as answering internal email and sending faxes. You can create projects and assign agents to these projects.

WFM examines the coverage for every interval and schedules a project for a time where it would have least impact on coverage. If an agent is assigned multiple projects, WFM also looks at the priority assigned to each project and assigns the project with the highest priority first. 1 is the highest priority. For more information on projects, see "Managing Projects" on page 214.
Understanding Multi Skill Agent Queuing

The Multi Skill Agent Queuing (MSAQ) feature allows agents to serve multiple CSQs simultaneously. It also indicates the relative priority at which each CSQ is to be served. MSAQ solves the challenges for contact centers with cross-skilled agents, multiple products and services, multiple languages, and agents shared across different CSQs.

These capabilities combine to give agents great flexibility, power, and mobility within the contact center.

This section covers the following topics.

- MSAQ Examples (page 53)
- Assigning Priorities (page 59)

MSAQ Examples

The following examples show how WFM uses MSAQ to assign agents from the CSQs to support English and French speaking customer based on priorities.

A contact center has to support English and French speaking customers. In this situation, the agents belong to three different CSQ mappings: French, Bilingual, and English. Agents assigned the French CSQ mapping are assigned to the French Support CSQ. Agents assigned to the English CSQ mapping are assigned to the English Support CSQ. Agents assigned to the Bilingual CSQ mapping are assigned to the English Support CSQ and the French Support CSQ.

**NOTE:** You do not have to create three different CSQ mappings to handle this kind of situation. You could assign the bilingual agents to the French and English CSQ mappings with the appropriate priority setting for the bilingual agents’ CSQs.
Figure 5 illustrates the contact center configuration.

Both CSQs have the MSAQ check box selected and are forecasted to require 4 agents from 8:00 am to 4:00 pm. All agents are ranked equally and are available to work from 8:00 am to 4:00 pm.

See the following examples for more information.

- Example 1 (page 55)
- Example 2 (page 57)
Example 1

The French Support CSQ is assigned a priority of 1. The French and English CSQ mappings are assigned a priority of 1 and the Bilingual CSQ mapping is assigned a priority of 2. The English Support CSQ is assigned a priority of 2 (Figure 6).

Figure 6. Multi Skill Agent Queuing example 1

When you produce a schedule, WFM first assigns 4 agents to the French Support CSQ, then assigns 4 agents to the English Support CSQ. In this situation, agents assigned to the Bilingual CSQ mapping are always assigned last because the priority assigned to the Bilingual CSQ mapping is lower than the priority for French or English.
As a result, your coverage is perfect for both CSQs, and you are overstaffed by one agent (Figure 7).

Figure 7. Multi Skill Agent Queuing bilingual scheduled

<table>
<thead>
<tr>
<th>CSQs</th>
<th>CSQ Mappings</th>
<th>Agents</th>
</tr>
</thead>
<tbody>
<tr>
<td>French Support</td>
<td>Priority: 1</td>
<td>French Priority 1</td>
</tr>
<tr>
<td>English Support</td>
<td>Priority: 2</td>
<td>English Priority 1</td>
</tr>
<tr>
<td>Priority 1</td>
<td></td>
<td>Priority 2</td>
</tr>
<tr>
<td>Priority 2</td>
<td></td>
<td>Priority 1</td>
</tr>
</tbody>
</table>
Example 2

The French Support CSQ is assigned a priority of 1. The French CSQ mapping is assigned a priority of 2 and the Bilingual CSQ mapping is assigned a priority of 1. The English Support CSQ is assigned a priority of 2. The English CSQ mapping is assigned a priority of 2 and the Bilingual CSQ mapping is assigned a priority of 1 (Figure 8).

Figure 8. Multi Skill Agent Queuing example 2

<table>
<thead>
<tr>
<th>CSQs</th>
<th>CSQ Mappings</th>
<th>Agents</th>
</tr>
</thead>
<tbody>
<tr>
<td>French</td>
<td>Priority 2</td>
<td>Rank: 1</td>
</tr>
<tr>
<td>Priority 1</td>
<td>French Support</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Priority 1</td>
<td>Rank: 1</td>
</tr>
<tr>
<td>Bilingual</td>
<td>Priority 1</td>
<td></td>
</tr>
<tr>
<td>Priority 1</td>
<td>English Support</td>
<td></td>
</tr>
<tr>
<td>Priority 2</td>
<td>Priority 2</td>
<td>Rank: 1</td>
</tr>
<tr>
<td>Priority 2</td>
<td>English CSQ Mapp</td>
<td></td>
</tr>
</tbody>
</table>
When you run the schedule, WFM assigns 4 agents to the French Support CSQ first and then assign 3 agents to the English Support CSQ. In this situation, the call center is short 1 English speaking agent (Figure 9).

**NOTE:** Multiple skill scheduling only works if the most skilled and valuable agents are scheduled at the lowest priority. If you do not assign the lowest priority to the most skilled and valuable agents, WFM:

- Might not have enough agents for coverage
- Minimizes call handling flexibility with fewer multi skilled agents

Figure 9. Multi Skill Agent Queuing where Bilingual is scheduled last

<table>
<thead>
<tr>
<th>CSQs</th>
<th>CSQ Mappings</th>
<th>Agents</th>
</tr>
</thead>
<tbody>
<tr>
<td>French Support</td>
<td>Priority: 1</td>
<td></td>
</tr>
<tr>
<td>Bilingual</td>
<td>Priority 1</td>
<td></td>
</tr>
<tr>
<td>English Support</td>
<td>Priority: 2</td>
<td></td>
</tr>
<tr>
<td>English</td>
<td>Priority 2</td>
<td></td>
</tr>
</tbody>
</table>
Assigning Priorities

You can assign priorities to:

- Each CSQ you create. For instructions, see "Creating a CSQ for Calls" on page 130 or "Creating a CSQ for Email" on page 138.

- Each CSQ assigned to a CSQ mapping. For instructions, see "Creating a CSQ Mapping" on page 125.

- Scheduling order parameter for agents in a CSQ. For instructions, see "Entering Scheduling Order" on page 145.

- Each project you create. For instructions, see "Creating a Project" on page 214.

- Each agent in WFM. For instructions, see "Configuring an Agent" on page 167.
Understanding Distributions

A distribution consists of one week’s worth of contact (call or email) volume data for each day and week in the specified reference period. For every schedule interval of every day in that week, a distribution includes the percentage of the day’s calls or email. A distribution also includes the average talk or processing time per contact, as well as the work time per call for each half hour increment.

You can use a distribution to determine when the CSQ receives the most contacts (for example, every day between 10:00 am and 11:00 am, or Mondays and Tuesdays between 6:00 pm and 8:00 pm) during the week.

This section covers the following topics.

- Guidelines for Generating a Distribution (page 60)
- Requirements for Generating a Distribution (page 61)
- Understanding How WFM Processes a Distribution (page 62)

Guidelines for Generating a Distribution

Choosing an appropriate contact reference period is important for generating a distribution suitable for your forecast period. You must generate a distribution before you generate a forecast.

You can generate a distribution once and reuse it for every forecast or generate a new distribution every time you generate a forecast. A distribution and forecast are linked automatically — a CSQ can only have one distribution and one forecast in production at any given time.

The type of distribution you generate (call or email) depends on the type of the CSQ for which you are generating the distribution.
Use the following guidelines when generating a distribution.

- If your daily or weekly contact volumes fluctuate wildly, choose a longer contact reference period (for example, the last 3 weeks). If your contact volumes are fairly stable, choose a shorter reference period (for example, 2 or 3 weeks).

- If your contact volume are fairly stable or seasonal, choose a longer contact reference period from the same period last year (for example, last year’s entire season).

- If you have 12 to 15 months of historical contact volume and your business and routing patterns have not changed dramatically, use a reference period from a year earlier that is similar to the forecast period. Using a reference period from a year earlier includes seasonal patterns.

- If you do not have 12 to 15 months of historical contact volume or your contact center conditions have changed dramatically, identify a more recent period that is likely to have a contact volume that is similar to the forecast period.

- If the contact volumes are reasonable stable throughout the year, you might go several months without having to generate a new call distribution.

- If the contact volumes vary frequently, you might need to regenerate your patterns at least once a month or every time you create a forecast.

- If the contact volume is reasonably stable throughout the year, you might go several months without having to regenerate your distribution. If the call or email volumes have strong seasonal variation, then you might need to regenerate your contact volume at least once a month.

For more information on distributions, see "Managing Distributions" on page 224.

Requirements for Generating a Distribution

To generate a distribution, you must specify the following information:

- A CSQ or virtual CSQ associated with this distribution.

- The historical reference period for contact volume that most closely resembles the future dates for which you want to generate a forecast. To determine the historical data available to you, see "Displaying Historical Data for a CSQ" on page 352.

- The days of the week for which the distribution will be relevant.
Understanding How WFM Processes a Distribution

When generating a distribution, WFM performs the following tasks:

1. WFM calculates the average contact volume in the history reference period for each scheduled period for every scheduled day of the week. For example, to calculate the average contact volume for the 8:30 to 9:00 am time slot on Monday, WFM takes the sum of the volume for the 8:30 to 9:00 am time slot for each Monday in the history reference period and divides the total by the number of Mondays in the history reference period.

2. WFM then divides the result for each half hour by the average contact volume for the day of the week across the history reference period to determine the percentage number of the day's contacts that arrive during this period.

3. WFM calculates the average talking time or processing time and work time values per contact for each half hour increment. For example, to calculate the average talking time or processing time for the 8:30 to 9:00 am time slot on Monday, WFM takes the sum of talking time or processing time for each contact to the CSQ between 8:30 and 9:30 am for each Monday in the contact history reference period and divides the total talking time or processing time by the number of contacts to determine the average talking time or processing time. WFM uses the same method to calculate average work time.

Talking time includes all time from the moment the agent answers a call or chat to the moment the agent disconnects or transfers the call or chat. This includes the time when the agent is actively talking to the caller and the time when the agent places the caller on hold. Processing time includes all time from the moment the agent opens the email to the moment the agent sends the email. This includes the time when the agent is actively writing a response to the email.
Understanding Forecasting

In WFM, a forecast is a prediction of the number of contacts that a contact center will receive over a specific period of time. WFM uses historical contact data first to generate a distribution, then uses the historical data and the distribution to generate a forecast, and finally uses the forecast to create a schedule.

You can create a forecast for any period between one day and 12 weeks. The distribution of a forecast contains contact data by day and by schedule interval (typically 30 minutes). For more information about forecasting, see "Using Forecasting" on page 63.

This section covers the following topics.

- Using Forecasting (page 63)
- Understanding Forecast Requirements (page 64)
- Understanding the Forecasting Process (page 66)
- Understanding How WFM Processes a Forecast (page 68)
- Using Forecasting with a Limited History or Rapidly Changing Situation (page 69)
- Using Forecasting with an Extensive History (page 69)
- Using Forecasting with Trends Methods (page 69)
- Using Daily Volume Estimation Methods (page 71)
- Using Contact Handling Estimation Methods (page 72)
- Handling Email Options (page 73)
- Modifying Forecasts (page 78)

Using Forecasting

Forecasting is an essential part of WFM. It provides the basis for creating schedules. You can use the Forecasting module to:

- Generate and edit scenarios. Historical data can be used to generate a scenario. Historical data contains the contact volume history for each period, day, and week in the specified reference period. A scenario identifies the following information by day of week for each half hour for each day of the week.
  - Percentage of the each day’s calls that arrive during each half hour period
  - Amount of time it takes on average to handle a contact to completion, including talk time plus after-contact work time for each half hour period. This is known as average handle time (AHT).
Include the calculation of the percentage of the day’s calls, by day of week, in each schedule period. It also identifies the average talk time and work time per call for each half hour increment. Use the distribution to generate a forecast. See the following topics for more information.

- Managing Distributions (page 224)
- Managing Distribution Scenarios (page 347)

Initiate forecasts and edit the results. See the following topics for more information.

- Generating a Call or Chat Forecast With Trends (page 233)
- Generating a Call or Chat Forecast Without Trends (page 239)
- Generating an Email Forecast without Trends (page 243)

Define and assign special events. Special Events cause historical contact volume to be above or below normal patterns and identify specific dates when the events occurred. See the following topics for more information.

- Managing Special Events (page 256)
- Assigning Special Events (page 261)

Create firm dates. A firm date is a fixed date on a calendar (for example, January 1). Use firm date when you want to use contact volume from a specified date in the past as the contact volume projection for a specified date in a forecast period. See "Managing Firm Dates" on page 266 for more information.

Identify closed days on which the contact center does not handle calls for a specific CSQ. See "Managing Closed Days" on page 269 for more information.

Understanding Forecast Requirements

When you generate a forecast, you need to specify:

- A CSQ or virtual CSQ
  For more information on CSQs or virtual CSQs, see "Understanding Contact Service Queues" on page 37.
- The dates for which you want to generate a forecast (forecast period)
  You need to know the day or days for which you want to generate a forecast. For a normal forecast, you can specify a week or two at a time. If there is a special event (for example, a holiday), you might want to generate forecasts for the days before and after the holiday one day at a time.
- The method used to forecast the contact volume for each day in the forecast period (for example, Previous Year Equivalent Day or Average of Equivalent Days)
■ With trends or without trends. If you choose to forecast with trends, you must also specify the method used to determine trends (for example, Specific Trends per Day or Overall Trend).

A trend is the year-to-year change in contact volume. A trend tells you the percentage of change (either greater, equal or less than) in contact volume for the current year over the same period last year. The method for determining the trend is dependent on the extent of historical data stored in WFM. See "Using Forecasting with Trends Methods" on page 69 for more information on trends.

■ The historical reference period

Specify the same start and end dates for the reference period you used when you created the distribution.

■ The average call or email handling time

To project the number of agents required, the forecasting process needs to project not only the number of calls or email likely to arrive in a scheduling period, but also the time the agents take to handle calls or email.

■ The adjustment factor

If you lack sufficient historical data to forecast with trends, but you think the volume in the forecast period will be above or below the volume in the historical reference period, you should enter the ratio of the forecast period to the historical volume as the adjustment factor. For example, if you think the forecast period volume will be five percent higher than the historical volume, enter 1.05 in the Adjustment Factor field. See the following topics for more information on Additional Parameters.

— Generating a Call or Chat Forecast Without Trends (page 239)
— Generating a Call or Chat Forecast Without Trends (page 239)

■ Service level targets

For each schedule period, you can set the target for customer service expressed in terms of the percentage of calls answered in a specified number of seconds or email answered within a number of hours. Meeting a more demanding target requires more agents than meeting a less demanding one. The forecast process adjusts projected agent requirements to levels required to meet the service goal. See the following topics for more information on Service Levels Calculation.

— Generating a Call or Chat Forecast With Trends (page 233)
— Generating a Call or Chat Forecast Without Trends (page 239)
Understanding the Forecasting Process

There are two basic types of processes for forecasting.

- **Call or Chat Forecasting Process (page 66):** Use this process when you create a forecast for a call CSQ.
- **Email Forecasting Process (page 67):** Use this process when you create a forecast for an email CSQ.

**Call or Chat Forecasting Process**

To create a call or chat forecast, you must complete the following tasks.

1. Identify the historical call or chat volume for your forecast.

   WFM uses historical data to project future requirements. You need to identify the reference period within the historical data that most closely resembles the future reference period for which you want to generate a forecast. For example, a reference period should reflect any weekly or seasonal patterns that are likely to occur during the forecast period. Choose a reference period with call or chat volume data that is similar to the forecast period. Choosing a reference period from a year prior to the forecast period often provides the best reflection of weekly and seasonal patterns.

   See the *Cisco Unified Workforce Optimization Workforce Management Installation Guide* for instructions on capturing historical call or chat data.

   To determine the historical data available to you, see "Displaying Historical Data for a CSQ" on page 352. For the best results, you need contact volume data for the past 12 to 15 months. Figure 10 shows an example of a historical call volume data.

   ![Figure 10. Historical call volume data](image)

2. Generate the call or chat distribution for each day of the week in your forecast period. The distribution is the calculation of the percentage of the day’s calls, by day of week, in each schedule period. It also identifies the average talk time and work time per call for each half hour increment.

   If you have extensive historical data, see "Using Forecasting with an Extensive History" on page 69 additional information. If you have limited historical data, see "Using Forecasting with a Limited History or Rapidly Changing Situation" on page 69 for more information.
The distribution is based on historical patterns. If you think there is a pattern in your forecast period that differs from the historical pattern, you can edit the distribution to reflect the forecasted pattern.

See "Managing Distributions" on page 224 for more information on distributions.

3. Apply adjustments by day for any special events that resulted in either higher than average or below average activity in the historical data. See "Editing Distributions" on page 227 for additional information on adjusting distribution results.

4. Generate the forecast for future dates and specify the same reference period you used in the distribution. See "Managing Forecast Requests" on page 233 for information on generating a forecast.

5. Review the forecast.

6. If you do not believe the forecast values are on target, edit the forecast. See "Editing Forecasts" on page 249 for more information on reviewing and editing a forecast.

Email Forecasting Process

To create a forecast for email, you must complete the following tasks.

1. Enter the historical email volume for your CSQ. For instructions, see "Entering Historical Data Manually" on page 360.

2. Identify the historical email data for your forecast.

   WFM uses historical data to project future requirements. You need to identify the reference period within the historical data that most closely resembles the future reference period for which you want to generate a forecast. For example, an reference period should reflect any weekly or seasonal patterns that are likely to occur during the forecast period. Choose a reference period with email volume data that is similar to the forecast period.

   To determine the historical data available to you, see "Displaying Historical Data for a CSQ" on page 352.

   If you have extensive historical data, see for "Using Forecasting with an Extensive History" on page 69 additional information. If you have limited historical data, see "Using Forecasting with a Limited History or Rapidly Changing Situation" on page 69 for more information.

3. Generate the email distribution for each day of the week in your forecast period. This email distribution is the calculation of the percentage of the day’s email, by day of week, in each schedule period. It also identifies the average processing time per email for each half hour increment.

   The distribution is based on historical patterns. If you think there is a pattern in your forecast period that differs from the historical pattern, you can edit the distribution to reflect the forecasted pattern.
See "Managing Distributions" on page 224 for more information on distribution scenarios.

4. Apply adjustments by day for any special events that resulted in either higher than average or below average activity in the historical data. See "Editing Distributions" on page 227 for additional information on adjusting distribution results.

5. Generate the forecast for future dates and specify the same reference period you used in the distribution. See "Managing Forecast Requests" on page 233 for information on generating a forecast.

6. Review the forecast.

7. If you do not believe the forecast values are on target, edit the forecast. See "Editing Forecasts" on page 249 for more information on reviewing and editing a forecast.

Understanding How WFM Processes a Forecast

After you configure your forecast request and initiate it, WFM performs the following steps to generate the forecast.

1. Applies any special event adjustments that you assigned for the CSQ in the historical reference period. See "Managing Special Events" on page 256 for more information.

2. Generates the volume projection for each day in the forecast period.

3. When forecasting with trends, determines the trend percentage by day and adjusts the volume projections by the trend amount.

   For example, if the forecast for the day was 40 calls and the trend indicated that this year’s contact volume was five percent above last year’s contact volume, the forecast process increases the projection for the day to 42 calls (1.05 x 40).

4. Adjusts the volume projection for each period by the Adjustment Factor.

   For example, if you enter 1.05 in this Adjustment factor field, WFM will increase the total volume projection for each forecasted day by 5%. If you enter .95 in this field, WFM will decrease the total volume projection for each forecasted day by 5%.

5. Applies the schedule period ratios from the distribution for the day to divide the projection for the day into projections for each schedule period within the day.

6. Multiplies the projection for each schedule period by the average handling time for the period to estimate the amount of agent handling time required.

7. Performs statistical analysis with respect to the agent call or email handling time estimates and the service level goals for the schedule periods to determine the number of agents required.
Using Forecasting with a Limited History or Rapidly Changing Situation

If there is no contact volume history 12 to 15 months prior to the forecast period, you must use historical data from a more recent period. Even if you have 12 to 15 months of history, your current contact center circumstance might have changed to such a degree that information from a year ago might no longer be indicative of future activity. You might need to choose a more recent historical volume period to represent future volume patterns.

For forecasts based on limited history, WFM:

- Includes any past special event adjustments configured for the days in the historical volume period.
- Gets the contact volume for each day of the week for all instances of that day of the week in the historical reference period. For example, when creating a forecast for a Monday using a 6 week historical volume period, WFM retrieves the volume history for the 6 Mondays in the historical volume reference period.
- Generates the estimates for the day by calculating the average from the values for the day of the week in the historical contact volume reference period. For example, WFM divides the sum of the 6 Mondays in the previous example by 6 to determine the estimate for the Monday in the forecast period.

Using Forecasting with an Extensive History

If 12 to 15 months of history is available, you have several options. These choices affect the following:

- Calculation of the volume estimate for a day
- Calculation of the year-to-year trend in volume

The forecast process offers two alternatives for generating the contact volume estimate for a day:

- Previous Year Equivalent Day: This option uses the contact volume for the equivalent day from the previous year.
- Average of Equivalent Days: This option uses the contact volume for the average of equivalent days of the week from the previous reference period.

Using Forecasting with Trends Methods

If you want to create a forecast with trends, WFM provides the following trend options:

- Overall Trend (page 70)
- Specific Trends per Day (page 70)
Use the following guidelines to determine if you should generate a forecast with trends:

- If you do not have 12 to 15 months of historical data in WFM, you must generate a forecast without trends. WFM generates a forecast using a default trend value of one.
- If you have 12 to 15 months of historical data and your contact center circumstances are fairly consistent with what they were a year ago, you can create a forecast with trends.

**Overall Trend**

When you choose to generate a forecast with trends and select the Overall Trend method, WFM calculates the total contact volume for the CSQ for this year’s period and the equivalent period from last year and divides this year’s total by last year’s total to determine the trend. Figure 11 shows an example of an overall trend calculation.

**Figure 11. Overall trend example**

![Overall trend example](image)

Year-to-year trend for all days, 1.03, or a 3 percent increase

**Specific Trends per Day**

When you choose to generate a forecast with trends and select the Specific Trends per Day method, WFM calculates a trend for each day of the week. WFM calculates the total contact volume for the CSQ for the day of the week in this year’s period and also the day of the week in the equivalent period last year. It then divides this year’s total by last year’s total to determine the trend for the day of the week. This method best captures year-to-year variations in the weekly call or email arrival pattern.
Figure 12 shows an example of a specific trends per day calculation.

**Using Daily Volume Estimation Methods**

WFM provides the following daily projection options:

- **Previous Year Equivalent Day (page 71)**
- **Average of Equivalent Days (page 71)**
- **Guideline for Estimating Daily Volume (page 72)**

**Previous Year Equivalent Day**

If you choose Previous Year Equivalent Day, WFM must have 12 months of historical data. When you generate a forecast using Previous Year Equivalent Day, WFM uses the contact volume of the same day of the week for the same week of the month for the previous year as the projection for the day.

For example, to generate a forecast for May 15, 2007, which is the third Tuesday in May, WFM uses the contact volume for the third Tuesday in May of 2006 (May 16, 2006) for the projection.

**Average of Equivalent Days**

When you generate a forecast with trends and Average of Equivalent Days, the reference date for the forecast day is the equivalent date from a year ago. You must select a range of weeks before and after the reference date from which the average of equivalent days is derived. WFM calculates the average contact volume for each day of the week in the range of weeks.

For example, if you want to generate a forecast for Tuesday, March 20, 2007, you might decide to include three weeks before and three weeks after the reference date as the call history reference period. WFM generates the forecast by calculating the
average contact volume for each Tuesday in the six week period from February 28, 2006 to April 3, 2006 (Figure 13).

**Figure 13. Average of equivalent days example**

When you generate a forecast without trends and Average of equivalent days, you must select either Date Range or Date List. WFM calculates the average contact volume for each day of the week in the selected date range or list of dates.

**NOTE**: To generate a forecast for a specific date based on a specific reference date, use firm date association. See "Creating and Editing a Firm Date Association" on page 266 for more information.

**Guideline for Estimating Daily Volume**

If your seasonal patterns are strong, use either Previous Year Equivalent Day or Average of Equivalent Days with a short reference period. Average of Equivalent Day with a longer reference period tends to hide seasonal patterns. If your day-to-day call volume is highly volatile, use Average of Equivalent Days with a longer reference period (for example, 3 to 6 weeks).

**Using Contact Handling Estimation Methods**

You have two options for call or email handling times:

- **Historical Handling Times**: This option uses the call or email handling times calculated from historical data as part of the distribution generation process. If you think the handling times in the forecast periods are likely to follow historical patterns, you should choose this option.

- **Standard Handling Times**: This option uses the standard call or email handling times for the CSQ configured in CSQs under the Environment menu. If you know the circumstances for the handling times depart from historical patterns for the forecast period, then enter the specified time in CSQs under the Environment menu and choose this option.
Handling Email Options

WFM provides forecast options for processing email contacts received during and after business hours. These options are available when you select Email as the CSQ Type when creating a forecast. See "Generating an Email Forecast without Trends" on page 243 additional information.

This topic provides the following information.

■ Handling Email Received During Business Hours (page 73)
■ Handling Email Received After Business Hours (page 73)
■ Handling Email Examples (page 74)

Handling Email Received During Business Hours

WFM provides the following options for processing email contacts received during business hours.

■ Linearly: If you choose this option, WFM divides all email received during business hours by the number of intervals in a work shift to determine the number of email handled during each half hour.

■ No Deferring: If you choose this option, agents must handle all email received during the half hour when they are received.

■ Non-Linearly: If you choose this option, WFM schedules the agents to handle 50% of the email received during the first half hour and divides the number of email handled for each remaining half hour by 50%, until the last half hour in the work shift. During the last half hour in the work shift, the agents are expected to complete the remaining email.

Handling Email Received After Business Hours

WFM provides the following options for processing email contacts received after business hours.

■ Linearly: If you choose this option, WFM divides all email received after business hours by the number of half hours in a work shift to determine the number of email handled during each half hour.

■ No Deferring: If you choose this option, agents must handle all email received after business hours during the first half hour of the next day.

■ Non-Linearly: If you choose this option, WFM schedules the agents to handle 50% of the email received after business hours during the first half hour and divides the number of email handled for each remaining half hour by 50%, until the last half hour in the work shift. During the last half hour in the work shift, the agents are expected to complete the remaining email.
Handling Email Examples

The following examples provide a unique combination of options for processing email contacts received during and after business hours. These examples assume 100% service level coverage for 2 hours of open service.

Example 1

In this example, 200 emails are received after business hours. The contact center chose not to defer email (No Deferring) received during and after business hours. The No Deferring option during business hours requires agents to handle all email received when they are received. The No Deferring option after business hours requires agents to handle all email received after business hours during the first half hour of the next day.

During the first half hour (Figure 14) the agents process the 200 emails received after business hours for the previous day and 40 additional email for a total of 240 emails. The contact center receives and handles 60 email in the second half hour, 80 emails in the third half hour and 120 email in the fourth half hour.

Example 2

In this example, 200 emails are received after business hours. The contact center chose not to defer email (No Deferring) received during business hours and handle email received after business hours linearly. The No Deferring option requires agents to handle all email received during business hours when they are received. The Linearly option divides all email received after business hours by the number of half hours in the work shift to determine the number of email handled during each half hour. Agents must handle all email received during business hours as they are received.

During the first half hour (Figure 15) the agents process 50 emails received after business hours for the previous day and 40 additional emails for a total of 90 emails. The agents continue to handle 50 emails received after business hours during each
remaining half hour in the work shift. The agents also handle all email received during each half hour.

**Example 3**

In this example, 200 emails are received after business hours. The contact center chose not to defer email (No Deferring) received during business hours and handle email received after business hours non-linearly. The No Deferring option requires agents to handle all email received during business hours when they are received. The Non-Linearly option schedules the agents to handle 50% of the emails received after business hours during the first half hour and divides the number of emails handled for each remaining half hour by 50%, until the last half hour. During the last half hour, the agents are expected to complete the remaining emails.

During the first half hour (Figure 16) the agents process 100 emails received after business hours for the previous day and 40 additional emails for a total of 140 emails. The agents continue to handle 50% of all remaining emails received after business hours during each remaining half hour in the work shift. The agents also handle all email received during each half hour.

**Figure 15. Handling Email: Example 2**

**Figure 16. Handling Email: Example 3**
Example 4

In this example, 200 emails are received after business hours. The contact center chose to handle all email received during and after business hours linearly. The Linearly option divides all email received during and after business hours by the number of half hours in the work shift to determine the number of email handled during each half hour. Agents must handle all email received during business hours as they are received.

During the first half hour (Figure 17) the agents process 50 emails received after business hours for the previous day and 10 additional emails for a total of 50 emails. The agents continue to handle 40 emails received after business hours during each remaining half hour in the work shift. The agents also handle all email received during each half hour.

Figure 17. Handling Email: Example 4

Example 5

In this example, 200 emails are received after business hours. The contact center chose to handle all email received during and after business hours non-linearly. The Non-Linearly option schedules the agents to handle 50% of the emails received after business hours and 50% of the emails received during the first half hour and divides the number of emails handled for each remaining half hour by 50%, until the last half hour in the work shift. During the last half hour, the agents are expected to complete the remaining emails.

During the first half hour (Figure 18) the agents process 100 emails received after business hours for the previous day and 20 additional emails for a total of 120 emails. The agents continue to handle 50% of emails received after business hours during
each remaining half hour. The agents also handle all 50% of emails received during each half hour. During the last half hour in the work shift, the agents complete the remaining emails.

**Figure 18. Handling Email: Example 5**

**Example 6**

In this example, 200 emails are received after business hours. The contact center chose to handle all email received during business hours linearly and after business hours non-linearly. Linearly divides all email received during business hours by the number of half hours in the work shift to determine the number of emails handled during each half hour. The Non-Linearly option schedules the agents to handle 50% of the email received after business hours and divides the number of emails handled for each remaining half hour by 50%, until the last half hour in the work shift. During the last half hour in the work shift, the agents are expected to complete the remaining emails.

During the first half hour (Figure 19) the agents process 100 emails received after business hours for the previous day and 10 additional emails for a total of 110 emails. The agents continue to handle 50% of emails received after business hours during each remaining half hour in the work shift. During the last half hour in the work shift, the agents complete the remaining emails.

**Figure 19. Handling Email: Example 6**
Modifying Forecasts

You can use the Edit Forecast function to review and edit a forecast. WFM generates the forecast based on historical information and allows you to modify the data. If you know a future event will significantly change contact volume patterns generated in the forecast, you can adjust the forecast to reflect that knowledge. See “Editing Forecasts” on page 249 for more information.
Understanding Special Events

A special event is a type of event that caused contact volume to deviate from normal. The special event can cause volume to either increase or decrease. In WFM, you can identify special events for a CSQ and let WFM adjust for the effect of the special event.

For more information on special events, see "Managing Special Events" on page 256 and "Assigning Special Events" on page 261.

This section covers the following topics.
- Understanding the Impact of a Special Event (page 79)
- Assigning Special Events (page 80)

Understanding the Impact of a Special Event

You need to determine the impact of a special event. When examining an historical special event, consider the following:
- What CSQ does the special event affect? A special event is always related to a CSQ.
- What type of event is this special event? You can configure generic types of special events with default values. Once you create a generic special event, you can select it from a list of available special event types whenever you need it.
- When did the special event occur?
- How many days after the special event did the contact volume impact appear? The impact of a power outage is immediate. The impact of a bill format change happens after the postal service delivers the bills and the customers open the mail.
- How long did the contact volume impact last in days? The impact of a power outage might only last a day, if service is restored during that time. The impact of a bill format change is likely to endure for a number of days, because customers handle bills at different times.
- What was the impact? What is the ratio of the contact volume that occurred with the special event divided by the contact volume that would most likely occur in the absence of the special event?

A special event impacts distribution requests and forecast requests.
Impact on Distribution Requests

When you launch a distribution request, if the specified reference period includes the special event date, the special event date is excluded from the specified reference period range. This ensures that, on the special event day, abnormal call patterns (including call handle times) do not impact the future call distribution patterns.

For example, consider a power outage that causes the call volume to be halved. A special event with an impact ratio of 0.5 is entered. The date of this special event, if part of a reference period, will be excluded.

Impact on Forecast Requests

When you launch a forecast request, if the specified reference period includes the special event date, then the actual historical call volume is calculated by dividing the historical call volume on the special event day by the impact factor.

That is,

\[
\text{Actual historical call volume} = \frac{\text{Historical call volume on the special event day}}{\text{Impact factor}}
\]

This normalizes the historical call data to reflect the actual call volume for that day, if the special event day had not been scheduled.

In the example above, let us say that the actual call volume on the day the power outage occurred was 5,000 calls. The power outage special event has an impact factor of 0.5. Using the above equation,

\[
\text{Actual historical call volume} = \frac{5,000}{0.5} = 10,000
\]

The call volume in the reference period has been normalized to compensate for the effect of the special event, which makes the forecast more accurate.

Assigning Special Events

Assign a special event to a CSQ for a specific day or days. WFM uses this information when generating a forecast.

When assigning a special event, you must specify the following information:

- The type of special event
  See "Managing Special Events" on page 256 for information on creating a special event.

- The CSQ affected by the special event
  A special event is always assigned to a CSQ.

- The date on which the special event occurred
The effect of a special event can only be applied to a past event. For example, a past event could be a power failure, sudden radio announcement, unexpected promotion, or problems with the telephone service provider. A future event could be a planned promotion, legislative changes, or monthly invoicing.

- The delay, in number of days, between the special event and the impact
- The duration, in number of days, of the impact
- The extent of the impact in ratio format
- Comments that describe the nature of the special event, if necessary
Understanding Firm Dates

You can use the Firm Dates function to associate a date for which you have historical data in WFM with a target date in your forecast period. The forecast generation process uses the contact volume for the historical date as the projection for the forecast day in the firm date mapping before applying a trend or adjustment factor.

Firm Dates offer you a way to provide better historical input for holidays that fall on a particular date and are not on the same day of the week from year to year.

If you do not have adequate historical data in the WFM database to use Firm Date, you can alternatively run the forecast and edit the forecast for the target date to reflect correct information. See "Editing a Forecast" on page 249 for more information.
Understanding Closed Days

You can use the Closed Days function to designate days in which a contact center is opened or closed. There are two types of days you can specify on the calendar.

- **Open Day:** A day when the contact center handles contacts. WFM displays all calendar days open by default. Monday through Friday are typical examples of open days.

- **Closed Day:** A day when the contact center does not handle contacts. If the contact center is only open Monday through Friday, you would designate Saturdays and Sundays as closed days.

**NOTE:** Designating a closed day changes the forecast for that day to zero calls. However, it does not affect any schedule already generated for that day. If agents are scheduled for a closed day, they remain scheduled for that day. See "Deleting a Work Shift" on page 188 for more information.

You should establish a procedure that updates open and closed days at least once a year.

If the open and closed days are the same for each CSQ, you can specify the open and closed days for one CSQ and copy your changes to the other CSQs.

See "Managing Closed Days" on page 269 for more information.
Understanding Scheduling

A schedule is a record that specifies when an employee is supposed be on duty to handle contacts. The complete definition of a schedule is the days of week worked, start time, break times and durations (as well as paid/unpaid status), and stop time.

Schedules are based on the agents’ work shifts. When WFM generates a schedule, it takes into account the agents’ work shifts and the forecast associated with the agents’ CSQ. WFM looks at the requirements, the agents’ availabilities, and preferences to create the most optimal schedules for the contact center and their agents.

WFM also uses absenteeism metrics when creating schedules. Absenteeism is based on actual hours absent rather than shrinkage which is an arbitrary figure applied against a full 24 hour period, which increases the number of actual FTEs scheduled.

When creating a schedule for a CSQ, WFM sorts all agents for the specified CSQ by CSQ mapping and then sorts them by CSQ priority, if used. Then WFM sorts the agents based on scheduling order parameters. Agents assigned to fixed work shifts are scheduled before agents assigned to variable work shifts.

After sorting agents, WFM schedules the first agent based on the agent’s work shift preferences, and optimizes the agents’ breaks, lunches, and projects based on the minimum and maximum delays entered. The work shifts, breaks, lunches, and projects are influenced by coverage requirements. After scheduling the first agent, WFM schedules the next agent, and so on.

Supervisors use schedules to track their agents’ time in the contact center. They can also modify the schedule to optimize the agents’ time.

See the following topics for more information.

- Configuration Requirements for Scheduling an Agent (page 84)
- Understanding Closed Days and Fixed Work Shifts (page 86)
- Maintaining a Schedule Intraday (page 86)
- Managing Schedules (page 271)

Configuration Requirements for Scheduling an Agent

This topic describes the minimum configuration requirements for scheduling an agent in WFM to meet forecast requirements. Before you launch a request for a schedule for a CSQ for a specific period, you must complete the following tasks.

1. Create and activate a view, and then assign the following elements to it.
   - The CSQ for which you are generating a schedule
   - The CSQ mapping that is associated with the above CSQ
Understanding Scheduling

WFM generates a schedule to meet forecast requirements. To generate a schedule, you must specify the following information:

- The CSQs or virtual CSQs for the forecast.

- The start date for the schedule and the number of weeks for the schedule.

**NOTE**: Specify the same start date for the forecast date you used when you created the distribution.

- The date and time when WFM runs the schedule.

1. Users corresponding to the agents that will support the CSQ for which you are generating a schedule
2. Team to which the above agents will belong
3. Work condition
4. Work shift

2. Activate agents to support the CSQ for which you are generating a schedule, and then assign the following elements to the agents.

- Team
- Work shift
- The CSQ mapping that is associated with the CSQ for which you are generating a schedule

3. Create a distribution for the CSQ.

4. Generate a forecast for the CSQ for the specific period for which you want a schedule.

**NOTE**: WFM only creates a schedule if a forecast exists for all of the days that the CSQ is open during the schedule period. If one or more open days do not have a forecast when you launch your schedule request, your request will fail.

5. Assign work shifts to agents that cover the schedule period.

6. Assign projects to agents.

7. Assign exceptions to agents.

**NOTE**: If the agents have planned vacations, holidays, or any other non-phone activities for a week that you want to include in a schedule, assign the exceptions to the agents before generating the schedule. Assigning exceptions to agents before you create a schedule save times and creates more accurate schedules. Also, WFM fills any gaps in the schedule, due to an absent agent, with another available agent when possible. If there are no planned exceptions, you can skip this step.
NOTE: Requests containing a large amount of data require significant time to run. It is recommended that you run requests during off-peak hours (for example, at night) because the process server only runs one request at a time, and running requests during peak hours will prevent other users from running their requests.

- Whether or not WFM automatically rotates work shifts. See "Assigning a Work Shift Rotation to an Agent" on page 200 for more information on work shift rotations.
- Whether or not WFM generates the schedule in 15-minute intervals. By default, WFM applies a scheduling algorithm that divides each day into half hour intervals.

Understanding Closed Days and Fixed Work Shifts

When WFM schedules an agent with a fixed work shift, it schedules the agent for days, hours, and arrival times exactly as specified in the work shift configuration. It does not take into account a closed day for a CSQ. As a result, an agent with a fixed work shift can be scheduled to work on a closed day when the contact center is not taking any calls (for example, a mid-week holiday).

To prevent this situation, complete the following steps:

1. Choose Environment > Exception Types and create an exception type to identify a closed day for which an agent with a fixed shift might be scheduled.
2. Choose Agents > Assign Exceptions and assign the exception to the agents with fixed work shifts that covers their available hours for that work shift on the closed day.

Maintaining a Schedule Intraday

The Schedule Maintenance pane (Schedules > Edit Schedule) shows the agents’ schedules and the coverage of requirements in 15- or 30-minute intervals for a selected CSQ. A contact center supervisor can use the Schedule Maintenance pane to quickly update single agent’s schedule on an intraday basis for maximum efficiency. See "Editing Schedules" on page 275 for more information.

You can also schedule activities (for example, a meeting) after you generate a schedule without impacting the service level objective. You can use the Post-Production Activity Planning pane to determine where to schedule non-phone or email activities with minimal impact to the daily service level objective for the CSQ pane shows the schedule in 15- or 30-minute intervals for a selected CSQ as well as a gap analysis, so you can see where best to schedule non-phone or email activities. A contact center supervisor can use the Post-Production Activity Planning pane to quickly update the schedule for one or more agents on an intraday basis for maximum efficiency. For more information, see "Post-Production Planning" on page 288.
Scheduling Multimedia Activities

WFM can forecast and schedule agents working on different types of contact (for example, calls, email, or chat services) simultaneously.

This section covers the following topics.

- Scheduling Agents to Respond to Email (page 87)
- Scheduling Agents to Support Chat Services (page 88)
- Scheduling Agents to Support Calls (page 89)

Scheduling Agents to Respond to Email

You can create a CSQ mapping for responding to email. Then create a CSQ with the CSQ Type or Service Type of Email. After you create this CSQ, you can assign agents to the CSQ mapping and schedule agents to respond to email.

To schedule agents to respond to email:

1. Create a CSQ mapping for responding to email. For instructions, see "Creating a CSQ Mapping" on page 125.
2. Create a CSQ of type Email. For instructions, see "Creating a CSQ for Email" on page 138.

   NOTE: You can create a CSQ for each type of email you want your agents to handle (for example, sales or IT help desk email).

3. Assign the CSQ to a CSQ mapping. For instructions, see "Assigning CSQs to CSQ Mapping" on page 128.
4. Enter the historical email volume for the CSQ. For instructions, see "Entering Historical Data Manually" on page 360.

   NOTE: Historical data is not available for email. You must enter it manually.

5. Create a distribution by specifying a start and end date from your historical reference period. For instructions, see "Creating a Distribution" on page 224 and "Editing a Distribution" on page 228.
6. Generate a forecast without trends for the CSQ using reference dates for which you have historical data. For instructions, see "Generating an Email Forecast without Trends" on page 243.
7. Create work shifts for the agents to handle email. For instructions, see "Creating a Work Shift" on page 179.
8. Assign the work shift to a agent. For instructions, see "Assigning a Work Shift Rotation to an Agent" on page 200.

9. Create a schedule for the agents to handle email. For instructions, see "Creating a Schedule" on page 272.

Scheduling Agents to Support Chat Services

You can create a CSQ mapping for responding to chat services. Then create a CSQ with the CSQ Type of Calls. After you create this CSQ, you can assign agents to the CSQ mapping and schedule agents to respond to chat services.

To schedule agents to support chat services:

1. Create a CSQ mapping for supporting chat. For instructions, see "Creating a CSQ Mapping" on page 125.

2. Create a CSQ of type Calls. For instructions, see "Creating a CSQ for Calls" on page 130.

   NOTE: Chat, like calls, are handled in real-time.

   NOTE: You can create a CSQ for each type of chat service you want your agents to handle (for example, sales or IT help desk chat services).

3. Assign the CSQ to a CSQ mapping. For instructions, see "Assigning CSQs to CSQ Mapping" on page 128.

4. Enter the historical chat volume for the CSQ. For instructions, see "Entering Historical Data Manually" on page 360.

   NOTE: Historical data is not available for chat. You must enter it manually.

5. Create a distribution by specifying a start and end date from your historical reference period. For instructions, see "Creating a Distribution" on page 224 and "Editing a Distribution" on page 228.

6. Generate a forecast for the CSQ using reference dates for which you have historical data. For instructions, see "Generating a Call or Chat Forecast With Trends" on page 233 or "Generating a Call or Chat Forecast Without Trends" on page 239.

7. Create work shifts for the agents to handle chat. For instructions, see "Creating a Work Shift" on page 179.

8. Assign the work shift to a agent. For instructions, see "Assigning a Work Shift Rotation to an Agent" on page 200.

9. Create a schedule for the agents to handle chat. For instructions, see "Creating a Schedule" on page 272.
Scheduling Agents to Support Calls

You can create a CSQ mapping for responding to calls. Then create a CSQ of type Calls. After you create this CSQ, you can assign agents to the CSQ mapping and schedule agents to respond to calls.

To schedule agents to support calls:

1. Create a CSQ mapping for supporting calls. For instructions, see "Creating a CSQ Mapping" on page 125.

2. Create a CSQ of type Calls. For instructions, see "Creating a CSQ for Calls" on page 130.

   NOTE: Calls are handled in real-time.

   NOTE: You can create a CSQ for each type of call you want your agents to handle (for example, sales or IT help desk calls services).

3. Assign the CSQ to a CSQ mapping. For instructions, see "Assigning CSQs to CSQ Mapping" on page 128.

4. Choose one of the following options.

   ■ If historical call volume is available, verify the historical call volume require is available in WFM. For instructions, see "Displaying Historical Data" on page 351).

   ■ If historical call volume is not available, enter the historical call volume for the CSQ. For instructions, see "Entering Historical Data Manually" on page 360.

5. Create a distribution by specifying a start and end date from your historical reference period. For instructions, see "Creating a Distribution" on page 224 and "Editing a Distribution" on page 228.

6. Generate a forecast for the CSQ using reference dates for which you have historical data. For instructions, see "Generating a Call or Chat Forecast With Trends" on page 233 or "Generating a Call or Chat Forecast Without Trends" on page 239.

7. Create work shifts for the agents to handle calls. For instructions, see "Creating a Work Shift" on page 179.

8. Assign the work shift to a agent. For instructions, see "Assigning a Work Shift Rotation to an Agent" on page 200.

9. Create a schedule for the agents to handle calls. For instructions, see "Creating a Schedule" on page 272.
Using Multiple Time Zones

Sometimes agents and CSQs are located in different time zones. WFM allows you to generate schedules for agents and CSQs residing in different time zones.

**NOTE:** If all of your agents are located in the same time zone, do not enable time zones for your site. Choose the Disabled option from the Time Zone drop-down list for all CSQs and agents. The Disabled option is selected by default. Only change the time zone if you are managing multiple CSQs and agents over different time zones.

If you are managing multiple sites over different time zones, you need to specify the correct time zone for each agent and CSQ. The specified time zone must be the time zone in which the agent or CSQ is located.

**NOTE:** Once you apply a time zone for a single agent or CSQ, you must apply a time zone for each of the remaining agents and CSQs.

If you change the time zone associated with an agent, you must also change the Arrival at the Earliest and Arrival at the Latest times in the Work Shift Detail pane to match the time zone where the CSQ or virtual CSQ is located. See "Creating a Work Shift" on page 179 for more information.

The CSQ and agent can be assigned to different time zones or the same time zone. For example, if the agent is located in the Montreal contact center and the CSQ is located in Minneapolis, select (GMT -5:00) Eastern (U.S.A. and Canada) for the agent’s time zone and (GMT -6:00) Central for the CSQ based in Minneapolis. If the agent’s start time is 9:00 am in Montreal, when a scheduler looks at the schedules for the CSQ, the agent’s start time appears as 8:00 am.

A virtual CSQ can contain multiple CSQs located in different time zones. When you assign multiple CSQs to a virtual CSQ, you must enter a number in the Hour Gap field for each CSQ in the virtual CSQ. The hour gap is the time zone difference between the CSQ and the base time zone for the virtual CSQ (for example, 3 or -3). If all of your CSQs are in the same time zone, enter 0. This ensures that all reports display the correct information.

See the following topic for more information.

- Scheduling Agents in Multiple Time Zones (page 91)
Scheduling Agents in Multiple Time Zones

Use the following procedure to create a single schedule for agents and CSQ in multiple time zones. Once the schedule is created, the schedule will be able to see all schedules and reports based on the time zone associated with the virtual CSQ.

To schedule agents in multiple time zones:

1. Assign the time zone in which the agent is located to the agent and repeat this step for each agent in WFM. For instructions, see "Configuring an Agent" on page 167.

   For example, a contact center has five agents in Minneapolis and five agents in Montreal. All of these agents are working for the IT help desk. Choose (GMT -6:00) Central from the Time Zone drop-down list for each agent located in Minneapolis and (GMT -5:00) Eastern (U.S.A. and Canada) from the Time Zone drop-down list for each agent located in Montreal.

   **NOTE:** Once you apply a time zone for a single agent or CSQ, you must apply a time zone for each of the remaining agents and CSQs.

2. Assign the appropriate time zone to each CSQ. For instructions, see "Editing a CSQ Mapping" on page 126.

3. Create a virtual CSQ (for example, Corporate IT help desk), assign the CSQs (for example, Minneapolis IT help desk and Montreal IT help desk) to the virtual CSQ, and enter a number in the Hour Gap field for each CSQ in the virtual CSQ. For instructions, see "Creating a Virtual CSQ" on page 142.

   The hour gap is the time zone difference between the CSQ and the base time zone for the virtual CSQ. For example, if the Corporate IT help desk is located in Montreal, enter 0 in the Hour Gap field for the Montreal IT help desk and enter -1 in the Hour Gap field for the Minneapolis IT help desk).

4. Create a CSQ mapping. For instructions, see "Creating a CSQ Mapping" on page 125.

5. Assign the virtual CSQ to a CSQ mapping. For instructions, see "Assigning CSQs to CSQ Mapping" on page 128.

6. Verify you have historical contact (call or email) volume for each CSQ in the virtual CSQ. For instructions, see "Displaying Historical Data" on page 351 for instructions) and merge the historical data for each CSQ. For instructions, see "Merging Historical Data" on page 358.

7. Create a distribution by specifying a start and end date from your historical reference period. For instructions, see "Creating a Distribution" on page 224 and "Editing a Distribution" on page 228.
8. Generate a forecast for the CSQ using reference dates for which you have historical data. See one of the following topics for instructions.
   - "Generating a Call or Chat Forecast With Trends" on page 233
   - "Generating a Call or Chat Forecast Without Trends" on page 239
   - "Generating an Email Forecast without Trends" on page 243

9. Create work shifts for the agents to handle contacts and change the Arrival at the Earliest and Arrival at the Latest times in the Work Shift Detail pane to match the time zone where the virtual CSQ is located. See "Creating a Work Shift" on page 179 for more information.

   For example, if the agents earliest arrival time in Minneapolis is 7:00 am and latest arrival time is 9:00 am, and the virtual CSQ is located in Montreal, enter 8:00 am in the Arrival at the Earliest fields and 10:00 am in the Arrival at Latest fields.

10. Assign the work shift to a agents. For instructions, see "Assigning a Work Shift Rotation to an Agent" on page 200.

11. Create a schedule for the agents to handle email. For instructions, see "Creating a Schedule" on page 272.
Using Real-Time Comparisons

WFM captures forecasted information and display the forecasted, projected, and actual service level scores in a dashboard. You can compare the actual service level scores to the forecasted and projected service level scores to see exactly what is happening in the contact center. The graphical illustration of these elements show how close the contact center achieved its desired service level. See "Contact Statistics and Productivity Data" on page 293 and "Displaying Supervisor Data Views" on page 304 for more information.
Viewing Real-Time Coverage of Requirements

WFM provides real-time information on coverage of requirements for a specific CSQ. You can use this real-time information to see exactly how the forecast affects the service level. See "Managing Coverage of Requirements" on page 306 for more information.
Monitoring Real-Time Adherence

WFM allows supervisors to monitor real-time adherence for each agent in their team to determine whether or not agents are adhering to their schedule. The supervisor can configure the Adherence pane to automatically refresh every 1—30 seconds with live data from the ACD. The supervisor can determine a team’s status at a glance. The agent’s current status and adherence is represented by a red or green dot (Figure 20).

![Figure 20. Adherence displaying values for the current date](image)

WFM also allows a supervisor to drill-down to more detailed agent information regarding the agent’s current activity. For example, click the agent’s last name or first name to view the Agent Details pane, or click the agent’s scheduled arrival time to view the Schedule Details pane.

See "Managing Adherence" on page 315 for more information.

This section covers the following topics.

- **Adherence and Conformity (page 95)**

Adherence and Conformity

When determining schedule adherence and conformity, the only time that matters is the time between the scheduled arrival and departure times. If the agent is logged in outside of the scheduled arrival and departure times, that additional time does not effect the adherence or conformity calculation.

Schedule adherence is calculated based on the following formula:

\[
\text{Schedule adherence} = \frac{(\text{Total time agent is ready, reserved for a call, or handling a call AND is scheduled to be in service for handling contacts}) + (\text{Total time the agent is not ready or not logged in AND is not scheduled to be in service})}{\text{Agent’s total schedule time}}
\]

Schedule conformity is calculated based on the following formula:

\[
\text{Schedule conformity} = \frac{(\text{Total time the agent is either ready, reserved for a call, or handling a call})}{\text{Agent’s total schedule time}}
\]
Understanding What-Ifs

You can use what-if analysis as a tool to estimate the impact of changes in future contact volume and/or contact arrival time on your contact center staffing requirements.

You can generate multiple distribution and forecast scenarios to determine the most likely scenario, and then to calculate resource requirements estimations as a result of these scenarios. This enables you to better understand and manage your contact center during times that have varying contact volumes and contact patterns.

Resource requirements estimations consider the existing work shift types, CSQs, forecast dates, and work shift types (including hours and work conditions), and then create a resource forecast based on the resources required to cover the specified forecast dates.

This section covers the following topics.

- Understanding Resource Requirements Calculations (page 96)
- Understanding Distribution Scenarios (page 96)
- Understanding Forecast Scenarios (page 97)

Understanding Resource Requirements Calculations

A resource requirements calculation is an estimate of the number of resources (agents) that are required to cover the forecasted contact volume for one or more CSQs on certain dates, given a specific configuration of work shifts, work conditions, and number of agents available for each shift. The resource requirements calculation is based on the production forecast.

You can generate a resource requirements calculation using the Resource Requirements Calculation function. For more information, see "Generating Resource Requirements Calculations" on page 340. You can display existing resource requirements calculations using the Existing Resource Requirements Calculations function. For more information, see "Managing Existing Resource Requirements Calculations" on page 344.

Understanding Distribution Scenarios

A distribution scenario consists of the contact volume for each period, day, and week in the specified reference period. When you generate a distribution from the Distribution Request pane, you can assign a name to the distribution scenario. You can use the Distribution Scenario List to view or delete the existing distribution scenarios. You can view the details for a specific distribution scenario and change the
Understanding What-Ifs

name of a distribution scenario from the Distribution Scenario Details pane. See "Managing Distributions" on page 224 and "Managing Distribution Scenarios" on page 347 for more information.

Understanding Forecast Scenarios

A forecast scenario is a forecast that is not immediately applied to a schedule. You can create a forecast scenario from the Forecast Scenario List pane. If you think the forecast scenario is more accurate than a regular forecast, you can apply the forecast scenario to a schedule from the Forecast Request pane by selecting the forecast scenario. You can also edit a forecast scenario from the Forecast Maintenance pane. See "Managing Forecast Requests" on page 233 and "Managing Forecast Scenarios" on page 349 for more information.
Planning Workforce Management Tasks

This section covers the following topics.

- Daily Checklist (page 98)
- Weekly Checklist (page 98)
- Monthly Checklist (page 99)
- Yearly Checklist (page 99)

Daily Checklist

Complete the following tasks on a daily basis.

- Check your intraday inbox messages for employee absences, work shift trades, and offers. Approve requests and update schedules as needed. For instructions, see "Managing Your Inbox" on page 323.
- Print today’s schedule and performance reports and distribute them to the appropriate people. For instructions, see "Managing Reports" on page 329.
- Monitor coverage and adherence to determine if additional staffing changes are required. For instructions, see "Managing Coverage of Requirements" on page 306 and "Managing Adherence" on page 315.

Weekly Checklist

Complete the following tasks on a weekly basis.

- Update the official schedule for the next several weeks to reflect any absence, work shift trades, or offers. For instructions, see "Managing Schedule Trades" on page 310 and "Managing Your Inbox" on page 323.
- Review intraday performance reports to determine if additional staffing changes are required. For instructions, see "Managing Reports" on page 329.
- Print the schedule for next week. For instructions, see "Managing Reports" on page 329.
Monthly Checklist

Complete the following tasks on a monthly basis.

- Check distribution scenarios to make sure forecasting and staffing assumptions reflect your current situation and objectives. For instructions, see "Editing a Distribution" on page 228.
- Update forecasts monthly. See the following topics.
  - Generating a Call or Chat Forecast With Trends (page 233)
  - Generating a Call or Chat Forecast Without Trends (page 239)
  - Generating an Email Forecast without Trends (page 243)
- Enter closed days (including weekends and holidays) for each CSQ. For instructions, see "Managing Closed Days" on page 269.
- Delete any distribution or forecast scenarios you no longer need. For instructions, see "Deleting a Distribution Scenario" on page 348 or "Deleting a Forecast Scenario" on page 350.
- Review unusual events and create a special event assignment. For instructions, see "Managing Special Events" on page 256 and "Assigning Special Events" on page 261.

Yearly Checklist

Complete the following tasks on a yearly basis.

- Enter closed days for each CSQ. For instructions, see "Managing Closed Days" on page 269.
- Create firm date associations between historical dates and target dates for each CSQ in your forecast period. For instructions, see "Managing Firm Dates" on page 266.
Generating Reports

WFM allows you to analyze statistics in terms of workforce productivity. The statistics are available in the format of a report.

For more information on reports, see the following topics:

- WFM Reports (page 100)
- Displaying a Report (page 102)
- Exporting and Saving Report Data (page 103)
- Managing Reports (page 329)

WFM Reports

Table 3 displays some of the reports available in WFM and their locations in the Administrator interface. The remaining reports are described in "Managing Reports" on page 329.

Table 3. WFM reports

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSQ Mapping List</td>
<td>Environment &gt; CSQ Mappings</td>
</tr>
<tr>
<td>CSQ Mapping Details</td>
<td>Environment &gt; CSQ Mappings &gt; CSQ Mapping Details</td>
</tr>
<tr>
<td>CSQ List</td>
<td>Environment &gt; CSQs</td>
</tr>
<tr>
<td>CSQ Details</td>
<td>Environment &gt; CSQs &gt; CSQ Details</td>
</tr>
<tr>
<td>Exception Type List</td>
<td>Environment &gt; Exception Types</td>
</tr>
<tr>
<td>Exception Details</td>
<td>Environment &gt; Exception Types &gt; Exception Details</td>
</tr>
<tr>
<td>Teams List</td>
<td>Agents &gt; Teams</td>
</tr>
<tr>
<td>Team Details</td>
<td>Agents &gt; Teams &gt; Team Details</td>
</tr>
<tr>
<td>Agent List</td>
<td>Agents &gt; Agents</td>
</tr>
<tr>
<td>Agent Details</td>
<td>Agents &gt; Agents &gt; Agent Details</td>
</tr>
<tr>
<td>Work Shift List</td>
<td>Agents &gt; Work Shifts</td>
</tr>
<tr>
<td>Work Shift Details</td>
<td>Agents &gt; Work Shifts &gt; Work Shift Details</td>
</tr>
<tr>
<td>Work Conditions List</td>
<td>Agents &gt; Work Conditions</td>
</tr>
<tr>
<td>Work Condition Details</td>
<td>Agents &gt; Work Conditions &gt; Work Condition Details</td>
</tr>
<tr>
<td>Project List</td>
<td>Agents &gt; Projects</td>
</tr>
<tr>
<td>Report Name</td>
<td>Location</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Project Details</td>
<td>Agents &gt; Projects &gt; Project Details</td>
</tr>
<tr>
<td>Distribution Details</td>
<td>Forecasting &gt; Edit Distribution</td>
</tr>
<tr>
<td>Forecast per CSQ per Interval</td>
<td>Edit &gt; Forecast</td>
</tr>
<tr>
<td>Special Event List</td>
<td>Special Events &gt; Special Event List</td>
</tr>
<tr>
<td>Event Details</td>
<td>Special Events &gt; Special Event Details</td>
</tr>
<tr>
<td>Results x CSQ Mapping</td>
<td>Intraday &gt; Supervisor</td>
</tr>
<tr>
<td>Results x CSQ: Agents</td>
<td>Intraday &gt; Supervisor</td>
</tr>
<tr>
<td>Results x CSQ: Calls</td>
<td>Intraday &gt; Supervisor</td>
</tr>
<tr>
<td>Results x Skill</td>
<td>Intraday &gt; Supervisor</td>
</tr>
<tr>
<td>Results x Skill: Agents</td>
<td>Intraday &gt; Supervisor</td>
</tr>
<tr>
<td>Results x Skill: Calls</td>
<td>Intraday &gt; Supervisor</td>
</tr>
<tr>
<td>Results x Team</td>
<td>Intraday &gt; Supervisor</td>
</tr>
<tr>
<td>View: ASA</td>
<td>Intraday &gt; Supervisor</td>
</tr>
<tr>
<td>View: ATT</td>
<td>Intraday &gt; Supervisor</td>
</tr>
<tr>
<td>View: Agents</td>
<td>Intraday &gt; Supervisor</td>
</tr>
<tr>
<td>View: All Data</td>
<td>Intraday &gt; Supervisor</td>
</tr>
<tr>
<td>View: Calls</td>
<td>Intraday &gt; Supervisor</td>
</tr>
<tr>
<td>View: Occupancy</td>
<td>Intraday &gt; Supervisor</td>
</tr>
<tr>
<td>Supervisor: View all data columns</td>
<td>Intraday &gt; Supervisor &gt; Get Full Report</td>
</tr>
<tr>
<td>CSQ Historical Data</td>
<td>Historical &gt; CSQ Historicals</td>
</tr>
<tr>
<td>• Per Day</td>
<td></td>
</tr>
<tr>
<td>• Per Week</td>
<td></td>
</tr>
<tr>
<td>• Per Month</td>
<td></td>
</tr>
<tr>
<td>• Per Year</td>
<td></td>
</tr>
<tr>
<td>Role List</td>
<td>Administration &gt; Roles</td>
</tr>
<tr>
<td>Role Details</td>
<td>Administration &gt; Roles</td>
</tr>
</tbody>
</table>
Displaying a Report

WFM provides a (Print) icon in the toolbar or a Get Report button in a pane when reports are available. Use the following mouse actions to display a report.

- To display a report using the (Print) icon, click (Print) in the toolbar. The Birt Report Viewer displays the report in a separate browser.
- To display a report using the Get Report button, click Get Report in the pane. The Birt Report Viewer displays the report in a separate browser.

Use these options to view, print, and save reports.

Saving and Printing a Report

To save and print a report:

1. Click (Print) in the toolbar or click Get Report. A new browser window appears and displays the report.
2. Click (Export report). The Export Report dialog box appears.
3. Select the file format, the pages you want to export, and, for a PDF only, the size, then click OK. The File Download dialog box appears.
4. Complete one of the following steps.
   - To save the report, click Save. The Save As dialog box appears. Click Save.
   - To open the report, click Open. The browser window displays the report in the format you selected. Complete one of the following steps.
     - To print the report, click or choose File > Print. The Print dialog box appears. Click OK.
     - To save the report, click or choose File > Save As. The Save As dialog box appears. Click Save.

NOTE: The default file name may contain the long string of text from the browser Address field. It is recommended that you enter a descriptive name in the File name field before you click Save.
Exporting and Saving Report Data

To export and save report data:

1. Click (Print) in the toolbar or Get Report. A new browser window appears and displays the report.

2. Click (Export data). The Export Data dialog box appears.

3. Select the columns you want to export, the output encoding, and the separator, then click OK. The File Download dialog box appears. Complete one of the following steps.
   - To open the file, click Open. Microsoft Excel opens and displays the exported data. Complete one of the following steps.
     - To print the report, click or choose File > Print. The Print dialog box appears. Click OK.
     - To save the report, click or choose File > Save As. The Save As dialog box appears. Click Save.

       **NOTE:** The default file name may not be descriptive. It is recommended that you enter a descriptive name in the File name field before you click Save.

   - To save the file, click Save. The data you exported is saved to a CSV file.

       **NOTE:** The default file name may not be descriptive. It is recommended that you enter a descriptive name in the File name field before you click Save.
Getting Started

Introduction

This chapter covers the following topics:

■ Logging In to WFM (page 106)
■ Using the Administrator Interface (page 108)
■ Setting Display Preferences (page 114)
■ Entering Dates (page 117)
■ Selecting a CSQ (page 118)
■ Selecting a Team from the Context Pane (page 120)
■ Selecting a CSQ Mapping from the Context Pane (page 121)
Logging In to WFM

The following procedure describes how to log in to WFM.

**NOTE:** The degree of access you have to WFM is determined by the roles and views assigned to your username. For more information on roles and views, see "Managing Administration" on page 367.

**To log in to WFM:**

1. Enter the following URL in your web browser, where `<wfm>` is either the name or IP address of the server on which WFM is installed. The Workforce Management login window appears (Figure 21).

   **http://<wfm>:8087/c3/**

   **NOTE:** The website address is case sensitive.

2. Enter your WFM username and password. The username is not case sensitive and the password is case sensitive.
NOTE: If your company uses Active Directory with WFM, your WFM username and password is your network login username and password. If your company does not use Active Directory with WFM, ask your system administrator for your WFM username and password.

3. Click GO or press Enter to log in to WFM. The Workforce Management window appears ().

NOTE: The topics that appear in the Navigation menu depend on the roles that are assigned to the username you used to log in to WFM. For more information on roles, see "Managing Roles" on page 368.
Using the Administrator Interface

The WFM administrator interface () has two panes. The left pane contains the Navigation menu. The right pane displays the fields associated with the menu item you select in the left pane.

Using the Navigation Menu

Use these mouse actions to use the Navigation menu.

- To expand or collapse the menu, click any topic.
- To hide the Navigation pane, click ☐ (left arrow).
- To display the Navigation pane, click ▶ (right arrow).
- Click a task to display the associated data in the right pane.

Sorting a Table

Data that is presented in tabular form (Figure 22) can be sorted based on the contents of a single column in the table. The sort can be ascending or descending.

The small arrow at the right of the primary sort column header displays the direction of the sort, ascending or descending.

NOTE: Numbers are sorted from left to right, without accounting for the actual value of the number. For example, the numbers 1, 210, 0999, 3, 34, and 3104 are sorted in ascending order as follows:

0999, 1, 210, 3, 3104, 34
To sort a table:

- Click the column header. Click again to reverse the sort order.

Figure 22. Example of sortable table

Searching for an Item in a Table

If a table contains many items, use (Search) to locate an item more quickly. WFM provides simple and advanced searches:

To perform a search:

1. Click (Search). The simple search fields appear (Figure 23).

Figure 23. Simple search fields
2. You have two options for performing a search:

- To perform a simple search, enter the user’s first name or last name, or both first and last names in the fields.
- To perform an advanced search, click Advanced Search (Figure 24), and enter the appropriate text in the fields. To return to the simple search fields, click Simple Search.

![Figure 24. Advanced search fields](image)

3. Click (Go). The results appear in the list.

**NOTE:** If you press the Enter key instead of clicking (Go), WFM places the focus on the first icon in the toolbar. For example, if the first image is (New), WFM displays a pane in which you can add a component (for example, the General tab on the Team Details pane). You must click (Go) to execute the search.

**Viewing Long Tables**

WFM often displays information in tables. Some tables have more rows than can be viewed on one pane. When a table is large, options appear at the bottom of the pane that allow you to move quickly through the table.

You view tables either in paging mode (the default) or scrolling mode. Figure 25 displays the text that appears at the bottom of the pane when you are in paging mode.

![Figure 25. Paging mode](image)

**Figure 26** displays the text that appears at the bottom of the pane when you are in scrolling mode.

![Figure 26. Scrolling mode](image)
Use these mouse actions to view a large table.

- Click Show All to switch to scrolling mode and display the table on a single page. Use the scroll bar on the right to move up and down on the page.
- Click Paging Mode to display items on multiple pages. When in paging mode, use the following mouse actions:
  - Click (Next Group) or (Previous Group) to move forward or backward 5 pages at a time.
  - Click Last to go to the last page.
  - Click First to go to the first page.
  - Enter a page number in the Goto field and click Goto to jump directly to that page. You can also click the desired page number between the arrows.

Moving Items between Lists

Use these mouse actions to select items in an available list and move them to an assigned list.

- To select an item in an available list, click the name of the item.
- To select multiple non-contiguous items in the available list, press the Ctrl key while selecting each item in the list.
- To select multiple contiguous items in an available list, click the first item in the list, and shift-click on the last item in the list.
- To move the available items to the assigned list, select the names of the items in the available list, then click >. The names of the selected items move to the assigned list.

Use these mouse actions to select items in an assigned list and move them to an available list.

- To select an item in an assigned list, select the check box next to the item.
- To select multiple non-contiguous items in the assigned list, select the check box next to each item.
- To select all items in an assigned list, select check box in the column header of the assigned list. A check mark appears in all check boxes in the assigned list.
- To move the assigned items to the available list, select the names of the items in the assigned list, then click <. The names of the selected items move to the available list.
Refreshing Data Displayed on a Pane

If the pane does not include a (Refresh) button, click another task in the Navigation menu, and then return to the original pane to refresh the data on the pane.

Icon Descriptions

The following table describes the most frequently-used actions and their icons.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔖</td>
<td>Hide</td>
<td>Hide the Navigation pane.</td>
</tr>
<tr>
<td>🔘</td>
<td>Restore</td>
<td>Display the Navigation pane.</td>
</tr>
<tr>
<td>☣️</td>
<td>New</td>
<td>Create a new file (user, agent, CSQ mapping, etc.).</td>
</tr>
<tr>
<td>📄</td>
<td>Copy</td>
<td>Copy an item.</td>
</tr>
<tr>
<td>📄</td>
<td>Paste</td>
<td>Paste an item.</td>
</tr>
<tr>
<td>📄</td>
<td>Save</td>
<td>Save the newly-created or modified items.</td>
</tr>
<tr>
<td>❌</td>
<td>Delete</td>
<td>Delete the selected files.</td>
</tr>
<tr>
<td>🔍</td>
<td>Search</td>
<td>Search for items in a list.</td>
</tr>
<tr>
<td>🗂️</td>
<td>Print</td>
<td>Generate a report in a separate browser using the information on the current screen. The report can then be saved to a file or sent to a printer. See &quot;Generating Reports&quot; on page 100 for more information.</td>
</tr>
<tr>
<td>🗂️</td>
<td>Export data</td>
<td>Export report data to a text file. See &quot;Exporting and Saving Report Data&quot; on page 103 for more information.</td>
</tr>
<tr>
<td>🗂️</td>
<td>Export report</td>
<td>Export report data to a PDF or XLS file. See &quot;Exporting and Saving Report Data&quot; on page 103 for more information.</td>
</tr>
<tr>
<td>🕒</td>
<td>Adjusted Time / Not Adjusted Time</td>
<td>Toggle between the time zone associated with the virtual CSQ or service (Adjusted Time) and the time zone associated with a single CSQ or service within the virtual CSQ or service (Not Adjusted Time).</td>
</tr>
<tr>
<td>🔄</td>
<td>Refresh</td>
<td>Refresh the displayed data (if applicable).</td>
</tr>
<tr>
<td>✅</td>
<td>Launch a request</td>
<td>Submit a processing request to the server.</td>
</tr>
<tr>
<td>🍃</td>
<td>Define the context</td>
<td>Define the work context (for example, CSQ or service or date).</td>
</tr>
</tbody>
</table>
### Navigation Button Descriptions

The following table describes the most frequently-used navigation buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences</td>
<td>Displays the My Preferences pane. See &quot;Setting Display Preferences&quot; on page 114 for more information.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays help. WFM provides detailed, browser-based help with comprehensive descriptions and step-by-step procedures.</td>
</tr>
<tr>
<td>About</td>
<td>Displays information about the WFM version in a separate dialog box.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE</strong>: Turn off your pop-up blocker to view this information.</td>
</tr>
<tr>
<td>Logout</td>
<td>Ends your session. When you click Logout, a confirmation dialog box appears. Click OK to confirm logging out and display the WFM Login window.</td>
</tr>
</tbody>
</table>

### Icon Action Descriptions

The following table describes the most frequently-used navigation buttons.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Group</td>
<td>Move forward 5 pages at a time.</td>
<td></td>
</tr>
<tr>
<td>Previous Group</td>
<td>Move backward 5 pages at a time.</td>
<td></td>
</tr>
<tr>
<td>Back</td>
<td>Return to previous pane. <strong>NOTE</strong>: The back button in Internet Explorer is disabled.</td>
<td></td>
</tr>
<tr>
<td>Graph</td>
<td>Display a data graph. <strong>NOTE</strong>: This icon appears only when there are 100 or fewer rows in a table.</td>
<td></td>
</tr>
<tr>
<td>New exception request</td>
<td>Create a new exception request.</td>
<td></td>
</tr>
<tr>
<td>New schedule swap request</td>
<td>Create a new request to trade schedules.</td>
<td></td>
</tr>
<tr>
<td>Edit</td>
<td>Edit a request.</td>
<td></td>
</tr>
</tbody>
</table>
Setting Display Preferences

Use the procedures below to change your display preferences.

- Displaying the Date Format (page 114)
- Customizing Dashboards (page 114)
- Selecting Schedule Display Parameters (page 115)
- Changing Your Password (page 116)

Displaying the Date Format

Use this procedure to view the default date format that appears in WFM panes and reports. The format displayed depends on your locale. For example, in the US, the date format displayed is mm-dd-yyyy.

Use the displayed format when entering dates. You cannot change the date format.

To display the default date format:

- Click Preferences and select the General tab. The General tab displays the Date Format (Figure 27).

Fig 27. My Preferences: General tab

Customizing Dashboards

Use this procedure to select the views and formats you want to appear on the Supervisor Dashboard and Supervisor panes.

To customize a dashboard

1. Click Preferences and select the Dashboard tab. The Dashboard tab appears.
2. Select the view you want to display on the Supervisor Dashboard pane from the Dashboard View drop-down list.
3. Select the view you want to display on the Supervisor pane from the Statistics View drop-down list.

4. Select the data you want to display for each graph in the Supervisor Dashboard pane from the Graph #1 Data, Graph #2 Data and Graph #3 Data drop-down lists.

5. Select the format you want for each graph in the Supervisor Dashboard pane from the Graph #1 Format, Graph #2 Format and Graph #3 Format drop-down lists.

6. Click (Save) to save your changes.

Selecting Schedule Display Parameters

Use this procedure to select the information that you want to appear on your schedule.

**To select schedule display parameters:**

1. Click Preferences and select the Schedule tab. The Schedule tab displays schedule options (Figure 28).

![Figure 28. My Preferences: Schedule tab](image)

2. Choose one of the following options from the Show Unavailable Agents on the Schedule drop-down list.
   - Yes: Displays unavailable agents on the schedule. Unavailable agents are agents who are not available to work.
   - No: Hides unavailable agents on the schedule.

3. In the Start Time field, select the time you want the schedule display to start.

4. In the End Time field, select the time when you want the schedule display to end.

5. Click (Save) to save your changes.
Changing Your Password

Use this procedure to change the password you use when logging in to WFM.

**NOTE:** If you are using Active Directory, the Password tab only appears if you are logged in as an administrator.

To change your password:

1. Click Preferences, and select the Password tab. The Password tab enables you to change your password (Figure 29).

2. Enter your current password in the Old Password field.
3. Enter your new password in the New Password field.
4. Reenter your new password in the Confirm New Password field to ensure the accuracy of what you entered in the New Password field.
5. Click (Save) to save your changes.

![Figure 29. My Preferences: Password tab](image)
Entering Dates

When entering dates in WFM, you can either:

- Enter the date manually using the format specified on the General tab in My Preferences (by default, mm-dd-yyyy)
- Select the date from the popup calendar that appears when you click the date field

To enter a date in a field using the popup calendar:

1. Click a date field in the pane. The calendar appears at the top of the Navigation pane.

2. Fill the date field by selecting the desired date from the popup calendar. By default, the calendar displays the current month and year.
   - To select a previous or future year, click the desired year at the bottom right of the calendar.
   - To select a month, click the letter associated with the month at the bottom left of the calendar. The letters are displayed in month order. You can also display the next or previous month by clicking (next month) or (previous month).
   - To select a day, click the date in the calendar.

3. Click Close to dismiss the calendar.
Selecting a CSQ

You can select a CSQ from the toolbar or Context pane.

This section covers the following topics.

- Selecting a CSQ from the Toolbar (page 118)
- Selecting a CSQ from the Context Pane (page 119)

Selecting a CSQ from the Toolbar

To select a CSQ from the toolbar:

- Select the name of the CSQ from the drop-down list in the toolbar (Figure 31).

Figure 31. Toolbar

![CSQ drop-down list]
Selecting a CSQ from the Context Pane

To select a CSQ from the Context pane:

1. Click (Define the Context) in the toolbar. The context pane displays CSQ options (Figure 32).

2. Click a number or description in the CSQs list. The information for the CSQ appears to the right of the pane.

3. Click (Define the Context) to dismiss the Context pane.
Selecting a Team from the Context Pane

To select team from the Context pane:

1. Click (Define the Context) in the toolbar. The context pane appears.
2. Click the TE (Team) tab. The Context pane displays team options (Figure 33).

3. Click a number or team in the Select a Team list. The information for the team appears to the right of the pane.
4. Click (Define the Context) to dismiss the Context pane.
Selecting a CSQ Mapping from the Context Pane

To select a CSQ mapping from the Context pane:

1. Click (Define the Context) in the toolbar. The context pane appears.
2. Click the CMA (CSQ Mappings) tab. The Context pane displays CMA options (Figure 34).

Figure 34. Context pane: CMA tab

<table>
<thead>
<tr>
<th>September 2007</th>
</tr>
</thead>
<tbody>
<tr>
<td>S  T  W  T  F  S</td>
</tr>
<tr>
<td>2  3  4  5  6  7  8</td>
</tr>
<tr>
<td>9  10 11 12 13 14 15</td>
</tr>
<tr>
<td>16 17 18 19 20 21 22</td>
</tr>
<tr>
<td>23 24 25 26 27 28 29</td>
</tr>
<tr>
<td>30</td>
</tr>
<tr>
<td>J  F  M  A  M  J  2006</td>
</tr>
<tr>
<td>J  A  S  O  N  D  2008</td>
</tr>
</tbody>
</table>

| CSQ | TE | CMA |

<table>
<thead>
<tr>
<th>CSQ Mappings</th>
<th>Number</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0007</td>
<td>Overflow...</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>SGM</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>test</td>
</tr>
<tr>
<td></td>
<td>11</td>
<td>IT</td>
</tr>
<tr>
<td></td>
<td>1111</td>
<td>Tech Su...</td>
</tr>
<tr>
<td></td>
<td>12345...</td>
<td>907654321</td>
</tr>
<tr>
<td></td>
<td>22</td>
<td>MQA1</td>
</tr>
<tr>
<td></td>
<td>223</td>
<td>minasya</td>
</tr>
<tr>
<td></td>
<td>55</td>
<td>MQA2</td>
</tr>
<tr>
<td></td>
<td>1m</td>
<td>Custom...</td>
</tr>
</tbody>
</table>

3. Click a number or name in the CSQ Mappings list. The information for the CSQ mapping appears to the right of the pane.
4. Click (Define the Context) to dismiss the Context pane.
Managing the Environment

Introduction

You can use the Environment module to manage a Cisco Unified Contact Center Express (Unified CCX) environment.

This chapter covers the following topics:

- Managing CSQ Mappings (page 124)
- Managing CSQs (page 130)
- Managing Exception Types (page 148)
- Managing Time Zones (page 154)
Managing CSQ Mappings

You can use the CSQ mappings function to complete the following tasks.

- Create CSQ mappings. For instructions, see "Creating a CSQ Mapping" on page 125.
- Edit CSQ mappings. For instructions, see "Editing a CSQ Mapping" on page 126.
- Assign agents to CSQ mappings. For instructions, see "Assigning Agents to a CSQ Mapping" on page 127.
- Assign CSQs to CSQ mappings. For instructions, see "Assigning CSQs to CSQ Mapping" on page 128.
- Delete CSQ mappings. For instructions, see "Deleting a CSQ Mapping" on page 129.

See "Understanding CSQ Mappings" on page 36 for more information.
Creating a CSQ Mapping

To create a new CSQ mapping:

1. Choose Environment > CSQ Mappings. The CSQ Mapping List appears (Figure 35).

![Figure 35. CSQ Mapping List](image)

2. Click (New) to create a CSQ mapping. The CSQ Mapping Details pane displays general options (Figure 36).

![Figure 36. CSQ Mapping Details: General tab](image)

3. Enter the name of the CSQ mapping. This name can contain up to 25 alphanumeric characters.

   **NOTE:** If the CSQ mapping exists in Unified CCX, Sync Service automatically loads the value into this field.

4. Click (Save) to save your changes. The following new tabs appear: Agents and CSQs.

   The following topics are procedures for assigning agents and CSQs.
   - Assigning Agents to a CSQ Mapping (page 127)
   - Assigning CSQs to CSQ Mapping (page 128)
Managing CSQ Mappings

Editing a CSQ Mapping

To edit a CSQ mapping:

1. Choose Environment > CSQ Mappings.
2. Click a name in the CSQ Mapping list. The CSQ Mapping Details pane displays general options (Figure 37).

Figure 37. CSQ Mapping Details: General tab

3. Change the name of the CSQ mapping. This name can contain up to 25 alphanumeric characters.

   NOTE: If you are using Unified CCX, Sync Service loads the value into this field. Do not change the name if you are using Unified CCX.

4. Click (Save) to save your changes.

   To add agents to this CSQ mapping, go to "Assigning Agents to a CSQ Mapping" on page 127.
Assigning Agents to a CSQ Mapping

**NOTE:** WFM cannot create a schedule for an agent if no CSQ mappings are assigned to the agent.

This procedure describes how to assign agents to a CSQ mapping.

**To assign an agent to a CSQ mapping:**

1. Click the Agents tab. The CSQ Mapping Details pane displays available and assigned agents (Figure 38).

![Figure 38. CSQ Mapping Details: Assign Agents tab](image)

2. If desired, filter the list of agents by team or CSQ mapping.

   **NOTE:** If you choose the blank option from the drop-down list, WFM displays all agents.

3. To assign agents to a CSQ mapping, select their names in the Available Agents list, then click >. The names of the selected agents move to the Assigned Agents list. See "Moving Items between Lists" on page 111 for more information.

4. To remove agents from a CSQ mapping, select their names from the Assigned Agents list, then click <. The names of the selected agents move to the Available Agents list.

5. Click (Save) to save your changes.
Assigning CSQs to CSQ Mapping

Use this procedure to create CSQ mappings for CSQs (including virtual CSQs) for Unified CCX.

The Sync Service automatically creates a one-to-one CSQ mapping for each CSQ it loads into WFM from Unified CCX. You cannot change a CSQ mapping that was created by the Sync Service.

To assign CSQs to a CSQ mapping:

1. Click the CSQs tab. The CSQ Mapping Details pane displays available and assigned CSQs (Figure 39).

2. To assign CSQs to a CSQ mapping, select the names of the CSQ in the Available CSQs list, then click >. The names of the CSQs move to the Assigned CSQs list. See "Moving Items between Lists" on page 111 for more information.

3. To remove CSQs from a CSQ mapping, select the check box next to the number of the CSQs from the Assigned CSQs list, then click <. The names of the CSQs return to the Available CSQs list.

4. Assign a priority to each CSQ.

NOTE: Assigning priorities to each CSQ allows WFM to resolve scheduling conflicts when agents are assigned to multiple CSQs. The highest priority
Managing CSQ Mappings

is 1. For example, you designate some of your agents to support two CSQs, and assign a priority to each CSQ in WFM. (If WFM generates the schedules for the two CSQs, and discovers there are not enough agents to support all forecast requirements across both CSQs, it compares the priority value for the two CSQs. WFM then schedules agents for the CSQ with the highest priority first.

5. Click (Save) to save your changes.

Deleting a CSQ Mapping

NOTE: For Unified CCX, do not use this procedure to delete CSQ mappings imported by the Sync Service.

To delete a CSQ mapping:

1. Choose Environment > CSQ Mappings.
2. Select the CSQ mapping to delete by completing one of the following steps.
   ■ To delete one or more CSQ mappings, select the check box next to the name of the CSQ mapping.
   ■ To delete all CSQ mappings, select the check box in the column header.
3. Click (Delete). An Internet Explorer dialog box appears.
4. Click OK to confirm the deletion and dismiss the dialog box.
Managing CSQs

A CSQ is a group of agents to which contacts are routed. It is generally associated with a specific skill. In WFM, you schedule agents to support the CSQ call or email requirements. For this reason, WFM makes CSQs the focal point for schedules and forecasts.

This section covers the following topics.

- Creating a CSQ for Calls (page 130)
- Creating a CSQ for Email (page 138)
- Editing a CSQ (page 140)
- Assigning CSQ Mappings to a CSQ (page 141)
- Creating a Virtual CSQ (page 142)
- Entering Scheduling Order (page 145)
- Deleting a CSQ (page 147)

See "Understanding Contact Service Queues" on page 37 for more information.

Creating a CSQ for Calls

**NOTE:** You can create a CSQ for each type of call or chat service you want your agents to handle (for example, sales calls or IT help desk chat services).

To create a new CSQ of type Calls:

1. Choose Environment > CSQs. The Contact Service Queue List appears (Figure 42).

**Figure 40. Contact Service Queue List**

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
<th>CSQ Priority</th>
<th>Time Zone</th>
<th>Virtual CSQ</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>cso01</td>
<td>1</td>
<td>Disabled</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>cso02</td>
<td>2</td>
<td>Disabled</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>cso03</td>
<td>0</td>
<td>Disabled</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>WFM_CSQ</td>
<td>0</td>
<td>Disabled</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>cso_e01</td>
<td>0</td>
<td>Disabled</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>cso_e02</td>
<td>0</td>
<td>Disabled</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>cad_dev</td>
<td>0</td>
<td>Disabled</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>cal_dev</td>
<td>0</td>
<td>Disabled</td>
<td></td>
</tr>
</tbody>
</table>
2. Click (New) to create a new CSQ. The CSQ Details pane displays general CSQ options (Figure 43).

Figure 41. CSQ Details: General tab

3. Choose Calls as the CSQ Type and complete the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>The number associated with this CSQ. This number is used to identify the CSQ. This name can contain up to 25 alphanumeric characters. This is a required field.</td>
</tr>
</tbody>
</table>

**NOTE:** Do not change the number if you are editing a CSQ, and you are using Unified CCX. The Sync Service loads the value from Unified CCX into this field.

See "Creating a Virtual CSQ" on page 142 for more information.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Forecasts or Schedules</td>
<td>Select the No Forecasts or Schedules check box if you do not want WFM to run any forecasts or schedules for this CSQ. If this option is selected, the CSQ only appears in the historical data and intraday sections. The CSQ is no longer in service and does not appear in the distribution, forecast or schedules.</td>
</tr>
<tr>
<td>Virtual CSQ</td>
<td>WFM automatically selects the Virtual CSQ check box when this CSQ contains other CSQs. For more information, see &quot;Creating a Virtual CSQ&quot; on page 142.</td>
</tr>
<tr>
<td>MSAQ</td>
<td>Select the MSAQ check box if you plan to run a MSAQ schedule request for 2 or more CSQs. See &quot;Understanding Multi Skill Agent Queuing&quot; on page 53 for more information.</td>
</tr>
<tr>
<td>Description</td>
<td>The description for this CSQ. The description cannot exceed 50 alphanumeric characters.</td>
</tr>
<tr>
<td>Color</td>
<td>Click the Color field to display the color palette, and select a color. WFM displays the color and the Java number associated with the color. The default color is green. This color appears in the In service time column on the schedule maintenance pane. You can select a color for each CSQ (for example, Customer Service, Email Service, and French). To avoid confusion, select a unique color for each CSQ.</td>
</tr>
<tr>
<td>CSQ Type</td>
<td>You can designate a CSQ to exclusively handle a specific type of service (for example, calls, email or chat). Choose the CSQ type. Your options are:</td>
</tr>
<tr>
<td></td>
<td>• Calls: Choose this option if the agents are handling customer calls or chat services. When you choose Calls, you must specify the Service Level Objective in seconds.</td>
</tr>
<tr>
<td></td>
<td>• Email: Choose this option if the agents are handling customer email. When you choose Email, you must specify the Service Level Objective in hours.</td>
</tr>
<tr>
<td></td>
<td>WFM uses this information when generating forecasts.</td>
</tr>
</tbody>
</table>


Managing CSQs

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSQ Priority</td>
<td>The priority assigned to this CSQ. Assigning a priority number to a CSQ allows WFM to resolve scheduling conflicts when agents are assigned to multiple CSQs. 1 is the highest priority.</td>
</tr>
</tbody>
</table>

To generate a schedule for a CSQ, WFM locates the agents with a CSQ mapping to the desired CSQ. WFM then determines which agents have a work shift with available hours on the specified day. See "Managing Work Shifts" on page 178 for more information. If the agent supports multiple CSQs, WFM uses CSQ priority to determine which CSQ will be assigned to the agent for this schedule. See "Entering Scheduling Order" on page 145 for more information.

For example, you designate some of your agents to support two CSQs, and assign a priority to each CSQ in WFM. (If WFM generates the schedules for the two CSQs, and discovers there are not enough agents to support all forecast requirements across both CSQs, it compares the priority value for the two CSQs. WFM then schedules agents for the CSQ with the highest priority first. See "Assigning CSQs to CSQ Mapping" on page 128 for more information on CSQ priority.)
Priority Assigning a priority number to a service allows WFM to resolve scheduling conflicts when agents are assigned to multiple services. 1 is the highest priority.

To generate a schedule for a service, WFM locates the agents with a service mapping to the desired service. WFM then determines which agents have a work shift with available hours on the specified day. See "Managing Work Shifts" on page 178 for more information. If the agent supports multiple services, WFM uses priority to determine which service will be assigned to the agent for this schedule. See "Entering Scheduling Order" on page 145 for more information.

For example, you designate some of your agents to support two services, and assign a priority to each service in WFM. (If WFM generates the schedules for the two services, and discovers there are not enough agents to support all forecast requirements across both services, it compares the priority value for the two service. WFM then schedules agents for the services with the highest priority first. See "Assigning CSQs to CSQ Mapping" on page 128 for more information on priority.

The Priority only appears when you are running WFM with Avaya CMS or Nortel Contact Center.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Priority</td>
<td>Assigning a priority number to a service allows WFM to resolve scheduling conflicts when agents are assigned to multiple services. 1 is the highest priority.</td>
</tr>
<tr>
<td></td>
<td>To generate a schedule for a service, WFM locates the agents with a service mapping to the desired service. WFM then determines which agents have a work shift with available hours on the specified day. See &quot;Managing Work Shifts&quot; on page 178 for more information. If the agent supports multiple services, WFM uses priority to determine which service will be assigned to the agent for this schedule. See &quot;Entering Scheduling Order&quot; on page 145 for more information. For example, you designate some of your agents to support two services, and assign a priority to each service in WFM. (If WFM generates the schedules for the two services, and discovers there are not enough agents to support all forecast requirements across both services, it compares the priority value for the two service. WFM then schedules agents for the services with the highest priority first. See &quot;Assigning CSQs to CSQ Mapping&quot; on page 128 for more information on priority. The Priority only appears when you are running WFM with Avaya CMS or Nortel Contact Center.</td>
</tr>
<tr>
<td>Standard Talk Time</td>
<td>The standard talk time in seconds for this CSQ. The standard talk time is the elapsed time from when an agent answers a call until the agent disconnects. It can be an average or an objective. You can specify that WFM update the value of standard talk time when calculating a distribution by selecting the Update CSQ Times check box on the Distribution Request pane under Forecasting &gt; Distribution. See &quot;Creating a Distribution&quot; on page 224 for more information. WFM uses this information to determine the number of agents required. You can enter the standard talk time for each CSQ in WFM. Alternatively, you can let WFM generate these values automatically based on historical data when running a contact distribution.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Standard Work Time</td>
<td>The standard after call work time in seconds for this CSQ. The standard after call work time can be an average or an objective. You can specify that WFM update the value of standard work time when calculating a distribution by selecting the Update CSQ Times check box on the Distribution Request pane under Forecasting &gt; Distribution. See &quot;Creating a Distribution&quot; on page 224 for more information. WFM uses this information to determine the number of agents required. You can enter the standard work time for each CSQ in WFM. Alternatively, you can let WFM generate these values automatically based on historical data when running a contact distribution.</td>
</tr>
<tr>
<td>Standard After Call Work</td>
<td>The standard after call work time in seconds for this service. The standard after call work time can be an average or an objective. You can specify that WFM update the value of standard work time when calculating a distribution by selecting the Update Service Times check box on the Distribution Request pane under Forecasting &gt; Distribution. See &quot;Creating a Distribution&quot; on page 224 for more information. WFM uses this information to determine the number of agents required. You can enter the standard after call work time for each service in WFM. Alternatively, you can let WFM generate these values automatically based on historical data when running a contact distribution. The Standard After Call Work only appears when you are running WFM with Avaya CMS or Nortel Contact Center.</td>
</tr>
<tr>
<td>Standard Productivity</td>
<td>The percentage of time an agent in a CSQ spends answering customer contacts. Agents in a contact center are generally productive between 80 and 85% of the time. However, if your contact center is generally productive 60% of the time, you need to enter that productivity value here.</td>
</tr>
</tbody>
</table>
A service level objective is a speed of answer goal that is often expressed as a percentage goal for answering calls within a specified number of seconds or email within a specified number of hours. For example, 80% of all calls answered within 20 seconds or 100 percent of email answered within 24 hours. A more demanding quality objective requires a higher staffing level.

If your CSQ Type is calls, enter the percentage in the % field and the number of seconds in the sec field for Service Level Objective.

If your CSQ Type is email, enter the percentage in the % field and the number of hours in the hrs field for Service Level Objective.

**NOTE:** WFM uses this information to determine the number of agents required. The values entered in these fields determine the number of agents projected (Agents Projected column) in Intraday > Supervisor. If the percentages are zero (0), zero appears in the Agents Projected column.

The percentage of contacts handled for this service. Then enter time allowed for this quality objective. For example, if you select Calls as your Service Type, you can specify that all agents must respond to 80% of all calls within 20 seconds or less. If you select Email as your Service Type, you can specify that all agents must respond to 80% of all email within 24 hours or less.

The Quality Objective only appears when you are running WFM with Avaya CMS or Nortel Contact Center.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Level Objective</td>
<td>A service level objective is a speed of answer goal that is often expressed as a percentage goal for answering calls within a specified number of seconds or email within a specified number of hours. For example, 80% of all calls answered within 20 seconds or 100 percent of email answered within 24 hours. A more demanding quality objective requires a higher staffing level. If your CSQ Type is calls, enter the percentage in the % field and the number of seconds in the sec field for Service Level Objective. If your CSQ Type is email, enter the percentage in the % field and the number of hours in the hrs field for Service Level Objective. <strong>NOTE:</strong> WFM uses this information to determine the number of agents required. The values entered in these fields determine the number of agents projected (Agents Projected column) in Intraday &gt; Supervisor. If the percentages are zero (0), zero appears in the Agents Projected column.</td>
</tr>
<tr>
<td>Quality Objective</td>
<td>The percentage of contacts handled for this service. Then enter time allowed for this quality objective. For example, if you select Calls as your Service Type, you can specify that all agents must respond to 80% of all calls within 20 seconds or less. If you select Email as your Service Type, you can specify that all agents must respond to 80% of all email within 24 hours or less. The Quality Objective only appears when you are running WFM with Avaya CMS or Nortel Contact Center.</td>
</tr>
</tbody>
</table>
Managing CSQs

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Zone</td>
<td>Select the time zone in which the CSQ or virtual CSQ is located from the drop-down list. If the CSQs assigned to a virtual CSQ are located across multiple time zones, you must designate a base location and time zone for the virtual CSQ. If this is a virtual CSQ, use the Hour Gap field on the Virtual CSQs tab to manage the different time zones for each CSQ in the virtual CSQ. See &quot;Creating a Virtual CSQ&quot; on page 142 for more information. The CSQ and agent can be assigned to different time zones or the same time zone. For example, if the agent is located in the Montreal contact center and the CSQ is located in Minneapolis, select the (GMT -5:00) Eastern (U.S.A. and Canada) for the agent’s time zone and (GMT -6:00) Central for the CSQ based in Minneapolis. If the agent’s start time is 9:00 am in Montreal, when a scheduler looks at the schedules for the CSQ, the agent’s start time appears as 8:00 am. Select the Disabled option from the drop-down list only if you are producing schedules for CSQs that are located in different time zones.</td>
</tr>
<tr>
<td>Opening</td>
<td>The hours between opening and closing are when the contact center accepts calls for a CSQ. <strong>NOTE:</strong> Agents may be scheduled for additional hours to perform work that is not related to the call center (for example, training, meetings, or set up work). Select the opening hours for each day of the week. Select the blank option located at the beginning of the drop-down list when the office is closed for the entire day. Open hours specified in these fields apply to the CSQ. It does not apply to the contact center. WFM captures historical data for CSQ activity within the specified opening and closing times, and days. <strong>NOTE:</strong> WFM does not keep historical data for times and days not specified.</td>
</tr>
</tbody>
</table>
Click \(\text{(Save)}\) to save your changes. The CSQ Mappings, CSQs, and Parameters tabs appear. Follow the instructions in the following topics to complete the CSQ.

- Assigning CSQ Mappings to a CSQ (page 141)
- Creating a Virtual CSQ (page 142)
- Entering Scheduling Order (page 145)

Creating a CSQ for Email

You can create a CSQ for each type of email you want your agents to handle (for example, sales or IT help desk email).

**NOTE:** Historical email volume is not available for a CSQ of type Email. It must be entered manually.
To create a new CSQ of type Email:

1. Choose Environment > CSQs. The Contact Service Queue List appears (Figure 42).

2. Click (New) to create a new CSQ. The CSQ Details pane displays general CSQ options (Figure 43).
3. Choose Email as the CSQ Type and complete the fields. The fields are described in "Creating a CSQ for Calls" on page 130.

4. Click (Save) to save your changes. The CSQ Mappings, Virtual CSQs, and Scheduling Order tabs appear.

Follow the instructions in the following topics to complete the CSQ:

- Assigning CSQ Mappings to a CSQ (page 141)
- Creating a Virtual CSQ (page 142)
- Entering Scheduling Order (page 145)

Editing a CSQ

To edit a CSQ:

1. Choose Environment > CSQs. The Contact Service Queue List appears (Figure 44).

Figure 44. Contact Service Queue List
2. Click the number of the CSQ you want to edit in the Number column. The CSQ Details pane displays general CSQ options (Figure 45).

![Figure 45. CSQ Details: General tab](image)

3. Complete the fields. The fields are described in "Creating a CSQ for Calls" on page 130. The Number field is disabled.

   **NOTE:** If you change the Opening and Closing hours for this CSQ, you must run an new distribution and forecast to reflect the change.

4. Click (Save) to save your changes.

**Assigning CSQ Mappings to a CSQ**

Use this procedure to assign CSQ mappings to CSQs and virtual CSQs for Unified CCX.

**NOTE:** You must assign a CSQ mapping to a CSQ before you can generate a schedule. If a CSQ mapping is not assigned to a CSQ, no agents will be assigned to the schedule.

The Sync Service automatically creates a one-to-one CSQ mapping for each CSQ it loads into WFM from Unified CCX. You cannot change a CSQ mapping that was created by the Sync Service.
To assign CSQ mappings to a CSQ:

1. Click the CSQ Mappings tab. The CSQ Details pane displays available and assigned CSQ mappings (Figure 46).

![Figure 46. CSQ Details: CSQ Mappings tab](image)

2. To assign CSQ mappings to a CSQ, select the names of the CSQ mappings in the Available CSQ Mappings list, then click >. The names of the CSQ mappings move to the Assigned CSQ Mappings list. See "Moving Items between Lists" on page 111 for more information.

3. To remove CSQ mappings from a CSQ, select the check box next to each name of the CSQ mapping from the Assigned CSQ Mappings list, then click <. The names of the CSQ mappings return to the Available CSQ Mappings list.

4. Assign a priority to each CSQ mapping. Assigning priorities to each CSQ mapping allows WFM to resolve scheduling conflicts when agents are assigned to multiple CSQ mappings. The highest priority is 1.

5. Click (Save) to save your changes.

Creating a Virtual CSQ

A virtual CSQ is a collection of CSQs unified (or merged) into a single CSQ. It can be associated with multiple CSQs. WFM uses the virtual CSQ when generating statistics, schedules, and forecasts.
Create a virtual CSQ when you want to create a single forecast, scenario or schedule for a group of CSQs. Consider creating a virtual CSQ if you have a group of agents who all support the same type of calls.

Once you create a virtual CSQ, WFM will start collecting historical data for the virtual CSQ. If historical data already exists for each CSQ in the virtual CSQ, you need to merge the historical data from the source CSQs into the virtual CSQ (Special Functions > Historical Merge).

**NOTE:** Historical email volume is not available for a virtual CSQ of type Email. It must be entered manually.

All historical data is merged into the virtual CSQ, including:

- Contact volume (sum)
- Talk time (average)
- ASA (weighted average)
- Quality of service (weighted average)
- ACW (weighted average)

A distribution, forecast, scenario, and schedule can be calculated for a virtual CSQ after you merge the required historical data. To create historical data for a virtual CSQ, see "Managing Special Functions" on page 355. To generate forecasts for a virtual CSQ, see "Managing Forecasts" on page 223.

You can add or remove CSQs from a virtual CSQ at any time by editing the CSQ. The historical data for each source CSQ within a virtual CSQ is available.

Use this procedure to create a virtual CSQ.

**To create a virtual CSQ:**

1. Click the Virtual CSQs tab. The CSQ Details pane displays available and assigned virtual CSQs (Figure 47).

**Figure 47. CSQ Details: Virtual CSQs tab**
2. To assign CSQs to a virtual CSQ, select the names of the CSQs in the Available Source CSQs list, then click >. The names of the CSQs move to the Assigned Source CSQs list.

3. To remove CSQs from a virtual CSQ, select the check box next to each name in the Assigned Source CSQs list, then click <. The names of the CSQs return to the Available Source CSQs list.

4. Enter a number in the Hour Gap field for each CSQ in the virtual CSQ. The hour gap is the time zone difference between the CSQs and the base time zone for the virtual CSQ (for example, 3 or -3). If all of your CSQs are in the same time zone, enter 0. This ensures that all reports display the correct information.

   For example, if the largest CSQ in the virtual CSQ is located in Minneapolis, you specify the time zone for Minneapolis which is Greenwich Mean Time (GMT) -6:00 as the base time zone for the virtual CSQ. The time zone for the Ottawa CSQ is GMT -5:00, and the Vancouver CSQ is GMT -8:00. You must enter the time zone difference for each CSQ in the virtual CSQ in the Hour Gap field. In this example, the time zone difference for the Ottawa CSQ is 1.0, and the Vancouver CSQ is 2.0.

5. Click (Save) to save your changes. WFM starts collecting data for the virtual CSQ.
**Entering Scheduling Order**

This procedure describes how to enter the scheduling order for the CSQ.

*To enter a scheduling order:*

1. Click the Scheduling Order tab. The CSQ Details pane displays options for prioritizing the order in which agents are scheduled in a CSQ (Figure 48).

   ![Figure 48. CSQ Details: Scheduling Order tab](image)

2. Click Reset Priorities. The default priorities appear under Scheduling Order Parameters (Figure 49).

   ![Figure 49. CSQ Details: Scheduling Order tab](image)

3. Change the number in the CSQ Priority field next to each parameter to change the preset priority order. 1 is the highest priority.

   **NOTE:** If you do not want to save your changes, click Reset Priorities to restore the priorities to their system default values.
The parameters are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Hours Available</td>
<td>The maximum number of hours when the agent is available during the work shift. This number is the sum of maximum availability for each day across all days of the week.</td>
</tr>
<tr>
<td>Minimum Hours Available</td>
<td>The minimum number of hours when the agent is available during the work shift. This number is the sum of minimum availability for each day across all days of the week. This parameter is configured in the Work Shift Detail pane. See &quot;Managing Work Shifts&quot; on page 178 for more information.</td>
</tr>
<tr>
<td>Maximum Hours per Week</td>
<td>The maximum number of hours when the agent can work each week. This parameter is configured in the Work Shift Detail pane. See &quot;Managing Work Shifts&quot; on page 178 for more information.</td>
</tr>
<tr>
<td>Minimum Hours per Week</td>
<td>The minimum number of hours when the agent can work each week. This parameter is configured in the Work Shift Detail pane. Your work shift is variable if there is a difference between the minimum and maximum hours per week. See &quot;Managing Work Shifts&quot; on page 178 for more information.</td>
</tr>
<tr>
<td>Company Start Date</td>
<td>The agent’s seniority within the company based on the date when the agent started working for the company. This parameter is configured in the Agent Details pane. See &quot;Managing Agents&quot; on page 166 for more information.</td>
</tr>
<tr>
<td>Department Start Date</td>
<td>The agent’s seniority within the contact center based on the date when the agent started working for the company. This parameter is configured in the Agent Details pane. See &quot;Managing Agents&quot; on page 166 for more information.</td>
</tr>
<tr>
<td>Rank</td>
<td>The agent’s position relative to a metric associated with the CSQ. This parameter is configured in the Agent Details pane and is not mandatory. See &quot;Managing Agents&quot; on page 166 for more information.</td>
</tr>
</tbody>
</table>

4. Click (Save) to save your changes.
Deleting a CSQ

This procedure permanently deletes the CSQ. It also deletes all links and historical data associated with the CSQ.

**NOTE:** Do not use this procedure to delete CSQs imported by the Sync Service.

To delete a CSQ:

1. Choose Environment > CSQs. The Contact Service Queue List appears.
2. Select the CSQ to delete by completing one of the following steps.
   - To delete one or more CSQs, select the check box next to the CSQ name.
   - To delete all CSQs, select the check box in the column header.
3. Click **(Delete).** An Internet Explorer dialog box appears.
4. Click OK to confirm the deletion and dismiss the dialog box.
Managing Exception Types

You can use the Exception Types feature to create different types of exceptions (for example, sick leave or vacation) that can be applied to agents.

You can edit the list at any time.

This section covers the following topics.

- Creating an Exception Type (page 148)
- Editing an Exception Type (page 150)
- Deleting an Exception Type (page 152)

See "Understanding Generic Exceptions and Exception Types" on page 49 for more information.

Creating an Exception Type

To create an exception type:

1. Choose Environment > Exception Types. The Exception Type List appears (Figure 50).

Figure 50. Exception Type List
2. Click New to create an exception type. The Exception Details pane appears (Figure 51).

![Figure 51. Exception Details: General tab](image)

3. Complete the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Exception| The name of the exception type. An exception is activity not planned in an employee's work schedule, including meetings, training sessions, unscheduled breaks, and absenteeism.  

**NOTE**: If the CSQ is closed on a specific day (for example, a holiday) that is usually open, WFM schedules the agents to work that day because the schedules are not affected by closed days. To schedule a day off for the agents on a day that is usually scheduled as a work day, create a Holiday exception type and assign this exception to the CSQ whenever the contact center is closed. See "Managing Closed Days" on page 269 for more information.  

| Active   | When the Active check box is selected, the exception type can be assigned to agents’ schedules for past, current, or future events. The Active check box is selected by default.  

The exception type appears as a selectable item in the Exception List on the Exception Assignments pane. WFM can schedule non-phone activities for the agent. See "Editing an Agent’s Exception" on page 175 for more information.  

Clear the check box to remove the exception type from the Exception List on the Exception Assignments pane or the Exceptions drop-down list when you edit an agent’s schedule (Schedules > Edit Schedule). |
4. Click \(\text{(Save)}\) to save your changes. A list of agents that have this exception tab appears. See "Editing an Exception Type" on page 150 for more information.

**NOTE:** When you add new exceptions you must compile the historical data for the new exceptions. See "Compiling Historical Data" on page 356 for more information.

**Editing an Exception Type**

You can use the following procedure to change an exception type. You might modify an exception type because it is not used any more or a paid exception type is now an unpaid exception type.

When you modify an exception type, you can select or clear the Active and Paid by default check boxes. You can also change the color assigned to the exception type.

**NOTE:** An exception name cannot be modified. If the name has changed internally or there is a terminology issue, delete the existing exception type and create a new exception type with the correct name.

**To edit an exception type:**

1. Choose Environment > Exception Types. The Exception Type List appears (Figure 52).
2. Click the name of an exception type in the Exception column.

Figure 52. Exception Type List

![Exception Type List](image)

The Exception Details pane displays general options (Figure 53).

Figure 53. Exception Details: General tab

![Exception Details: General tab](image)

3. Select or clear the following check boxes.
   - Active
   - Paid by default

The fields are described in "Creating an Exception Type" on page 148.

4. Click the Color field to display the color palette, and select a color. WFM displays the color and the Java number associated with the color.

5. To view the agents assigned to this exception type, click the Agents having this Exception tab. The Exception Details pane displays agents assigned to this exception (Figure 54).
NOTE: To change the agents who are assigned to this exception, see "Assigning Exception Types" on page 207.

Figure 54. Exception Details: Agents having this Exception tab

6. Click \(\text{(Save)}\) to save your changes.

NOTE: These changes affect new exceptions assigned to agents from this time onward. Any exceptions previously assigned to agents are not affected by this change. The agents listed under Agents having this exception does not change.

Deleting an Exception Type

This procedure permanently deletes the exception type. Delete an exception type when:

- There is a terminology issue. Terminology issues generally occur when you are initially configuring WFM.

- The exception type is no longer assigned to agents. You can only delete exception types that are not assigned to agents. Once an exception type is assigned, you need to modify the existing schedules using Schedules > Edit Schedules to remove the exception type from the database.

NOTE: Do not delete exception types that are no longer used, if they were previously assigned to agents. They are required by the database when creating reports.
To delete an exception type:

1. Choose Environment > Exception Types. The Exception Type List appears (Figure 55).

2. Select the exception type to delete by completing one of the following steps.
   - To delete one or more exception types, select the check box next to the exception type name.
   - To delete all exception types, select the check box in the column header.

3. Click (Delete). An Internet Explorer dialog box appears.
4. Click OK to confirm the deletion and dismiss the dialog box.
Managing Time Zones

Your servers might be in one time zone, and your contact centers might be in other time zones. In most cases, users prefer to see reports and schedules in their local time rather than server time.

You can use the Time Zones function to associate a time zone with CSQs and agents. The time zone assigned to a CSQ or agent should correspond with the location of the CSQ or agent. See "Using Multiple Time Zones" on page 90 for more information.

This section covers the following topics.

- Adding CSQs to a Time Zone (page 155)
- Adding Agents to a Time Zone (page 157)
Adding CSQs to a Time Zone

To add CSQs to a time zone:

1. Choose Environment > Time Zones. The Time Zone List appears (Figure 56).

Figure 56. Time Zone List

<table>
<thead>
<tr>
<th>Zone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disabled</td>
</tr>
<tr>
<td>(GMT -12:00) International Date Line</td>
</tr>
<tr>
<td>(GMT -11:00) Midway</td>
</tr>
<tr>
<td>(GMT -10:00) Hawaii</td>
</tr>
<tr>
<td>(GMT -9:00) Alaska</td>
</tr>
<tr>
<td>(GMT -8:00) Pacific</td>
</tr>
<tr>
<td>(GMT -7:00) Mountain</td>
</tr>
<tr>
<td>(GMT -6:00) Central</td>
</tr>
<tr>
<td>(GMT -5:00) Eastern (U.S.A and Canada)</td>
</tr>
<tr>
<td>(GMT -4:30) Caracas</td>
</tr>
<tr>
<td>(GMT -4:00) Atlantic</td>
</tr>
<tr>
<td>(GMT -3:30) Newfoundland</td>
</tr>
<tr>
<td>(GMT -3:00) Buenos Aires</td>
</tr>
<tr>
<td>(GMT -2:00) Central Atlantic</td>
</tr>
<tr>
<td>(GMT -1:00) Azores</td>
</tr>
<tr>
<td>(GMT) Greenwich, London</td>
</tr>
<tr>
<td>(GMT +1:00) Paris, Brussels</td>
</tr>
<tr>
<td>(GMT +2:00) Cairo, Jerusalem</td>
</tr>
<tr>
<td>(GMT +3:00) Moscow</td>
</tr>
<tr>
<td>(GMT +4:00) Abu Dhabi</td>
</tr>
<tr>
<td>(GMT +5:00) Islamabad</td>
</tr>
<tr>
<td>(GMT +5:30) Calcutta</td>
</tr>
<tr>
<td>(GMT +6:00) Novosibirsk</td>
</tr>
<tr>
<td>(GMT +7:00) Bangkok, Djakarta</td>
</tr>
<tr>
<td>(GMT +8:00) Kula Lumpur, Singapore</td>
</tr>
<tr>
<td>(GMT +9:00) Tokyo, Seoul</td>
</tr>
<tr>
<td>(GMT +10:00) Brisbane, Sydney</td>
</tr>
<tr>
<td>(GMT +11:00) New Caledonia</td>
</tr>
<tr>
<td>(GMT +12:00) Auckland, Wellington</td>
</tr>
<tr>
<td>(GMT +13:00) Nuku’alofa</td>
</tr>
</tbody>
</table>
2. Click a time zone. The Time Zone Detail pane displays available and assigned CSQs (Figure 57).

Figure 57. Time Zone Detail: CSQs tab

3. To assign CSQs to a time zone, select the names of the CSQs in the Available CSQs list, then click >. The names of the CSQs move to the Assigned CSQs list. See "Moving Items between Lists" on page 111 for more information.

   NOTE: To change the time zone for a CSQ, assign the CSQ to another time zone.

4. Click (Save) to save your changes.
Adding Agents to a Time Zone

To add agents to a time zone:

1. Click the Agents tab. The Time Zone Detail pane displays available and assigned agents (Figure 58).

2. To assign agents to a time zone, select the names of the agents in the Available Agents list, then click >. The names of the agents return to the Assigned Agents list. See "Moving Items between Lists" on page 111 for more information.

   **NOTE:** To change an agent’s time zone, assign the agent to another time zone.

3. Click (Save) to save your changes.
Managing Agents

Introduction

You can use the Agents module to complete the following tasks.

- Create and maintain teams. For more information, see "Managing Teams" on page 160.
- Maintain agents. For more information, see "Managing Agents" on page 166.
- Create and maintain work shifts. For more information, see "Managing Work Shifts" on page 178.
- Create work conditions (lunches and breaks) and associate them with work shifts. For more information, see "Managing Work Conditions" on page 189.
- Assign work shifts to agents. For more information, see "Assigning Work Shifts" on page 197.
- Assign exceptions to agents. For more information, see "Assigning Exception Types" on page 207.
- Create and maintain projects. For more information, see "Managing Projects" on page 214.

NOTE: If you are using Unified CCX, see "Understanding Synchronization between Unified CCX and WFM" on page 25 for information on how the Sync Service imports agents, teams, and CSQs from Unified CCX into WFM.
Managing Teams

You can use the Teams function to manage teams in WFM.

**NOTE:** When the Sync Service extracts a team from Unified CCX, it loads the team into WFM and the team appears on the Team List. See "Understanding Sync Service and Teams" on page 26 for more information.

This section covers the following topics.

- Creating a Team (page 160)
- Editing a Team (page 162)
- Assigning Agents to a Team (page 163)
- Deleting a Team (page 165)

Creating a Team

To create a team:

1. Choose Agents > Teams. The Team List appears (Figure 59).

![Team List](image)
2. Click (New) to create a team. The Team Details pane displays general options (Figure 60).

Figure 60. Team Details: General tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Team Name</td>
<td>Name of team. If a team exists in Unified CCX, the Sync Service extracts the team from Unified CCX and displays the Unified CCX team name in this field.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Do not modify this field, if the team is extracted from Unified CCX.</td>
</tr>
<tr>
<td>Default Team</td>
<td>Select the Default Team check box if you want this team to be the agent’s main team in WFM.</td>
</tr>
<tr>
<td>Productivity Compilation</td>
<td>Select the Productivity compilation check box if you want data to be compiled at the team level when WFM produces productivity reports. Selecting the Productivity compilation check box enables the data capture module to compile all daily, weekly, monthly, and yearly productivity indicators for the selected team. This compilation is performed when the data capture module detects productivity data and all cumulative totals are recalculated. These new totals are available for graphs and tabular reports the next day.</td>
</tr>
<tr>
<td>System Team</td>
<td>Indicates whether or not the team was created by the Sync Service. You cannot select or clear this check box.</td>
</tr>
</tbody>
</table>
Editing a Team

To edit a team:

1. Choose Agents > Teams. The Team List appears (Figure 61).

![Team List](image1.png)

2. Click a team name. The Team Details pane displays general team options (Figure 62).

![Team Details: General tab](image2.png)

3. Complete the fields. The fields are described in "Creating a Team" on page 160.
NOTE: Do not modify the Team Name field, if the team is extracted from Unified CCX.

4. Click (Save) to save your changes.

Assigning Agents to a Team

To assign agents to a team:

1. Choose Agents > Teams. The Team List appears (Figure 63).

   Figure 63. Team List

   ![Team List](image)

2. Click a team name. The Team Details pane displays general team options (Figure 64).

   Figure 64. Team Details: General tab

   ![Team Details](image)
3. Click the Agents tab. The Team Details pane displays available and assigned agents (Figure 65).

Figure 65. Team Details: Agents tab

4. To assign agents to a team, select the names of the agents in the Available Agents list, then click >. The agents’ move to the Assigned Agents list. See "Moving Items between Lists" on page 111 for more information.

5. To remove agents from a team, select the check box next to each agent’s number from the Assigned Agents list, then click <. The agents’ names return to the Available Agents list.

6. To make this team an agent’s main team, select the check box next to the agent under the Main Team column. In WFM, an agent can be part of many teams, but the My Page feature requires a primary team to be identified for the statistic displays and messaging.

7. Click (Save) to save your changes.
Deleting a Team

To delete a team:

2. Select the team to delete by completing one of the following steps.
   - To delete one or more teams, select the check box next to the team name.
   - To delete all teams, select the check box in the column header.
3. Click (Delete). An Internet Explorer dialog box appears.
4. Click OK to confirm the deletion and dismiss the dialog box.
Managing Agents

You can use the Agents function to complete the following tasks.

- Configuring agents. "Configuring an Agent" on page 167 and "Deleting an Agent" on page 177.

- Add teams to an agent. "Assigning Teams to an Agent" on page 172.

- Assign CSQ mappings to an agent. "Assigning CSQ Mappings to an Agent" on page 173.

- Display an agent’s work shift rotation. "Displaying an Agent’s Work Shift Rotation" on page 174.

- Display, edit, and delete an agent’s exceptions. "Displaying an Agent’s Exceptions" on page 174, "Editing an Agent’s Exception" on page 175, and "Deleting an Agent’s Exceptions" on page 176.

- Display vacation assigned to an agent.

If you selected Default Team when you created a team, WFM automatically assigns the team to any agent you create.
Configuring an Agent

To edit an agent:

1. Choose Agents > Agents. The Agent List appears (Figure 66).

![Agent List](image)

2. Click an employee number in the Employee Number column. The Agent Details pane appears (Figure 67).

NOTE: This list of agents might contain users that are inactive in Unified CCX. Log into Unified CCX and check the List of Inactive Agents if you want to verify whether an agent is active or inactive in Unified CCX. You can also

May 2010 167
delete an inactive agent in Unified CCX. Inactive agents in Unified CCX are considered active users in WFM.

**Figure 67. Agent Details: General Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Number</td>
<td>The employee number. This number is required and must be unique. If an agent exists in Unified CCX, the Sync Service extracts the agent from Unified CCX and displays the Unified CCX value in this field.</td>
</tr>
<tr>
<td>First Name</td>
<td>The agent’s first name. This field is required.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The agent’s last name. This field is required.</td>
</tr>
</tbody>
</table>

3. Complete the fields.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Login Name           | The agent’s Active Directory login name. This field is required and must be manually configured in WFM as part of user configuration. This is the login name the agent uses to log into WFM. The agent’s password is configured on the General tab of the User Details pane. See "Creating a New User" on page 381 or "Editing an Existing User Account" on page 385.  

**NOTE:** The login name entered in the User Code field must match the Active Directory login name. |
| Log ID               | The agent's telephone ID (login ID). Since WFM uses Log ID to identify an agent, Log ID must be unique. This field is required.  

| Phone Numbers        | The agent's personal telephone number(s) and extension numbers. This field is optional. If only one telephone number is required, enter the telephone number in the first field. The agent’s telephone number appears on reports and lists. |
| Company Start Date   | The date when the agent started working for the company. This is the date when the agent started working for the company and not necessarily in the contact center. This field is required. WFM uses this information for scheduling based on an agent's seniority within the company. |
| Department Start Date| The date when the agent started working in the contact center. This field is required. WFM uses information for scheduling based on an agent’s seniority within the contact center. |
| End Date             | The termination date in this field when the agent no longer works for the company. When a termination date is entered in this field, WFM will no longer schedule the agent after this entered date. This field operates independently of the agent’s active status. WFM schedules the agent up to and including the entered date. |
4. Select the Active check box. WFM only schedules an agent if the Active check box is selected. The check box is selected by default.

**NOTE:** If you do not select this check box, the agent cannot log into My Page.

To deactivate the agent, clear the Active check box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rank</td>
<td>The agent's rank using alphanumeric characters. This is an optional attribute used primarily to rank agents based on their seniority and expertise. WFM uses this value to define scheduling priorities. The exact meaning of rank depends on the service that your contact center provides. You decide what the rank means in your contact center and enter the value for your agents. For example, if your contact center sells products, you can rank your agents on the value of the sales closed or the percentage of calls in which the agents close sales. If your contact center provides a service, you can rank agents based on quality evaluations or subject matter knowledge.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Select a time zone from the list. This time zone selected should be the time zone in which the agent is located. The CSQ and agent can be assigned to different time zones or the same time zone. For example, if the agent is located in the Montreal contact center, select the (GMT -5:00) Eastern (Canada and United-States time zone). If this agent is located in the Vancouver contact center, select the (GMT -8:00) Pacific time zone. Select the Disabled option from the list only if you are producing schedules for agents who are located in different time zones.</td>
</tr>
</tbody>
</table>

**NOTE:** Do not select Disabled to disable the time zone associated with an agent if the time zone is already assigned to the agent’s CSQ.

**NOTE:** If you change the time zone associated with an agent, you must also change the arrival and departure times in the work shift registry to match the time zone where the virtual CSQ is located. See "Creating a Work Shift" on page 179 for more information.
NOTE: Delete all work shifts assigned to this agent before you deactivate the agent (see "Assigning a Work Shift Rotation to an Agent" on page 200). This action removes the link between the work shifts and the agent.

5. Click Notes on Agent. The Notes on Agent pane appears (Figure 68).

![Figure 68. Notes on Agent](image)

6. Complete the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supervisor Note</td>
<td>This message displays information regarding this agent. Only a supervisor can read this note.</td>
</tr>
<tr>
<td>Agent Note</td>
<td>This message appears on individual schedules up to and including the date specified in the Do not print after the field. The message can contain a maximum of 120 characters.</td>
</tr>
<tr>
<td>Agent Note’s Expiration Date</td>
<td>This date indicates when you want the message specified in the Agent Note message field to stop appearing in the individual schedules. If you do not enter a date, the message remains in the individual schedule.</td>
</tr>
</tbody>
</table>

7. Complete the following tasks.

- Assigning Teams to an Agent (page 172)
- Assigning CSQ Mappings to an Agent (page 173)
- Displaying an Agent’s Work Shift Rotation (page 174)
- Displaying an Agent’s Exceptions (page 174)

8. Click ![](image) (Save) to save your changes.
Assigning Teams to an Agent

To assign teams to an agent:

1. Click the Teams tab. The Agent Details pane displays available and assigned teams (Figure 69).

   Figure 69. Agent Details: Assign Teams tab

2. To assign teams to an agent, select the names of the teams in the Available Teams list, then click >. The name of the teams move to the Assigned Teams list. See "Moving Items between Lists" on page 111 for more information.

3. To remove teams assigned to an agent, select the check box next to the name of each teams in the Assigned Teams list, then click <. The name of the teams return to the Available Teams list.

4. Select the check box next to the team in the Main column that you want to designate as the agent’s main team. In WFM, an agent can be part of many teams, but the My page feature requires a main team to be identified for the statistic displays and messaging.

5. Click (Save) to save your changes.
Assigning CSQ Mappings to an Agent

To assign CSQ mappings to an agent:

1. Click the CSQ Mappings tab. The Agent Details pane displays available and assigned CSQ mappings (Figure 70).

2. To assign CSQ mappings to an agent, select the names of the CSQ mappings in the Available CSQ Mapping list, then click >. The names of the CSQ mappings move to the Assigned CSQ Mapping list.

   NOTE: If you are using the Multi Skill Agent Queuing (MSAQ) feature, you can assign more than one CSQ to the agent.

3. To remove CSQ mappings assigned to an agent, select the names of the CSQ mappings from the Assigned CSQ Mappings list, then click <. The names of the CSQ mappings return to the CSQ Mappings list.

4. Click (Save) to save your changes.
Displaying an Agent’s Work Shift Rotation

To display an agent’s work shift rotation:

- Click the Work Shifts tab. A list of the available rotations appears (Figure 71).

**NOTE:** To edit the agent’s work shift rotation, click Edit Agent Rotation. See "Assigning a Work Shift Rotation to an Agent" on page 200.

**Figure 71. Agents Details: Work Shifts tab**

![Agent Work Shift Rotation Table]

Displaying an Agent’s Exceptions

The Exceptions tab on the Agent Details pane displays past and future exceptions assigned to an agent. It displays the name of the exception, the date on which the exception occurs, duration, and the start and end times for the exception for a partial day exception or a check in the Entire day column if the exception lasts an entire day. The Start, End, Duration, and Entire Day columns are not populated if a schedule does not exist for the dates specified in the date column.

To display an agent’s exceptions:

- Click the Exceptions tab. A list of the exceptions that are assigned to the agent appears (Figure 72).

**Figure 72. Agent Details: Exceptions tab**

![Assigned Exceptions Table]
Editing an Agent’s Exception

To edit an agent’s exception:

1. Click the name of the exception in the Name column. The Editing <agent name - date> pane appears (Figure 73).

2. Select a team from the Team List.

Figure 73. Editing Agent Name - Date

3. If desired, filter the agents by choosing one of the following options from the Team List drop-down list:
   - Active: To display only active agents in the Agent List.
   - Inactive: To display only inactive agents in the Agent List.
   - All: To display all agents, active and inactive, in the Agent List.

4. Select one or more agents from the list. A field below the Agent List shows how many agents you selected from this list.

5. Select the type of exception you want to assign from the Exception List.

6. Enter the date when the exception will start in the Starts On field.
7. Specify the duration of the exception. You have two options:
   - If the exception covers the whole service day, select the Entire Day check box.
   - If the exception covers only part of the service day, enter the start and end time. The Hours field displays the duration of the exception.

8. If the agent will be paid for these hours, select the Paid check box. By default, WFM displays the Paid status that you entered when you created the exception type. See "Editing an Exception Type" on page 150. However, you can change it here.

9. Click (Save) to save your changes.

Deleting an Agent’s Exceptions

To delete an agent’s exception:

1. Click the Exceptions tab. The Agent Details pane displays assigned exceptions (Figure 74).

2. Complete one of the following steps.

   IMPORTANT: Do not click (Delete) in the toolbar. Clicking (Delete) in the toolbar deletes the agent.

   - To delete one or more exceptions, select the check box next to the exception name and click (Delete the selected exception) next to the Assigned Exceptions table. An Internet Explorer dialog box appears.
   - To delete all exceptions, select the check box in the heading in the first column and click (Delete the selected exception) next to the Assigned Exceptions table. An Internet Explorer dialog box appears.

3. Click OK to confirm the deletion and dismiss the dialog box.

4. Click (Save) to save your changes.
Deleting an Agent

To delete an agent:

2. Select the agent to delete by completing one of the following steps.
   - To delete one or more agents, select the check box next to the agent name.
   - To delete all agents, select the check box in the column header.
3. Click (Delete). An Internet Explorer dialog box appears.

   NOTE: This Windows Internet Explorer dialog also appears if you press the enter key on the Agent List pane. Nothing happens if no agents are selected in the Agent List.

4. Click OK to confirm the deletion and dismiss the dialog box.

   NOTE: WFM does not delete active agents. If the agent is active, an error message will appear. To deactivate an agent, clear the Active check box as described in "Configuring an Agent" on page 167.
Managing Work Shifts

You can use the Work Shifts function to complete the following tasks.

- Create work shifts. For more information, see "Creating a Work Shift" on page 179.
- Modify work shifts. For more information, see "Editing a Work Shift" on page 184.
- Display agents that are associated with a work shift. For more information, see "Displaying Agents Associated with a Selected Work Shift" on page 186.
- Associate work conditions with a work shift. For more information, see "Associating Work Conditions with a Work Shift" on page 187.
- Delete work shifts. For more information, see "Deleting a Work Shift" on page 188.

See "Understanding Work Shifts" on page 43 for more information.
Creating a Work Shift

To create a work shift:

1. Choose Agents > Work Shifts. The Work Shift List appears (Figure 75).

   ![Figure 75. Work Shift List](image)

2. Click (New) to create a work shift. The Work Shift Detail pane displays work shift options (Figure 76).

   ![Figure 76. Work Shift Detail: General tab](image)
3. Complete the fields as described in the table below.

**NOTE:** To create a variable work shift, at least one of the parameters listed below must be different. If all parameters are equal, the work shift is Fixed.

- Hours per Week: (minimum/maximum)
- Days per Week: (minimum/maximum)
- Arrival at the Earliest or Arrival at the Latest
- Minimum Hours / Maximum Hours on the same day
- Number of available days versus number of maximum days

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the work shift. The name can contain a maximum of 50 characters. Specify a descriptive name that is easy to understand. A descriptive name makes it easier to assign work shifts to agents. For example, you could enter the following work shift name: “Variable shift 0-40”, indicating that the work shift is variable and has a minimum of 0 hours and a maximum of 40 hours.</td>
</tr>
<tr>
<td>Active</td>
<td>The Active check box is automatically selected when you create a new work shift. Clear the Active check box if you want to deactivate this work shift.</td>
</tr>
</tbody>
</table>

**NOTE:** When you deactivate this work shift, this work shift no longer appears on the agents' schedule. You need to determine if another work shift can be assigned to the agents.
Managing Work Shifts

### Work Shift Type

Select the work shift type. Your options are:

- **Fixed**: When chosen, WFM displays an Hours per Week field and a Days per Week field. It also displays the Hours and Arrival fields under Detailed parameters. A fixed work shift is a work shift that covers requirements for fixed hours and days. Use this work shift type to schedule agents for phone and email-related activities for entire days or weeks. Assign fixed work shifts to senior and full-time agents.

- **Assignment**: When chosen, WFM displays an Hours per Week field and a Days per Week field. It also displays the Hours and Arrival fields under Detailed parameters. An assignment is a type of fixed work shift that does not cover requirements. Use this work shift type to schedule agents for non-phone and non-email related activities for entire days or weeks.

- **Variable**: When chosen, WFM displays Minimum and Maximum fields for the Hours per Week and Days per Week. It also displays the following fields: Schedule Increment and Optimization under General Parameters, and Minimum Hours, Maximum Hours Days Off Allowed, Arrival at the Earliest, Arrival at the Latest and Minimum Interval under Detailed Parameters. A variable work shift is a work shift that covers requirements for variable hours and days. Use this work shift type to schedule agents for phone and email-related activities for variable days and weeks. Assign variable work shifts to part-time agents.

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Shift Type</td>
<td>Select the work shift type. Your options are:</td>
</tr>
<tr>
<td>Hours per Week</td>
<td>If you selected work shift type of Fixed or Assignment, enter the number of paid work hours per week for this work shift. If you selected the work shift type of Variable, enter the minimum and maximum number of paid work hours per week for this work shift.</td>
</tr>
<tr>
<td>Days per Week</td>
<td>If you selected work shift type of Fixed or Assignment, enter the number of work days per week for this work shift. If you selected the work shift type of Variable, enter the minimum and maximum number of work days per week for this work shift.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Schedule Increment</td>
<td>Select a 15- or 30-minute increment for this work shift. (For example, choosing a 15-minute schedule increment, results in 15-minute time increments for the work shift.) These options only appear if you select a work shift type of Variable.</td>
</tr>
<tr>
<td>Optimization</td>
<td>Select the optimization method you want to apply to this work shift. The available optimization methods are:</td>
</tr>
<tr>
<td></td>
<td>• Multilinear: When chosen, WFM schedules all agents with fixed work shifts first. Then it examines requirements starting at the beginning of the day to identify any requirements not already covered by agents with fixed work shifts. If an agent with a variable work shift is available and a requirement exists for an agent, WFM schedules the agent without considering if there might be a greater need for an agent later in the day.</td>
</tr>
<tr>
<td></td>
<td>• Optimum: When chosen, WFM schedules all agents with fixed work shifts first. Then it schedules the remaining available agents to best meet the forecast requirements throughout the remainder of the day.</td>
</tr>
<tr>
<td></td>
<td>When you are creating a new work shift, the default value is optimum. For more information, see “Optimization” on page 45.</td>
</tr>
<tr>
<td></td>
<td>These options only appear if you select a work shift type of Variable.</td>
</tr>
<tr>
<td>Hours</td>
<td>The number of hours to be worked for each day in the format HH:MM. The total hours for the week appear in the Total Hours column. The number of hours usually excludes time for a lunch. This field only appears when you select a work shift type of Fixed or Assignment.</td>
</tr>
<tr>
<td>Arrival</td>
<td>Select the arrival time from the drop-down list for each day in these fields. These fields only appear if you select a work shift type of Fixed or Assignment.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Minimum Hours</td>
<td>The minimum number of hours to be worked for each day in the format HH:MM. The total hours for the week appear in the Total Hours column. The minimum number of hours usually excludes time for a lunch. These fields only appear if you select a work shift type of Variable.</td>
</tr>
<tr>
<td>Maximum Hours</td>
<td>The maximum number of hours to be worked for each day in the format HH:MM. The total hours for the week appear in the Total Hours column. The maximum number of hours usually excludes time for a lunch. For example, if the maximum number of paid hours is 8 hours, enter 8:00. Do not include any non-paid time in this field (for example, a half hour lunch break). These fields only appear if you select a work shift type of Variable.</td>
</tr>
<tr>
<td>Days Off Allowed</td>
<td>Select the check box associated with each day an agent is allowed off. When the check box is clear, the agent is required to work that day if the work shift indicates there are hours available to work that day. An agent with a variable work shift might not be scheduled to work on a day they are scheduled to be available. These check boxes only appear if you select a work shift type of Variable.</td>
</tr>
<tr>
<td>Arrival at the Earliest</td>
<td>Select the earliest arrival time allowed from the drop-down list for each day in these fields. Your work shift is variable if there a difference between the earliest arrival time and latest arrival time. These fields only appear if you select a work shift type of Variable.</td>
</tr>
<tr>
<td>Arrival at the Latest</td>
<td>Select the latest arrival time allowed from the drop-down list for each day in these fields. These fields only appear if you select a work shift type of Variable.</td>
</tr>
</tbody>
</table>
4. Click (Save) to save your changes. The Agents and Work Conditions tabs appear.

### Editing a Work Shift

**NOTE:** If this work shift is already assigned to an agent, the changes appear the next time you generate the schedule. See "Creating a Schedule" on page 272 for more information. The changes will not take affect until you generate the schedule.
To edit a work shift:

1. Choose Agents > Work Shifts. The Work Shift List appears (Figure 77).

Figure 77. Work Shift List

2. Click a work shift name in the Name column. The Work Shift Detail pane displays general work shift options (Figure 78).

Figure 78. Work Shift Detail: General tab

3. Complete the fields as described in "Creating a Work Shift" on page 179.

4. Click (Save) to save your changes.
Displaying Agents Associated with a Selected Work Shift

To display agents associated with a selected work shift:

1. Click the Agents tab. The Work Shift Detail pane displays agents assigned to the work shift (Figure 79).

   **NOTE:** The Agents tab only appears after you create and save a work shift. Agents only appear on this pane after they are assigned to a work shift.

![Figure 79. Work Shift Detail: Agents tab](image)

2. To modify an agent that is assigned to this work shift, click the agent number in the Number column. See "Configuring an Agent" on page 167 for more information on modifying an agent.
Associating Work Conditions with a Work Shift

To associate work conditions with a work shift:

1. Click the Work Conditions tab. The Work Shift Detail pane displays available and assigned work conditions (Figure 80). See "Creating a Work Condition" on page 189 for more information on work conditions.

Figure 80. Work Shift Detail: Work Conditions tab

2. To assign work conditions to a work shift, select the names of the work conditions in the Available Work Conditions list, then click >. The names of the work conditions move to the Assigned Work Conditions list. See "Moving Items between Lists" on page 111 for more information.

3. To remove work conditions assigned to a work shift, select the names of the work conditions from the Assigned Work Conditions list, then click <. The names of the work conditions return to the Available Work Conditions list.

4. Click (Save) to save your changes.
Deleting a Work Shift

**NOTE:** Remove any agents assigned to a work shift before you delete a work shift. WFM will not delete a work shift if agents are assigned to the work shift. To remove an agent from a work shift, see "Assigning a Work Shift Rotation to an Agent" on page 200.

To delete a work shift:

2. Select the work shift to delete by completing one of the following steps.
   - To delete one or more work shifts, select the check box next to the work shift name.
   - To delete all work shifts, select the check box in the column header.
3. Click (Delete). An Internet Explorer dialog box appears.
4. Click OK to confirm the deletion and dismiss the dialog box.
Managing Work Conditions

This section covers the following topics.

- Creating a Work Condition (page 189)
- Editing a Work Condition (page 193)
- Assigning Work Shifts to a Work Condition (page 194)
- Deleting a Work Condition (page 196)

See "Understanding Work Conditions" on page 48 for more information.

Creating a Work Condition

To create a work condition:

1. Choose Agents > Work Conditions. The Work Condition List appears (Figure 81).
2. Click (New) to create a work condition. The Work Condition Detail pane displays general work condition options (Figure 82).

**Figure 82. Work Condition Detail: General tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the work condition. This is a required field. Specify a descriptive name that is easy to understand. It should also specify the number of work hours to which the work condition applies (for example, Customer Service - 4.5 hours). A descriptive name makes it easier to assign work shifts to agents.</td>
</tr>
</tbody>
</table>
4. To add a break, click Add and select the activity type for this work condition. Your options are:

- Lunch
- Break

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hours of Work per Day (HH:mm)</td>
<td>The number of paid hours covered by this work condition in HH:MM format. For example, enter 07:30 for 7.5 hours. If the agent can work 4.5 to 6 hours during a work shift and scheduling is in half hour increments, you must configure work conditions for 4.5, 5, 5.5 and 6 hours and assign them to the agent’s work shift. You can set up to 28 different work conditions for the same block of hours. A block of hours is the duration of a work shift (for example, six hours). If you do not configure a work conditions work shift length, WFM will not schedule break and lunch times.</td>
</tr>
</tbody>
</table>
| General Condition                          | Select the General Condition check box if both of the following statements are true:  
  • This work condition applies to every work shift that has the same block of hours (Hours of Work per Day).  
  • No other work condition is associated with the work shift.  

**NOTE:** If you do not select the General Condition check box for this work condition and no other work condition is linked to a work shift, WFM will not schedule break or lunch times to agents assigned to this work shift.                                                                                                                                                                                                                                                                                                                                                                                                                                                                 |
| As of (HH:mm)                              | Enter the earliest shift arrival time for this work condition using the HH:MM format. For example:  
  • If you want the work condition to apply only to work shifts that begin after 06:30, then enter 06:30 in this field.  
  • If you want the work condition to apply for all arrival times, enter 00:00 in this field.                                                                                                                                                                                                                                                                                                                                                                                                                                                                 |
| Monday—Sunday                              | Select the check box associated with each day when this work condition applies.                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                             |
5. Complete the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Name                | The activity name associated with a break or lunch. For example, you could have a morning break, lunch, and an afternoon break. If you leave this field empty, WFM enters the name of the chosen activity (Lunch or Break) in this field when you click [Save].  
  **NOTE:** Some terms are reserved in WFM. These terms are In service, Available, Not available, Closed CSQ, Overtime, and Exception. |
| Minimum Delay       | The minimum delay using the HH:MM format. The minimum delay is the amount of time that must elapse between the shift arrival time and the start of the work condition activity.                                      |
| Maximum Delay       | The maximum delay in hours and minutes using the HH:MM format. The maximum delay is the amount of time that must elapse between the shift arrival time and the start of the work condition activity.                                      |
| Duration            | The duration of the activity in minutes. If your database increment is 5 minutes, you can specify the duration in 5-minute increments. If your database increment is 15 minutes, you can specify the duration in 15-minute increments. |
| Increment           | The increment determines the times when the work condition can begin using HH:MM format. Valid increments are 00:05, 00:10, 00:15, 00:20 and 00:30. For example, if you enter 00:10 and work begins at 8:00, the work condition activity for an agent might begin at 08:00, 08:10, 08:20, 08:30, 08:40 or 08:50. |
| Paid Portion        | The portion of the work condition (in minutes) that is paid.                                                                                                                                                   |
| Minimum Interval    | The minimum interval (in minutes) between breaks. This is the minimum interval between the end of the previous work condition activity and the start of this work condition activity.  
  **NOTE:** The minimum interval of the first break should be “0” since there is no previous break. |
6. To delete one or more breaks, select the check box next to the Activity type for each break and click Delete.

   To delete all breaks, select the check box in the heading of the first column and click Delete.

   WFM removes the break from the Breaks table.

7. Click (Save) to save your changes. The Work Condition Details displays available and assigned work shifts. See "Assigning Work Shifts to a Work Condition" on page 194 for more information.

**Editing a Work Condition**

To edit a work condition:

1. Choose Agents > Work Conditions. The Work Condition List appears (Figure 83).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Click the Color field to display the color palette and select a color. WFM displays the color and the Java number associated with the color. The default colors are:</td>
</tr>
<tr>
<td></td>
<td>• Yellow for break time</td>
</tr>
<tr>
<td></td>
<td>• Magenta for lunch time</td>
</tr>
<tr>
<td></td>
<td>These colors appear in the Schedule Maintenance pane. You can select a color for each break or lunch time. To avoid confusion, select a unique color for each work condition.</td>
</tr>
</tbody>
</table>
2. Click a work condition name. The Work Condition Detail pane displays general work condition options (Figure 84).

Figure 84. Work Condition Details: General tab

3. Complete the fields. See "Creating a Work Condition" on page 189 for more information on these fields.

4. To add, modify or remove break activities, click Breaks to open the panel and choose one of the following options.
   - To add an activity line, click Add and complete the fields.
   - To delete one or more breaks, select the check box next to the Activity type for each break and click Delete.
     To delete all breaks, select the check box in the heading of the first column and click Delete.
     WFM removes the break from the Breaks table.

5. Click (Save) to save your changes.

Assigning Work Shifts to a Work Condition

You need to assign the appropriate work condition to a work shift to ensure proper coverage of requirements for every work shift type and duration. Once a work shift is assigned to a work condition, it will be included the next time you generate a schedule.
NOTE: If you generate a schedule and discover agents without work conditions, go to the Work Shifts tab on the Work Conditions Detail pane and assign the work shift to a work condition, then run the schedule again or edit the agents’ schedules.

To assign work shifts to a work condition:

1. Click the Work Shift tab. The Work Condition Detail pane displays available and assigned work shifts (Figure 85).

2. To assign work shifts to a work condition, select the names of the work shifts in the Available Work Shifts list, then click >. The names of the work shifts move to the Assigned Work Shifts list. See "Moving Items between Lists" on page 111 for more information.

3. To remove work shifts assigned from a work condition, select the check box next to each work shifts name from the Assigned Work Shifts list, then click <. To remove all work shifts assigned to a work condition, select the check box in the column header, then click <. The names of the work shifts return to the Available Work Shifts list.

4. Click (Save) to save your changes.
Deleting a Work Condition

**IMPORTANT:** This procedure permanently deletes the work condition.

*To delete a work condition:*

2. Select the work condition to delete by completing one of the following steps.
   - To delete one or more work conditions, select the check box next to the work condition name.
   - To delete all work conditions, select the check box in the column header.
3. Click (Delete). An Internet Explorer dialog box appears.
4. Click OK to confirm the deletion and dismiss the dialog box.
Assigning Work Shifts

You can use the Work Shift Assignments pane to complete the following tasks.

- Create a work shift rotation and assign it to an agent
- Assigning work shifts to a work shift rotation
- Insert a new work shift after an existing work shift in a work shift rotation
- Insert a new work shift before an existing work shift in a work shift rotation
- Delete assigned work shifts from a work shift rotation
- Split a work shift for a specific week in a work shift rotation
- Advance a work shift by one week
- Postpone a work shift by one week
- Copy a work shift rotation from one agent to another agent

This section covers the following topics.

- Creating a Work Shift Rotation (page 197)
- Creating a Split Work Shift (page 199)
- Assigning a Work Shift Rotation to an Agent (page 200)
- Displaying Assigned Work Shifts (page 206)

See "Understanding Work Shifts" on page 43 for more information.

Creating a Work Shift Rotation

If you use work shift rotations in which an agent works different work shifts over several weeks, you must first define the work shifts and then the rotation sequence.

**NOTE:** The first day of the week must be configured before you create a work shift rotation. If you change the first day of the week, new work shift rotations must be created in order to incorporate the change.

When you create a work shift rotation, you can assign one or more work shifts to the agent. The work shifts rotate automatically when you generate schedules for the agent’s CSQ.

The first week of the rotation is always the current week when you create a new rotation and generate a schedule.
For example, create a work shift rotation with three different work shifts (for example, night shift, day shift, and weekends) and assign the work shifts to the following weeks:

- Week 1: night shift
- Week 2: day shift
- Week 3: weekends

If you generate a 4 week schedule for the agent’s CSQ, WFM automatically assigns the night shift to the fourth week of the schedule.

**To create a work shift rotation:**

1. Create the work shifts. For more information, see "Creating a Work Shift" on page 179. For example:
   - For an agent with a three week day shift followed by a one week night shift, create a one week day shift and a one week night shift.
   - For an agent who only works three out of four weeks, create a one week work shift.
   - For a full-time agent whose schedule never varies, create a one week work shift.

2. Create work shift rotation. For more information, see "Assigning a Work Shift Rotation to an Agent" on page 200 and "Creating a New Work Shift Rotation" on page 201. For example:
   - For an agent with a three week day shift followed by a one week night shift, assign the one week day shift to the work shift rotation for three weeks and then assign the one week night shift to the fourth week of the work shift rotation.
   - For an agent who only works three out of four weeks, create a 14 week work shift rotation, delete 10 of the weeks, assign the one week work shift to the work shift rotation for three weeks and leave the fourth week of the rotation blank.
   - For a full-time agent whose schedule never varies, assign the one week work shift to the work shift rotation.

3. Generate the weekly schedule production. For more information, see "Automated Work Shift Rotation" on page 273.

**NOTE:** When you create work shift rotation and generate the weekly schedule production, you will see the automatic work shift rotation selected by default (see "Automated Work Shift Rotation" on page 273). An automatic work shift rotation follows this schedule until you decide to change it. For example, if you schedule an agent to work three out of four weeks, the agent will be assigned to work the first three weeks (06-02-2008, 06-9-2008 and 06-17-2008) and off on the fourth week (06-23-2008). As the weeks progress, the schedule will rotate and the...
Creating a Split Work Shift

A split work shift is a situation where an agent works two different shifts during the same day. Before you split a work shift, you must create two work shifts that start and end at different times or days.

To create a split work shift:

1. Create two work shifts. For more information, see "Creating a Work Shift" on page 179.

   For example, if an agent works 4 hours in the morning and 4 hours in the evening, you must create one work shift that covers the morning hours and another work shift that covers the evening hours.

   **NOTE:** Before you split a work shift, you must create two work shifts that start and end at different times. The start and end time for each work shift must not overlap and the work shifts should not conflict with each other.

2. Create a split work shift. For more information, see "Assigning a Work Shift Rotation to an Agent" on page 200, "Creating a New Work Shift Rotation" on page 201, and "Splitting a Work Shift" on page 203.

3. Generate the weekly schedule production. For more information, see "Automated Work Shift Rotation" on page 273.

   **NOTE:** When you create work shift rotation and generate the weekly schedule, you will see the automatic work shift rotation selected by default (see "Automated Work Shift Rotation" on page 273). An automatic work shift rotation follows this schedule until you decide to change it.
Assigning a Work Shift Rotation to an Agent

To assign a work shift rotation to an agent:

1. Choose Agents > Assign Work Shifts. The Work Shift Assignments pane displays available and assigned work shift rotations (Figure 86).

Figure 86. Work Shift Assignments: Work Shift Rotation tab

2. If desired, filter the list of agents by CSQ mapping or team.

3. Choose the agent to whom you want to assign a work shift from the Select an Agent list. A list of work shifts assigned to the selected agent appears under Agent Work Shift Rotation. If the list is empty, then the agent has not been assigned any work shifts.

   NOTE: If you are editing an agent from the Agent Details pane, only the agent you selected from the Agent List appears in this field.

4. Under Work Shifts List, select a work shift to assign to the agent.

5. Assign the selected work shift to the selected agent by completing one of the following options:
   - Creating a New Work Shift Rotation (page 201)
   - Replacing an Existing Work Shift with a New Work Shift (page 201)
   - Inserting a New Work Shift after an Existing Work Shift (page 201)
Assigning Work Shifts

- Inserting New Work Shift before an Existing Work Shift (page 202)
- Deleting Assigned Work Shifts (page 202)
- Splitting a Work Shift (page 203)
- Advancing or Postponing Assigned Work Shifts (page 203)
- Copying a Work Shift Rotation to Other Agents (page 203)

Creating a New Work Shift Rotation

Use this procedure to create a new work shift rotation.

To create a work shift rotation:

1. Delete all of the existing assignments by selecting the check box in the column heading of the Agent Work Shift Rotation table and click (Delete).
2. Click (New Rotation). Fourteen weeks (without work shift assignments) appear under Agent Work Shift Rotation.
3. Select a work shift from the Work Shifts List.
4. Assign the work shift to all of the weeks by selecting the top check box in the list and clicking (Insert On).
5. Delete any undesired assignments by selecting the check box for those assignments and clicking (Delete).
6. Click (Save) to save your changes.

Replacing an Existing Work Shift with a New Work Shift

Use this procedure to replace a work shift assigned to an agent with a new work shift.

To replace an existing work shift with a new work shift:

1. Select the check boxes for the assignments you want to change.
2. Select a work shift from the Work Shifts List.
3. Click (Insert On). WFM replaces the selected work shifts with the new work shift.
4. Click (Save) to save your changes.

Inserting a New Work Shift after an Existing Work Shift

Use this procedure to insert a new work shift after an existing work shift in the Agent Work Shift Rotation list.

To insert a new work shift after an existing work shift:

1. Select the check box next to a work shift assignment in the Agent Work Shift Rotation list.
2. Select a work shift from the Work Shifts List.

3. Click (Insert After). The dates for assignments that occur before the new assignment do not change. The dates for the assignments that occur after the new assignment advance by one week.

4. Click (Save) to save your changes.

**Inserting New Work Shift before an Existing Work Shift**

Use this procedure to insert a new work shift before an existing work shift in the Agent Work Shift Rotation list.

To insert a new work shift before an existing work shift:

1. Select the check box next to a work shift assignment in the Agent Work Shift Rotation list.

2. Select a work shift from the Work Shifts List.

3. Click (Insert Before). The dates for assignments that occur before the new assignment do not change. The dates for the assignments that occur after the new assignment advance by one week.

4. Click (Save) to save your changes.

**Deleting Assigned Work Shifts**

Use this procedure to delete assigned work shifts. There are several ways to delete assigned work shifts. This procedure explains each option for deleting assigned work shifts. Your options are:

- Deleting an entire work shift rotation
- Deleting work shifts

To delete an entire work shift rotation:

1. Click (Delete Rotation (All Work Shifts)). The existing weeks remain, but the work shift assignments for those weeks are deleted.

2. Click (Save) to save your changes.

**NOTE:** Delete any weeks that do not have work shifts assigned to them, because WFM will take them into account when generating a schedule.

To delete assigned work shifts:

1. To delete all work shift assignments, select the check box in the heading of the first column of the Agent Work Shift Rotation table and click (Delete).

   To remove one or more work shift assignments, select the check box next to each work shift assignment name and click (Delete).
2. Click (Save) to save your changes.

**Splitting a Work Shift**

Use this procedure to split a work shift. Split a work shift when an agent works two different shifts during a day.

**NOTE:** Before you split a work shift, you must create two work shifts that start and end at different times. The start and end time for each work shift must not overlap and the work shifts should not conflict with each other.

This procedure assumes that you already added one of the two work shifts to the Work Shift Rotation List as described in "Creating a New Work Shift Rotation" on page 201.

**To split a work shift:**

1. Select the check box next to the existing work shift you want to split in the Agent Work Shift Rotation list.
2. Click (Add Work Shift to Selected Weeks (Split Shift)). The selected work shift does not change. A new work shift assignment appears next to the selected work shift assignment and displays the same date and work shift name.
3. Select the check box next to the newly created work shift in the Agent Work Shift Rotation list.
4. Select a work shift in the Work Shift Lists that you want to use for the additional shift in the split work shift.
5. Click (Insert On). The selected work shift in the Agent Work Shift Rotation now displays the name of the work shift selected in the Work Shifts List.
6. Click (Save).

**Advancing or Postponing Assigned Work Shifts**

**To advance or postpone assigned work shifts from the Work Shifts Assignment pane:**

- To advance all the work shift assignments by one week, click (Advance) and (Save) to save your changes.
- To postpone all of the work shift assignments by one week, click (Postpone) and (Save) to save your changes.

**Copying a Work Shift Rotation to Other Agents**

This procedure describes how to copy a work shift rotation to other agents.
To copy a work shift rotation to other agents:

1. Choose Agents > Assign Work Shifts. The Work Shift Assignments pane displays available and assigned work shifts (Figure 87).

![Figure 87. Work Shift Assignments: Work Shift Rotation tab](image)
2. To copy the work shift rotation from the Agent Work Shift Rotation list, click (Copy). The Select Agents pane appears (Figure 88).

Figure 88. Select Agents

3. Select the agents to which you want to copy the displayed work shift rotation.

4. Click (Paste) to paste the work shift rotation to the selected agents.

5. Click (Save) to save your changes.

6. To verify the work shift rotation was copied to the selected agents, complete one of the following steps.

   - Select the name of the agent to whom you copied the work shift rotation from the Select an Agent drop-down list. The agent’s work shift rotation should appear in the Agent Work Shift Rotation list.
   - Display the agent’s work shift rotation.
     a. Choose Agents > Agents. The Agent List appears.
     b. Click the employee number associated with the agent you want to verify. The Agent Details pane appears.
     c. Click the Work Shifts tab. The work shift rotation copied to this agent should appear on this pane.

**NOTE:** You can edit the agent’s work shift rotation by clicking Edit Agent Rotation.
Displaying Assigned Work Shifts

To display assigned work shifts:

1. Click the Assigned Work Shifts tab. The Work Shift Assignments pane displays assigned work shifts (Figure 89).

   Figure 89. Work Shift Assignments: Assigned Work Shifts tab

2. Enter a date for the first day of a week (Sunday) in the Select a date field and click Display Assignments. The assigned work shifts for the selected date appear in the Assignments pane.

3. Click a work shift under the Work Shift Name column to display agents assigned to this work shift. WFM displays the work shifts details in the Assignment Details pane.
Assigning Exception Types

This section covers the following topics.

- Understanding the Exception Assignment Fields (page 207)
- Assigning a Pre-Production Exception (page 208)
- Examples of Exceptions (page 210)

See "Understanding Generic Exceptions and Exception Types" on page 49 for more information.

**NOTE:** If you need to assign an exception to an agent on a date after you have produced the schedule for that date, you should use the Post-Production Planning function. If you do not, you will have to update the schedule manually. For more information about adding unplanned exceptions to a schedule, see "Post-Production Planning" on page 288.

**Understanding the Exception Assignment Fields**

The fields for the Exception Assignments pane are described in the following table (Figure 90).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception List</td>
<td>Name of exception.</td>
</tr>
<tr>
<td>Starts On</td>
<td>Date on which the exception starts. The default is the current date.</td>
</tr>
<tr>
<td>Ends On</td>
<td>Date on which the exception ends.</td>
</tr>
<tr>
<td>After number Occurrences</td>
<td>Choose this option if you want the exception to be repeated a specified number of times and enter the number of times the exception is repeated.</td>
</tr>
<tr>
<td>Entire Day</td>
<td>Whether the exception covers the whole service day.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Exception start time (in hours and minutes) using HH:MM format.</td>
</tr>
<tr>
<td>End Time</td>
<td>Exception end time (in hours and minutes) using HH:MM format.</td>
</tr>
<tr>
<td>Hours</td>
<td>Total number of hours required for the exception.</td>
</tr>
</tbody>
</table>
Assigning a Pre-Production Exception

This topic explains how to use the Exception Assignments pane to assign an exception before a schedule has been produced. For information about assigning exceptions after a schedule has been produced, see "Assigning a Post-Production Exception" on page 291.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paid</td>
<td>Whether the agent will be paid for these hours. By default, WFM displays the Paid status entered when you created the exception type. See &quot;Editing an Exception Type&quot; on page 150. However, you can change it here. <strong>NOTE:</strong> If the exception is paid, the total number of hours between the start and the end time must be equal to the number of paid hours. The number of paid hours does not include lunch time.</td>
</tr>
<tr>
<td>Frequency</td>
<td>Choose the frequency of the occurrences. The options are Daily, Weekly, Monthly, and Yearly (for example, once a week for 10 weeks). See “Examples of Exceptions” on page 210 for more information.</td>
</tr>
<tr>
<td>Occurrence</td>
<td>Choose the type of occurrence. The options that appear in this field depend on the option you chose under Frequency. See &quot;Examples of Exceptions&quot; on page 210 for more information.</td>
</tr>
</tbody>
</table>
To assign a pre-production exception:

1. Choose Agents > Assign Exceptions. The Exception Assignments pane appears (Figure 90).

**Figure 90. Exception Assignments**

2. Select the team of the agent to whom you want to assign the exception.

3. If desired, filter the list of agents by choosing one of the following options from the Team List drop-down list:
   - Active: To display only active agents in the Agent List.
   - Inactive: To display only inactive agents in the Agent List.
   - All: To display all agents, active and inactive, in the Agent List.

4. Select one or more agents from the Agent List. A field below the Agent List shows how many agents you selected from this list.

5. Select an exception from the Exception List.

6. Select start date and either end date or number of occurrences.

7. Enter the length of the exception.

8. Select pay status, frequency, and occurrence.

9. Click (Save) to save your changes.
Examples of Exceptions

The following list provides typical examples used when defining frequency and occurrence of exceptions.

- An agent is assigned to special administration work for two months. The assignment starts on July 2nd and ends on September 21st. The agent is required to perform this administration work on every Wednesday and Thursday from 10:00 to noon. Figure 91 shows how to enter this exception.

Figure 91. Example 1

![Figure 91: Example 1 Exception List and Frequency Settings]

- Paid
- Weekly
- Every 1 Weeks
A group of agents must attend ten meetings on Mondays every other week for one hour. The meeting runs from 14:00 to 15:00. The meetings start on February 12th. (Note that the Ends on option is disabled.) Figure 92 shows how to enter this exception.

Figure 92. Example 2

```plaintext
Exception List
Team Meeting

Dates
Starts On: 02-12-2008
Ends On: 02-12-2008
After: 10 Occurrences

Frequency
○ Daily
○ Weekly
○ Monthly
○ Yearly

Length
Entire Day: ☐
Start Time: 14:00
End Time: 15:00
Hours: 01:00

Occurrence
Every 2 Weeks
☐ Sunday
☐ Monday
☐ Tuesday
☐ Wednesday
☐ Thursday
☐ Friday
☐ Saturday
```
Starting on February 12th, the contact center assigns two agents to prepare statistics reports for one full day on the 5th day of every third month for the year 2007. Figure 93 shows how to enter this exception.

**Figure 93. Example 3**

<table>
<thead>
<tr>
<th>Exception List</th>
<th>Dates</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statistics Reporting</td>
<td>Starts On: 02-12-2008</td>
<td>☐ Daily</td>
</tr>
<tr>
<td></td>
<td>Ends On: 02-12-2008</td>
<td>☐ Weekly</td>
</tr>
<tr>
<td></td>
<td>After: 4</td>
<td>☐ Monthly</td>
</tr>
<tr>
<td></td>
<td></td>
<td>☐ Yearly</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Occurrence:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>☐ The 5th Of every 4 Month</td>
</tr>
<tr>
<td></td>
<td></td>
<td>☐ The First Of every 1 Month</td>
</tr>
</tbody>
</table>

Four agents are required to mail the monthly statements from 08:00 to 12:00, the first Monday of every month, from the beginning of the year. Figure 94 shows how to enter this exception.

**Figure 94. Example 4**

<table>
<thead>
<tr>
<th>Exception List</th>
<th>Dates</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monthly Statements</td>
<td>Starts On: 01-1-2008</td>
<td>☐ Daily</td>
</tr>
<tr>
<td></td>
<td>Ends On: 02-12-2008</td>
<td>☐ Weekly</td>
</tr>
<tr>
<td></td>
<td>After: 1</td>
<td>☐ Monthly</td>
</tr>
<tr>
<td></td>
<td></td>
<td>☐ Yearly</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Occurrence:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>☐ The 1st Of every 1 Month</td>
</tr>
<tr>
<td></td>
<td></td>
<td>☐ The First Of every 1 Month</td>
</tr>
</tbody>
</table>
Alternatively, you could specify 12 occurrences without specifying an end date. Figure 95 shows how to enter this exception.
Managing Projects

You can use the Projects function to complete the following tasks.

- Create projects. For more information, see "Creating a Project" on page 214.
- Edit projects. For more information, see "Editing a Project" on page 219.
- Assign agents to a project. For more information, see "Assigning Agents to a Project" on page 220.
- Delete projects. For more information, see "Deleting a Project" on page 222.

See "Understanding Projects" on page 52 for more information.

Creating a Project

To create a project:

1. Choose Agents > Projects. The Project List appears (Figure 96).

Figure 96. Project List
2. Click (New) to create a project. The Project Details pane displays general project options (Figure 97).

Figure 97. Project Details: General tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Name</td>
<td>The name of the project.</td>
</tr>
<tr>
<td>Active</td>
<td>WFM only schedules the project if the Active check box is selected. The check box is selected by default. Clear the Active check box if you want to deactivate the project.</td>
</tr>
<tr>
<td>Start Date</td>
<td>The start date for the project.</td>
</tr>
<tr>
<td>End Date</td>
<td>The end date for the project.</td>
</tr>
</tbody>
</table>
Priority

The priority number for this project. Assigning priorities to projects allows WFM to resolve scheduling conflicts when agents are assigned to multiple projects. 1 is the highest priority.

For example, you designate some of your agents to support two projects and assign a priority to each project in WFM. If WFM generates the schedules for the two projects and discovers there are not enough agents to support all forecast requirements across both projects, it compares the priority value for the two projects. WFM then schedules agents for the project with the highest priority first.

Paid

Whether agents are paid to do this project.

Color

The color that appears in the Project column on the Schedule Maintenance pane. The default color is blue.

To avoid confusion, select a unique color for each project. Click the Color field to display the color palette and select a color. WFM displays the color and the Java number associated with the color.

Monday—Sunday

The days on which agents can work on this project.

Weekly Distribution

Select this check box if you want this project to occur when it would have the least impact on coverage. Weekly distribution projects are scheduled after the schedule is completed for all agents. WFM examines the coverage for every interval and schedules a project for a time where it would have least impact on coverage during the week. If an agent is assigned multiple projects, WFM also looks at the priority assigned to each project and assigns the project with the highest priority first.

When selected, the following fields appear:

- Maximum Hours per Week
- Apply to All Selected Days
- Applies to One of the Selected Days
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Maximum Hours per Week</strong></td>
<td>The maximum number of hours per week agents can work on this project and select one of the following options.</td>
</tr>
<tr>
<td></td>
<td>• Apply to All Selected Days: Applies Maximum Hours per Week to all selected days (Monday-Sunday).</td>
</tr>
<tr>
<td></td>
<td>• Apply to One of the Selected Days: Applies Maximum Hours per Week only to one of the selected days (Monday-Sunday).</td>
</tr>
<tr>
<td><strong>Start Time</strong></td>
<td>The project start time in the HH:MM format.</td>
</tr>
<tr>
<td><strong>End Time</strong></td>
<td>The project end time in the HH:MM format.</td>
</tr>
<tr>
<td><strong>Minimum Duration</strong></td>
<td>The minimum amount of time, in minutes, an agent is expected to work on this project. If you enter zero (0) in this field, WFM will not apply this project at a time where the service level will go below the service level objective.</td>
</tr>
<tr>
<td><strong>Maximum Duration</strong></td>
<td>The maximum amount of time, in minutes, and agent is expected to work on this project.</td>
</tr>
<tr>
<td><strong>Duration Unit</strong></td>
<td>The minimum increment, in minutes, for the length of time. If the Minimum Duration is 30 minutes and the Maximum Duration is 60 minutes and you specify 15 minutes in the Duration Unit field, the time worked could be 30, 45 or 60 minutes.</td>
</tr>
<tr>
<td><strong>Schedule Increment</strong></td>
<td>Select a 15- or 30-minute increment for this project. If you choose a 15-minute schedule increment, the start time would be 08:00, 08:15, or 08:30 and the number of hours worked would be 3, 3.25, 3.5, 3.75.</td>
</tr>
</tbody>
</table>
4. Click the Agents tab. The Project Details pane displays available and assigned agents (Figure 98).

Figure 98. Project Details: Assign Project to Agents tab

5. To assign agents to a project, select the names of the agents in the Available Agents list, then click >. The agents move to the Assigned Agents list. See "Moving Items between Lists" on page 111 for more information.

6. To remove agents from a project, select their names from the Assigned Agents list, then click <. The agents’ names return to the Available Agents list.

7. Click (Save) to save your changes.
Editing a Project

To edit a project:

1. Choose Agents > Projects. The Project List appears (Figure 99).

![Figure 99. Project List](image)

2. Click a project name. The Project Details pane displays general project options (Figure 100).

![Figure 100. Project Details: General tab](image)

3. Complete the fields. The fields are described in "Creating a Project" on page 214.

4. Click (Save) to save your changes.
Assigning Agents to a Project

*To assign agents to a project:*

1. Choose Agents > Projects. The Project List appears (Figure 101).

   **Figure 101.** Project List

   ![Project List](image)

2. Click a project name. The Project Details pane displays general project options (Figure 102).

   **Figure 102.** Project Details: General tab

   ![Project Details: General tab](image)
3. Click the Agents tab. The Project Details pane displays available and assigned agents (Figure 103).

Figure 103. Project Details: Agents tab

4. To assign agents to a project, select the names of the agents in the Available Agents list, then click >. The agents move to the Assigned Agents list. See "Moving Items between Lists" on page 111 for more information.

5. To remove agents from a project, select their names from the Assigned Agents list, then click <. The agents’ names return to the Available Agents list.

6. Click (Save) to save your changes.
Deleting a Project

To delete a project:

2. Select the project to delete by completing one of the following steps.
   ■ To delete one or more projects, select the check box next to the project name.
   ■ To delete all projects, select the check box in the column header.
3. Click \( \times \) (Delete). An Internet Explorer dialog box appears.
4. Click OK to confirm the deletion and dismiss the dialog box.
Managing Forecasts

Introduction

You can use the Forecasting module to complete the following tasks.

- Create distributions. For more information, see "Managing Distributions" on page 224.
- Edit and delete distributions. For more information, see "Editing Distributions" on page 227.
- Create forecasts. For more information, see "Managing Forecast Requests" on page 233.
- Edit and delete forecasts. For more information, see "Editing Forecasts" on page 249.
- Create and edit special events. For more information, see "Managing Special Events" on page 256.
- Assign special events. For more information, see "Assigning Special Events" on page 261.
- Delete special events. For more information, see "Deleting a Special Event" on page 259.
- Create firm date assignments. For more information, see "Managing Firm Dates" on page 266.
- Enter closed days. For more information, see "Managing Closed Days" on page 269.

For more information, see "Understanding Forecasting" on page 63.
Managing Distributions

You can use the Distribution function to complete the following task.

- Create a distribution. For more information, see "Creating a Distribution" on page 224.

See "Understanding Distributions" on page 60 for more information.

Creating a Distribution

To create a distribution:

1. Choose Forecasting > Distribution. The Distribution Request pane appears (Figure 104).

Figure 104. Distribution Request

2. From the Select CSQ list, select one or more source or virtual CSQs.
3. Optional: To assign this distribution to a scenario, complete the following steps.
   a. Select the Assign Distribution to a Scenario check box. A drop-down list and the Create New Scenario check box appear.

   **NOTE:** The drop-down list only displays scenarios if you have selected CSQs that are associated with scenarios.

   b. Complete one of the following steps:
      ■ To use an existing scenario, select it from the drop-down list.
      ■ To create a new scenario, complete the following steps.
         1. Select the Create New Scenario check box. The Scenario Name field appears.
         2. Type a name for the distribution scenario.

4. Under Reference Period, enter the start and end dates for the historical reference period.
   
   To determine the historical data available to you, see "Displaying Historical Data for a CSQ" on page 352.

   **NOTE:** Make a note of these dates. You will need them when you generate a forecast for this CSQ.

5. Under Calculate Distribution, clear the check boxes for any days for which you do not want a distribution. For example, if the CSQ is closed on Sunday and Monday, clear the Sunday and Monday check boxes.

6. If you want WFM to update the Standard Talk Time and After Call Work Time for the CSQ, select the Update CSQ Times check box. For more information, see "Creating a CSQ for Calls" on page 130 or "Creating a CSQ for Email" on page 138.

7. In the Execute Request Date field, enter the date and the time at which you want to run this request.

   **NOTE:** Enter the date using the MM-DD-YYYY format and the time using the HH:MM format. For example, if you want to execute the request at 8:30 am on January 28, 2008, enter **01-28-2008 08:30**. When you select a date from the calendar, WFM automatically inserts the selected date and the current time.

   **NOTE:** Requests containing a large amount of data require significant time to run. It is recommended that you run requests during off-peak hours (for example, at night) because the process server only runs one request at a time, and running requests during peak hours will prevent other users from running their requests.
8. Click ✅ (Launch Request). WFM launches your distribution request.

**NOTE:** You can monitor the status of your request on the Server Request List. For more information about this list, see "Managing Requests to the Server" on page 394.
The future does not always repeat the past. Future events can cause a contact distribution to change. If you know about upcoming events that might affect a distribution, you can use the Edit Distribution function to modify the distribution to account for those events. For any half hour interval, you can change the number of contacts likely to arrive, the average talk or processing time, and the average work time.

You can use the Edit Distribution function to complete the following tasks.

- Display and modify a distribution on one or more days. For more information, see "Editing a Distribution" on page 228.
- Display a distribution graph. For more information, see "Displaying a Distribution Graph" on page 232.
- Copy a distribution from one day to another. For more information, see "Copying a Distribution" on page 232.
Editing a Distribution

To edit a distribution:

1. Choose Forecasting > Edit Distribution. The Distribution Maintenance pane appears (Figure 105).

Figure 105. Distribution Maintenance
2. Select the name of the CSQ from the drop-down list in the toolbar. WFM populates the fields in the Distribution Maintenance pane (Figure 106).

**NOTE:** By default, WFM displays the distribution for Sunday. To display the distribution for a different day, select the day from the Select Day list.

Figure 106. Distribution Maintenance

3. **Optional:** Select a distribution scenario from the Select a Distribution Scenario drop-down list.
4. Update the fields in the following columns: Email, ATT (average talk time), and AWT (average wrapup time). The fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Interval | The start time for the half hour interval.  
For a CSQ of type Calls, the distribution covers intervals when the CSQ is open (see the opening and closing hours in the CSQ Detail pane).  
For a CSQ of type Email, WFM displays all intervals in the 24 hours, since the call center can receive email even when the CSQ is closed. |
| Ratio | The percentage of the day’s calls that arrive during the interval.  
The value is expressed in decimal format. WFM will distribute the forecasted call volume according to this distribution ratio when you generate a forecast. |
| Calls | The number of calls received during the interval. WFM uses this value when making ratio adjustments. If you modify the number, WFM calculates the correct distribution ratio.  
This column only appears when you choose a CSQ of type Calls. |
| Contacts | The number of contacts forecasted to arrive during the interval. WFM uses this value when making ratio adjustments. If you modify the number, WFM calculates the correct distribution ratio. |
| Email | The number of emails received during the interval. WFM uses this value when making ratio adjustments. If you modify the number, WFM calculates the correct distribution ratio.  
This column only appears when you choose a CSQ of type Email. |
| ATT | Average Talk Time. The amount of time, in seconds, an agent takes to process calls for each interval. Talk time is elapsed time from when an agent answers a call until the agent disconnects or transfers the call. This includes the time when the agent is actively talking to the caller and the time when the agent places the caller on hold. The average time that agent was in the Talk In, Talking Out, and Talking other states during an interval.  
This column only appears when you choose a CSQ of type Calls. |
5. Click ![Save](Save) to save your changes.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AHT</td>
<td>Average Handle Time. The average amount of time, in seconds, it takes to handle a contact to completion, including talk time plus after-contact work time. To calculate, divide the total seconds of work time by the number of contacts. Handle time includes the time agents spend in the Talking In, Hold, Work Ready, and Work Not Ready states.</td>
</tr>
<tr>
<td>APT</td>
<td>Average Processing Time. The average processing time for answered email during the scheduled period. Processing time includes all time from the moment the agent opens the email to the moment the agent sends the email. This includes the time when the agent is actively writing a response to the email. This field column appears when you choose a CSQ of type Email.</td>
</tr>
<tr>
<td>AWT</td>
<td>Average Wrapup Time. The average time required by an agent after a conversation is ended or a response to email is sent, to complete work that is directly associated with the call or email just completed. Does not include time for any activities such as meetings, breaks, or correspondence. If the CSQ is of type Email and you are not using an email switch, the value in this column is zero (0).</td>
</tr>
<tr>
<td>ACW</td>
<td>After Call Work. The average time required by an agent after a conversation is ended or a response to email is sent, to complete work that is directly associated with the call or email just completed. Does not include time for any activities such as meetings, breaks, or correspondence. If the CSQ is of type Email and you are not using an email switch, the value in this column is zero (0).</td>
</tr>
</tbody>
</table>
Displaying a Distribution Graph

To display a distribution graph:

- Click (Graph) next to a column heading to display the data graph. The x-axis displays the schedule intervals (Figure 107).

**NOTE:** The graph icon only appears when the table has 100 rows or less.

**NOTE:** The x-axis has a maximum of 30 points. If you specify more than 30 intervals, WFM displays the average for each displayed interval.

Figure 107. Graph sample dialog box

Copying a Distribution

To copy a distribution:

1. Select the day with the distribution to copy from the Select Day drop-down list.
2. Click (Copy). WFM copies the selected distribution to the clipboard and displays this message.
   
   Copy done. Ready to paste.
3. Select the day to copy the distribution to from the Select Day drop-down list.
4. Click (Paste). WFM pastes the distribution and displays this message.
   
   Paste done successfully.
5. Click (Save) to save your changes.
Managing Forecast Requests

You can use the Forecast Request function to complete the following tasks.

- If you have 12 to 15 months of historical data in WFM, you can generate a call or chat forecast with trends. For more information, see "Generating a Call or Chat Forecast With Trends" on page 233.

- If you have less than 12 months of historical data in WFM, you must generate a call or chat forecast without trends. For more information, see "Generating a Call or Chat Forecast Without Trends" on page 239.

- Generate an email forecast without trends. For more information, see "Generating an Email Forecast without Trends" on page 243.

Generating a Call or Chat Forecast With Trends

If you have at least 12 months’ worth of historical data in WFM, use this procedure to generate a call or chat forecast with trends.

**NOTE:** WFM requires a year’s worth of historical data to generate a forecast with trends. If an entire year is not available, the forecast value will be zero.

**IMPORTANT:** You must generate a distribution before you generate a forecast. For more information, see "Creating a Distribution" on page 224.
To generate a call or chat forecast request with trends:

1. Choose Forecasting > Forecast Request. The Forecast Request pane appears (Figure 108).

   ![Figure 108. Forecast Request](image)

2. Choose Calls from the CSQ Type drop-down list. The Select CSQs list displays all of the CSQs of type Calls.

   **NOTE:** If you have a CSQ designated to handle chat, you must choose Calls.

3. Select the CSQs from the Select CSQs list.

4. Optional: To use scenarios, click Get Scenarios and then complete one or both of the following steps.
   - To apply a distribution scenario to a forecast, choose the scenario from the Select Distribution Scenario drop-down list.
   - To generate a forecast scenario, choose the scenario from the Select Forecast Scenario drop-down list.

5. Under Forecast Dates, enter the start and end dates for the forecast period.

   **NOTE:** Make a note of these dates. You will need to enter them when you generate a schedule for this CSQ, because the schedule request must cover the same period as the forecast.

   **NOTE:** You can generate a forecast for a period as short as one day. However, if you want to use the forecast to generate a schedule, you must
generate a forecast that is at least one week long, since the minimum length of a schedule is one week.

**NOTE:** You can generate forecasts for dates that have already past.

6. Under Year-To-Year Trend Calculation, select the With Trends option.

7. Under Type of Trend Calculation, select one of the following options.
   - Overall Trend
   - Specific Trends per Day

**NOTE:** Both options will provide reasonable results. The Specific Trends per Day option is recommended, unless the CSQ experiences a wide fluctuation in the pattern of contacts from week to week. For more information, see "Using Forecasting with Trends Methods" on page 69.

8. Under Reference Period for Trend Calculation, enter the start and end dates.

   WFM calculates the average contact volume for each day of the week in your reference period to use as the forecasted call volumes for each day of the week in your forecast period. WFM considers the following factors when generating a forecast.

   - If you use more than one week for your reference period, the dates with the highest and lowest call volumes are automatically omitted from the average calculation.
   - If you have special events assigned to one or more dates in your reference period, the impact ratio is automatically applied to the volume on these dates before the average is calculated.
   - If there are firm dates associated to one or more of forecast dates, the volumes from the associated dates are used instead of the same dates in the average calculation.

9. Under Daily Volume Based On, select one of the following options. For more information, see "Using Daily Volume Estimation Methods" on page 71.

   - Average of Equivalent Days: If you select this option, complete the following steps.
     a. Enter the number of weeks prior to the selected day in the Weeks Prior to Equivalent Day field.
     b. Enter the number of weeks after the selected day in the Weeks After Equivalent Day field.
   - Previous Year Equivalent Day: If you select Previous Year Equivalent Day, no additional information is needed.
10. To adjust average call handling time, click Additional Parameters. The Additional Parameters panel expands (Figure 109).

**Figure 109.** Additional Parameters

![](image181x571 to 519x637)

a. Select one of the following options for Average Call Handling Time. For more information, see "Using Contact Handling Estimation Methods" on page 72.

- **Distribution Call Handling Times:** If you changed the call handling time when you created the distribution, WFM uses the modified time when generating the forecast. See "Creating a Distribution" on page 224 for more information.

- **Standard Handle Times:** WFM uses the call handling times specified when you created the CSQ. See "Creating a CSQ for Calls" on page 130 or "Creating a CSQ for Email" on page 138 for more information.

b. In the Adjustment Factor field, enter the ratio by which you want the forecast adjusted. If you do not want any special adjustment, set the adjustment factor to 1.0.

**NOTE:** Use Standard Times if you know the talk time and work time will be different than the values in the distribution (for example, the agents are using a new system that they are not used to). Adjust the Standard Times in the CSQ Details pane before launching the forecast.

**NOTE:** WFM applies this adjustment independent of the trend calculation.

**NOTE:** Unless your contact center is growing by a known factor, it is recommended that you leave this field set to the default value of 1.0 and instead modify the adjustment factor on the Forecast Maintenance pane, where you can analyze the data in more detail (for more information, see "Editing Forecasts" on page 249).

**NOTE:** Modify the adjustment factor if you know the historical data in your reference period should be increased or decreased. For
example, enter 1.5 if you think the CSQ will receive 50% more calls than it did during the forecast reference period. Enter 0.5 if you think the CSQ will receive 50% fewer calls than it did during the forecast reference period.

11. In the Execute Request Date field, enter the date and the time at which you want this request to run.

**NOTE:** Enter the date using the MM-DD-YYYY format and the time using the HH:MM format. For example, if you want to execute the request at 8:30 am on January 28, 2008, enter **01-28-2008 08:30**. When you select a date from the calendar, WFM automatically inserts the selected date and the current time.

**NOTE:** Requests containing a large amount of data require significant time to run. It is recommended that you run requests during off-peak hours (for example, at night) because the process server only runs one request at a time, and running requests during peak hours will prevent other users from running their requests.

12. To adjust service level objectives, click Service Levels Calculation. The Service Levels Calculation panel expands and displays a table that has one row for every half-hour interval. The default Service % value is 80. The default Seconds value is 20 (Figure 110).

**Figure 110. Staffing levels calculation**

<table>
<thead>
<tr>
<th>Period</th>
<th>Service %</th>
<th>Seconds</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>00:30</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>01:00</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>01:30</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>02:00</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>02:30</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>03:00</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>03:30</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>04:00</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>04:30</td>
<td>80</td>
<td>20</td>
</tr>
</tbody>
</table>
13. For each half-hour interval, complete the following steps.
   
   a. In the Service % field, enter the percentage of calls that must be answered within the specified number of seconds to meet your service level objective. A dialog box appears, asking if you want the new value to be applied to the next period. If you click Cancel, only the value for the selected interval changes. If you click OK, the values for the selected interval and all subsequent intervals change.

   b. In the Seconds column, enter the number of seconds in which all calls must be answered to meet your service level objective.

14. Click (Launch Request). A Windows Internet Explorer dialog box appears (Figure 111).

   **Figure 111.** Windows Internet Explorer dialog box

   ![Windows Internet Explorer dialog box](image)

   You might override existing forecasts. Do you want to continue?

   OK Cancel

15. Click OK to dismiss the dialog box. WFM launches the forecast request.

   **NOTE:** You can monitor the status of your request on the Server Request List pane. See "Managing Requests to the Server" on page 394 for more information.
Generating a Call or Chat Forecast Without Trends

If you have less than 12 months' worth of historical data in WFM, use this procedure to generate a call or chat forecast without trends. WFM will generate the forecast using a default trend value of one.

**NOTE:** You must generate a distribution before you generate a forecast. For more information, see "Creating a Distribution" on page 224.

**To generate a call or chat forecast request without trends:**

1. Choose Forecasting > Forecast Request. The Forecast Request pane appears (Figure 112).

   ![Figure 112. Forecast Request](image)

2. Choose Calls from the CSQ Type drop-down list. The Select CSQs list displays all of the CSQs of type Calls.

   **NOTE:** If the CSQ is designated to handle chat, you must select Calls.

3. Select one or more CSQs from the Select CSQs list.
4. **Optional:** To use scenarios, click Get Scenarios and then complete one or both of the following steps.
   - To apply a distribution scenario to a forecast, choose the scenario from the Select Distribution Scenario drop-down list.
   - To generate a forecast scenario, choose the scenario from the Select Forecast Scenario drop-down list.

5. Under Forecast Dates, enter the start and end dates for the forecast period.

   **NOTE:** Make a note of these dates. You will need to enter them when you generate a schedule for this CSQ, because the schedule request must cover the same period as the forecast.

   **NOTE:** You can generate a forecast for a period as short as one day. However, if you want to use the forecast to generate a schedule, you must generate a forecast that is at least one week long, since the minimum length of a schedule is one week.

   **NOTE:** You can generate forecasts for dates that are in the past.

6. Under Year-To-Year Trend Calculation, select the Without Trends option.

7. Under Volume Projection Reference Period, complete one of the following steps.
   - If you choose Date Range, enter the start and end dates.
   - If you choose Date List, enter a date, then click >. Repeat this step for each date you want to add to the list. If you want to remove a date from the list, click the date in the list, then click <.

8. To adjust average call handling time, click Additional Parameters. The Additional Parameters panel expands (Figure 113).

   **Figure 113.** Additional Parameters

   ![Additional Parameters](image)

   a. Select one of the following options. See "Using Contact Handling Estimation Methods" on page 72 for additional information.

      - Distribution Call Handling Times: If you changed the call handling time when you created the distribution, WFM uses the modified call handling time when generating the forecast. See "Creating a Distribution" on page 224 for more information.
Standard Handle Times: WFM uses the call handling times specified when you created the CSQ. See "Creating a CSQ for Calls" on page 130 or "Creating a CSQ for Email" on page 138 for more information.

b. In the Adjustment Factor field, enter the ratio by which you want the forecast adjusted. If you do not want any special adjustment, set the adjustment factor to 1.0.

NOTE: WFM applies this adjustment independent of the trend calculation.

NOTE: Unless your contact center is growing by a known factor, it is recommended that you leave this field set to the default value of 1.0 and instead modify the adjustment factor on the Forecast Maintenance pane, where you can analyze the data in more detail (for more information, see "Editing Forecasts" on page 249).

NOTE: Modify the adjustment factor if you know the historical data in your reference period should be increased or decreased. For example, enter 1.5 if you think the CSQ will receive 50% more calls than it did during the forecast reference period. Enter 0.5 if you think the CSQ will receive 50% fewer calls than it did during the forecast reference period.

9. In the Execute Request Date field, enter the date and the time at which you want this request to run.

NOTE: Enter the date using the MM-DD-YYYY format and the time using the HH:MM format. For example, if you want to execute the request at 8:30 am on January 28, 2008, enter 01-28-2008 08:30. When you select a date from the calendar, WFM automatically inserts the selected date and the current time.

NOTE: Requests containing a large amount of data require significant time to run. It is recommended that you run requests during off-peak hours (for example, at night) because the process server only runs one request at a time, and running requests during peak hours will prevent other users from running their requests.
10. To adjust service level objectives, click Service Levels Calculation. The Service Levels Calculation panel expands and displays a table that has one row for every half-hour interval. The default Service % value is 80. The default Seconds value is 20 (Figure 114).

Figure 114. Staffing levels calculation

<table>
<thead>
<tr>
<th>Period</th>
<th>Service %</th>
<th>Seconds</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>00:30</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>01:00</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>01:30</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>02:00</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>02:30</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>03:00</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>03:30</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>04:00</td>
<td>80</td>
<td>20</td>
</tr>
<tr>
<td>04:30</td>
<td>80</td>
<td>20</td>
</tr>
</tbody>
</table>

a. For each half-hour interval, complete the following steps.

- In the Service % field, enter the percentage of calls that must be answered within the specified number of seconds to meet your service level objective. A dialog box appears, asking if you want the new value to be applied to the next period. If you click Cancel, only the value for the selected interval changes. If you click OK, the values for the selected interval and all subsequent intervals change.

- In the Seconds column, enter the number of seconds in which all calls must be answered to meet your service level objective.
11. Click (Launch Request). A Windows Internet Explorer dialog box appears (Figure 115).

Figure 115. Windows Internet Explorer dialog box

12. Click OK to dismiss the dialog box. WFM launches the forecast request.

NOTE: You can monitor the status of your request on the Server Request List pane. See "Managing Requests to the Server" on page 394 for more information.

Generating an Email Forecast without Trends

Use this procedure to generate an email forecast without trends. WFM will generate the forecast using a default trend value of one.

NOTE: WFM requires a year’s worth of historical data to generate a forecast with trends. Since historical data for email must be manually entered, it is assumed you have less than 12 months’ worth of historical data.

NOTE: You must generate a distribution before you generate a forecast. For more information, see "Creating a Distribution" on page 224.
To generate an email forecast request without trends:

1. Choose Forecasting > Forecast Request. The Forecast Request pane appears (Figure 116).

2. Select Email from the CSQ Type drop-down list. WFM displays the CSQs associated with the email in the Select CSQs list.

3. Select the CSQs from the Select CSQs drop-down list.

4. Select the start date for the forecast period from the Start Date field under Forecast Dates.

5. Select the end date for the forecast period from the End Date On field under Forecast Dates.

   **NOTE:** Make a note of these dates. You will need to enter them when you generate a schedule for this CSQ, because the schedule request must cover the same period as the forecast.

   **NOTE:** You can generate a forecast for a period as short as one day. However, if you want to use the forecast to generate a schedule, you must generate a forecast that is at least one week long, since the minimum length of a schedule is one week.

   **NOTE:** You can generate forecasts for dates that are in the past.

7. Under Volume Projection Reference Period, enter the start date and the end date.

**NOTE:** Specify the same start and end dates for the reference period you used when you created the distribution scenario.

8. To adjust average handling time, click Additional Parameters to display more parameters (Figure 117).

**Figure 117.** Additional Parameters

a. Select one of the following options:

- Distribution Call Handling Times: If you changed the email handling time when you created the distribution, WFM uses the modified time when generating the forecast. See "Creating a Distribution" on page 224 for more information.

- Standard Handling Times: WFM uses the email handling times specified when you created the CSQ. See "Creating a CSQ for Calls" on page 130 or "Creating a CSQ for Email" on page 138 for more information.

b. In the Adjustment Factor field, enter the ratio by which you want the forecast adjusted. If you do not want any special adjustment, set the adjustment factor to 1.0.

**NOTE:** WFM applies this adjustment independent of the trend calculation.

**NOTE:** Unless your contact center is growing by a known factor, it is recommended that you leave this field set to the default value of 1.0 and instead modify the adjustment factor on the Forecast Maintenance pane, where you can analyze the data in more detail (for more information, see "Editing Forecasts" on page 249).

**NOTE:** Modify the adjustment factor if you know the historical data in your reference period should be increased or decreased. For example, enter 1.5 if you think the CSQ will receive 50% more emails than it did during the forecast reference period. Enter 0.5 if you think
the CSQ will receive 50% fewer emails than it did during the forecast reference period.

9. In the Execute Request Date field, enter the date and the time at which you want to run this request.

**NOTE:** Enter the date using the MM-DD-YYYY format and the time using the HH:MM format. For example, if you want to execute the request at 8:30 am on January 28, 2008, enter **01-28-2008 08:30**. When you select a date from the calendar, WFM automatically inserts the selected date and the current time.

**NOTE:** Requests containing a large amount of data require significant time to run. It is recommended that you run requests during off-peak hours (for example, at night) because the process server only runs one request at a time, and running requests during peak hours will prevent other users from running their requests.

10. To adjust service level objectives, click Service Levels Calculation. The Service Levels Calculation panel expands and displays a table that has one row for every half-hour interval. The default Service % value is 100. The default Hours value is 4 (Figure 118).

![Figure 118. Service levels calculation](image)

a. For each half-hour interval, complete the following steps.

- In the Service % field, enter the percentage of emails that must be answered within the specified number of hours to meet your service level objective. A dialog box appears, asking if you want the new value
to be applied to the next period. If you click Cancel, only the value for the selected interval changes. If you click OK, the values for the selected interval and all subsequent intervals change.

- In the Hours column, enter the number of hours in which all emails must be answered to meet your service level objective.

11. To adjust email handling deferral, click Defer Handling of Email. The Defer Handling of Email panel expands (Figure 119).

**NOTE:** Defer Handling of Email only appears if you select a CSQ Type of Email.

![Figure 119. Defer Handling of Email](image)

a. Select one of the following options to handle emails received during business hours. For more information about the options, see "Handling Email Options" on page 73.

- Linearly: If you select this option, WFM divides the number of all emails received during business hours by the number of intervals in a work shift to determine the number of emails handled during each half hour.
- No Deferring: If you select this option, agents must handle all emails received during the half hour in which they are received.
- Non-Linearly: If you select this option, WFM schedules the agents to handle 50% of the emails received during the first half hour and divides the number of emails handled for each remaining half hour by 50%, until the last half hour in the work shift. During the last half hour in the work shift, the agents are expected to complete the remaining emails.

b. Select one of the following options to handle emails received after business hours. For more information about the options, see "Handling Email Options" on page 73.

- Linearly: If you select this option, WFM divides the number of all emails received after business hours by the number of half hours in a work shift to determine the number of emails handled during each half hour.
- No Deferring: If you select this option, agents must handle all emails received after business hours during the first half hour of the next day.
Non-Linearly: If you select this option, WFM schedules the agents to handle 50% of the emails received after business hours during the first half hour and divides the number of emails handled for each remaining half hour by 50%, until the last half hour in the work shift. During the last half hour in the work shift, the agents are expected to complete the remaining emails.

12. Click (Launch Request). A Windows Internet Explorer dialog box appears (Figure 120).

Figure 120. Windows Internet Explorer dialog box

13. Click OK to dismiss the dialog box. WFM launches the forecast request.

NOTE: You can monitor the status of your request on the Server Request List pane. See "Managing Requests to the Server" on page 394 for more information.
Editing Forecasts

You can use the Edit Forecast to complete the following tasks.

- Modify a forecast. For more information, see "Editing a Forecast" on page 249.
- Display a forecast graph. For more information, see "Displaying a Forecast Graph" on page 255.

Editing a Forecast

To edit a forecast:

1. Choose Forecasting > Edit Forecast. The Forecast Maintenance pane appears (Figure 121).

   Figure 121. Forecast Maintenance: Initial view

   ![Forecast Maintenance: Initial view](image)

2. Select a date.
3. Select a CSQ from the drop-down list in the toolbar.
4. Click Initialize. WFM displays the selected forecast (Figure 122).

**Figure 122.** Forecast Maintenance: After selecting date and CSQ

5. Complete the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interval</td>
<td>Schedule interval for the selected day in 30-minute increments.</td>
</tr>
</tbody>
</table>
| Calls             | Total number of calls forecasted to arrive during each interval.  
                      | This field appears only when you choose a CSQ of type Calls.                                          |
| Received Email    | Number of emails forecasted to arrive during each interval.  
                      | This field appears only when you choose a CSQ of type Email.                                          |
| Deferred Email    | Number of deferred email forecasted to be processed during each interval.  
<pre><code>                  | This field appears only when you choose a CSQ of type Email.                                          |
</code></pre>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SL%</td>
<td>Service Level %. Percentage of contacts handled for each interval. The service level identifies the percentage of calls for the CSQ to be answered within the number of seconds specified by the service level (SL) field and the percentage of email for the CSQ to be processed with the number of hours specified in the Service Level Hours field.</td>
</tr>
<tr>
<td>SL</td>
<td>Service Level. Number of seconds in which calls must be answered for each interval. This field appears only when you choose a CSQ of typeCalls.</td>
</tr>
<tr>
<td>Service Level Hours</td>
<td>Number of hours in which email must be processed for each interval. This field appears only when you choose a CSQ of typeEmail.</td>
</tr>
<tr>
<td>ATT</td>
<td>Average Talk Time. Average time, in seconds, necessary for agents to process calls for each interval. Talk time is elapsed time from when an agent answers a call until the agent disconnects. This includes the time when the agent is actively talking to the caller and the time when the agent places the caller on hold. This field appears only when you choose a CSQ of typeCalls.</td>
</tr>
<tr>
<td>AWT</td>
<td>Average Wrapup Time. Average time required by an agent after a conversation is ended or a response to email is sent, to complete work that is directly associated with the call or email just completed. Does not include time for any activities such as meetings, breaks, or correspondence.</td>
</tr>
<tr>
<td>ACW</td>
<td>After Call Work. The average time required by an agent after a conversation is ended or a response to email is sent, to complete work that is directly associated with the call or email just completed. Does not include time for any activities such as meetings, breaks, or correspondence.</td>
</tr>
</tbody>
</table>
ASA Average Speed of Answer. The average time elapsed in seconds between the time the call was dropped for each interval. The ASA is calculated as the sum of the queue time for calls answered during the interval and divided by the number of calls answered during the interval. If your CSQ Type is Email, the value in this column is zero (0).

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agents Forecasted - Fixed</td>
<td>Enter the number of agents available during this schedule who have a fixed work shift for each interval. See &quot;Fixed Work Shift&quot; on page 43 for more information.</td>
</tr>
<tr>
<td>Agents Scheduled</td>
<td>The number of agents currently scheduled for each interval. After you generate a forecast, the value in this field is zero (0). The value changes when you create a schedule.</td>
</tr>
<tr>
<td>Agent Gap</td>
<td>The gap between the number of agents scheduled and the number of agents forecasted using the following formula:</td>
</tr>
<tr>
<td></td>
<td>Number of agents forecasted - Number of agents scheduled</td>
</tr>
<tr>
<td>Hour Gap</td>
<td>Displays gap, in hours, in the service requirements for each interval. A negative value indicates there are not enough agents to cover the service requirements. A positive value indicates there are more agents covering service requirements than required.</td>
</tr>
<tr>
<td>Occupancy Ratio</td>
<td>Enter the percentage of logged in time that an agent spends in active contact handling states (for example, on incoming calls, in wrap-up activity, on outbound calls).</td>
</tr>
<tr>
<td>Total</td>
<td>Enter the total number of calls or email you expect to receive, the average talking time in the Total field. WFM automatically completes the remaining fields when you click outside the field.</td>
</tr>
</tbody>
</table>

**NOTE:** WFM might change the number you entered to correspond with the calculation.
6. Apply an adjustment factor to a column by completing the following steps.
   a. Choose a column name from the drop-down list below Adjustment Factor.

   b. Enter an adjustment number in the Adjustment Factor field.

      For example, to increase the data in the column by 5%, enter 1.05. To
decrease the data in the column by 12%, enter 0.88.

   c. Click Apply to modify the column data by the specified adjustment factor.

   d. Repeat steps a through c for each column you want to change.

      You can also modify in the Total field and click Recalculate. The data in
the column for each interval will be recalculated according to the value
entered in the Total field. Or enter changes directly into the interval field
for each column.

      The values are updated in applicable fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Received During Business</td>
<td>If you chose a CSQ Type of Email, displays email is</td>
</tr>
<tr>
<td>Hours</td>
<td>handled received during business hours. Your options are:</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>• Linearly: If you choose this option, WFM divides all</td>
</tr>
<tr>
<td></td>
<td>email received during business hours by the number of intervals in the work</td>
</tr>
<tr>
<td></td>
<td>shift to determine the number of email handled during each interval.</td>
</tr>
<tr>
<td></td>
<td>• No Deferring: If you choose this option, agents must handle all email</td>
</tr>
<tr>
<td></td>
<td>received during business hours when they are received.</td>
</tr>
<tr>
<td></td>
<td>• Non-Linearly: If you choose this option, WFM schedules the agents to</td>
</tr>
<tr>
<td></td>
<td>handle by 50% of the email received during the first interval and divides</td>
</tr>
<tr>
<td></td>
<td>the number of email handled for each remaining interval by 50%, until the</td>
</tr>
<tr>
<td></td>
<td>last interval. During the last interval, the agents are expected to</td>
</tr>
<tr>
<td></td>
<td>complete the remaining email.</td>
</tr>
</tbody>
</table>

See "Handling Email Options" on page 73 for more information on these options.
Received Outside of Business Hours

If you chose a CSQ Type of Email, select how you want to handle email received after business hours. Your options are:

- Linearly: If you choose this option, WFM divides all email received after business hours by the number of intervals in the work shift to determine the number of email handled during each interval.
- No Deferring: If you choose this option, agents must handle all email received after business hours during the first interval of the next day.
- Non-Linearly: If you choose this option, WFM schedules the agents to handle by 50% of the email received after business hours during the first interval and divides the number of email handled for each remaining interval by 50%, until the last interval. During the last interval, the agents are expected to complete the remaining email.

See "Handling Email Options" on page 73 for more information on these options.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quality Threshold</td>
<td>Ignore. This field always displays 0.</td>
</tr>
<tr>
<td></td>
<td>This field appears only when you choose a CSQ of type Calls.</td>
</tr>
<tr>
<td>Adjustment Factor</td>
<td>Adjustment factor specified in Forecast Request.</td>
</tr>
<tr>
<td>Call Trend</td>
<td>Year-to-year trend used in call forecast projections.</td>
</tr>
<tr>
<td></td>
<td>This field appears only if you chose a CSQ of type Calls and With Trends when you generated the forecast.</td>
</tr>
<tr>
<td>Email Trend</td>
<td>Year-to-year trend used in email forecast projections.</td>
</tr>
<tr>
<td></td>
<td>This field appears only if you chose a CSQ of type Email and With Trends when you generated the forecast.</td>
</tr>
<tr>
<td>ATT Trend</td>
<td>Average Talk Time Trend. Year-to-year trend in average talk time.</td>
</tr>
<tr>
<td></td>
<td>This field appears only if you chose a CSQ of type Calls and With Trends when you generated the forecast.</td>
</tr>
</tbody>
</table>
7. Optional: To apply a distribution scenario to this forecast, select one from the Select Distribution Scenario drop-down list.

8. Optional: To apply a forecast scenario to this forecast, select one from the Select Forecast Scenario drop-down list.

9. When finished with data modifications, click Recalculate to change the data.

   **NOTE:** Do not press Enter to recalculate values. Pressing Enter displays the calendar.

10. Click Apply in Production to put this forecast into production and make it the forecast used when generating a schedule.

11. Click (Save) to save your changes.

**Displaying a Forecast Graph**

*To display a forecast graph:*

- Click (Graph) next to a column heading to display the data graph.

   **NOTE:** The graph icon only appears when the table has 100 or less rows.
Managing Special Events

You can use the Special Events function to complete the following tasks.

- Create special events. For more information, see "Creating a Special Event" on page 256.
- Edit special events. For more information, see "Editing a Special Event" on page 259.
- Delete special events. For more information, see "Deleting a Special Event" on page 259.

See "Assigning Special Events" on page 261 for additional information on assigning a special event to a CSQ for a specific day or days.

Creating a Special Event

To create a special event:

1. Choose Forecasting > Special Events. The Special Event List appears (Figure 123).

   Figure 123. Special Event List

<table>
<thead>
<tr>
<th>Event</th>
<th>Impact Delay</th>
<th>Impact Duration</th>
<th>Impact Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blizzard</td>
<td>1</td>
<td>1</td>
<td>1.75</td>
</tr>
</tbody>
</table>
2. Click [New] to create a special event. The Special Event Details pane displays event definition options (Figure 124).

Figure 124. Special Event Details: Event Definition tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Name</td>
<td>Name of the event you want to create.</td>
</tr>
<tr>
<td>Impact Delay</td>
<td>Delay, in number of days, between the special event and the impact. This field can be modified later in &quot;Assigning a Special Event&quot; on page 261.</td>
</tr>
<tr>
<td>Impact Delay Notes</td>
<td></td>
</tr>
</tbody>
</table>
| Impact Duration| \[
| Impact Ratio  | |

**NOTE:** You can only specify whole days. Fractional values (for example, .5) are not supported.

For example, the default impact delay for a radio promotion would be 0, because as soon as the broadcast starts, the customers start calling the contact center. The impact delay for a sales brochure mailed to customers could be 2 days, and would start the moment the sales brochures were mailed (launch date) and ends when the customers receive the sales brochures and start calling the contact center.
4. Click  

(Save) to save your changes.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact Duration</td>
<td>Number of days you expect the impact on your contact center will last. This field can be modified later in &quot;Assigning a Special Event&quot; on page 261.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> You can only specify whole days. Fractional (for example, .5) values are not supported.</td>
<td></td>
</tr>
<tr>
<td>Impact Ratio</td>
<td>Percentage factor for the contacts you actually received on the day of the special event. Normal contact volume is forecasted if the event did not occur. If your contact volume:</td>
</tr>
<tr>
<td>• Decreased by 50%, enter 0.50 (for example, you received 75 contacts when you usually receive 100 contacts)</td>
<td></td>
</tr>
<tr>
<td>• Increased by 25%, enter 1.25 (for example, you received 888 contacts when you usually receive 710 contacts)</td>
<td></td>
</tr>
<tr>
<td>• Increase by 25%, enter 1.25</td>
<td></td>
</tr>
<tr>
<td>• Decreased by 12%, enter 0.88 (for example, you received 2158 contacts when you usually receive 2452 contacts)</td>
<td></td>
</tr>
<tr>
<td>This field can be modified later in &quot;Assigning a Special Event&quot; on page 261.</td>
<td></td>
</tr>
<tr>
<td>The ratio is always calculated in the following way: Number of calls received divided by the number of calls usually received.</td>
<td></td>
</tr>
</tbody>
</table>
Editing a Special Event

To edit a special event:

1. Choose Forecasting > Special Events. The Special Event List appears (Figure 125).

![Figure 125. Special Event List](image)

1. From the Special Event List, click an event name. The Special Event Details pane appears (Figure 126).

![Figure 126. Special Event Details: Event Definition tab](image)

2. Complete the fields. The fields are described in "Creating a Special Event" on page 256.

3. Click (Save) to save your changes.

Deleting a Special Event

To delete a special event:

1. Choose Forecasting > Special Events. The Special Event List appears.
2. Select the special event to delete by completing one of the following steps.
   - To delete one or more special events, select the check box next to the special event name.
   - To delete all special events, select the check box in the column header.

3. Click ☒ (Delete). An Internet Explorer dialog box appears.

4. Click OK to confirm the deletion and dismiss the dialog box.
Assigning Special Events

This section covers the following topics.

- Assigning a Special Event (page 261)
- Editing an Assigned Special Event (page 264)
- Deleting an Assigned Special Event (page 265)

Assigning a Special Event

To assign a special event:

1. Choose Forecasting > Assign Events. The Assigned Special Events pane appears (Figure 127).

Figure 127. Assigned Special Events

<table>
<thead>
<tr>
<th>Date</th>
<th>Event</th>
<th>CSU Number</th>
<th>CSU Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>03-29-2007</td>
<td>Power Failure</td>
<td>1</td>
<td>Customer Service</td>
</tr>
<tr>
<td>08-01-2007</td>
<td>Test</td>
<td>11</td>
<td>Tests</td>
</tr>
<tr>
<td>08-16-2007</td>
<td>Blizzard</td>
<td>11</td>
<td>Tests</td>
</tr>
<tr>
<td>08-21-2007</td>
<td>Test</td>
<td>11</td>
<td>Tests</td>
</tr>
<tr>
<td>08-22-2007</td>
<td>Blizzard</td>
<td>11</td>
<td>Tests</td>
</tr>
<tr>
<td>09-22-2007</td>
<td>Blizzard</td>
<td>11</td>
<td>Tests</td>
</tr>
</tbody>
</table>
2. Click ✖ to assign a special event. The Assigned Event List appears (Figure 128).

Figure 128. Assigned Event List

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event</td>
<td>Event name.</td>
</tr>
<tr>
<td>Select CSQ</td>
<td>CSQ or virtual CSQ to which the special event is to apply.</td>
</tr>
<tr>
<td>Date</td>
<td>Date that the event occurred. The effect of a special event can only be applied to a past event. For example, a past event could be a power failure, sudden radio announcement, unexpected promotion, or problems with the telephone service provider. A future event could be a planned promotion, legislative changes, or monthly invoicing.</td>
</tr>
<tr>
<td>Impact Delay</td>
<td>Delay, in number of days, between the time special event occurred and the time the impact was felt. The default value is the value that you specified when you created the special event type. See &quot;Creating a Special Event&quot; on page 256 for more information. NOTE: You can only specify whole days. Fractional values (for example, .5) are not supported.</td>
</tr>
<tr>
<td>Impact Duration</td>
<td></td>
</tr>
<tr>
<td>Impact Ratio</td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td></td>
</tr>
</tbody>
</table>
Assigning Special Events

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact Duration</td>
<td>Number of days you expect the impact on your contact center will last. The default value is the value that you specified when you created a special event. See &quot;Creating a Special Event&quot; on page 256.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> You can only specify whole days. Fractional values (for example, .5) are not supported.</td>
</tr>
<tr>
<td>Impact Ratio</td>
<td>Percentage factor for the contacts you actually received on the day of the special event. Normal contact volume is forecasted if the event did not occur. If your contact volume:</td>
</tr>
<tr>
<td></td>
<td>• Decreased by 50%, enter 0.50 (for example, you received 75 contacts when you usually receive 100 contacts)</td>
</tr>
<tr>
<td></td>
<td>• Increased by 25%, enter 1.25 (for example, you received 888 contacts when you usually receive 710 contacts)</td>
</tr>
<tr>
<td></td>
<td>• Increase by 25%, enter 1.25</td>
</tr>
<tr>
<td></td>
<td>• Decreased by 12%, enter 0.88 (for example, you received 2158 contacts when you usually receive 2452 contacts)</td>
</tr>
<tr>
<td></td>
<td>This field can be modified later in &quot;Assigning a Special Event&quot; on page 261.</td>
</tr>
<tr>
<td></td>
<td>The ratio is always calculated in the following way: <strong>Number of calls received divided by the number of calls usually received.</strong></td>
</tr>
<tr>
<td>Comments</td>
<td>Description of the nature of the special event, if necessary.</td>
</tr>
</tbody>
</table>

4. Click (Save) to save your changes.
Editing an Assigned Special Event

To edit an assigned special event:

1. Choose Forecasting > Assign Events. The Assigned Special Events pane appears (Figure 129).

![Assigned Special Events](image1)

2. Click the date of the event you want to edit. The Assigned Event List appears (Figure 130).

![Assigned Event List](image2)

3. Apply changes to the assigned event.

4. Complete the fields. The fields are described in "Creating a Special Event" on page 256.

5. Click (Save) to save your changes.
Deleting an Assigned Special Event

To delete an assigned special event:

1. Choose Forecasting > Assigned Special Events. The Assigned Special Events pane appears (Figure 131).

Figure 131. Assigned Special Events

<table>
<thead>
<tr>
<th>Date</th>
<th>Event</th>
<th>CSQ Number</th>
<th>CSQ Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>03-29-2007</td>
<td>Power Failure</td>
<td>1</td>
<td>Customer Service</td>
</tr>
<tr>
<td>08-01-2007</td>
<td>Test</td>
<td>1</td>
<td>Customer Service</td>
</tr>
<tr>
<td>08-16-2007</td>
<td>Blizzard</td>
<td>11</td>
<td>Tests</td>
</tr>
<tr>
<td>08-21-2007</td>
<td>Test</td>
<td>11</td>
<td>Tests</td>
</tr>
<tr>
<td>08-22-2007</td>
<td>Blizzard</td>
<td>11</td>
<td>Tests</td>
</tr>
</tbody>
</table>

2. Select the special event assignment to delete by completing one of the following steps.
   - To delete one or more special event assignments, select the check box next to the special event assignment.
   - To delete all special event assignments, select the check box in the column header.

3. Click ✗ (Delete). An Internet Explorer dialog box appears.
4. Click OK to confirm the deletion and dismiss the dialog box.
Managing Firm Dates

Use Forecast > Firm Dates to create, copy or delete firm date associations.

This section covers the following topics.
- Creating and Editing a Firm Date Association (page 266)
- Copying a Firm Date Association (page 267)
- Deleting a Firm Date Association (page 267)

Creating and Editing a Firm Date Association

To create a firm date association:

1. Choose Forecasting > Firm Dates. The Firm Date Association pane appears (Figure 132).

![Figure 132. Firm Date Association](Image)

2. Select a CSQ from the drop-down list on the toolbar.
3. Enter a future date in the Target Date field.

   **NOTE:** This is the future date to which you want to associate with the reference date (for example, the next New Year’s Eve).

4. Enter an historical date in the Reference Date field.

   **NOTE:** This is the date to which you want to associate the target date. For example, the previous New Year’s Eve.

5. Click > to move the target and reference dates to the Associated Dates table.
6. Enter the name of this firm date association in the Description field. This field is required.
7. Click ![Save](Image) to save your changes.
Managing Firm Dates

Copying a Firm Date Association

To copy a firm date association:

1. From the Firm Date Association pane (Figure 133), select a CSQ from the CSQ field on the toolbar. WFM will copy the firm date association from this CSQ.

![Figure 133. Firm Date Association](image)

2. Click to copy the selected firm date association to the clipboard. WFM displays the following message:

   Copy done. Ready to paste.

3. Select a CSQ from the drop-down list on the toolbar.
4. Click to paste the firm date association. WFM copies the firm date association to the selected CSQ and displays the following message:

   Paste done successfully.
5. Click (Save) to save your changes.

Deleting a Firm Date Association

To delete a firm date association:

1. To delete one or more firm date associations from the Firm Date Association pane (Figure 134), select the check box next to each firm date association and click < to delete.

![Figure 134. Firm Date Association](image)
To delete all firm date associations, select the check box in the header (beside Target date) and click < to delete.

2. Click (Save) to save your changes.
Managing Closed Days

You can use the Closed Days function to designate closed days for each CSQ. You can also copy closed days from one CSQ to another CSQ.

This section covers the following topics.

- Updating a CSQ Calendar (page 269)
- Copying Open and Closed Days to another CSQ (page 270)

Updating a CSQ Calendar

Use this procedure to designate the open and closed days for a CSQ in your contact center.

**NOTE:** You must specify open and closed days for each CSQ in your contact center.

If the open and closed days are the same for each CSQ, you can specify the open and closed days for one CSQ and copy your changes to the other CSQs. Follow the procedure described below to specify open and closed days for one CSQ, and then follow the procedure in "Copying Open and Closed Days to another CSQ" on page 270 for the remaining CSQs.

**To update the CSQ calendar:**

1. Choose Forecasting > Closed Days. The CSQ Closed Days pane appears (Figure 135).

   ![Figure 135. CSQ Closed Days](image)

2. Select a CSQ from the CSQ field on the toolbar.
NOTE: The open and closed days are only applied to the selected CSQ.

3. Use the arrow keys to select a year.
4. Click the days you want to open or close in the calendar.
   ■ To close a day, click a day with a white background. The background turns blue to indicate a closed day.
   ■ To open a day, click a day with a blue background. The background turns white to indicate an open day.
5. Click (Save) to save your changes.
6. Repeat steps 2 through 5 for each CSQ in your contact center.

Copying Open and Closed Days to another CSQ

Use this procedure to copy open and closed days from one CSQ to another CSQ. It assumes that you have already saved open and closed days to a CSQ and want to copy those days to another CSQ. The Copy button is disabled if you do not save your changes to open and closed days.

To copy open and closed days to another CSQ:

1. From the CSQ Closed Days pane (Figure 136), click (Copy) to copy the days to the clipboard. WFM displays the following message:
   Copy done. Ready to paste.
2. Select a CSQ from the CSQ field on the toolbar and click (Paste). WFM copies the selected days in the calendar to the selected CSQ and displays the following message:
   Paste done successfully.
3. Click (Save) to save your changes.

Figure 136. CSQ Closed Days
Managing Schedules

Introduction

You can use the Schedules module to complete the following tasks.

- Creating Schedules (page 272)
- Editing Schedules (page 275)
- Displaying Schedules (page 282)

For an explanation of schedules and the scheduling process, see "Understanding Scheduling" on page 84.
Creating Schedules

You can use the Schedule Request function to create a schedule for agents in a CSQ.

This sections covers the following topics.

- Creating a Schedule (page 272)

Creating a Schedule

IMPORTANT: Before you can create a schedule, you must complete several prerequisites. For more information, see "Configuration Requirements for Scheduling an Agent" on page 84.

To create a schedule:

1. Choose Schedules > Schedule Request. The Schedule Production Request pane appears (Figure 137).

2. Select the name of the CSQ from the Select CSQs list. For more information, see "Selecting a CSQ" on page 118.
3. Complete the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automated Work Shift Rotation</strong></td>
<td>Whether WFM automatically rotates the assigned work shifts for all agents from week to week. The first rotation will start on the day specified in the Starting week of field. This check box is selected by default. For best results, this check box should remain selected. <strong>NOTE:</strong> If you clear this box, you must manually rotate the work shifts for each agent. See &quot;Assigning a Work Shift Rotation to an Agent&quot; on page 200 for more information.</td>
</tr>
<tr>
<td><strong>Interpolate Forecasts to 15 Minutes</strong></td>
<td>WFM calculates the number of agents required based on previous and following 15-minute intervals to create a requirements curve. This check box is selected by default. When this check box is selected, WFM assigns the agents where needed in a 30-minute interval. For example, when selected WFM assigns 2 agents to the first 15-minute interval and 3 agents to the second 15-minute interval based on the call center’s requirements. The agents are assigned to the schedule when they are most needed. This is a curve calculation. If you clear the check box, WFM assigns the same number of agent to both 15-minute intervals. For example, 3 agents to the first 15-minute interval and 3 agents to the second 15-minute interval. This is a stairway calculation.</td>
</tr>
<tr>
<td><strong>Start Date</strong></td>
<td>Schedule start date. WFM displays the date for the next Monday or Sunday by default. <strong>NOTE:</strong> Specify the same start date for the forecast date you used when you created the distribution scenario.</td>
</tr>
<tr>
<td><strong>Number of Weeks</strong></td>
<td>Number of weeks for this schedule. WFM displays one week by default. You can enter up to 12 weeks of schedule production. <strong>NOTE:</strong> Running a schedule consumes server resources. Specify the minimum number of weeks necessary to satisfy scheduling needs.</td>
</tr>
</tbody>
</table>
4. Click (Launch Request). WFM launches the schedule production request.

**NOTE:** You can monitor the status of your request on the Server Request List pane. See "Managing Requests to the Server" on page 394 for more information.
Editing Schedules

You can use the Schedule Maintenance pane to complete the following tasks.

- Make last minute changes to an existing schedule
- Maintain the agent’s schedule generated from a CSQ
- Move an agent’s schedule time from one CSQ to another CSQ
- Change the lunch or break time
- Add or delete one or more exceptions

The Schedule Maintenance pane displays a summary of each agent’s schedule for a selected CSQ or team on a specified day.

To optimize agent productivity, schedules must be accurate. The Schedule Maintenance pane allows you to:

- Adjust any schedules (past, current, or future) to help reach a higher percentage of schedule adherence from the agents.
- Know what agents are doing at any time.

This section covers the following topics.

- Editing a Schedule (page 275)
- Editing an Agent’s Schedule (page 278)
- Interpreting the Schedule Maintenance Pane (page 279)
- Interpreting Coverage of Requirements (page 280)

Editing a Schedule

The Schedule Maintenance pane shows the schedule for a selected CSQ or team on a specified day. From this pane, you can complete any of the following tasks:

- View the schedule for a CSQ or team.
- Sort the schedule by last name, sequence, and arrival time.
- View the default colors assigned to each activity. You can change the default colors from the appropriate screens.
- Edit an agent’s schedule by clicking the agent’s name.
- View the coverage of requirements for each interval at the bottom of the pane.

You can modify the status of an activity from the Schedule Maintenance pane. When you initially display a schedule on the Schedule Maintenance pane, the default settings for each activity are shown. For example, the Schedule Maintenance displays
the default settings for exceptions as defined on the Exception Details pane
(Environment > Exception Types).

If you are displaying an MSAQ schedule, the Schedule Maintenance and Schedule
Viewer panes both display all agents who are assigned to the selected CSQ or team,
even if the agents are not scheduled to support the selected CSQ or team on the
displayed date. For more information about the MSAQ feature, see "Understanding
Multi Skill Agent Queuing" on page 53.

To edit a schedule:

1. Choose Schedules > Edit Schedule.
2. Click (Define the Context). The calendar pane appears.
3. Select a date.

   NOTE: Specify one of the days in your forecast production request.

4. Select a CSQ or team. See the following topics for more information:
   - Selecting a CSQ (page 118)
   - Selecting a Team from the Context Pane (page 120)
   - Selecting a CSQ Mapping from the Context Pane (page 121)
5. Click (Define the Context) again to remove the date and CSQ or team list
    from the pane. WFM displays the schedule information for the CSQ, team
    (Figure 138).

Figure 138. Schedule Maintenance

![Schedule Maintenance Diagram]
6. Use these mouse actions to modify the Schedule Maintenance pane.
   - To hide the Navigation pane and expand the information displayed pane, click \( \text{Hide} \) next to Navigation.
   - To change how agents are displayed, select an option from the Sort by drop-down list. Your sort options are Last Name, Sequence, and Arrival Time.
   - If the schedule is produced for a virtual CSQ that contains source CSQ located in different time zones, click \( \text{TimeZone} \) in the toolbar to convert schedule times to time zones associated with the CSQ. Click \( \text{TimeZone} \) again to display the time zone associated with the virtual CSQ. By default, the agents' scheduled times are the same as the CSQ on which they are working.
   - To display the schedule for another day, click \( \text{Previous} \) next to the date in the toolbar to go to the previous day or click \( \text{Next} \) to go to the next day.
   - To view a tooltip that displays the type and length of the activity for an agent, move your cursor over the item.

7. Click an agent’s last name or first name to display the agent’s activities in detail for that day (Figure 139).

8. Choose an interval using one of the following options.
   - To choose multiple contiguous intervals, click the first interval and shift-click the last interval you want from the list.
   - To choose multiple non-contiguous intervals, use the Ctrl key.
   - Choose a start interval and an end interval from the drop-down list in the Activity pane and click Interval Selection. WFM highlights the chosen intervals in the list.

Figure 139. Agent Schedule Detail
9. Choose an activity that you want to apply to the selected intervals.
   
   ■ If you chose In Service, choose a CSQ from the CSQ drop-down list.
   
   ■ If you chose Exception, choose an exception from the Exceptions drop-down list. For example, you can apply an exception for a vacation request to a schedule that is already published.
   
   ■ If you chose Project, choose a project from the Projects drop-down list.
   
   ■ If you chose Assignment, choose a work shift from the Assignment drop-down list.
   
10. Choose one of the following options to indicate pay status for the chosen activity: Paid, Unpaid or Overtime.

11. Choose whether the activity applies to the current day or the previous day.

12. Click (Save) to save your changes.

---

Editing an Agent’s Schedule

**To edit an agent’s schedule:**

1. Click an agent’s first or last name. WFM displays the agent’s activities in detail for that day (Figure 140).

![Figure 140. Agent Activities](image)

2. Select start and end intervals from the interval drop-down lists.

3. Click Interval Select.

4. Choose the activity that you want to apply to the selected intervals.

5. If you choose Exceptions, select the desired exception from the Exceptions drop-down list.

   **NOTE:** You can add only one exception each time you perform this procedure. If you want to add more than one exception, perform the procedure again, once for each additional exception.
6. Select Paid, Unpaid, or Overtime pay status to change the default pay status value for the chosen activity.

The default pay status assigned to each activity is as follows:

- In service: Paid
- Overtime: Paid
- Available: Unpaid
- Break: Paid
- Lunch: Unpaid
- Not Available: Unpaid
- Closed Service: Unpaid
- Assignment: Paid

7. Select whether the activity applies to the current day or the previous day (for night shifts only).

8. Click (Save) to save your changes.

Interpreting the Schedule Maintenance Pane

The following list describes how to interpret the Schedule Maintenance pane.

- To view a tooltip that displays the type and length of the activity for an agent, move your cursor over the item. By default, the activity colors are defined as follows:
  - Teal green indicates in service
  - Bright green indicates overtime
  - Light grey indicates available for scheduling, but not scheduled
  - Yellow indicates on a break
  - Pink indicates lunch
  - Red indicates an exception
  - Dark grey indicates not available for scheduling
  - Purple indicates on assignment
  - Blue indicates working on a project
To modify the default color associated with an activity, you have to go to the appropriate WFM pane. To change the color of:

- In Service, go to the CSQ Details pane (Environment > CSQs)
- Exception, go to the Exception Details pane (Environment > Exception Types)
- Lunch or Break, go to the Work Condition Detail pane (Agents > Work Conditions)

**NOTE:** You can also change the name of the lunch or break from the Work Condition Detail pane (for example, First Break and Second Break) and assign different colors to each break.

To view a tooltip for Coverage of Requirements (bottom part of the pane) move your cursor over the item. The tool tip displays the following information:

- The time associated with the 15-minute segment
- The number before the slash indicates the number of agents scheduled
- The number after the slash indicates the number of agents forecasted.

Since the coverage of requirements is at 15-minute intervals and the schedule display is in 30-minute intervals, the label is divided in two sections. The color codes are defined as follows:

- Red indicates not enough agents are available during the 15-minute interval.
- Blue indicates a surplus of available agents during the 15-minute interval.
- Green indicates the number of agents scheduled is equal to the number of agents forecasted for the 15-minute interval.

**Interpreting Coverage of Requirements**

This topic explains how to interpret the coverage of requirements for a schedule on a specific day from the Schedule Maintenance pane.

The Schedule Maintenance pane displays a Coverage of Requirements bar (Figure 141) at the bottom of the pane. The Coverage of Requirements bar shows the coverage of requirements for each 15-minute interval for the selected CSQ. You can use this information to see exactly how the schedule affects the service level. It shows what your coverage is and updates automatically whenever the schedule is changed.
See "Managing Coverage of Requirements" on page 306 for more information on coverage of requirements.

**Figure 141. Coverage of Requirements bar**

A contact center supervisor can use the Schedule Maintenance pane to quickly update an agent’s schedule on an intraday basis for maximum efficiency.

The Coverage of Requirements bar displays 15-minute intervals and the schedule displays 30-minute intervals. The first 15-minute interval in the Coverage of Requirements bar represents coverage for the first half of the 30-minute interval and second 15-minute interval represents coverage for the second half of the 30-minute interval.

Use the following key to determine the coverage of requirements for each interval.

- Red: Not enough agents available for this interval.
- Blue: Too many agents available for this interval.
- Green: The number of agents scheduled and the number of agents forecasted are equal.

To view a tooltip that displays the coverage information, move your cursor over the interval in the Coverage of Requirements bar. The tooltip displays information in the format HH:MM = xx/yy, where HH:MM is the time in hours and minutes (for example, 09:15), xx is number of agents scheduled, and yy is the number of agents forecasted for each 15-minute interval.

---

May 2010 281
Displaying Schedules

You can use the Schedule Viewer function to display schedules for agents from the same CSQ in summary and detail.

The Schedule Viewer pane displays the following information.

- A schedule summary for an entire week
- The start and end time for each agent for each day of the week
- The total time in service for the week

This section covers the following topics.

- Using the Schedule Viewer (page 282)

Using the Schedule Viewer

If you are displaying an MSAQ schedule, the Schedule Maintenance and Schedule Viewer panes both display all agents who are assigned to the selected CSQ or team, even if the agents are not scheduled to support the selected CSQ or team on the displayed date. For more information about the MSAQ feature, see "Understanding Multi Skill Agent Queuing" on page 53.

To view a schedule:

1. Choose Schedules > Schedule Viewer.
2. Click (Define the Context). The Date Calendar appears.
3. Select a date.

   **NOTE:** Specify one of the days in your forecast production request.

4. Select a CSQ or team. See the following topics for more information:
   - Selecting a CSQ (page 118)
   - Selecting a Team from the Context Pane (page 120)
   - Selecting a CSQ Mapping from the Context Pane (page 121)
5. Click (Define the Context) again to remove the date and CSQ list from the pane. The Schedule Viewer pane appears (Figure 142).

   **NOTE:** The Schedule Viewer pane only displays start and end intervals for paid hours. It does not display unpaid hours, even if the agent is in service and the in service time is unpaid. If an agent is assigned to an unpaid activity all day, the Schedule View pane displays 00:00—00:00.
Displaying Schedules

NOTE: The Time in Service column might not display the correct Time in Service value for overnight work shifts. For example, your work shift starts at 22:00 each day and ends at 06:45, and includes one 30-minute lunch and one 15-minute break for a total of 8 hours in service and 75 minutes or 1.25 hours not in service. If you work 7 days a week, the total time in service column should be 56 hours. However, WFM might add time not in service to the calculation, for a total of 64.25 hours.

Figure 142. Schedule Viewer

6. Use these mouse actions to modify the Schedule Viewer pane.

NOTE: WFM displays schedule details in 15-minute increments, even though you can define the duration of activities in 5-minute intervals. As a result, if you schedule an activity that lasts 40 minutes, WFM will display the activity as two 15-minute intervals.

- To hide the Navigation pane and expand the information displayed pane, click (Hide) next to Navigation.
- If the schedule is produced for a virtual CSQ that contains source CSQs located in different time zones, click in the toolbar to convert schedule times to time zones associated with the CSQs. Click again to display the time zone associated with the virtual CSQ. By default, the agents’ scheduled times are the same as the CSQ on which they are working.
- To display the schedule for another day, click (Previous) next to the date in the toolbar to go to the previous day or click (Next) to go to the next day.
- To sort the table by the agent’s last name (or first name), click Name (or FirstName) in the column header. Click again to reverse the sort order.
- To sort the table by work shift time, click the date (for example, 07-27-2008) in the column header. Click again to reverse the sort order.
To view the schedule for a specific day of the week (for example, Tuesday), click the day in the column header. The Schedule viewer displays the schedule for the selected day. To return to the weekly schedule, click (Previous) next in the toolbar (Figure 143).

Figure 143. Schedule Viewer

To view an agent’s details, click the agent’s first name or last name. To return to the weekly schedule, click (Previous) next in the toolbar.
To view an agent’s detailed schedule (including paid and unpaid time), click the start-end time (for example, 09:00—17:20) below one of the day columns to display the agent’s activities in detail. The Schedule Details pane appears (Figure 144). To return to the weekly schedule, click (Previous) next in the toolbar.

Figure 144. Schedule Viewer

<table>
<thead>
<tr>
<th>Detail</th>
<th>Date</th>
<th>Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00 - 09:00 = Not Available</td>
<td>2007-09-05</td>
<td>1</td>
</tr>
<tr>
<td>09:00 - 10:15 = In service</td>
<td>2007-09-05</td>
<td>1</td>
</tr>
<tr>
<td>10:15 - 10:30 = Break</td>
<td>2007-09-05</td>
<td>1</td>
</tr>
<tr>
<td>10:30 - 12:00 = In service</td>
<td>2007-09-05</td>
<td>1</td>
</tr>
<tr>
<td>12:00 - 12:30 = Lunch</td>
<td>2007-09-05</td>
<td>1</td>
</tr>
<tr>
<td>12:30 - 15:00 = In service</td>
<td>2007-09-05</td>
<td>1</td>
</tr>
<tr>
<td>15:00 - 15:15 = Break</td>
<td>2007-09-05</td>
<td>1</td>
</tr>
<tr>
<td>15:15 - 17:20 = In service</td>
<td>2007-09-05</td>
<td>1</td>
</tr>
<tr>
<td>17:20 - 23:59 = Not Available</td>
<td>2007-09-05</td>
<td>1</td>
</tr>
</tbody>
</table>

In service: 7hrs
Overtime: 0hrs
Available: 0hrs
Break: 0.5hrs
Lunch: 0.86hrs
Exception: 0hrs
Assignment: 0hrs
Project: 0hrs
Not Available: 15.67hrs
Paid/Unpaid: 7.5 / 16.5hrs
Managing Intraday Functions

Introduction

After you have produced a schedule, you can use the Intraday module to complete the following tasks.

- Review schedules and set times for activities, such as meetings, training, and administrative activities, which take agents away from handling calls. For more information, see "Post-Production Planning" on page 288.
- Review contact statistics and productivity data. For more information, see "Contact Statistics and Productivity Data" on page 293.
- Review current performance measurements. For more information, see "Displaying Supervisor Data Views" on page 304.
- Review scheduled agent coverage for each CSQ. For more information, see "Managing Coverage of Requirements" on page 306.
- Trade agent schedules by swapping one agent’s schedule for a day with that of another agent’s schedule. For more information, see "Managing Schedule Trades" on page 310.
- Monitor your agents’ adherence to their schedules. For more information, see "Managing Adherence" on page 315.
- Receive and act on shift trades, open shift requests, and exception requests from agents in your team(s). For more information, see "Managing Your Inbox" on page 323.
Post-Production Planning

Post-production planning refers to the process of scheduling agents for non-service activities, such as meetings or training, after a schedule has been generated (post-production). You can use the Post-Production Activity Planning pane to find times when you can schedule agents for activities so that the service level is least affected.

You can use the Post-Production function to complete the following tasks.

- Look for all of the possible intervals during which agents are available for a non-service activity. For more information, see "Planning Non-Service Activities" on page 288.

- Determine the best time to schedule a non-service activity so that it has the least impact on the service level objective of the CSQ. For more information, see "Interpreting the Analysis Results Table" on page 291.

- Schedule the non-service activity by assigning an exception to the agents involved. For more information, see "Assigning a Post-Production Exception" on page 291.

Planning Non-Service Activities

To plan non-service activities:

1. Choose Intraday > Post-Production. The Select Interval tab of the Post-Production Activity Planning pane appears (Figure 145).

Figure 145. Post-Production Activity Planning: Select Interval tab
2. Select a CSQ from the drop-down list in the toolbar.
3. Complete the fields as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Date, End Date</td>
<td>The first and last day the planned activity can occur. <strong>NOTE:</strong> A schedule must already exist for this period.</td>
</tr>
<tr>
<td>Start Time, End Time</td>
<td>The earliest time the planned activity can start and the latest time the planned activity can end.</td>
</tr>
<tr>
<td>Exception Length</td>
<td>The duration of the exception in minutes. The duration of the exception can cover several consecutive intervals. For example, you can search for a 30-minute time slot with 4 agents available between Monday and Friday, from 08:00 to 14:00. When you specify an value in the Exception Length field, WFM will interpolate the value in the Forecasted field for the duration of exception specified in this field. The value in the Forecasted field on the Post-Production Activity Planning pane only matches the value in the Forecasted field on Coverage of Requirements pane when the value in the Exception Length field matches the interval for the schedule.</td>
</tr>
<tr>
<td>Number of Agents</td>
<td>The number of agents to whom you want to assign the activity. <strong>NOTE:</strong> If you enter zero (0) in this field, WFM displays the maximum number of agents available for this planned activity without affecting the coverage requirements.</td>
</tr>
</tbody>
</table>
4. Click Analyze to display the best period to apply the activity. The Analysis Results table appears (Figure 146). The table is described below.

- To sort the table by a column, click the column header.
- To display a graph of the data, click (Graph) next to a column header.
- The graph icon appears only when the table has 100 or fewer rows.

Figure 146. Post Production Planning: Analysis Results table

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Date at the beginning of the schedule interval.</td>
</tr>
<tr>
<td>Start</td>
<td>Time at the beginning of the schedule interval.</td>
</tr>
<tr>
<td>End</td>
<td>Time at the end of the schedule interval.</td>
</tr>
<tr>
<td>Forecast</td>
<td>Number of agents required for the schedule interval.</td>
</tr>
<tr>
<td>Scheduled</td>
<td>Number of agents scheduled for this schedule interval.</td>
</tr>
<tr>
<td>Gap</td>
<td>Gap between the number of agents scheduled and the number of agents forecasted. Calculated using the following formula: (Scheduled – Forecasted)</td>
</tr>
</tbody>
</table>

Data Description

- **Date**: Date at the beginning of the schedule interval.
- **Start**: Time at the beginning of the schedule interval.
- **End**: Time at the end of the schedule interval.
- **Forecast**: Number of agents required for the schedule interval.
- **Scheduled**: Number of agents scheduled for this schedule interval.
- **Gap**: Gap between the number of agents scheduled and the number of agents forecasted. Calculated using the following formula: (Scheduled – Forecasted)
Interpreting the Analysis Results Table

This topic explains how to interpret the results displayed in the Analysis Results table on the Post-Production Activity Planning pane.

After you click Analyze, the Analysis Results table is populated. To determine the least disruptive time for a planned activity, look at the Gap column. The Gap column displays the difference, in number of agents, between the forecasted requirements and scheduled agents. You can use the gap to determine the number of agents who are available for the planned activity without affecting the coverage requirements.

A positive gap means that the number of agents scheduled exceeds the forecasted requirements. If the Analysis Results table includes intervals with positive gaps, you can use these intervals for exceptions, assignments, or projects. For example, if the interval from 10:30 to 11:00 has a gap of 4.0, you can schedule a 30-minute meeting with 4 agents during that time.

A negative gap means that the number of agents scheduled is less than the forecasted requirements. If the Analysis Results table includes intervals with negative gaps, you should find agents to fill those gaps.

Assigning a Post-Production Exception

This topic explains how to use the Post-Production Activity Planning pane to assign an exception after a schedule has been produced. For information about assigning exceptions before a schedule has been produced, see "Assigning a Pre-Production Exception" on page 208.

To assign a post-production exception:

1. From the Post-Production Activity Planning pane, click a start time in the Analysis Results table (Figure 146). A new tab, Select an Exception, appears behind the current tab, Select Interval.

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ratio</td>
<td>Percentage of the coverage during the interval. The value is expressed in decimal format. For example, if you plan a one hour meeting that contains four 15-minute intervals and you are overstaffed for three of these intervals and short staffed for one of these intervals, you are covered for 75% (0.75) of the meeting.</td>
</tr>
<tr>
<td>Service Level</td>
<td>Percentage of contacts forecasted to be answered for each interval within the service level objective based on the scheduled staffing level.</td>
</tr>
</tbody>
</table>
2. Click the Select an Exception tab. The tab appears (Figure 147).

Figure 147.  Post-Production Activity Planning: Select an Exception tab

3. Optional: Filter the list of agents by choosing a team or CSQ mapping. To display all agents, click All (below the agent list).

4. Select one or more agents to whom you want to assign the exception. To select multiple agents, use the Ctrl key.

5. Click Validate to ensure the selected agents are scheduled for the selected CSQ mapping for that day and interval. A list of available agents appears.

   NOTE: If you select agents who are not scheduled for that day, time, or CSQ, they will not appear in the table at the bottom of the pane.

6. Select the exception that you want to assign to the agents from the Select an Exception drop-down list.

7. Click Schedule the Exception to assign the exception to the selected agents. WFM adds the exception to the schedule.
Contact Statistics and Productivity Data

Every 30 minutes, the Capture service collects contact data for the day so far from the ACD. This contact data is displayed on the Supervisor Dashboard pane in graphical and tabular form.

You can use the Dashboard function to complete the following tasks.

- Display contact statistics and productivity data for a CSQ. For more information, see "Displaying Contact Statistics and Productivity Data" on page 293.

- Interpret contact statistics and productivity data for a CSQ. For more information, see one of the following topics.
  - Interpreting Numerical Data in the Left Pane (page 295)
  - Interpreting Graphical Data in the Middle Pane (page 297)
  - Interpreting Statistical Data in the Right Pane (page 298)

Displaying Contact Statistics and Productivity Data

NOTE: You can customize the data that appears in the Supervisor Dashboard pane. For more information, see "Customizing Dashboards" on page 114.

To display contact statistics and productivity data:

1. Choose Intraday > Dashboard. The Supervisor Dashboard pane appears. By default, the Supervisor Dashboard pane displays data for the current date.
2. Select a CSQ from the toolbar. The Supervisor Dashboard pane displays the selected information (Figure 148).

Figure 148. Supervisor Dashboard

3. Complete any of the following steps if needed.
   - To sort the table by a column, click the column header.
   - To refresh the data, choose Intraday > Dashboard.
   - To display data for another CSQ, select the CSQ from the drop-down list on the toolbar.
   - To display data for another date, click (Define the Context) in the toolbar, then click a date in the calendar in the context pane.
   - To display a graph associated with a column header, click (Graph) next to the column header. A new browser window appears and displays the selected data in graph form.

   NOTE: The graph icon only appears if the table has 100 or less rows.
Interpreting Numerical Data in the Left Pane

Table 4 describes the numerical data that is displayed in the left pane of the Supervisor Dashboard. All data is for the selected CSQ for the selected day, unless stated otherwise.

Table 4. Numerical display options

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Calls Forecasted</td>
<td>Calls forecasted for the day.</td>
</tr>
<tr>
<td>Total Calls Projected</td>
<td>Total calls projected for the day based on the current trend. Calculated</td>
</tr>
<tr>
<td></td>
<td>using the following formula:</td>
</tr>
<tr>
<td></td>
<td>[ Fd \times \left( \frac{Op}{Fp} \right) ]</td>
</tr>
<tr>
<td></td>
<td>where:</td>
</tr>
<tr>
<td></td>
<td>• ( Fd ) = Forecast calls for the day</td>
</tr>
<tr>
<td></td>
<td>• ( Op ) = Offered calls for all intervals completed so far</td>
</tr>
<tr>
<td></td>
<td>• ( Fp ) = Forecast calls for all intervals completed so far</td>
</tr>
<tr>
<td>Current Calls Forecasted</td>
<td>Calls forecasted for the day so far (for all of the intervals from</td>
</tr>
<tr>
<td></td>
<td>midnight to the last complete interval).</td>
</tr>
<tr>
<td>Current Calls Answered</td>
<td>Percentage of calls that agents answered for the day so far. Calculated</td>
</tr>
<tr>
<td></td>
<td>using the following formula:</td>
</tr>
<tr>
<td></td>
<td>[(H \div A) \times 100]</td>
</tr>
<tr>
<td></td>
<td>where:</td>
</tr>
<tr>
<td></td>
<td>• ( H ) = Handled calls so far (calls answered by agents)</td>
</tr>
<tr>
<td></td>
<td>• ( A ) = Actual calls so far (includes abandoned calls)</td>
</tr>
<tr>
<td>Current Calls Actual</td>
<td>Calls answered by agents for all intervals so far (for all of the</td>
</tr>
<tr>
<td></td>
<td>intervals from midnight to the last complete interval).</td>
</tr>
<tr>
<td>Service Level Forecasted</td>
<td>Percentage of calls forecasted to be answered for each interval within the</td>
</tr>
<tr>
<td></td>
<td>service threshold time.</td>
</tr>
<tr>
<td>Service Level Actual</td>
<td>Percentage of actual calls answered for each interval within the service</td>
</tr>
<tr>
<td></td>
<td>threshold time.</td>
</tr>
</tbody>
</table>
### Table 4. Numerical display options (cont’d)

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
</table>
| Occupancy Ratio      | Forecasted percentage of time that agents spend in active call handling states versus total time in service. Active call handling states include talking on incoming calls, engaged in wrap-up activity, and making outbound calls. Calculated using the following formula:  
\[(T_f + W_f) ÷ L_f\]  
where:  
- \(T_f\) = Talk time forecasted  
- \(W_f\) = Work time forecasted  
- \(L_f\) = Login time forecasted |
| Actual               | Actual percentage of logged in time that agents spend in active call handling states versus their total time in service. Active call handling states include talking on incoming calls, engaged in wrap-up activity, and making outbound calls. Calculated using the following formula:  
\[(L_a + R_a) ÷ L_a\]  
where:  
- \(L_a\) = Login time actual  
- \(R_a\) = Ready time actual |
| ASA                  | Average Speed of Answer Forecasted. Forecasted average time elapsed in seconds, between the time the call was dropped out of the IVR (after menu selections) and the time an agent answers. |
| Actual               | Average Speed of Answer Real. Calculated using the following formula:  
\[Q ÷ A\]  
where:  
- \(Q\) = Queue time for calls answered by agents  
- \(A\) = Calls answered by agents |
Interpreting Graphical Data in the Middle Pane

Table 5 describes the data that you can display graphically in the middle pane of the Supervisor Dashboard. For instructions about how to choose data to display, see "Customizing Dashboards" on page 114. Each graph displays data by specified intervals from the following perspectives:

- Forecasted: The forecasted value for the CSQ yields
- Projected: The projected value for the CSQ yields based on the current trend
- Actual: The actual results

Table 5. Graphical display options

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calls</td>
<td>The forecasted, projected, or actual number of calls for each schedule interval.</td>
</tr>
<tr>
<td>Agents</td>
<td>The forecasted, projected, or actual number of agents for each schedule interval.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Agents are counted as actual agents only when they are scheduled and not in the Not Ready state.</td>
</tr>
<tr>
<td>Service Level</td>
<td>The forecasted, projected, or actual percentage of contacts answered for each interval within the service threshold time.</td>
</tr>
</tbody>
</table>
| Occupancy Ratio    | The forecasted, projected, or actual percentage of logged in time that agents spend in active contact handling states versus their total time in session. Active call handling states include talking on incoming calls, engaged in wrap-up activity, and making outbound calls. Calculated using the following formula: 
  \[(L - R) \div L\]  
  where: 
  - \(L\) = Logged in time  
  - \(R\) = Ready time |
| Average Speed of Answer | The forecasted, projected, or actual average speed of answer. The same as the average queue time. |
| Average Talk Time  | The forecasted, projected, or actual time, in seconds, necessary for agents to process calls. Talk time is elapsed time from when an agent answers a call until the agent disconnects. This includes the time when the agent is actively talking to the caller and the time when the agent places the caller on hold. |
Interpreting Statistical Data in the Right Pane

Table 6 describes the statistical data you can display in the right pane of the Supervisor Dashboard. For instructions about how to customize the statistics view, see "Customizing Dashboards" on page 114. All fields apply to the CSQ for the specified interval. The third column provides the name of the statistics view that contains the listed data.

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
<th>Where Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interval</td>
<td>Start time for a specific interval.</td>
<td>All options</td>
</tr>
<tr>
<td>Coeff</td>
<td>Ratio applied to Calls. Expressed in decimal format.</td>
<td>View: All Data</td>
</tr>
<tr>
<td>Target %</td>
<td>Service level percentage of calls to be answered within the time specified in Target Sec.</td>
<td>Results x CSQ: Agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Results x CSQ: Calls</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: Agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: All Data</td>
</tr>
<tr>
<td>Target Sec</td>
<td>Service level time in seconds within which Target % of calls should be answered.</td>
<td>View: Agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: All Data</td>
</tr>
<tr>
<td>Calls Forec</td>
<td>Forecasted calls.</td>
<td>Results x CSQ: Calls</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: All Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: Calls</td>
</tr>
<tr>
<td>Calls Real</td>
<td>Total actual calls. Calculated using the following formula: A + B</td>
<td>View: All Data</td>
</tr>
<tr>
<td></td>
<td>where:</td>
<td>View: Calls</td>
</tr>
<tr>
<td></td>
<td>• A = Answered calls</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• B = Abandoned calls</td>
<td></td>
</tr>
<tr>
<td>Calls Projected</td>
<td>Total calls expected. This is a trend calculation based on the current trend of real and forecasted calls.</td>
<td>Results x CSQ: Agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: Agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: All Data</td>
</tr>
</tbody>
</table>
### Table 6. Statistical display options (cont’d)

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
<th>Where Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agents Forecasted</td>
<td>Forecasted agents required.</td>
<td>Results x CSQ: Agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: Agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: All Data</td>
</tr>
<tr>
<td>Agents Real</td>
<td>Actual full-time equivalent agents. Calculated using the following formula:</td>
<td>Results x CSQ: Agents</td>
</tr>
<tr>
<td></td>
<td>L ÷ 1800 where: L = Agent’s login time</td>
<td>View: Agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: All Data</td>
</tr>
<tr>
<td>Agents Projected</td>
<td>Total agents required. This is a trend calculation based on the current trend of real and forecasted agents.</td>
<td>Results x CSQ: Agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: Agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: All Data</td>
</tr>
<tr>
<td>Agents Scheduled</td>
<td>Agents scheduled.</td>
<td>Results x CSQ: Agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: Agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: All Data</td>
</tr>
<tr>
<td>ASA Forecasted</td>
<td>Average Speed of Answer Forecasted. Forecasted average time elapsed in seconds between the time the call was dropped out of the IVR (after menu selections) and the time an agent answers.</td>
<td>View: All Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: ASA</td>
</tr>
<tr>
<td>ASA Actual</td>
<td>Average Speed of Answer Actual. Calculated using the following formula:</td>
<td>Results x CSQ: Agents</td>
</tr>
<tr>
<td></td>
<td>Q ÷ A where: Q = Queue time for answered calls and A = Answered calls</td>
<td>View: All Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: ASA</td>
</tr>
<tr>
<td>Data</td>
<td>Description</td>
<td>Where Used</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>ATT Forecasted</td>
<td>Average Talk Time Forecasted. Forecasted time in seconds necessary for agents to process calls, which is all time from the moment the agent answers a call to the moment the agent ends the call. Includes time during which the caller is either actively talking to the agent or on hold. Appears only for a CSQ of type Calls.</td>
<td>View: All Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: ATT</td>
</tr>
<tr>
<td>ATT Actual</td>
<td>Average Talk Time Actual. Average time in seconds necessary for agents to process calls for each interval, which is all time from the moment the agent answers a call to the moment the agent ends the call. Includes time during which the caller is either actively talking to the agent or on hold. Appears only for a CSQ of type Calls.</td>
<td>View: All Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: ATT</td>
</tr>
<tr>
<td>Occupancy</td>
<td>Forecasted percentage of logged in time that an agent spends in active contact handling states (for example, on incoming calls, in wrap-up activity, on outbound calls).</td>
<td>Results x CSQ: Agents</td>
</tr>
<tr>
<td>Forecasted</td>
<td></td>
<td>View: All Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: Occupancy</td>
</tr>
<tr>
<td>ACW Forecasted</td>
<td>After Call Work Forecasted. Forecasted average seconds per call necessary for agents to complete after call work.</td>
<td>Results x CSQ: Agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: All Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: Calls</td>
</tr>
<tr>
<td>Data</td>
<td>Description</td>
<td>Where Used</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>ACW Actual</td>
<td>After Call Work Actual. Real average time in seconds per call necessary for agents to complete after call work. Calculated using the following formula: ( W \div A ) where: • ( W ) = Work time • ( A ) = Answered calls</td>
<td>Results x CSQ: Agents View: All Data View: Calls</td>
</tr>
<tr>
<td>Abandon Real</td>
<td>Actual contacts for which the caller terminates the contact while in queue. Ringing time is included in queue time.</td>
<td>Results x CSQ: Calls View: All Data</td>
</tr>
<tr>
<td>Calls Handled</td>
<td>Calls answered by agents.</td>
<td>Results x CSQ: Calls View: All Data</td>
</tr>
<tr>
<td>Time in Service</td>
<td>Total time, in hours, that agents are in session (logged in).</td>
<td>View: All Data</td>
</tr>
<tr>
<td>SL Real</td>
<td>Service Level Real. Actual speed of answer attained. Calculated using the following formula: ( \frac{(B_{sl} + A_{sl})}{(B_t + A_t)} ) where: • ( B_{sl} ) = Calls abandoned before service level threshold • ( A_{sl} ) = Calls answered within service level threshold • ( B_t ) = Total abandoned calls • ( A_t ) = Total answered calls</td>
<td>Results x CSQ: Calls View: All Data View: Calls</td>
</tr>
<tr>
<td>Data</td>
<td>Description</td>
<td>Where Used</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>Waiting Time</td>
<td>Total time in the ready state.</td>
<td>View: All Data</td>
</tr>
<tr>
<td>Calls Answered %</td>
<td>Percentage of calls answered. Calculated using the following formula:</td>
<td>Results x CSQ: Calls</td>
</tr>
<tr>
<td></td>
<td>A ÷ (A + B)</td>
<td>View: All Data</td>
</tr>
<tr>
<td></td>
<td>where:</td>
<td>View: Calls</td>
</tr>
<tr>
<td></td>
<td>• A = Answered calls</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• B = Abandoned calls</td>
<td></td>
</tr>
<tr>
<td>Occupancy Actual</td>
<td>Actual percentage of time that agents spend in active contact handling states (for example, on incoming calls, in wrap-up activity, on outbound calls).</td>
<td>Results x CSQ: Calls</td>
</tr>
<tr>
<td></td>
<td>View: All Data</td>
<td>View: Occupancy</td>
</tr>
<tr>
<td>Precision %</td>
<td>Gap as a percentage between forecasted and actual calls. Calculated using the following formula:</td>
<td>View: All Data</td>
</tr>
<tr>
<td></td>
<td>(F ÷ R) × 100</td>
<td></td>
</tr>
<tr>
<td></td>
<td>where</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• F = Forecasted calls</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• R = Received calls</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Value results from Forecast Precision Level calculation, which is completed when you compile historical data. For more information, see &quot;Compiling Historical Data&quot; on page 356.</td>
<td></td>
</tr>
</tbody>
</table>
### Contact Statistics and Productivity Data

#### Table 6: Statistical display options (cont’d)

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
<th>Where Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gap in Service x Projected</td>
<td>Gap between agents in service and agents projected. Calculated using the following formula: ( A_s - A_p ) where: ( A_s = ) Agents in service ( A_p = ) Agents projected</td>
<td>Results x CSQ: Calls</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: All Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: Agents</td>
</tr>
<tr>
<td>Gap Forecasted x Projected</td>
<td>Gap between agents projected and agents forecasted. Calculated using the following formula: ( A_f - A_p ) where: ( A_f = ) Agents forecasted ( A_p = ) Agents projected</td>
<td>Results x CSQ: Calls</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: Agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: All Data</td>
</tr>
<tr>
<td>Gap Scheduled x Projected</td>
<td>Gap between agents scheduled and agents projected. Calculated using the following formula: ( A_s - A_p ) where: ( A_s = ) Agents scheduled ( A_p = ) Agents projected</td>
<td>Results x CSQ: Calls</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: Agents</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: All Data</td>
</tr>
<tr>
<td>SL FC</td>
<td>Service Level Forecasted. Forecasted speed of answer within the service level target time.</td>
<td>View: All Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td>View: Service Level</td>
</tr>
</tbody>
</table>

*Note: The table continues on the next page.*
Displaying Supervisor Data Views

Every 30 minutes, the Capture service collects contact data from the ACD. This contact data is displayed in a table on the Supervisor pane.

You can use the Supervisor function to display the following data views. For information about the fields displayed in the data views, see "Displaying Contact Statistics and Productivity Data" on page 293. For instructions about how to display one of these views, see "Displaying a Supervisor Data View" on page 304.

- Results x CSQ Mapping
- Results x CSQ: Agents
- Results x CSQ: Calls
- Results x Team
- View: ASA
- View: ATT
- View: Agents
- View: All data
- View: Calls
- View: Occupancy
- View: Service Level

Displaying a Supervisor Data View

**NOTE:** You can change the default data view that appears on the Supervisor pane. For more information, see "Customizing Dashboards" on page 114.

**To display a supervisor data view:**

1. Choose Intraday > Supervisor. The Supervisor pane appears. By default, it displays the Results x CSQ: Agents data view for the current date.
2. Select a CSQ from the toolbar (Figure 149).

Figure 149. Supervisor

![Supervisor Data Views](image)

3. Complete any of the following steps as needed.
   - To display the data as a report, click Get Report: Full. A new browser window appears and displays the report.
   - To sort the table by a column, click the column header.
   - To display a different set of data, select a data view from the drop-down list. The Supervisor pane displays the selected information.
   - To refresh the data, choose Intraday > Supervisor.
   - To display data for another CSQ, select the CSQ from the drop-down list on the toolbar.
   - To display data for another date, click (Define the Context) in the toolbar, then click a date in the calendar in the context pane.
   - To display a graph associated with a column header, click (Graph) next to the column header. A new browser window appears and displays the selected data in graph form.

**NOTE:** The graph icon only appears if the table has 100 or less rows.
Managing Coverage of Requirements

The Coverage of Requirements pane displays the coverage requirements and service level for the selected CSQ in 15-minute intervals. The Coverage of Requirement pane displays the following information:

- The daily service level objective for the CSQ
- The anticipated daily service level average per CSQ
- The anticipated service level per interval per CSQ

You can use the Coverage of Requirements pane to see how WFM predicts the CSQ will do for each day and interval. It shows you if your forecast is accurate when compared to the production schedule. For instructions, see "Displaying Coverage of Requirements" on page 307.

You can also use this screen to edit the schedule to improve the overall service level objective. (For example, by rescheduling an agent's break to occur 15 or 30 minutes later to resolve a staffing issue.) It is especially useful when you need to correct a situation where there are not enough agents to meet the service level objective. This schedule flexibility can make a big difference when maintaining the daily service level objective.

This section covers the following topics.

- Interval Display Options (page 306)

Interval Display Options

The interval table displays the following information:

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interval</td>
<td>The start time for a schedule interval.</td>
</tr>
<tr>
<td>Forecasted Agents</td>
<td>The number of agents forecasted per interval.</td>
</tr>
<tr>
<td>Scheduled Agents</td>
<td>The number of agents scheduled to be in service per interval.</td>
</tr>
<tr>
<td>Agents Gap</td>
<td>The gap between the number of agents scheduled and the number of agents forecasted using the following formula:</td>
</tr>
<tr>
<td></td>
<td>Number of agents forecasted – Number of agents scheduled</td>
</tr>
<tr>
<td>Service Level</td>
<td>The expected percentage of calls answered within the service level objective for the CSQ per the schedule interval, based on the scheduled staffing level and forecasted call volume.</td>
</tr>
</tbody>
</table>
Displaying Coverage of Requirements

To display coverage of requirements:

1. Choose Intraday > Coverage. The Coverage of Requirements pane appears. By default, the pane has no CSQ selected and displays no data (Figure 150).

Figure 150. Coverage of Requirements

2. Select the CSQ type from the CSQ Type drop-down list. Your options are:
   - Calls
   - Email

3. Select one or more CSQ from the Select CSQs list. If you select multiple CSQs, the coverage results display the totals for the selected CSQs.

4. Enter the date for which you want to display the coverage of requirements.
5. Click Calculate Coverage. The pane displays data for the selected date and CSQ (Figure 151).

Figure 151. Coverage of Requirements: After calculating coverage

Interpreting the Coverage of Requirements

The Coverage of Requirements pane displays three color-coded tables. Each table displays 8 hours’ worth of interval data. The first table displays the intervals from 00:00 to 08:00, the second displays the intervals from 08:00 to 16:00, and the third displays the intervals from 16:00 to 24:00.

Each table has five columns; the fourth and fifth columns are color-coded to aid in interpretation. The first column in each table lists the interval. The second, third, and fourth columns in each table represent the coverage of requirements, which consists of three numbers: the forecasted agents, the scheduled agents, and the gap between the two numbers. The fifth column in each table lists the service level.

Table 7 describes the colors applied to the fourth column, Agents Gap.

Table 7. Agent Gap color key

<table>
<thead>
<tr>
<th>Color</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>No gap</td>
</tr>
</tbody>
</table>
Table 7. Agent Gap color key (cont'd)

<table>
<thead>
<tr>
<th>Color</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Shortage of agents</td>
</tr>
<tr>
<td>Blue</td>
<td>Surplus agents scheduled</td>
</tr>
</tbody>
</table>

Table 8 lists the meaning of the colors applied the fifth column, Service Level.

Table 8. Service Level color key

<table>
<thead>
<tr>
<th>Color</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>Service level for the interval is greater than the service level objective (displayed above the interval table).</td>
</tr>
<tr>
<td>Green</td>
<td>Service level for the interval is equal to the service level objective (displayed above the interval table).</td>
</tr>
<tr>
<td>Light red</td>
<td>Service level for the interval is less than the service level objective (displayed above the interval table).</td>
</tr>
<tr>
<td>Dark red</td>
<td>Service level is less than the objective and less than the anticipated service level for the day (displayed above the interval table).</td>
</tr>
</tbody>
</table>
Managing Schedule Trades

This function allows the user to perform the following types of transactions:

- A schedule trade between agents for the same date
- A schedule trade between agents for two different days
- Copy one or more periods from an agent’s schedule to one or more agents’ schedules for one or many dates.

This section covers the following topics.

- Trading Schedules on the Same Day (page 310)
- Trading Schedules for Different Days (page 311)
- Copy Selected Intervals to Other Agents (page 312)

Trading Schedules on the Same Day

Use this procedure to swap one or more days between agents. Both agents must be scheduled to work on the days you choose. You can swap one or more consecutive days as long as you specify the same start and end dates for the source agent and the destination agent. For example, you swap the source agent’s Monday morning work shift with the destination agent’s Monday afternoon work shift.

**To trade schedules on the same day:**

1. Choose Intraday > Schedule Trade. The Schedule Trade pane appears (Figure 152). The Schedule Trade (Same Day) option is selected by default.

2. If desired, filter the list of source agents by team, CSQ mapping, or All (below the Source Agent list).
3. Select the source agent from the Source Agent list.
4. Select a date in the Start Date and End Date fields.
5. Click Get Schedule for the source agent. The schedule for the source agent appears.
6. If desired, filter the list of destination agents by team, CSQ mapping, or All (below the Destination Agent list).
7. Select one agent from the Destination Agent list.
8. Select a date in the Start Date and End Date fields.
9. Click Get Schedule for the destination agent. The schedule for the destination agent appears.
10. Review the schedule and click ✔️ to finish this trade. WFM automatically updates the agents’ schedules.

Trading Schedules for Different Days

Use this procedure to swap a day off or holiday between agents. You can swap one or more consecutive working days for days off or holidays as long as you specify different dates. Essentially, you are swapping one set of dates with a different set of dates. For example, you can swap one agent’s day off, which is Monday, with another agent’s day off, which is Friday.

**NOTE:** To use this procedure, you must be trading each agent’s day off with the other agent’s work shift. When you trade working days, WFM trades the days off automatically. For example, consider two agents, Agent A and Agent B. Agent A works Monday and does not work on Wednesday. Agent B works Wednesday and does not work Monday. If you trade their work shifts, Agent A now works Wednesday and does not work on Monday, and Agent B works Monday and does not work on Wednesday.
To trade schedules for different days:

1. Choose Intraday > Schedule Trade. The Schedule Trade pane appears (Figure 152).

2. Choose Schedule Trade (Different Days).

3. If desired, filter the list of source agents by team, CSQ mapping, or All (below the Source Agent list).

4. Select the source agent from the Source Agent list.

5. Select a date in the Start Date and End Date fields.

6. Click Get Schedule for the source agent. The schedule for the source agent appears.

7. If desired, filter the list of destination agents by team, CSQ mapping, or All (below the Destination Agent list).

8. Select one agent from the Destination Agent list.

9. Select start and end dates.

10. Click Get Schedule for the destination agent. The schedule for the destination agent appears.

11. Review the schedule and click to finish this trade. WFM automatically updates the agents’ schedules.

Copy Selected Intervals to Other Agents

Use this procedure to copy intervals in an agent’s work shift for a specified day to one or more agent’s work shifts for one or more specified days. For example, you can copy a meeting from 08:00 to 10:00 from one agent’s schedule to the schedules for several agents. One situation in which this procedure is useful is when you need to
add an agent who was not active when the schedule was produced. The Copy Selected Intervals function allows you to add agents without regenerating the schedule. When you copy selected intervals to new agents, first find an agent with a schedule that is similar to the one you want to assign the new agents (for example, the same CSQ and work times) and follow the procedure below to copy the schedule to the new agents.

**NOTE:** You can only enter one date to copy from, but you can select one or more intervals from the schedule on that date to copy to multiple agents.

**To copy selected intervals to other agents:**

1. Choose Intraday > Schedule Trade. The Schedule Trade pane appears.
2. Choose Copy Selected Intervals (Figure 152).

![Schedule Trade: Copy Selected Intervals](image)

3. If desired, filter the list of source agents by team, CSQ mapping, or All (below the Source Agent list).
4. Select the source agent from the Source Agent list.
5. Select a date in the Start Date field.
6. Click Get Schedule for the source agent. The schedule for the source agent appears.
7. Select the intervals in the source agent’s schedule you want to copy to the destination agent’s schedule.
   - To copy one or more intervals, select the check box next to each interval in the source agent’s schedule.
   - To copy all intervals, select the check box in the column header of the source agent’s schedule.
8. If desired, filter the list of destination agents by team, CSQ mapping, or All (below the Destination Agent list).

9. Select one or more agents from the Destination Agent list.

10. Select a start and end date in for the destination agent.

   **NOTE:** You do not need to click Get Schedule for the destination agents. The activity for each interval copied from the source agent replaces the activity for each interval in the destination agents’ schedules.

11. Click ✅ to finish this copy. WFM automatically updates the agents' schedules.
Managing Adherence

WFM collects data from your contact center ACD to determine all agents’ states in real time. WFM then compares these real-time states with the agents’ schedules, and calculates the agents’ adherence and conformity. You can view schedule adherence by team, by CSQ mapping, and by CSQ.

Adherence is the percentage of time that agents follow their schedules. When calculating adherence, WFM considers scheduled arrival and departure times, breaks, lunches, and time spent on scheduled activities. For example, an agent who is scheduled to arrive at 08:00 and leave at 16:00 and sticks to the schedule for the entire day is adhering to the schedule 100%.

Conformity is the percentage of time an agent works the right amount of time regardless of the time of day when the agent works. Schedule conformity does not take arrival and departure times into account. For example, an agent who is scheduled to work from 08:00-16:00, but instead works from 10:00 to 18:00 would be conforming, but not adhering to the schedule.

For more information, see “Adherence and Conformity” on page 95.

You can use the Adherence function to complete the following tasks.

■ Compare an agent’s scheduled activities with real-time statistics about the agent from Unified CCX. For more information, see "Monitoring Schedule Adherence" on page 315.

■ Sort and graph adherence data. For more information, see "Displaying Historical Adherence Data" on page 318.

■ Interpret adherence statistics. For more information, see "Interpreting Adherence Data" on page 320.

Monitoring Schedule Adherence

To monitor schedule adherence:

1. Choose Intraday > Adherence. The Adherence pane appears. By default, it displays the current date (Figure 155).

Figure 155. Adherence
2. Select a CSQ, team, or CSQ mapping. WFM displays the selected real-time adherence data (Figure 156).

Displaying an Adherence Report for a Specific Agent

The Adherence report shows how well the agent has maintained schedule adherence since the start of the day.

To display an adherence report for a specific agent:

- To display the Adherence report for a specific agent, click a percentage in the %SA (Schedule Adherence) column. The Adherence Report for the selected agent pane appears (Figure 157). Click (Back) to return to the Adherence pane.

Table 9 describes the data in the Adherence Report. Adherence is calculated using agent state data, which is captured from the ACD in real time. For this reason, the values displayed at the top of the Adherence report (Minutes Scheduled, Minutes In
Service, and Minutes Worked) reflect the time at which you requested adherence data, and may differ from the values shown in the detail portion of the report.

Table 9. Adherence Report data

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minutes Scheduled</td>
<td>Minutes the agent was scheduled to work for the current date so far.</td>
</tr>
<tr>
<td>Minutes in Service</td>
<td>Minutes the agent was scheduled to be in service and available to handle calls for the current date so far. When agents are in service they are either ready to handle a call or handling a call.</td>
</tr>
<tr>
<td>Minutes Worked</td>
<td>Actual minutes the agent was ready or handling calls so far for the current date.</td>
</tr>
<tr>
<td>Minutes NA</td>
<td>Minutes the agent was not in adherence so far for the current date.</td>
</tr>
</tbody>
</table>
| %SA                             | Agent’s schedule adherence (SA) as a percentage. Clickable. Calculated using the following formula: $( (M_s - M_{na}) \div M_s ) \times 100$
  where:
  - $M_s =$ Minutes scheduled
  - $M_{na} =$ Minutes not in adherence
  In the example above, the agent’s schedule adherence is: $((469 - 67) \div 469) \times 100 = 85.7\%$. |
| %SC                             | Agent’s schedule conformity (SC) as a percentage. Calculated using the following formula: $(M_w \div M_{is}) \times 100$
  where:
  - $M_w =$ Minutes worked
  - $M_{is} =$ Minutes In Service
  **NOTE:** Minutes in service include breaks and lunch; minutes worked do not. |
| Gap                             | Minutes during which the agent did not adhere to the schedule. This number is always displayed under the beginning of the activity. |
| In                              | Time that the agent started the activity.                                  |
| Out                             | Time that the agent finished the activity.                                 |
Displaying Historical Adherence Data

To display historical adherence data:

- Click (Define the Context), and then click a past date in the Context pane. WFM displays historical adherence data.

Using the Automatic Refresh Timer

NOTE: The Refresh and timer icons appear only when you display the current date on a production system.

To use the automatic refresh timer:

- To refresh the screen immediately, click (Refresh) at the top of the pane.
- To start the automatic refresh timer, click (Start Timer). The timer starts. To stop the timer, click (Stop Timer). The timer stops.
- To change the refresh rate, enter the number of seconds in the refresh field and click (Start Timer) (Figure 158). WFM refreshes the pane after the time has elapsed.

NOTE: The default delay, 30 seconds, is configured by the administrator.

Table 9. Adherence Report data (cont’d)

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Activity type. The possible types are:</td>
</tr>
<tr>
<td></td>
<td>• LO: Logged out</td>
</tr>
<tr>
<td></td>
<td>• NR: Not ready</td>
</tr>
<tr>
<td></td>
<td>• WT: Ready</td>
</tr>
<tr>
<td></td>
<td>• BU: Busy</td>
</tr>
<tr>
<td></td>
<td>• IC: In call</td>
</tr>
<tr>
<td>Length</td>
<td>Minutes that the agent spent on the activity.</td>
</tr>
</tbody>
</table>
**Adjusting Schedule Times**

By default, agent schedule times are the same as the CSQ on which they are working.

To adjust schedule times:

- To convert schedule times to time zones associated with the CSQs, click (Not Adjusted Time).
- To convert schedule times to time zones associated with the virtual CSQ, click (Adjusted Time).

**Displaying Agent Configuration Data**

To display agent configuration data:

- Click either the last name or first name of the agent. The Agent Details pane appears. To return to the Adherence pane, click (Back).

**Displaying Schedule Details**

To display schedule details:

- To display schedule details, click a time in the Scheduled Arrival column. The Schedule details pane appears. (Figure 159). Click (Back) to return to the Adherence pane.

*Figure 159. Schedule Details*
Interpreting Adherence Data

Table 10 lists the data displayed on the Adherence pane for all dates (current and past) and all ACDs.

Table 10. Adherence data for current and past dates and all ACDs

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone ID</td>
<td>Agent’s phone number.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Agent’s last name; clickable (accesses Agent Details pane).</td>
</tr>
<tr>
<td>First Name</td>
<td>Agent’s first name; clickable (accesses Agent Details pane).</td>
</tr>
<tr>
<td>Scheduled Arrival</td>
<td>Time at which the agent is scheduled to start work; clickable (accesses Schedule Details pane).</td>
</tr>
<tr>
<td>Actual Arrival</td>
<td>Actual time at which the agent starts working; clickable (accesses Schedule Details pane).</td>
</tr>
<tr>
<td>Scheduled Departure</td>
<td>Time at which the agent is scheduled to end work.</td>
</tr>
<tr>
<td>Actual Departure</td>
<td>Actual time at which the agent stops working.</td>
</tr>
</tbody>
</table>
| % SA       | Agent’s schedule adherence (SA) as a percentage; clickable (accesses detailed agent adherence report). Calculated using the following formula: \( ((M_s - M_{na}) / M_s) \times 100 \) where:  
  • \( M_s \) = Minutes scheduled  
  • \( M_{na} \) = Minutes not in adherence |
| % SC       | Agent’s schedule conformity (SC) as a percentage. Calculated using the following formula: \( (M_w / M_{is}) \times 100 \) where:  
  • \( M_w \) = Minutes worked (does not include breaks, lunch)  
  • \( M_{is} \) = Minutes In Service (does include breaks, lunch) |

Table 11 lists the data displayed on the Adherence pane for past dates and all ACDs.

Table 11. Adherence data for past dates and all ACDs

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minutes Scheduled</td>
<td>Minutes that the agent was scheduled to work.</td>
</tr>
</tbody>
</table>
Table 12 lists the data displayed on the Adherence pane for the current date and all ACDs.

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minutes in Service</td>
<td>Total time, in minutes, that agent was in session (logged in).</td>
</tr>
<tr>
<td>Minutes Worked</td>
<td>Minutes that the agent worked.</td>
</tr>
<tr>
<td>Minutes NA</td>
<td>Minutes during which the agent was not in adherence.</td>
</tr>
</tbody>
</table>

Table 11. Adherence data for past dates and all ACDs

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled Activity</td>
<td>Activity the agent is scheduled to be doing. Possible activities are:</td>
</tr>
<tr>
<td></td>
<td>• In service: Time that an agent is scheduled to be logged in and ready to handle contacts.</td>
</tr>
<tr>
<td></td>
<td>• Outside hours: Time that the CSQ is closed and for which agents are not handling contacts.</td>
</tr>
<tr>
<td></td>
<td>• Available: Time that the agent is not scheduled, but the agent’s work shift allows the agent to be scheduled.</td>
</tr>
<tr>
<td></td>
<td>• Break or Lunch: Time that the agent is not handling contacts because of a work condition.</td>
</tr>
<tr>
<td></td>
<td>• Exception: Time that the agent is not handling contacts because of an unplanned activity, such as a meeting, training session, unscheduled break, or absence.</td>
</tr>
<tr>
<td></td>
<td>• Project: Time that the agent is completing non-contact related activities, to optimize use of idle time.</td>
</tr>
<tr>
<td></td>
<td>• N/A: Not available. Time that the agent is not scheduled for the CSQ and the agent’s work shift does not allow the agent to be scheduled.</td>
</tr>
<tr>
<td></td>
<td>• N/S: Not scheduled. Time that the agent is not scheduled to work.</td>
</tr>
<tr>
<td></td>
<td>• Assignment: Time that an agent is scheduled for non-contact related activities. For more information about assignment work shifts, see &quot;Understanding Work Shifts&quot; on page 43.</td>
</tr>
<tr>
<td>Adherence</td>
<td>Whether the agent is adhering to the schedule. WFM compares the Scheduled Activity state with the current agent state to determine if the agent is adhering to the schedule. The icon indicates the agent is adhering to the schedule. The icon indicates the agent is not adhering to the schedule.</td>
</tr>
</tbody>
</table>
Table 12. Adherence data for current date and all ACDs (cont’d)

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Break Start</td>
<td>Scheduled time at which the agent’s break begins.</td>
</tr>
<tr>
<td>Break End</td>
<td>Scheduled time at which the agent’s break ends.</td>
</tr>
</tbody>
</table>

Table 13 lists the data displayed on the Adherence pane for the current date only when your WFM system is configured for Unified CCX.

Table 13. Adherence data for current date with Unified CCX

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NR</td>
<td>Not Ready. Whether the agent is in a not ready state.</td>
</tr>
<tr>
<td>RE</td>
<td>Ready. Whether the agent is in a ready state.</td>
</tr>
<tr>
<td>TK</td>
<td>Talking. Whether the agent is in a talk state.</td>
</tr>
<tr>
<td>OH</td>
<td>On Hold. Whether the agent is in an on hold state'.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Unified CCX does not use the OH state. When an agent puts a</td>
</tr>
<tr>
<td></td>
<td>customer on hold, the agent state remains TK.</td>
</tr>
<tr>
<td>WK</td>
<td>Work. Whether the agent is in a working state.</td>
</tr>
<tr>
<td>LO</td>
<td>Logged Out. Whether the agent is in a logged out state.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If WFM receives a walkaway code for an agent, it puts the agent</td>
</tr>
<tr>
<td></td>
<td>in the LO state since the agent is not in service.</td>
</tr>
</tbody>
</table>
Managing Your Inbox

Use this feature to approve schedule trades between agents and exception requests.

This section covers the following topics.

- Accessing Your Inbox (page 323)
- Approving Exception Requests (page 324)
- Approving or Denying a Schedule Trade Request (page 326)

Accessing Your Inbox

To access your Inbox:

1. Choose Intraday > Inbox. The Inbox List pane appears (Figure 160).

Figure 160. Inbox List

![Inbox List](image)

The columns on this pane are described in the following table.

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Displays an icon and a number that has a specific meaning related to the status of the message. The icons and numbers are described as follows.</td>
</tr>
<tr>
<td></td>
<td>• ⚠️ + 1: A request is in process and requires you to perform an action.</td>
</tr>
<tr>
<td></td>
<td>• 🤔 + 2: A request is in process. No action is required.</td>
</tr>
<tr>
<td></td>
<td>• Blank + 3: A request was rejected or closed.</td>
</tr>
<tr>
<td>From</td>
<td>The name of the agent who sent the request. Click the name to display the agent’s details. See &quot;Managing Agents&quot; on page 159 for more information on agent details</td>
</tr>
</tbody>
</table>
### Data Description

<table>
<thead>
<tr>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
</table>
| Request Type       | The type of request. The following request types are available:  
  - Exception request: Indicates an agent is requesting an exception (for example, agent needs to take the morning off to go see a doctor). This request is usually submitted before a schedule is created, so an agent is not scheduled for this period.  
  - Work Shift Grab: Indicates an agent is requesting a schedule trade with another agent.  
  Click a request in the Request Type column to see the details for the request.  
  If you are authorized to approve exception requests and schedule trades between agents, see the following topics for more information.  
  - Approving Exception Requests (page 324)  
  - Approving or Denying a Schedule Trade Request (page 326) |
| Status             | The status of the request. The possible values are:  
  - Closed: A request is resolved.  
  - Validated/Waiting for Approval: The request is open and waiting for a response. |
| Received           | The date and time when the message was received or created.                                                                                   |
| Expiration Date    | The expiration date, if applicable.                                                                                                            |
| Actions            | Action icons only appear in this field for agents in My Page > Inbox.  
  **NOTE:** This field is always blank in the Intraday > Inbox.                                                                                 |

### Approving Exception Requests

Exception requests can be approved or denied only by an administrator.
Managing Your Inbox

To approve exception requests:

1. Choose Intraday > Inbox. The Inbox List appears (Figure 161).

   **Figure 161. Inbox List**

<table>
<thead>
<tr>
<th>From</th>
<th>Request Type</th>
<th>Status</th>
<th>Received</th>
<th>Expiration Date</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sim Agent002</td>
<td>Vacation Request</td>
<td>Validated/Waiting for Approval</td>
<td>02-11-2009 13:56:49</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sim Agent002</td>
<td>Work Shift Grab</td>
<td>Validated/Waiting for Approval</td>
<td>02-11-2009 15:08:42</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sim Agent014</td>
<td>Work Shift Grab</td>
<td>Validated/Waiting for Approval</td>
<td>02-11-2009 16:19:30</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Click Exception Request in the Request Type column that corresponds to the request you want to approve. The Request Details pane appears (Figure 162).

   **Figure 162. Request Details**

   - Type: Exception Request
   - Submitted on: 2007-08-07
   - Submitted by: Alessandra Sanchez
   - Exception Request: Day Off
   - Date: 2007-08-30
   - Duration: 
   - Status: Submitted/Waiting for Validation
   - History: Submitted on 2007-08-07 14:22 by Alessandra Sanchez
             Comment: Going fishing

3. Link the agent’s exception request to an actual exception by clicking the exception from the Please Select an Exception drop-down list.

4. You might also include a comment with your approval or refusal.

5. Click Approve to assign the exception or Deny to refuse the exception. In both cases, the agent will receive the approved or denied message in the agent’s Inbox.

   **IMPORTANT:** If schedules are already created for this date, the supervisor or scheduler must edit the schedule to reflect this change. If schedules are not created for this date, the exception date and time
is added to exceptions assigned to this agent (see "Assigning Exception Types" on page 207), and when the schedule is created the exception will be applied automatically.

Approving or Denying a Schedule Trade Request

This topic describes how to approve a schedule trade request.

When approving a schedule trade, click Analyze to compare the schedules of both agents and make sure there are no exceptions already planned for these agents. If there are exceptions or scheduling conflicts, you might need to reschedule the conflicting issues.

Check the compatibility information to make sure there are no conflicts. The compatibility information includes availability, CSQ mapping, teams, CSQs, and time zones. Once approved, the schedule adjustments are automatic and a reply is sent to the agents.

Schedule trade requests can be approved or denied only by an administrator.

To approve or deny a schedule trade request:

1. Choose Intraday > Inbox. The Inbox List appears (Figure 163).

Figure 163. Inbox List
2. Click Work Shift Grab in the Request Type column that corresponds to the request you want to approve. The Request Details pane appears (Figure 164).

![Figure 164. Request Details](image)

3. Click Analyze to view the two schedules. The analyze details appear in the Request Details pane (Figure 165).

![Figure 165. Request Details](image)

4. If necessary, include a comment with your approval or denial.

5. Click Approve to accept the schedule trade or Deny to refuse the trade. In both cases, the agents receive the approved or denied message in their Inbox. If the schedule trade is approved, WFM automatically trades the schedule for both agents (see "Editing Schedules" on page 275).
Managing Reports

Introduction

You can use the Reports module to complete the following tasks.

- Generate productivity reports. For more information, see "Managing Productivity Reports" on page 330.
- Generate interval results reports. For more information, see "Managing Interval Results Reports" on page 333.
- Generate schedule reports. For more information, see "Managing Schedule View Reports" on page 335.
- Generate performance analysis reports. For more information, see "Managing Performance Analysis Reports" on page 337.
Managing Productivity Reports

You can use the Productivity Reports module to complete the following tasks.

- Generate a productivity report. For more information, see "Generating a Productivity Report" on page 330.

- Interpret a productivity report. For more information, see the Cisco Unified Workforce Optimization Workforce Management Reports Reference Guide.

- Save or print a productivity report. For more information, see "Exporting and Saving Report Data" on page 103.

Generating a Productivity Report

You can generate the following types of productivity reports.

- Agent productivity
- Agent period results
- Agent adherence
- Team productivity
- Team period results
- Team summary
- Team adherence
- Team agent period
- Team agent adherence

To generate a productivity report:

1. From the main Navigation pane, click Reports. The Historical Report Navigation pane appears.

2. Click Productivity Reports. A list of productivity reports appears.

3. Click the name of the desired productivity report. A pane containing report specification fields appears.

4. Enter the report start and end dates in the Start Date and End Date fields.

5. Complete one of the following steps.

   - If you are generating an agent report, complete the following steps.

     a. Optional: To filter the list of agents by team, select the Teams option, then select one or more teams in the Team list. To filter the list of agents by CSQ mapping, select the CSQ Mapping option, then select one or more CSQ mappings in the CSQ Mapping list.

     b. Select one or more agents from the Agent list.
If you are generating a team report, select one or more teams from the Team list.

6. Select an interval (day, week, or month) from the Interval drop-down list.

7. Select a report format (HTML, CSV, or PDF) from the Format drop-down list.

8. If you are generating a period results report, adherence report, or summary report, select the fields to include in the report by completing the following steps.

**NOTE:** For information about the fields that are available in these reports, see the Cisco Unified Workforce Optimization Workforce Management Reports Reference Guide.

**NOTE:** If the name of a field is disabled, you cannot remove it from the report. You also cannot change the position of the field.

- To add a field to the report, select the name of the field in the Available list, and then click >.
- To add all of the fields to the report, click >>.
- To remove a field from the report, select the name of the field in the Selected list, and then click <.
- To remove all of the fields from the report, click <<.
- To move a field up in the report, select the name of the field in the Selected List, and then click Up.
- To move a field down in the report, select the name of the field in the Selected List, and then click Down.

9. Click Submit. A new browser window opens and displays the report. You can print the report or save it to a file. For more information, see "Exporting and Saving Report Data" on page 103.

**Recalculating Data for Productivity Reports**

It might become necessary to correct a schedule for a past day and recompute adherence and conformity calculations so that agent and team productivity statistics are correct.

The WFM Adherence Conformity Calculator (ACC) service processes data from the daily schedule and agent status table and computes the adherence and conformity percentages for historical productivity reports every day.

If you make changes in a past schedule and need to recompute this data, perform the following steps.
To recompute adherence and conformity data:

1. On the server that hosts the Transaction services, open the com_odysoft_calabrio_scheduler.properties file in a text editor.
2. Locate the lastHistoricalDay property section.
3. Change the value (the default value is –5, meaning 5 days in the past) to a value that includes the date whose schedule you changed.

   **NOTE:** The higher the value you enter, the longer it will take for the data to be recalculated. The recommended maximum value is –14.

4. Save your changes.
5. Restart the ACC service so that the property value change takes effect.
Managing Interval Results Reports

You can use the Interval Results module to complete the following tasks.

- Generate an interval results report. For more information, see "Generating a Productivity Report" on page 330.
- Interpret an interval results report. For more information, see the Cisco Unified Workforce Optimization Workforce Management Reports Reference Guide.
- Save or print an interval results report. For more information, see "Exporting and Saving Report Data" on page 103.

Generating an Interval Results Report

You can generate the following types of interval results reports.

- Service All Data
- Service Interval
- Service Agent Interval
- Agent Interval
- Agent Service Interval
- Team Interval
- Team Agent Interval

To generate an interval results report:

1. From the main Navigation pane, click Reports. The Historical Report Navigation pane appears.
2. Click Interval Results. A list of interval results reports appears.
3. Click the name of the desired interval results report. A pane containing report specification fields appears.
4. Enter the report start date in the Start Date field.
5. Complete one of the following steps.
   - If you are generating a service report, select one or more services from the Service list.
   - If you are generating an agent report, complete the following steps.
     a. Optional: To filter the list of agents by team, select the Teams option, then select one or more teams in the Team list. To filter the list of agents by CSQ mapping, select the CSQ Mapping option, then select one or more CSQ mappings in the CSQ Mapping list.
b. Select one or more agents from the Agent list.

- If you are generating a team report, select one or more teams from the Team list.

6. Select a report format (HTML, CSV, or PDF) from the Format drop-down list.

7. If you are generating an interval report, select the fields to include in the report by completing the following steps.

**NOTE:** For information about the fields that are available in these reports, see the *Cisco Unified Workforce Optimization Workforce Management Reports Reference Guide*.

**NOTE:** If the name of a field is disabled, you cannot remove it from the report. You also cannot change the position of the field.

- To add a field to the report, select the name of the field in the Available list, and then click >.
- To add all of the fields to the report, click >>.
- To remove a field from the report, select the name of the field in the Selected list, and then click <.
- To remove all of the fields from the report, click <<.
- To move a field up in the report, select the name of the field in the Selected List, and then click Up.
- To move a field down in the report, select the name of the field in the Selected List, and then click Down.

8. Click Submit. A new browser window opens and displays the report. You can print the report or save it to a file. For more information, see "Exporting and Saving Report Data" on page 103.
Managing Schedule View Reports

You can use the Schedule View Reports module to complete the following tasks.

■ Generate a schedule view report. For more information, see "Generating a Productivity Report" on page 330.

■ Interpret a schedule view report. For more information, see the Cisco Unified Workforce Optimization Workforce Management Reports Reference Guide.

■ Save or print a schedule view report. For more information, see "Exporting and Saving Report Data" on page 103.

Generating a Schedule View Report

You can generate the following types of schedule view reports.

■ Agent Schedule Daily
■ Agent Schedule Weekly
■ Service Schedule By Agent
■ Service Schedule By Interval
■ Team Scheduled Task Hours
■ Agent Overtime
■ Agent Task Percentages
■ Agent Task Graph

To generate a schedule view report:

1. From the main Navigation pane, click Reports. The Historical Report Navigation pane appears.
2. Click Schedule View. A list of schedule view reports appears.
3. Click the name of the desired report. A pane containing report specification fields appears.
4. Enter the report start date in the Start Date field.
5. If appropriate, enter the report end date in the End Date field.
6. Complete one of the following steps.
   ■ If you are generating an agent report, complete the following steps.
      a. Optional: To filter the list of agents by team, select the Teams option, then select one or more teams in the Team list. To filter the list of agents by CSQ mapping, select the CSQ Mapping option, then select one or more CSQ mappings in the CSQ Mapping list.
      b. Select one or more agents from the Agent list.
If you are generating the Service Schedule By Agent report, complete the following steps.

a. Select one or more services from the Service list.
b. Select a category from the Agent Category list.

If you are generating a Service Schedule By Interval report, select one or more services from the Service list.

If you are generating a team report, select one or more teams from the Team list.

7. If you are generating an Agent Task Percentages report, select an interval (day, week, or month) from the Interval drop-down list.

8. Select a report format (HTML, CSV, or PDF) from the Format drop-down list.

**NOTE:** For the Agent Task Graph, only the HTML and CSV formats are available.

9. If you are generating an Agent Schedule report, Service Schedule By Interval report, Team Scheduled Task Hours report, Agent Overtime report, or Agent Task Percentages report, select the fields to include in the report by completing the following steps.

**NOTE:** For information about the fields that are available in these reports, see the *Cisco Unified Workforce Optimization Workforce Management Reports Reference Guide*.

**NOTE:** If the name of a field is disabled, you cannot remove it from the report. You also cannot change the position of the field.

- To add a field to the report, select the name of the field in the Available list, and then click >.
- To add all of the fields to the report, click >>.
- To remove a field from the report, select the name of the field in the Selected list, and then click <.
- To remove all of the fields from the report, click <<.
- To move a field up in the report, select the name of the field in the Selected List, and then click Up.
- To move a field down in the report, select the name of the field in the Selected List, and then click Down.

10. Click Submit. A new browser window opens and displays the report. You can print the report or save it to a file. For more information, see "Exporting and Saving Report Data" on page 103.
Managing Performance Analysis Reports

You can use the Performance Analysis Reports module to complete the following tasks.

- Generate a performance analysis report. For more information, see "Generating a Productivity Report" on page 330.
- Interpret a performance analysis report. For more information, see the Cisco Unified Workforce Optimization Workforce Management Reports Reference Guide.
- Save or print a performance analysis report. For more information, see "Exporting and Saving Report Data" on page 103.

Generating a Performance Analysis Report

You can generate the following types of performance analysis reports.

- Performance Daily
- Performance Interval
- Call Volume Graph
- Service Level Graph
- Forecast Accuracy Graph
- Call Volume Graph Interval
- Service Level Graph Interval
- Forecast Graph Interval
- Agent Graph Interval
- Agent Report Card

To generate a performance analysis report:

1. From the main Navigation pane, click Reports. The Historical Report Navigation pane appears.
2. Click Performance Analysis Reports. A list of performance analysis reports appears.
3. Click the name of the desired report. A pane containing report specification fields appears.
4. Enter the report start date in the Start Date field.
5. If appropriate, enter the report end date in the End Date field.
6. Complete one of the following steps.
   ■ If you are generating an agent report, complete the following steps.
     a. **Optional:** To filter the list of agents by team, select the Teams option, then select one or more teams in the Team list. To filter the list of agents by CSQ mapping, select the CSQ Mapping option, then select one or more CSQ mappings in the CSQ Mapping list.
     b. Select one or more agents from the Agent list.
     c. Enter the calls per hour objective in the Goal for calls per hour field.
     d. Enter the adherence goal in the Goal for adherence percentage field.
     e. Enter the quality goal in the Goal for quality score field.
   ■ If you are generating any other kind of report, select one or more services from the Service list.

7. Select a report format (HTML or CSV) from the Format drop-down list.

   **NOTE:** For the Performance Daily report, Performance Interval report, and Agent Report Card, you can also select the PDF format.

8. If you are generating a Performance report or an Agent Report Card report, select the fields to include in the report by completing the following steps.

   **NOTE:** For information about the fields that are available in these reports, see the *Cisco Unified Workforce Optimization Workforce Management Reports Reference Guide*.

   **NOTE:** If the name of a field is disabled, you cannot remove it from the report. You also cannot change the position of the field.

   ■ To add a field to the report, select the name of the field in the Available list, and then click >.

   ■ To add all of the fields to the report, click >>.

   ■ To remove a field from the report, select the name of the field in the Selected list, and then click <.

   ■ To remove all of the fields from the report, click <<.

   ■ To move a field up in the report, select the name of the field in the Selected List, and then click Up.

   ■ To move a field down in the report, select the name of the field in the Selected List, and then click Down.

9. Click Submit. A new browser window opens and displays the report. You can print the report or save it to a file. For more information, see "Exporting and Saving Report Data" on page 103.
Managing What-If Scenarios

Introduction

You can use the What-Ifs module to complete the following tasks.

■ Create resource requirements calculations. For more information, see "Generating Resource Requirements Calculations" on page 340.

■ Display resource requirements calculations. For more information, see "Managing Existing Resource Requirements Calculations" on page 344.

■ Create, rename, and delete distribution scenarios. For more information, see "Managing Distribution Scenarios" on page 347.

■ Create, rename, and delete forecast scenarios. For more information, see "Managing Forecast Scenarios" on page 349.
Generating Resource Requirements Calculations

You can use the Resource Requirements Calculation function to complete the following task.

- Calculate resource requirements based on a production forecast. For more information about production forecasts, see "Managing Forecast Requests" on page 233.

For more information about resource requirements calculations, see "Understanding Resource Requirements Calculations" on page 96.

Generating a Resource Requirement Calculation

To generate a resource requirement calculation:

1. Choose What-Ifs > Resource. The Resource Requirements Calculation pane appears. By default, the table displays all possible work shifts for Sunday (Figure 166).

2. Select one or more CSQs from the Select CSQs list.
3. Under Dates, enter the start and end dates in the Start Date and End Date fields.

**NOTE:** You can use any date range for which you have already generated a forecast; a duration of one week is most commonly used. If you enter a longer date range, the calculation uses the average contact volume.

4. In the Execute Request Date field, enter the date and time at which you want to run this request.

**NOTE:** Enter the date using the MM-DD-YYYY format and the time using the HH:MM format. For example, if you want to execute the request at 8:30 am on January 28, 2008, enter 01-28-2008 08:30. When you select a date from the calendar, WFM automatically inserts the selected date and the current time.

**NOTE:** Requests containing a large amount of data require significant time to run. It is recommended that you run requests during off-peak hours (for example, at night) because the process server only runs one request at a time, and running requests during peak hours will prevent other users from running their requests.

5. Click the button for the day you want to configure. The table displays all possible work shifts for the selected day.

6. For each work shift that you want to include in the resource requirement calculation, complete the following steps.

   a. Select one or more work shifts by selecting the check box next to each work shift duration. To select all work shifts, select the check box in the column heading.

   b. Complete the fields for the work shift as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum</td>
<td>Earliest time agents can take their first break, in HH:MM format. Default value is 00:00.</td>
</tr>
<tr>
<td>Break 1</td>
<td></td>
</tr>
<tr>
<td>Maximum</td>
<td>Latest time agents can take their first break, in HH:MM format. Default value is 00:00.</td>
</tr>
<tr>
<td>Break 1</td>
<td></td>
</tr>
<tr>
<td>Duration</td>
<td>Duration of the activity in minutes. Default value is 0.</td>
</tr>
</tbody>
</table>

**NOTE:** If your database increment is 5 minutes, you can specify the duration in 5-minute increments. If your database increment is 15 minutes, you can specify the duration in 15-minute increments.
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Break 2</td>
<td>Earliest time agents can take their second break, in HH:MM format. Default value is 00:00.</td>
</tr>
<tr>
<td>Maximum Break 2</td>
<td>Latest time agents can take their second break, in HH:MM format. Default value is 00:00.</td>
</tr>
<tr>
<td>Duration</td>
<td>Duration of the activity in minutes. Default value is 0.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If your database increment is 5 minutes, you can specify the duration in 5-minute increments. If your database increment is 15 minutes, you can specify the duration in 15-minute increments.</td>
</tr>
<tr>
<td>Minimum Lunch</td>
<td>Earliest time agents can go to lunch, in HH:MM format. Default value is 00:00.</td>
</tr>
<tr>
<td>Maximum Lunch</td>
<td>Latest time agents can go to lunch, in HH:MM format. Default value is 00:00.</td>
</tr>
<tr>
<td>Duration</td>
<td>Duration of the activity in minutes. Default value is 0.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If your database increment is 5 minutes, you can specify the duration in 5-minute increments. If your database increment is 15 minutes, you can specify the duration in 15-minute increments.</td>
</tr>
<tr>
<td>Project1, Project2,</td>
<td>If projects are assigned to the selected work shift, the duration of each project in minutes. Default value is 0.</td>
</tr>
<tr>
<td>Project3</td>
<td><strong>NOTE:</strong> If your database increment is 5 minutes, you can specify the duration in 5-minute increments. If your database increment is 15 minutes, you can specify the duration in 15-minute increments.</td>
</tr>
<tr>
<td>Maximum Agents</td>
<td>Maximum number of agents available for the work shift. Default value is 9999.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If you want WFM to determine the maximum number of agents available, use the default value.</td>
</tr>
</tbody>
</table>

c. **Optional:** To copy the selected day’s work shift configuration to another day, complete the following steps.

1. Click 📋 (Copy). WFM copies the work shift configuration to the clipboard.
2. Click the button for the day you want to configure next. The table displays all possible work shifts for the selected day.
3. Click 💾 (Paste). WFM pastes the work shift configuration to the selected day.
7. Click (Launch Request). WFM launches your request.

**NOTE:** You can monitor the status of your request on the Server Request List. For more information about this list, see "Managing Requests to the Server" on page 394.
Managing Existing Resource Requirements Calculations

You can use the Resource List function to complete the following task.

- Displaying Existing Resource Requirement Calculations (page 344)

Displaying Existing Resource Requirement Calculations

To display existing resource requirements calculations:

1. Choose What-Ifs > Resource List. The Existing Resource Requirements Calculations pane appears (Figure 167).

![Figure 167. Existing Resource Requirements Calculations](image)

2. Select the name of the CSQ from the drop-down list in the toolbar. For more information, see Selecting a CSQ (page 118).

3. Under Search Existing Resource Requirements, enter the start and end dates for the existing resource requirements in the Start Date and End Date fields.
4. Click Search. A list of week days and dates appear (Figure 168).

Figure 168. Existing Resource Requirements Calculation: Search

5. Under Display Resource Requirements, enter the start and end dates for the forecasted resource requirements in the Start Date and End Date fields.

6. Enter the agents' hourly rate in the Hourly Rate field.

7. Click Display Results. The Resource Requirements Calculation pane appears (Figure 169).

Figure 169. Resource Requirements Calculation: Display Results
The data on this pane is described in the following table.

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday—Sunday Minimum</td>
<td>Minimum number of agents required for the work shift to cover the requirements for the day.</td>
</tr>
<tr>
<td>Monday—Sunday Average</td>
<td>Average number of agents required for the work shift to cover the requirements for the day.</td>
</tr>
<tr>
<td>Monday—Sunday Maximum</td>
<td>Maximum number of agents required for the work shift to cover the requirements for the day.</td>
</tr>
<tr>
<td>Hours in Service</td>
<td>Total number of hours in service for each day.</td>
</tr>
<tr>
<td>Projects</td>
<td>Total number of hours working on projects for each day, if there are any projects.</td>
</tr>
<tr>
<td>Hours in Overtime</td>
<td>Total number of hours spent in overtime for each day.</td>
</tr>
<tr>
<td>Standard Deviation</td>
<td>Gap between the minimum number hours for that day and the maximum number of hours for that day.</td>
</tr>
<tr>
<td>Productivity</td>
<td>Occupancy percentage per selected work shift.</td>
</tr>
<tr>
<td>Calls</td>
<td>Number of calls received each day.</td>
</tr>
<tr>
<td>Contacts</td>
<td>Number of contacts received each day.</td>
</tr>
<tr>
<td>Contacts per Hour</td>
<td>Average number of contacts per hour.</td>
</tr>
<tr>
<td>Cost per Contact</td>
<td>Average cost per contact.</td>
</tr>
<tr>
<td>Hourly Rate</td>
<td>Hourly rate per agent.</td>
</tr>
<tr>
<td>Daily Budget</td>
<td>Budget for each day.</td>
</tr>
<tr>
<td>Weekly Budget</td>
<td>Budget for the week.</td>
</tr>
<tr>
<td>Internal Budget</td>
<td>Budget for the interval.</td>
</tr>
</tbody>
</table>
Managing Distribution Scenarios

You can use the Distribution Scenario function to complete the following tasks.

- Create distribution scenarios. For more information, see "Creating a Distribution Scenario" on page 347.
- Rename distribution scenarios. For more information, see "Renaming a Distribution Scenario" on page 348.
- Delete distribution scenarios. For more information, see "Deleting a Distribution Scenario" on page 348.

For more information, see "Understanding Distribution Scenarios" on page 96. For information about creating distributions and assigning them to distribution scenarios, see "Creating a Distribution" on page 224 and "Editing Distributions" on page 227.

Creating a Distribution Scenario

To create a distribution scenario:

1. Choose What-Ifs > Distribution Scenario. The Distribution Scenario List pane appears (Figure 170).

2. Click (New). The Distribution Scenario Details pane appears (Figure 171).

3. Enter a name for the distribution scenario.
4. Select the CSQ you want to assign to this scenario.
5. Click (Save) to save your changes. WFM creates the scenario.
Renaming a Distribution Scenario

To rename a distribution scenario:

1. Choose What-Ifs > Distribution Scenario. The Distribution Scenario List appears (Figure 172).

2. Click the name of a scenario under Description. The Distribution Scenario Details pane appears (Figure 173).

3. Enter a new name for the distribution scenario in the Scenario Name field.

4. Click (Save) to save your changes. WFM changes the name of the distribution scenario.

Deleting a Distribution Scenario

To delete a distribution scenario:


2. Select the distribution scenario to delete by completing one of these steps.
   - To delete one or more scenarios, select the check box next to the distribution scenario name.
   - To delete all scenarios, select the check box in the column header.

3. Click (Delete). An Internet Explorer dialog box appears.

4. Click OK to confirm the deletion and dismiss the dialog box.
Managing Forecast Scenarios

You can use the Forecast Scenario function to complete the following tasks.

- Create forecast scenarios. For more information, see "Creating a Forecast Scenario" on page 349.
- Rename forecast scenarios. For more information, see "Renaming a Forecast Scenario" on page 350.
- Delete forecast scenarios. For more information, see "Deleting a Forecast Scenario" on page 350.

For more information, see "Understanding Forecast Scenarios" on page 97. For information about creating forecasts and assigning them to forecast scenarios, see "Managing Forecast Requests" on page 233 and "Editing Forecasts" on page 249.

Creating a Forecast Scenario

To create a forecast scenario:

1. Choose What-Ifs > Forecast Scenario. The Forecast Scenario List pane appears (Figure 174).

   Figure 174. Forecast Scenario List

<table>
<thead>
<tr>
<th>Scenario Name</th>
<th>Assigned CSQ Number</th>
<th>Assigned CSQ Name</th>
<th>View scenario</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scenario 2008</td>
<td>1</td>
<td>Sales</td>
<td></td>
</tr>
</tbody>
</table>

2. Click (New). The Forecast Scenario Details pane appears (Figure 175).

   Figure 175. Forecast Scenario Details

3. Enter a name for the forecast scenario in the Scenario Name field.
4. Select the CSQ you want to assign to this scenario.
5. Click (Save) to save your changes. WFM creates the scenario.
Renaming a Forecast Scenario

To rename a forecast scenario:

1. Choose What-Ifs > Forecast Scenario. The Forecast Scenario List appears (Figure 176).

2. Click the name of a scenario under Scenario Name. The Forecast Scenario Details pane appears (Figure 177).

3. Enter a new name for the forecast scenario in the Scenario Name field.

4. Click (Save) to save your changes. WFM changes the scenario name.

Deleting a Forecast Scenario

To delete a forecast scenario:


2. Select the forecast scenario to delete by completing one of these steps.
   - To delete one or more scenarios, select the check box next to its name.
   - To delete all scenarios, select the check box in the column header.

3. Click (Delete). An Internet Explorer dialog box appears.

4. Click OK to confirm the deletion and dismiss the dialog box.
Displaying Historical Data

Introduction

You can use the Historical module to complete the following task.

- Display historical data for CSQs in tabular or graph formats. For more information, see "Displaying Historical Data for a CSQ" on page 352.

**NOTE:** The Workforce Management OOC Service (OOC Service) must be running as the NT authenticated user to enable WFM to retrieve historical data from Unified CCX. For more information on the OOC service, see the *Cisco Unified Workforce Optimization Workforce Management Installation Guide.*
Displaying Historical Data for a CSQ

You can display historical data for a CSQ in either a tabular or graphical format.

To display historical data for a CSQ:

1. Choose Historical > CSQ. The CSQ Historical Data pane appears (Figure 178).

Figure 178. CSQ Historical Data

2. Select the CSQ from the drop-down list in the toolbar or click (Define the Context) and select the CSQ from the CSQ list. See "Selecting a CSQ" on page 118 for more information.

3. Enter the start and end dates.

4. Select the interval type from the drop-down list. Possible values are Per Interval, Per Day, Per Week, Per Month, or Per Year.

5. Click Show Data. WFM displays the historical data report for the CSQ (Figure 179).

Figure 179. CSQ Historical Data

NOTE: WFM does not automatically capture calls that last over 1 hour, 44 minutes, and 59 seconds. If you want long calls included in the WFM database, you must manually capture the historical call data for that day. See “Capturing Historical Call Data” in the Cisco Unified Workforce Optimization Workforce Management Installation Guide.

6. Click (Graph) next to a column heading to display the graph associated with the column. WFM displays the data in graph format (Figure 180).

NOTE: The graph icon only appears when the table has 100 or less rows.
NOTE: The x-axis displays up to 30 intervals. If you specify more than 30 intervals, WFM will calculate the average for each displayed interval.

Figure 180. Historical Data graph sample

![Service Level graph](image)

The labels in these graphs are described in the following table.

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offered</td>
<td>Number of calls that are received by the ACD for each interval. Offered calls are then either answered by a resource (handled) or abandoned.</td>
</tr>
<tr>
<td>Handled Calls</td>
<td>Number of calls answered for each interval.</td>
</tr>
<tr>
<td>Calls Abandoned</td>
<td>Number of calls per interval for which the caller terminated the call while in queue.</td>
</tr>
<tr>
<td>Ratio</td>
<td>Percentage of the day’s calls that arrive during the interval.</td>
</tr>
<tr>
<td>ASA</td>
<td>Average Speed of Answer. Average time elapsed in seconds between the times the call was dropped for each interval. The ASA is calculated as the sum of the queue time for calls answered during the interval and divided by the number of calls answered during the interval. If the CSQ Type is Email, the value is zero (0).</td>
</tr>
<tr>
<td>Service Level</td>
<td>Percentage of contacts answered for each interval within the service threshold time.</td>
</tr>
</tbody>
</table>
Managing Special Functions

Introduction

You can use the Special Functions module to complete the following tasks.

- Compile forecast accuracy data for CSQs. For more information, see "Compiling Historical Data" on page 356.
- Merge historical data from source CSQs to virtual CSQs. For more information, see "Merging Historical Data" on page 358.
- Enter historical data manually. For more information, see "Entering Historical Data Manually" on page 360.
Compiling Historical Data

This topic describes how to compile historical data. You can use the Compilation function to calculate the accuracy of a forecast for a CSQ based on historical data.

**NOTE:** You can use the result of the forecast accuracy calculation to improve the accuracy of your forecasts. To do so, enter an adjustment factor on the Forecast Maintenance pane (Forecast > Edit Forecast). For example, if the forecast accuracy for a CSQ is 103%, enter an adjustment factor of 97% on the Forecast Maintenance pane for that CSQ.

**To compile historical data:**

1. Choose Special Functions > Compilation. The Data Compilation Requests pane appears (Figure 181).

![Figure 181. Data Compilation Request](image)

2. Choose one of the following options.
   - **Forecast Accuracy:** This option calculates the precision level of the forecasts for the entered date range. It is selected by default. When you launch the compilation request, WFM will show you how close to reality
the generated and updated forecasts were. The result of this calculation appears in "Creating a CSQ for Calls" on page 130 or "Creating a CSQ for Email" on page 138.

Forecast accuracy is the ratio of the forecasted call volume over the actual call volume. For example, if your forecast precision level is 105%, the forecast contact volume was greater than the actual contact volume by 5%.

**NOTE:** The forecast accuracy calculation is based on historical information only. It is not a forward looking calculation. It assesses how a forecast measured up against the actual contacts received during the forecast period.

3. Enter the start and end dates for this forecast accuracy calculation.

4. If you chose Forecast Accuracy, select one or more CSQs from the Select CSQs list.

   **NOTE:** The Select CSQs list only displays CSQs with forecasts.

5. Enter the date using the MM-DD-YYYY format (for example, 01-28-2008) and time using the HH:MM format (for example, 08:30) when you want to run this request in the Execute Request Date field. When you select a date from the calendar, WFM automatically inserts the current time. The best practice is to compile the historical data during off-peak hours.

   **NOTE:** Requests containing a large amount of data require significant time to run. It is recommended that you run requests during off-peak hours (for example, at night) because the process server only runs one request at a time, and running requests during peak hours will prevent other users from running their requests.

6. Click ![Launch Request](Launch Request). WFM launches the compilation request.

   **NOTE:** You can monitor the status of your request on the Compilation Request List pane. See "Managing Compilation Requests" on page 397 for more information.
Merging Historical Data

Use this feature to merge historical data from the source CSQs into the virtual CSQ.

**NOTE:** You must create virtual CSQ before you can perform this task.

All historical data from the CSQs is merged, including
- Contact volume (sum)
- Talk time (average)
- ASA (weighted average)
- Quality of service (weighted average)
- ACW (weighted average)

A distribution, forecast, scenario, and schedule can be calculated for a virtual CSQ when you have the required historical data. The historical data for each source CSQ within the virtual CSQ will remain available.

**To merge historical data:**

1. Choose Special Functions > Historical Merge. The Historical Data Merge Request pane appears (Figure 182).

![Figure 182. Historical Data Merge Request](image)

2. Enter the start and the end dates for this historical data merge.
Merging Historical Data

**NOTE:** You need historical data within this date range for this historical data merge to work. You can specify any legitimate historical date up to and including the current date.

3. Select a virtual CSQ from the Select a CSQ drop-down list. WFM displays the source CSQs associated with the selected virtual CSQ.

4. Enter the date and time when this merge will run in the Execute the Request On field. The process server will run the request at the specified date and time. The best practice is to merge the data during an off-peak hour.

**NOTE:** Requests containing a large amount of data require significant time to run. It is recommended that you run requests during off-peak hours (for example, at night) because the process server only runs one request at a time, and running requests during peak hours will prevent other users from running their requests.

The remaining fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Number | Number associated with the source CSQ in the selected virtual CSQ.  

**NOTE:** Information only appears in this field when you select a virtual CSQ, from the Select a CSQ drop-down list. |
| Name | Name of the CSQ included in the selected virtual CSQ. |

5. Click (Launch Request). WFM launches the merged historical data request. After creating an historical data for a virtual CSQ, the data compilation per day, week, month, and year for the virtual CSQ automatically appears in the displays and reports.

**NOTE:** You can monitor the status of your request on the Compilation Request List pane. See "Managing Compilation Requests" on page 397 for more information.
Entering Historical Data Manually

WFM requires historical data to generate forecasts and schedules and to calculate statistical metrics. The more accurate the historical data is, the more accurate the forecasts and schedules will be. However, sometimes historical data for a CSQ is incomplete or inaccurate. When this happens, you need the ability to enter missing data manually or edit existing data that is inaccurate.

The following list includes some of the situations in which you might need to enter or edit historical data.

■ To correct inaccurate data due to system or network issues
■ To adjust unusual data due to an infrequent event, such as a marketing campaign
■ To input missing data when call volume is normal but no data was captured because the system or the network was down
■ To create a database when historical data is either unavailable or missing, as when you first install WFM
■ To support forecasting and scheduling with CSQs for email (and other media)

NOTE: Unified CCX can store historical data about email volume, but WFM does not support capturing this type of data.

To correct these situations, WFM provides the capability to manually edit historical data for a CSQ that already exists in the database, and manually enter historical data for a CSQ that has no historical data in the database.

This topic covers the following information:

■ Entering Historical Data Manually (page 361)
■ Editing Historical Data Manually (page 363)
Entering Historical Data Manually

This procedure explains how to enter historical data for a CSQ that has no data on a specific date. You can enter values in any field, whether the field corresponds to a specific interval or to a total or average for the day. One fast method for creating historical data is to enter a number in one of the total fields. WFM will automatically enter that value in all of the corresponding interval fields and then display the default value of 0 in the total field.

NOTE: If you want to enter a value in the total Handled or Abandoned field that is automatically distributed across all of the corresponding interval fields, the CSQ must have a distribution. For information about creating distributions, see "Creating a Distribution" on page 224.

To enter historical data manually:

2. Select a CSQ from the drop-down list in the toolbar.
3. Select a date (Figure 183).

![Figure 183. Manual Data Entry per Interval without data](image-url)
4. Click Initialize Historical Data. WFM displays zeroes (0) in all of the interval and total fields (Figure 184).

Figure 184. Manual Data Entry per Interval

5. Enter values for the fields as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offered</td>
<td>Number of emails that are received during each interval. This field only appears when you choose a CSQ of typeEmail.</td>
</tr>
<tr>
<td>Handled</td>
<td>Number of calls handled for each interval.</td>
</tr>
<tr>
<td>Abandoned</td>
<td>Number of contacts per interval where the person originating the contact terminates the contact while in queue.</td>
</tr>
<tr>
<td>ASA</td>
<td>Average Speed of Answer. Average speed of answer in seconds for each interval</td>
</tr>
</tbody>
</table>
Entering Historical Data Manually

6. Click Get Total to display the total for each column.

7. Click (Save) to save your changes.

Editing Historical Data Manually

This procedure explains how to manually edit the historical data on a specific date for a CSQ. You can edit values in any field, whether the field corresponds to a specific interval or to a total or average for the day. One fast method for changing all of the interval fields in a column is to enter a number in one of the total fields. WFM will automatically enter that value in all of the corresponding interval fields and then display the default value of 0 in the total field.
NOTE: If you want to enter a value in the total Handled or Abandoned field that is automatically distributed across all of the corresponding interval fields, the CSQ must have a distribution. For information about creating distributions, see "Creating a Distribution" on page 224.

To edit historical data manually:

2. Select a CSQ from the drop-down list in the toolbar.
3. Click (Define the Context). The Context Pane appears.
4. Select a date in the calendar. If there is historical data for the CSQ, WFM displays it (Figure 185).

Figure 185. Manual Data Entry per Interval with data

<table>
<thead>
<tr>
<th>Date</th>
<th>Interval</th>
<th>Handled</th>
<th>Aband.</th>
<th>ASA</th>
<th>ATT</th>
<th>AWT</th>
<th>SL</th>
</tr>
</thead>
<tbody>
<tr>
<td>07-24-2008</td>
<td>00:00</td>
<td>8</td>
<td>0</td>
<td>13</td>
<td>211</td>
<td>10</td>
<td>85</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>00:30</td>
<td>8</td>
<td>0</td>
<td>13</td>
<td>234</td>
<td>39</td>
<td>89</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>01:00</td>
<td>8</td>
<td>0</td>
<td>24</td>
<td>210</td>
<td>16</td>
<td>72</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>01:30</td>
<td>8</td>
<td>0</td>
<td>15</td>
<td>210</td>
<td>49</td>
<td>82</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>02:00</td>
<td>12</td>
<td>0</td>
<td>19</td>
<td>229</td>
<td>33</td>
<td>71</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>02:30</td>
<td>12</td>
<td>0</td>
<td>13</td>
<td>223</td>
<td>28</td>
<td>73</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>03:00</td>
<td>12</td>
<td>0</td>
<td>11</td>
<td>227</td>
<td>20</td>
<td>86</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>03:30</td>
<td>12</td>
<td>0</td>
<td>25</td>
<td>217</td>
<td>18</td>
<td>89</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>04:00</td>
<td>12</td>
<td>0</td>
<td>10</td>
<td>232</td>
<td>12</td>
<td>89</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>04:30</td>
<td>12</td>
<td>0</td>
<td>27</td>
<td>230</td>
<td>40</td>
<td>81</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>05:00</td>
<td>12</td>
<td>0</td>
<td>16</td>
<td>207</td>
<td>14</td>
<td>70</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>05:30</td>
<td>12</td>
<td>0</td>
<td>11</td>
<td>220</td>
<td>22</td>
<td>70</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>06:00</td>
<td>17</td>
<td>0</td>
<td>11</td>
<td>185</td>
<td>14</td>
<td>83</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>06:30</td>
<td>17</td>
<td>0</td>
<td>26</td>
<td>196</td>
<td>16</td>
<td>85</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>07:00</td>
<td>17</td>
<td>0</td>
<td>12</td>
<td>189</td>
<td>45</td>
<td>84</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>07:30</td>
<td>17</td>
<td>0</td>
<td>11</td>
<td>198</td>
<td>13</td>
<td>74</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>08:00</td>
<td>13</td>
<td>0</td>
<td>19</td>
<td>156</td>
<td>13</td>
<td>74</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>08:30</td>
<td>13</td>
<td>0</td>
<td>18</td>
<td>156</td>
<td>13</td>
<td>74</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>09:00</td>
<td>13</td>
<td>0</td>
<td>19</td>
<td>215</td>
<td>16</td>
<td>70</td>
</tr>
<tr>
<td>07-24-2008</td>
<td>09:30</td>
<td>13</td>
<td>0</td>
<td>15</td>
<td>201</td>
<td>33</td>
<td>80</td>
</tr>
</tbody>
</table>

5. Edit the data fields as required. The fields are described in "Entering Historical Data Manually" on page 361.
6. Click Get Total to display the total for each column.

7. Click (Save) to save your changes.
Managing Administration

Introduction

You can use the Administration module to complete the following tasks.

- Control user access to functions through roles. For more information, see "Managing Roles" on page 368.
- Control access to data through views. For more information, see "Managing Views" on page 371.
- Create users in WFM or import users from Unified CCX. For more information, see "Managing Users" on page 381.
- Specify default configuration parameters for the enterprise, the dashboard, and schedules. For more information, see "Managing the Default System Configuration" on page 389.
- Monitor the status of requests to generate distributions, forecasts, and schedules. You can also delete incomplete requests. For more information, see "Managing Requests to the Server" on page 394.
- Monitor the status of requests to compile various historical measurements from data extracted from the historical data tables in Unified CCX and delete incomplete requests. For more information, see "Managing Compilation Requests" on page 397.
- Create a system-wide list of exception types that appear as options that an agent can select from their My Page when they request time off. For more information, see "Managing Generic Exceptions" on page 400.

See "Administering Users in WFM" on page 29 for more information.
Managing Roles

This section covers the following tasks.

- Displaying a Role (page 368)
- Displaying a Role's Privileges (page 369)
- Assigning Users to a Role (page 370)

Displaying a Role

Use this procedure to display the roles associated with WFM.

To display a role:

1. From the Navigation menu, choose Administration > Roles. The Role List pane appears (Figure 186).

Figure 186. Role List

![Role List](Image)

2. Click a role. The Roles Details pane displays the Role Name field (Figure 187).

Figure 187. Role Details: General tab

![Role Details: General tab](Image)
Displaying a Role's Privileges

Use this procedure to display the privileges associated with a role in WFM.

To display privileges:

■ From the Roles Details pane, click the Privileges tab. The Roles Details pane displays the available and assigned privileges (Figure 188).

**NOTE:** The privileges that appear in these lists are dependent on the role you selected from the Role List.

Figure 188. Role Details: Assigned Privileges tab
Assigning Users to a Role

Use this procedure to assign users to a role in WFM. You can assign multiple roles to a user. For more information, see "Managing Roles" on page 368.

To assign users to a role:

1. From the Role Details pane, click the Assign Users tab. The Roles Details pane displays the available and assigned users (Figure 189).

2. To assign users to a role, select their names in the Available Users list, then click >. The names of the selected users move to the Assigned Users list. See "Moving Items between Lists" on page 111 for more information.

3. To remove users from a role, select the check box next to their login name in Assigned Users list, then click <. The names of the selected users return to the Available Users list.

To remove all users in the Assigned Users list, click the check box in the column header, then click >. The names of all selected users return to the Available Users list.

NOTE: If you intend to assign multiple roles to a user, see "Understanding Roles, Views, and Privileges" on page 29 for a description of restrictions. You can assign any combinations of administrator, scheduler or supervisor roles to a user. If you assign an agent role to a user, that is the only role you can assign to that user. WFM does not support an agent with multiple roles.
Managing Views

A view determines the level of accessibility a user has in WFM. For example, you can assign a view that is associated with one or more users, CSQs, CSQ mappings, teams, work conditions, work shifts, and exceptions.

This section covers the following topics.

- Creating a View (page 371)
- Editing an Existing View (page 372)
- Assigning Users to a View (page 373)
- Assigning CSQs to a View (page 373)
- Assigning Teams to a View (page 374)
- Assigning Projects to a View (page 375)
- Assigning Work Conditions to a View (page 376)
- Assigning Work Shifts to a View (page 377)
- Assigning Exception Types to a View (page 378)
- Assigning CSQ Mappings to a View (page 379)
- Deleting a View (page 380)

Creating a View

This procedure describes how to create a view. Users assigned to this view can only see information associated with this view.

To create a new view:

1. Choose Administration > Views. The View List appears (Figure 190).

Figure 190. View List
2. Click (New) to create a new view. The View Details pane displays the general view options (Figure 191).

![Figure 191. View Details: General tab](image)

3. Enter the name of the view in the Name field.
4. Select the Active check box to make this view accessible to assigned users.

   **NOTE:** WFM creates a system view called EnterpriseView for all newly created views. The System View check box is disabled for all other views.

5. Click (Save) to save your changes. The Users, CSQs, Teams, Projects, Conditions, Work Shifts, Exceptions, and CSQ Mappings tabs appear.

**Editing an Existing View**

This procedure describes how to edit an existing view.

**To edit an existing view:**

1. Choose Administration > Views.
2. Click the name of a view.
3. Apply changes to the view.
4. Click (Save) to save your changes.
Assigning Users to a View

You can assign one or more users to a view. The user can only perform tasks against entities in the view or views you assigned to the user. A view restricts the scope of information that a user can see or change. This procedure describes how to assign users to a view.

To assign users to a view:

1. To assign users to a view, select the user names in the Available Users list, then click > (). The names of the selected users move to the Assigned Users list. See "Moving Items between Lists" on page 111 for more information.

2. To remove users from a view, select their names from the Assigned Users list, then click <. The names of the selected users return to the Available Users list.

3. Click (Save) to save your changes when you are finished.

Assigning CSQs to a View

This procedure describes how to assign CSQs to a view. A user will only see CSQs assigned to their view.

To assign CSQs to a view:

1. To assign CSQs to a view, select the names of the CSQs in the Available CSQs list, then click > (Figure 192). The names of the CSQs move to the Assigned CSQs list. See "Moving Items between Lists" on page 111 for more information.

2. To remove CSQs from a view, select their names from the Assigned CSQs list, then click <. The names of the CSQs return to the Available CSQs list.

Figure 192. View Details: CSQs tab

3. Click (Save) to save your changes.
Assigning Teams to a View

This procedure describes how to assign teams to a view. To assign a user access to information or tasks associated with an agent, you assign a view that is associated with a team to which that agent belongs. A user will only see teams assigned to their view.

To assign teams to a view:

1. To assign teams to a view, select the names of the teams in the Available Teams list, then click > (Figure 193). The names of the teams move to the Assigned Teams list. See "Moving Items between Lists" on page 111 for more information.

2. To remove teams from a view, select their names from the Assigned Teams list, then click <. The names of the teams return to the Available Teams list.

3. Click (Save) to save your changes.

Figure 193. View Details: Teams tab
Assigning Projects to a View

This procedure describes how to assign projects to a view.

To assign projects to a view:

1. To assign projects to a view, select the names of the projects in the Available Projects list, then click > (Figure 194). The names of the projects move to the Assigned Projects list. See "Moving Items between Lists" on page 111 for more information.

2. To remove projects from a view, select their names from the Assigned Projects list, then click <. The names of the projects return to the Available Projects list.

3. Click (Save) to save your changes.

Figure 194. View Details: Projects tab
Assigning Work Conditions to a View

This procedure describes how to assign work conditions to a view. A user will only see work conditions assigned to their view.

To assign work conditions to a view:

1. To assign work conditions to a view, select the names of the work conditions in the Available Work Conditions list, then click > (Figure 195). The names of the work conditions move to the Assigned Work Conditions list. See "Moving Items between Lists" on page 111 for more information.

2. To remove work conditions from a view, select their names from the Assigned Work Conditions list, then click <. The names of the work conditions return to the Available Work Conditions list.

Figure 195. View Details: Conditions tab

3. Click (Save) to save your changes when you are finished with all tabs in this pane.
Assigning Work Shifts to a View

This procedure describes how to assign work shifts to a view. A user will only see work shifts assigned to their view.

To assign work shifts to a view:

1. To assign work shifts to a view, select the names of the work shifts in the Available Work Shifts list, then click > (Figure 196). The names of the work shifts move to the Assigned Work Shift list. See "Moving Items between Lists" on page 111 for more information.

2. To remove teams from a view, select their names from the Assigned Work Shift list, then click <. The names of the work shifts return to the Available Work Shift list.

Figure 196. View Details: Work Shift tab

3. Click (Save) to save your changes.
Assigning Exception Types to a View

This procedure describes how to assign exception types to a view. A user will only see exception types assigned to their view.

To assign exception types to a view:

1. To assign exception types to a view, select the names of the exception types in the Available Exceptions list, then click > (Figure 197). The names of the exception types move to the Assigned Exceptions list.

2. To remove exception types from a view, select their names from the Assigned Exceptions list, then click <. The names of the exception types return to the Available Exceptions list.

3. Click (Save) to save your changes.
Assigning CSQ Mappings to a View

This procedure describes how to assign CSQ mappings to a view. A user will only see CSQ mappings assigned to their view.

To assign CSQ mappings or skills to a view:

1. To assign CSQ mappings to a view, select the names of the CSQ mappings in the Available CSQ Mappings list, then click > (Figure 198). The names of the CSQ mappings move to the Assigned CSQ Mappings list.

2. To remove CSQ mappings from a view, select the names of the CSQ mappings from the Assigned CSQ Mappings list, then click <. The names of the CSQ mappings return to the Available CSQ Mappings list.

Figure 198. View Details: CSQ Mappings tab

3. Click (Save) to save your changes.
Deleting a View

This procedure describes how to delete a view.

To delete a view:

1. Choose Administration > Views. The View List pane appears.

2. Select the view to delete by completing one of the following steps.
   - To delete one or more views, select the check box next to the view name.
   - To delete all views, select the check box in the column header.

3. Click ✗ (Delete). An Internet Explorer dialog box appears.

4. Click OK to confirm the deletion and dismiss the dialog box.
Managing Users

This section covers the following topics.

- Creating a New User (page 381)
- Editing an Existing User Account (page 385)
- Assigning a Role to a User (page 386)
- Assigning Views to a User (page 387)
- Deleting a User (page 388)

Creating a New User

This procedure describes how to create a new user in WFM. A user created in WFM is not associated with any users in Unified CCX. If you create a user in WFM, the user will not appear in Unified CCX.
To create a new user in WFM:

1. Choose Administration > Users. The User List appears (Figure 199).

![User List](image)

**NOTE:** This list might contain users that are inactive in Unified CCX. If you want to verify whether a user is active or inactive in Unified CCX, log into Unified CCX and check the List of Inactive Agents.
2. Click (New) to create a new user. The General tab of the User Details pane appears (Figure 200).

**Figure 200. User Details: General tab**

3. Complete the fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>User’s last name.</td>
</tr>
<tr>
<td>First Name</td>
<td>User’s first name.</td>
</tr>
<tr>
<td>Login Name</td>
<td>WFM username for the user. The username is not case sensitive. If you are using Active Directory, the user name must match the user’s Active Directory login name. This field is required and must be manually configured in WFM as part of user configuration. This is the name the user uses to log into WFM.</td>
</tr>
<tr>
<td>New Password</td>
<td>User’s password.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> This field does not appear if you are using Active Directory. WFM automatically uses the password associated with the user’s Active Directory username.</td>
</tr>
<tr>
<td></td>
<td>To change the administrator password, click Preferences and then click the Password tab. Instructions for changing the administrator password are provided in &quot;Changing Your Password&quot; on page 116.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>User’s password, to ensure the accuracy of what you entered in the Password field.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> This field does not appear if you are using Active Directory. WFM automatically uses the password associated with the user’s Active Directory username.</td>
</tr>
</tbody>
</table>
The data is described in the following table.

<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Whether a user is active. Only active users can log into WFM.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If you do not select this check box, the user cannot log into WFM.</td>
</tr>
<tr>
<td></td>
<td>Clear the Active check box if you want to deactivate the user.</td>
</tr>
<tr>
<td></td>
<td>When you add an active user, you must assign a role to the user before you can save your changes. See &quot;Assigning a Role to a User&quot; on page 386 and &quot;Assigning Views to a User&quot; on page 387 for more information.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Label</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>System User</td>
<td>Whether the user has access to the EnterpriseView. When checked, the user has access to the EnterpriseView.</td>
</tr>
<tr>
<td>Registration Date</td>
<td>Date when the user was created.</td>
</tr>
<tr>
<td>Last Access Date</td>
<td>Last time this user logged into WFM.</td>
</tr>
<tr>
<td>Deactivation Date</td>
<td>Date when the user was deactivated. This date appears when you clear the Active check box.</td>
</tr>
<tr>
<td>Linked to Agent</td>
<td>Whether an agent is associated with this user. When this check box is selected, it indicates an agent is associated with this user.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> An agent must be associated with the user so the agent can log into the system and access My Page.</td>
</tr>
</tbody>
</table>

4. Complete one of the following steps:
   - If this is not an active user, click Save (Save) to save your changes.
   - If this is an active user, you must assign at least one role to the user before you can save your changes. If you assign an administrator, scheduler or supervisor role to a user, you must also assign at least one view to the user. See "Assigning a Role to a User" on page 386 and "Assigning Views to a User" on page 387 for more information.
Editing an Existing User Account

This procedure describes how to edit an existing user account.

To edit a user account:

1. Choose Administration > Users. The User List pane appears (Figure 201).

   ![User List](image)

   Figure 201. User List

   NOTE: This list of users might contain users that are inactive in Unified CCX. If you want to verify whether a user is active or inactive in Unified CCX, log into Unified CCX and check the List of Inactive Agents. You can also delete an inactive user in Unified CCX.

2. Click the last name of the user account that you want to edit.

3. Apply changes to the user account.

4. Click (Save) to save your changes.
Assigning a Role to a User

Use this procedure to assign a role to a user in WFM.

To assign a role to a user:

1. From the Users Detail pane, click the Assign Roles tab. The User Details pane displays available and assigned roles (Figure 202).

   Figure 202. User Details: Assign Roles tab

   ![Assign Roles tab](image)

2. To assign a role to a user, select the name of the roles in the Available Roles list, then click >. The name of the role move to the Assigned Roles list. See "Moving Items between Lists" on page 111 for more information.

3. To remove a role, select role from the Assigned Roles list, then click <. The names of the role return to the Available Roles list.

   NOTE: If you intend to assign multiple roles to a user, see "Understanding Roles, Views, and Privileges" on page 29 for a description of restrictions. You can assign any combinations of administrator, scheduler or supervisor roles to a user. If you assign an agent role to a user, that is the only role you can assign to that user. WFM does not support an agent with multiple roles.

4. Click (Save) to save your changes.
Assigning Views to a User

Use this procedure to assign a view to a user created in WFM. If the Sync Service imported the user into WFM, this tab will not appear. The user can only perform tasks against entities in the view or views you assigned to the user. A view restricts the scope of information that a user can see or change.

To assign views to a user:

1. From the Users Detail pane, click the Assign Views tab. The User Details pane displays available and assigned views (Figure 203).

   **NOTE:** If the user is imported as an agent from Unified CCX, the Assign Views tab does not appear.

2. To assign a view to a user, select the name of the view in the Available Views list, then click >. The name of the view move to the Assigned Views list. See "Moving Items between Lists" on page 111 for more information.

3. To remove a view, select view from the Assigned Views list, then click <. The names of the view return to the Available Views list.

   **NOTE:** You must assign at least one view to the user.

4. Click (Save) to save your changes.
Deleting a User

This procedure describes how to delete a user in WFM.

**NOTE:** The Sync Service does not delete a user from WFM when the user is deleted in Unified CCX. Do not delete a user who originated in Unified CCX, until the user is deleted from Unified CCX.

To delete a user:

1. Choose Administration > Users. The User List pane appears.
2. Select the user to delete by completing one of the following steps.
   - To delete one or more users, select the check box next to the user name.
   - To delete all users, select the check box in the column header.
3. Click **(Delete)**. An Internet Explorer dialog box appears.
4. Click OK to confirm the deletion and dismiss the dialog box.
Managing the Default System Configuration

You can use the Default Configuration function to configure the following elements of WFM. When a user logs into WFM for the first time, these defaults will be enabled by default.

- Configure the company or enterprise name. For instructions, see "Configuring System-Level Defaults" on page 389.
- Configure the default dashboard view. For instructions, see "Configuring the Dashboard" on page 389.
- Configure the start and end times for the schedule view. For instructions, see "Configuring the Default Schedule Format" on page 392.

Configuring System-Level Defaults

To configure system-level defaults:

1. Choose Administration > Default Configuration. The General tab of the Default System Configuration pane appears (Figure 204).

   Figure 204. Default System Configuration: General tab

   

   ![Default System Configuration: General tab]

2. Enter the name of your company or enterprise in the Enterprise Name field. The name can contain a maximum of 50 characters.

3. Click (Save) to save your changes.

Configuring the Dashboard

To configure the dashboard:

2. Click the Dashboard tab (Figure 205).

Figure 205. Default System Configuration: Dashboard tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Interval</td>
<td>Interval in which you want the data to be displayed. You can choose 15-, 30-, or 60-minute intervals.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Dashboard View</td>
<td>Default dashboard view for all users. Your options are:</td>
</tr>
<tr>
<td></td>
<td>• Results × CSQ</td>
</tr>
<tr>
<td></td>
<td>• Results × CSQ: Agents</td>
</tr>
<tr>
<td></td>
<td>• Results × CSQ: Calls</td>
</tr>
<tr>
<td></td>
<td>• Results × Team</td>
</tr>
<tr>
<td></td>
<td>• View: ASA</td>
</tr>
<tr>
<td></td>
<td>• View: ATT</td>
</tr>
<tr>
<td></td>
<td>• View: Agents</td>
</tr>
<tr>
<td></td>
<td>• View: All data</td>
</tr>
<tr>
<td></td>
<td>• View: Calls</td>
</tr>
<tr>
<td></td>
<td>• View: Occupancy</td>
</tr>
<tr>
<td></td>
<td>• View: Service Level</td>
</tr>
<tr>
<td>Statistics View</td>
<td>Default statistics view for all users. Your options are:</td>
</tr>
<tr>
<td></td>
<td>• Results × CSQ</td>
</tr>
<tr>
<td></td>
<td>• Results × CSQ: Agents</td>
</tr>
<tr>
<td></td>
<td>• Results × CSQ: Calls</td>
</tr>
<tr>
<td></td>
<td>• Results × Team</td>
</tr>
<tr>
<td></td>
<td>• View: ASA</td>
</tr>
<tr>
<td></td>
<td>• View: ATT</td>
</tr>
<tr>
<td></td>
<td>• View: Agents</td>
</tr>
<tr>
<td></td>
<td>• View: All data</td>
</tr>
<tr>
<td></td>
<td>• View: Calls</td>
</tr>
<tr>
<td></td>
<td>• View: Occupancy</td>
</tr>
<tr>
<td></td>
<td>• View: Service Level</td>
</tr>
<tr>
<td>Graph 1, 2 and 3 Data</td>
<td>Type of data to appear on the dashboard. Your options are:</td>
</tr>
<tr>
<td></td>
<td>• Forecasted Calls</td>
</tr>
<tr>
<td></td>
<td>• Agents Forecasted</td>
</tr>
<tr>
<td></td>
<td>• Forecasted Service Level</td>
</tr>
<tr>
<td></td>
<td>• Actual Occupancy Ratio</td>
</tr>
<tr>
<td></td>
<td>• Forecasted Average Speed of Answer</td>
</tr>
<tr>
<td></td>
<td>• Actual Call Handling Time</td>
</tr>
</tbody>
</table>
Configuring the Default Schedule Format

To configure the default schedule format:


1. Click the Schedule tab (Figure 206).

Figure 206. Default System Configuration: Schedule tab

2. Complete the fields as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule Production Interval</td>
<td>Schedule interval in minutes. Determined when database is created. Not editable.</td>
</tr>
</tbody>
</table>

1. Users can change their default views by changing their preferences as described in "Setting Display Preferences" on page 114.

4. Click (Save) to save your changes.
### Managing the Default System Configuration

3. Click ![Save] (Save) to save your changes.

<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule Interval</td>
<td>Interval length for displaying data.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Default schedule display start time.</td>
</tr>
<tr>
<td>End Time</td>
<td>Default schedule display end time.</td>
</tr>
<tr>
<td>First Day of the Week</td>
<td>First day of the week. Default = Sunday. If you change this value to another day of the week, do so before you set up and assign work shift rotations.</td>
</tr>
<tr>
<td>Number of Weeks Visible to Agents (Past)</td>
<td>Number of previous weeks that will be available for the agent to view.</td>
</tr>
<tr>
<td>Number of Weeks Visible to Agents (Future)</td>
<td>Number of future weeks that will be available for the agent to view.</td>
</tr>
</tbody>
</table>

1 Users can change preferences as described in "Setting Display Preferences" on page 114.
Managing Requests to the Server

Types of server requests include requests for distributions, forecasts, and schedules. These requests can be submitted by supervisors, schedulers, and administrators. The server request queue enables users to monitor the status of their request and to delete unneeded requests.

This section covers the following topics.

- Displaying a Server Request (page 394)
- Deleting Server Requests (page 396)

Displaying a Server Request

To display a request details:

1. Choose Administration > Server Request. The Server Request List appears (Figure 207). The columns are described in the following table.

   NOTE: To refresh the data, choose Administration > Server Requests.

![Server Request List](image)

**Figure 207. Server Request List**

<table>
<thead>
<tr>
<th>ID</th>
<th>Status</th>
<th>Process Start</th>
<th>Process End</th>
<th>Requester</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>2</td>
<td>02-16-2008 11:57</td>
<td>02-16-2008 12:58</td>
<td>administrator</td>
<td>Call Forecast</td>
</tr>
<tr>
<td>11</td>
<td>2</td>
<td>02-16-2008 00:00</td>
<td>02-16-2008 13:09</td>
<td>administrator</td>
<td>Strategic Planning</td>
</tr>
<tr>
<td>12</td>
<td>2</td>
<td>02-16-2008 13:06</td>
<td>02-16-2008 13:09</td>
<td>administrator</td>
<td>Call Distribution</td>
</tr>
<tr>
<td>13</td>
<td>2</td>
<td>02-16-2008 13:09</td>
<td>02-16-2008 15:22</td>
<td>administrator</td>
<td>Call Forecast</td>
</tr>
<tr>
<td>14</td>
<td>2</td>
<td>02-16-2008 00:00</td>
<td>02-16-2008 15:23</td>
<td>administrator</td>
<td>Strategic Forecast</td>
</tr>
<tr>
<td>15</td>
<td>2</td>
<td>02-16-2008 15:22</td>
<td>02-16-2008 15:23</td>
<td>administrator</td>
<td>Call Distribution</td>
</tr>
<tr>
<td>16</td>
<td>2</td>
<td>02-16-2008 00:00</td>
<td>02-16-2008 15:23</td>
<td>administrator</td>
<td>Strategic Planning</td>
</tr>
<tr>
<td>17</td>
<td>2</td>
<td>02-16-2008 00:00</td>
<td>02-16-2008 15:23</td>
<td>administrator</td>
<td>Strategic Forecast</td>
</tr>
<tr>
<td>18</td>
<td>2</td>
<td>02-16-2008 00:00</td>
<td>02-16-2008 15:23</td>
<td>administrator</td>
<td>Strategic Forecast</td>
</tr>
<tr>
<td>20</td>
<td>2</td>
<td>02-16-2008 17:44</td>
<td>02-16-2008 17:44</td>
<td>administrator</td>
<td>Call Distribution</td>
</tr>
<tr>
<td>21</td>
<td>2</td>
<td>02-16-2008 17:47</td>
<td>02-16-2008 18:03</td>
<td>administrator</td>
<td>Call Forecast</td>
</tr>
<tr>
<td>22</td>
<td>2</td>
<td>02-16-2008 18:03</td>
<td>02-16-2008 18:24</td>
<td>administrator</td>
<td>Schedule Production</td>
</tr>
</tbody>
</table>

0 - In Queue
1 - Processing
2 - Completed Successfully
3 - Initializing Process
9 - Unsuccessful
2. Click the request ID. The Server Request Details pane appears and displays information associated with the request (Figure 208).

Figure 208. Server Request Details: Request tab

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Order in which the server request arrived.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the request. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>• 0 - In queue: The request is waiting in the queue.</td>
</tr>
<tr>
<td></td>
<td>• 1 - Processing: This request is currently being processed.</td>
</tr>
<tr>
<td></td>
<td>• 2 - Completed Successfully: The request ended successfully.</td>
</tr>
<tr>
<td></td>
<td>• 9 - Unsuccessful: The request failed. For more details, click the ID number.</td>
</tr>
<tr>
<td>Process Start</td>
<td>Date and time in which the request was initiated.</td>
</tr>
<tr>
<td>Process End</td>
<td>Date and time in which the request was completed.</td>
</tr>
<tr>
<td>Requester</td>
<td>Name of the user who initiated the request.</td>
</tr>
<tr>
<td>Description</td>
<td>Type of request. The possible values are Call Distribution and Schedule Production.</td>
</tr>
</tbody>
</table>
3. Click the Assigned CSQs tab to display more information (Figure 209).

![Figure 209. Server Request Details: Assigned CSQs tab](image)

**Deleting Server Requests**

To delete server requests:


2. Select the request to delete by completing one of the following steps.

   **NOTE:** You can only delete requests with the status 0, 2, or 9. A status of 1 indicates the request is currently processing and cannot be deleted.

   - To delete one or more requests, select the check box next to the request ID.
   - To delete all users, select the check box in the column header.

3. Click **Delete**. An Internet Explorer dialog box appears.

4. Click OK to confirm the deletion and dismiss the dialog box.
Managing Compilation Requests

The Compilation Request List displays a summary of each request sent to the server. From the Compilation Request List, you can monitor the status of requests to compile data that was extracted from historical data tables. You can also delete incomplete requests.

This section covers the following topics.

- Displaying Compilation Requests (page 397)
- Deleting Compilation Requests (page 399)

Displaying Compilation Requests

To display compilation requests to the server:

1. Choose Administration > Compilation Requests. The Compilation Request List appears (Figure 210).

The columns are described in the following table.

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Number indicating the order in which the compilation request arrived. Click the number to display more information on the request. The Compilation Request Details pane appears.</td>
</tr>
</tbody>
</table>
Status | Current status of the request. Possible status values are:
--- | ---
0 - To be Processed | This status indicates the request is waiting to be processed.
1 - Processing | This status indicates the request is currently being processed.
2 - Ended Successfully | This status indicates the request ended successfully.
9 - Ended Abnormally | This status indicates the request failed. This error occurs when a prerequisite is missing. For example, no forecast for the schedule launched. The reason for the failure appears on the Compilation Request Details pane. For more details, click the ID number in the Number column.

**NOTE**: When a compilation request completes, it disappears from the Compilation Request List.

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
</table>
| Status | Current status of the request. Possible status values are:
- 0 - To be Processed: This status indicates the request is waiting to be processed.
- 1 - Processing: This status indicates the request is currently being processed.
- 2 - Ended Successfully: This status indicates the request ended successfully.
- 9 - Ended Abnormally: This status indicates the request failed. This error occurs when a prerequisite is missing. For example, no forecast for the schedule launched. The reason for the failure appears on the Compilation Request Details pane. For more details, click the ID number in the Number column.

**NOTE**: When a compilation request completes, it disappears from the Compilation Request List.

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Date</td>
<td>Date when the request was initiated.</td>
</tr>
<tr>
<td>End Date</td>
<td>Date when the request was processed.</td>
</tr>
<tr>
<td>Requester</td>
<td>Name of the user who initiated the request.</td>
</tr>
<tr>
<td>Description</td>
<td>Summary of the request.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority assigned to the request. The highest priority is 1.</td>
</tr>
</tbody>
</table>
2. To view the details of a request, click a number in the Number column. The Compilation Request Details pane appears (Figure 211).

3. To delete the displayed request, click (Delete).

**NOTE:** You can only delete requests with the status 0, 2, or 9. A status of 1 indicates the request is currently processing and cannot be deleted.

### Deleting Compilation Requests

*To delete compilation requests:*

1. Choose Administration > Compilation Requests. The Compilation Request List pane appears.

2. Select the request to delete by completing one of the following steps.

   **NOTE:** You can only delete requests with the status 0, 2, or 9. A status of 1 indicates the request is currently processing and cannot be deleted.

   - To delete one or more requests, select the check box next to the request ID.
   - To delete all users, select the check box in the column header.

3. Click (Delete). An Internet Explorer dialog box appears.

4. Click OK to confirm the deletion and dismiss the dialog box.
Managing Generic Exceptions

From the Generic Exceptions pane, you can create exception types that appear as options that agents can select from their My Page when they request time off. For more information, see "Understanding Generic Exceptions and Exception Types" on page 49.

This section covers the following topics.

■ Creating a Generic Exception (page 400)
■ Editing a Generic Exception (page 401)
■ Deleting a Generic Exception (page 401)

Creating a Generic Exception

To create a generic exception:

1. Choose Administration > Generic exceptions. The Generic Exception List appears (Figure 212).

Figure 212. Generic Exception List

2. Click (New). The Generic Exception Details pane displays the Name field (Figure 213).

Figure 213. Generic Exception Details

3. Enter the name for the exception.
4. Click (Save) to save your changes.
Managing Generic Exceptions

Editing a Generic Exception

To edit a generic exception:

1. Choose Administration > Generic Exceptions. The Generic Exception List appears (Figure 214).

   Figure 214. Generic Exception List

   ![Generic Exception List](image)

2. Click the name of the generic exception. The Generic Exception Details pane displays the Name field (Figure 213).

3. Change the name of the generic exception.

4. Click (Save) to save your changes.

Deleting a Generic Exception

To delete a generic exception:


2. Select the exception to delete by completing one of the following steps.
   - To delete one or more exceptions, select the check box next to the exception name.
   - To delete all exceptions, select the check box in the column header.

3. Click (Delete). An Internet Explorer dialog box appears.

4. Click OK to confirm the deletion and dismiss the dialog box.
Glossary

A

abandoned contact
A call or other type of contact that has been offered into a communications network or telephone system, but is terminated by the person originating the contact before any conversation happens. In an outbound calling scenario, abandoned calls refer to connects that are disconnected by the automated dialer once live contact is detected and no agent is available to match up with the call.

ACD
Automatic Call Distributor. A specialized phone system used for handling many incoming calls. The ACD will recognize and answer an incoming call; will look in its database for call routing instructions. It will send the call to a recording or a voice response unit (VRU) or will send the call to an available agent according to the instructions for that call. An ACD will normally produce management information tracking both calls and agent performance.

ACW
After Call Work. Work immediately following an inbound call or transaction. If work must be completed before agent can handle next contact, then ACW is factored into average handle time. Work might involve keying activity codes, updating database, filling out forms, or placing an outbound contact. The agent is unavailable to receive any inbound calls while in this state. Also called wrapup and post contact processing (PCP).

adjustment factor
Increases or decreases the selected value by the specified percentage in a forecast, or scenario. For example, if you enter 1.05 in this Adjustment factor field, WFM will increase the selected value or forecast by 5%. If you enter 0.95 in this field, WFM will decrease the selected value or forecast by 5%.
**administrator**
A user role that can access Environment, Agents, Forecasting, Schedules, Intraday, Reports, What-ifs, Historical, Special Functions, and Administration in the Navigation menu. An administrator can be assigned any combination of the following roles: administrator, scheduler and supervisor.

**adherence**
The term used to describe how well agents stick to their planned work schedules when they arrive, depart, go on break, or take lunch. Also known to as compliance.

**agent**
1. The person who handles calls and email in a contact center. Also called a customer service representative or telephone sales representative. 2. A user role in WFM that can access My Page in the Navigation menu. The agent role cannot be assigned to users who have other roles.

**AHT**
Average Handle Time. The amount of time it takes on average to handle a contact to completion, including talk time plus after-contact work time. To calculate, divide the total seconds of work time by the number of contacts.

**AOD**
Average Open Days. The average number of days in which a contact center is open. The average number of open days does not include all closed and open holidays, and closed days that are not weekends.

**APT**
Average Processing Time. The average time necessary for agents to process email. Process time is elapsed time from when an agent opens the email until the agent sends the email. This includes the time when the agent is actively writing a response to the email.

**ASA**
Average Speed of Answer. This is the average time it takes to answer a call. The ASA is calculated as the sum of the queue time for calls answered during the interval and divided by the number of calls answered during the interval.

**assignment**
An assignment is a type of fixed work shift that does not cover requirements. Use this work shift type to schedule agents for non-phone related activities for entire days or weeks. Assign fixed work shifts to senior and full-time agents.
ACW
After Call Work. The average time required by an agent after a conversation is ended or a response to an email is sent, to complete work that is directly associated with the call or email just completed. Does not include time for any activities such as meetings, breaks, or correspondence. Also known as Average Work Time (AWT).

AWT
Average Work Time. Also known as After Call Work (AWC). The average time required by an agent after a conversation is ended or a response to an email is sent, to complete work that is directly associated with the call or email just completed. Does not include time for any activities such as meetings, breaks, or correspondence.

average talk time
The average elapsed time from when an agent answers a call until the agent disconnects.

B

block of hours
The duration of a work shift (for example, six hours). You can set up to 28 different work conditions for the same block of hours.

break
An activity during which an agent is not handling contacts because of a work condition.

business orientation
The result you intend to obtain during the year and the means you use to reach that result. For example:

- A 10% contact volume growth
- A 5% sales increase
- A 5% reduction in labor turnover rate

C

call distribution scenario
The calculation of the percentage of the day’s calls, by day of week, in each schedule period. It also identifies the average talk time and work time per call for each half hour increment.
closed day
A day when the contact center does not handle contacts. If the contact center is only open Monday through Friday, you would designate Saturdays and Sundays as closed days.

concurrent user
The users who are logged into WFM at any given time. The maximum capacity for concurrent users is the total number of users that can be logged into WFM at any given time.

configured user
Any scheduled or recorded agent plus all other users with active login rights to Workforce Optimization (WFO) applications (for example, supervisors, managers, quality evaluators, or schedulers). The maximum capacity for configured users is the total number of users that can be configured in WFM. See, also named user.

conformity
The term used to describe how well an agent works the right amount of time for a day regardless of the time of day when the agent works.

contact
A connection via voice or email from a customer to an agent in the customer contact center.

contact center
A business center with two or more persons that provides customer services by phone, email and fax. A contact center may be help desks, customer service centers, catalog sales centers, reservation centers, or telemarketing/collection operations.

CSQ
Contact Service Queue. In Unified CCX, a group of agents to which contacts are routed. It is generally associated with a specific skill.

CSQ mapping
A mechanism used by Unified CCX to link agents with a CSQ. It usually reflects an agent’s skill within the contact center. A CSQ mapping has no other purpose or effect. The Sync Service extracts a CSQ identity from Unified CCX, and loads it into WFM and also creates a CSQ mapping for it in WFM. WFM uses the CSQ mapping when creating schedules.

customer service representative
A service representative who handles customer calls and contacts, including account inquiries, complaints, and support calls.
database
Collection of data structured and organized in a disciplined fashion for quick and easy access to information of interest.

debugging file
A debugging file (with the *.dbg file extension) contains diagnostic information that can help resolve issues. WFM creates debugging logs by default. If you want debugging turned off, you must edit the appropriate configuration file.

distribution scenario
Contains the contact (call or email) volume history for each period, day and week in the specified reference period. It includes the calculation of the percentage of the day's calls or email, by day of week, in each schedule period. It also identifies the average talk time or average processing time and work time per call for each half hour increment.

email
electronic mail. the transmission, electronically, of letters, memos, and messages from one computer to another.

e-mail distribution scenario
The calculation of the percentage of the day's email, by day of week, in each schedule period. It also identifies the average processing time and work time per call for each half hour increment.

error code
A brief description of a system event.

exception
Any unplanned activity in an employee's work schedule, including meetings, training sessions, unscheduled breaks, and absenteeism.

firm date
A fixed date on a calendar (for example, January 1). Create a firm date association between two days when you want to generate a forecast for a specific date using a specific date in the past as the contact volume projection for a specified date in a forecast period.
fixed work shift
A fixed work shift is a work shift that covers requirements for fixed hours and days. Use this work shift type to schedule agents for phone and email-related activities for entire days or weeks. A fixed work shift has the following characteristics:

- Work days during the week are fixed
- Hours worked each day are fixed, but do not have to be the same for each day
- The shift start time each day is fixed, but does not have to be the same for each day

forecast
A prediction of future events. In WFM, a forecast uses historical contact information from a specified period to estimate the contact volume and scheduling requirements for a contact center.

forecast scenario
A forecast that is not immediately applied to a schedule. You can create a forecast scenario from the Forecast Scenario List pane. If you think the forecast scenario is more accurate than a regular forecast, you can apply the forecast scenario to a schedule from the Forecast Request pane by selecting the forecast scenario. You can also edit a forecast scenario from the Forecast Maintenance pane.

G

gap
The difference between the number of agents scheduled and the number of agents forecasted to be needed. See also negative gap and positive gap.

generic exception
A high level type of exception that an agent can select when requesting time off. For example, a generic exception could be absence, sick leave, or vacation. If an agent has a doctor appointment, the agent selects the sick leave generic exception and specifies a doctor appointment in the Comment field.

greedy algorithm
Any algorithm that repeatedly produces a locally optimum choice at each stage with the hope of finding the global optimum for the specified conditions. It might not completely solve the problem, or, if it produces a solution, it might not be the very best one, but it is one way of approaching the problem and sometimes yields very good (or even the best possible) results.
H

handled call
A call that is answered by an employee as opposed to being blocked or abandoned.

handle time
The combination of conversation time and after call work time.

historical data
The contact and agent information captured on reports generated by the ACD over a period of time. WFM use this information to generate schedule forecasts.

I

impact delay
A delay, typically in days, between the special event and the impact.

For example, the default impact delay for a radio promotion would be 0, because as soon as the broadcast starts, the customers start calling the contact center. The impact delay for a sales brochure mailed to customers could be 2 days, and would start the moment the sales brochures were mailed (launch date) and ends when the customers receive the sales brochures and start calling the contact center.

in service
An activity during which an agent is scheduled to be logged in and ready to handle contacts.

ISO week date
The ISO week date system is a leap week calendar system that is part of the ISO 8601 date and time standard. The system is used in government and business for fiscal years, as well as in timekeeping.

The system uses the same cycle of 7 weekdays as the Gregorian calendar. Weeks start with Monday. ISO years have a year numbering which is approximately the same as the Gregorian years, but not exactly. An ISO year has 52 or 53 full weeks (364 or 371 days). The extra week is called a leap week.

A date is specified by the ISO year in the format YYYY, a week number in the format ww prefixed by the letter W, and the weekday number, a digit data from 1 through 7, beginning with Monday and ending with Sunday. For example, 2006-W52-7 (or in its most compact form 06W527) is the Sunday of the 52nd week of 2006. In the Gregorian system this day is called 31 December 2006.

The system has a 400-year cycle of 146,097 days (20,871 weeks), with an average year length of exactly 365.2425 days, just like the Gregorian calendar. In every 400 years there are 71 years with 53 weeks.
KPI
Key Performance Indicator. The most critical measures of performance in any organization, typically productivity measures.

**log file**
A log file (with the *.log file extension) contains event messages and, if problems occur, warning and other error messages. All messages in log files are identified by an error code.

**linearly**
An option for handling email. During business hours, WFM divides all email received during business hours by the number of intervals in a work shift to determine the number of email handled during each half hour. After business hours, WFM divides all email received after business hours by the number of half hours in a work shift to determine the number of email handled during each half hour.

**lunch**
An activity during which an agent is not handling contacts because of a work condition.

N/A
See not available.

**named user**
Any scheduled or recorded agent plus all other users with active login rights to Workforce Optimization (WFO) applications (for example, supervisors, managers, quality evaluators, or schedulers. See, also configured user.

**negative gap**
There are not enough agents to meet the schedule requirements. If there is a negative gap, you need to find agents to fill that gap in the schedule.

**no deferring**
An option for handling email. During business hours, agents must handle all email received during the half hour when they are received. After business hours, agents must handle all email received after business hours during the first half hour of the next day.
non-linearly
An option for handling email. During business hours, WFM schedules the agents to handle 50% of the email received during the first half hour and divides the number of email handled for each remaining half hour by 50%, until the last half hour in the work shift. During the last half hour in the work shift, the agents are expected to complete the remaining email. After business hours, WFM schedules the agents to handle 50% of the email received after business hours during the first half hour and divides the number of email handled for each remaining half hour by 50%, until the last half hour in the work shift. During the last half hour in the work shift, the agents are expected to complete the remaining email.

non-phone activity
Any activity that prevents an agent from answering phones. Non-phone activities include meetings, training sessions, PTO, email, vacation, late, holiday, unscheduled breaks, and absenteeism.

not available
An activity during which an agent is not scheduled for a skill group or service and the agent’s work shift does not allow the agent to be scheduled.

not scheduled
An activity during which an agent is not scheduled to work.

occupancy
Generally a percent of logged in time that an agent spends in active contact handling states (for example, on incoming calls, in wrapup activity, or outbound calls).

occupancy ratio
The percentage of time an agent spends answering customer contacts for each interval versus their total time in session.

open day
A day when the contact center handles contacts. WFM displays all calendar days open by default. Monday through Friday are typical examples of open days.

outside hours
An activity during which the CSQ is closed and agents are not handling contacts.

paid exception
An exception for which an employee is paid (for example, sick leave).
PBX
A private telephone exchange located on the user's premises and connected to the public network via trunks. (Sometimes called PABX where the A stands for “automatic.”)

positive gap
The number of agents scheduled exceeds the schedule requirements. When there is a positive gap, you can use that time for exceptions, assignments, or projects. For example, you can find the time to schedule a 30 minute meeting with 4 agents after the schedule is produced when there is a positive gap of 4 or more agents.

post-production planning
Post-production planning refers to the process of scheduling agents for non-service activities, such as meetings or training, after a schedule has been generated (post-production). You can use the WFM Post-Production Activity Planning pane to find times when you can schedule agents for activities so that the service level is least affected.

precision %
A percentage indicating how precise the forecast was when compared to the actual contact volume. The formula used to determine precision is:

\[
\text{precision} = \frac{\text{forecasted contact volume}}{\text{actual contact volume}}
\]

privilege
The permission to perform a transaction. For example, the ability to accept schedule trades or delete skills.

processing time
The time necessary for agents to process email. Process time is elapsed time from when an agent opens the email until the agent sends the email. This includes the time when the agent is actively writing a response to the email.

productivity ratio
The percentage of time a CSQ spends answering customer contacts.

project
A non-routine activity that prevents agents from answering contacts. Projects are generally assigned to optimize agent idle time. These non-routine activities occur each work shift and can be assigned for periods of a day or a week. They can be activities that are internal to the customer contact center efforts, such as answering email and sending faxes.

PTO
Personal time off.
**Q**

**queue**
In WFM, the “waiting line” for delayed calls. A queue holds the call until an agent is available. It can also refer to a list of items waiting to be processed (for example, email).

**R**

**real-time adherence**
Measurement of how closely agents stick to their planned work schedule. Real-time statistics are available from the ACD to show the current state of any agent; these states can be compared to agent's schedule to determine adherence at any point in time.

**resource requirement estimation**
A calculation that looks at the existing work shift types, CSQs and forecast dates, and work shift types (including hours and work conditions) and creates a resource scenario based on calculated resources required to cover the specified forecast dates.

**resource scenario**
Contains the estimated resource requirements per work shift duration for a specified day during the work week. You can create a resource requirements scenario from the Resource Requirements Calculation pane (What-Ifs > Resource). To view existing resource scenarios for a work day, go to the Existing Resource Requirements Calculations (What-Ifs > Resource List).

**role**
A collection of privileges. A user can have one or many roles. The user has the collective privileges across all roles assigned to the user. If multiple roles are assigned to a user, the user will see a combination of topics on the Navigation menu that reflect the roles assigned to the user. There are four roles with specific limitations: agent, administrator, scheduler and supervisor. See privilege, agent, administrator, scheduler and supervisor.

**S**

**scheduler**
A user role that can access Environment, Agents, Forecasting, Schedules, Intraday, Reports, What-Ifs, and Historical in the Navigation menu. A scheduler can be assigned any combination of the following roles: administrator, scheduler and supervisor.
schedule
A record that specifies when an employee is supposed to be on duty to handle contacts. The complete definition of a schedule is the days of week worked, start time, break times and durations (as well as paid/unpaid status), and stop time.

schedule adherence
The percentage of time an agent follows the schedule. When WFM calculates this percentage it takes into account scheduled arrival and departure times, breaks, lunches and time spent on scheduled activities. For example, an agent who is scheduled to arrive at 08:00 and leave at 16:00 and sticks to the schedule for that day is adhering to the schedule.

schedule conformity
The percentage of time an agent works the right amount of time regardless of the time of day when the agent works. Schedule conformity does not take arrival and departure times into account. For example, an agent who is scheduled to work from 08:00-16:00, but instead works from 10:00 to 18:00 would be conforming, but not adhering to the schedule.

scope
A set of boundaries in which privileges apply. WFM sets scope by role, privilege, and view. Some transactions have no scope restriction (for example, setting preferences). An supervisor who can create schedules, can only create schedules for agents assigned the teams associated with the view assigned to the supervisor.

service goal
A definable service objective. For example, answering 80% of calls within the first 20 seconds.

service level or service level objective
A speed of answer goal that is often expressed as a percentage goal for answering calls within a specified number of seconds or email within a specified number of hours. For example, 80% of all calls answered within 20 seconds or 100 percent of email answered within 24 hours. A more demanding quality objective requires a higher staffing level.

shift offer
An agent makes a shift available to others (for example, when the agent plans to be absent for a day).

shift trade
An agent offers to trade shifts with another agent.

skill
A developed aptitude or ability (for example, speaking a foreign language).
special event
A type of event that caused contact volume to deviate from normal. The special event can cause volume to either increase or decrease. In WFM, you can define special events that might cause a forecast to be above or below normal and assign the special events to specific dates for specific CSQs. This allows you to identify points in time when a special event altered contact volume for the CSQ.

standard forecast
A prediction of future events for any specified period (for example, three weeks or nine months) and the distribution of a standard forecast is be day and interval. See also, forecast.

supervisor
A supervisor is usually the person who has first-line responsibility for the management of a group of agents. Often has special telephone or computer terminal for monitoring agents and the system performance. In WFM, the supervisor has access to Schedules, Intraday, and Reports in the Navigation menu. A supervisor can be assigned any combination of the following roles: administrator, scheduler and supervisor.

talk time
The elapsed time from when an agent answers a call until the agent disconnects.

team
A group of agents. An agent can belong to many teams. WFM generates reports by team.

trend
The year-to-year change in contact volume. A trend tells you the percentage of change (either greater, equal or less than) in contact volume for the current year over the same period last year. The method for determining the trend is dependent on the extent of historical data stored in WFM.

unpaid exception
An exception for which an employee is not paid (for example, doctor appointment).

user
A person who can log into WFM. A user can be linked to an agent identity to take calls.
variable work shift

A variable work shift is a work shift that covers requirements for variable hours and days. Use this work shift type to schedule agents for phone and email-related activities for variable days and weeks. In contrast to a fixed work shift, a variable work shift offers flexibility in at least one of the following ways:

- You can designate at least one day a week as an optional work day. You can choose whether or not to schedule an agent for an optional work day based on the customer contact center's requirements.
- You can designate the total work hours for at least one day a week as variable.
- You can designate the arrival time for at least one day a week as variable.

view

The level of accessibility a user has in WFM. For example, you can assign a view that is associated with one or more users, CSQs, CSQs mappings teams, work conditions, work shifts, and exceptions.

virtual CSQs

A collection of CSQs unified (or merged) into a single CSQs. It can be associated with multiple CSQs. WFM uses the virtual CSQs when generating statistics, schedules, and forecasts.

work condition

A set of rules used to identify a routine activity that prevents the agent from answering contacts. These routine activities occur during every work shift. Examples of routine activities that occur during every work shift are breaks and lunches.

work shift

The hours and days when an agent can work. It includes days, hours, arrival, and departure times.

work shift rotation

A work shift in which an agent works different shifts over a several weeks.

Workforce Management

1. The art and science of having the right number of agents, at the right times, to answer an accurately forecasted volume of incoming calls at the service level standard set by the call center. 2. A Cisco product.
wrapup time
The time required by an agent after a conversation is ended or a response to an email is sent, to complete work that is directly associated with the call just completed. Does not include time for any activities such as meetings, breaks, or correspondence.
### Index

<table>
<thead>
<tr>
<th>A</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>adherence</td>
<td>calendar</td>
</tr>
<tr>
<td>display options 320</td>
<td>copying 270</td>
</tr>
<tr>
<td>displaying additional information 318</td>
<td>updating 269</td>
</tr>
<tr>
<td>monitoring 315</td>
<td>call forecast</td>
</tr>
<tr>
<td>overview 315</td>
<td>generating with trends 234</td>
</tr>
<tr>
<td>schedule adherence and conformity 95</td>
<td>generating without trends 239</td>
</tr>
<tr>
<td>administration</td>
<td>chat services</td>
</tr>
<tr>
<td>managing 367</td>
<td>scheduling agents to support 88, 89</td>
</tr>
<tr>
<td>managing compilation requests 397</td>
<td>closed days</td>
</tr>
<tr>
<td>managing default system configuration 389</td>
<td>copying 270</td>
</tr>
<tr>
<td>managing generic exceptions 400</td>
<td>described 83</td>
</tr>
<tr>
<td>managing roles 368</td>
<td>entering 269</td>
</tr>
<tr>
<td>managing server requests 394</td>
<td>overview 83</td>
</tr>
<tr>
<td>managing users 381</td>
<td>compilation requests 397</td>
</tr>
<tr>
<td>managing views 371</td>
<td>managing 397</td>
</tr>
<tr>
<td>agent</td>
<td>configuration</td>
</tr>
<tr>
<td>assigning CSQ mappings 173</td>
<td>dashboard 389</td>
</tr>
<tr>
<td>assigning teams 172</td>
<td>general entries 389</td>
</tr>
<tr>
<td>deleting 177</td>
<td>schedule 392</td>
</tr>
<tr>
<td>deleting exceptions 176</td>
<td>contact forecast maintenance</td>
</tr>
<tr>
<td>displaying exception list 174</td>
<td>editing 249</td>
</tr>
<tr>
<td>editing 167</td>
<td>contact service queue (CSQ)</td>
</tr>
<tr>
<td>overview 166</td>
<td>adding source CSQs to a virtual CSQ 143</td>
</tr>
<tr>
<td>agent productivity report</td>
<td>assigning CSQ mappings to a CSQ 142</td>
</tr>
<tr>
<td>generating 330, 333, 335, 337</td>
<td>creating CSQ to respond to calls 130</td>
</tr>
<tr>
<td>assigning</td>
<td>creating CSQ to respond to email 139</td>
</tr>
<tr>
<td>CSQ mappings to a view 379</td>
<td>deleting 147</td>
</tr>
<tr>
<td>CSQs to a view 373</td>
<td>editing 140</td>
</tr>
<tr>
<td>exceptions to a view 378</td>
<td>managing 130</td>
</tr>
<tr>
<td>teams to a view 374, 375</td>
<td>coverage</td>
</tr>
<tr>
<td>users to a role 370</td>
<td>interval display options 306</td>
</tr>
<tr>
<td>users to a view 373</td>
<td>viewing requirements 307</td>
</tr>
<tr>
<td>views to a user 387</td>
<td>coverage of requirements</td>
</tr>
<tr>
<td>work conditions to a view 376</td>
<td>interpreting 280</td>
</tr>
<tr>
<td>work shifts to a view 377</td>
<td>interpreting coverage 308</td>
</tr>
<tr>
<td></td>
<td>creating 125</td>
</tr>
<tr>
<td></td>
<td>CSQ</td>
</tr>
<tr>
<td></td>
<td>creating a virtual CSQ 142</td>
</tr>
<tr>
<td>CSQ calendar</td>
<td>F</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>copying to another CSQ</td>
<td>firm date association</td>
</tr>
<tr>
<td>updating</td>
<td>creating 266</td>
</tr>
<tr>
<td>CSQ mapping</td>
<td>deleting 267</td>
</tr>
<tr>
<td>adding an agent</td>
<td>overview 82</td>
</tr>
<tr>
<td>adding CSQs</td>
<td>forecast</td>
</tr>
<tr>
<td>creating</td>
<td>generating without trends 244</td>
</tr>
<tr>
<td>deleting</td>
<td>forecast scenario 97</td>
</tr>
<tr>
<td>editing</td>
<td>creating 349</td>
</tr>
<tr>
<td></td>
<td>deleting 350</td>
</tr>
<tr>
<td></td>
<td>renaming 350</td>
</tr>
</tbody>
</table>

| CSQ mapping            | G                  |
| adding an agent        | generic exceptions |
| adding CSQs            | creating 400       |
| creating               | deleting 401       |
| deleting               | editing 401        |
| editing                | managing 400       |
|                       | glossary 403       |
|                       | guidelines         |
|                       | estimating daily volume 72 |
|                       | generating a distribution 60 |
|                       | generating a forecast with trends 70 |

| dashboards             | H                  |
| customizing            | historical data    |
| displaying productivity data | display in tabular format 352 |
| statistical display options | displaying CSQ historical data 352 |
|                       | overview 351       |

| default system         | I                  |
| configuration         | icons, description of 112 |
| managing              | inbox               |
|                       | approving exception requests 325 |
|                       | approving schedule requests 326 |
|                       | denying schedule requests 326 |
|                       | monitoring 323       |
|                       | overview 323         |

| documentation          | L                  |
|                       | logging into WFM 106 |

| E                      | M                  |
| email                  | multimedia activities 87 |
| scheduling agents to respond | 87 |
| exception              | approve request 325 |
| approving request      | assigning a post-production 291 |
| assigning a post-production | assigning a pre-production 209 |
| exception type         | assigning 175       |
| assigning              | assigning to a view 378 |
|                        | creating 148        |
|                        | creating generic 400 |
|                        | deleting 153        |
|                        | editing 150         |
|                        | examples 210        |
|                        | managing generic 400 |
| exceptions             | managing 207        |
|                       | understanding 49    |
navigation pane, using 108
non-service activities
planning 288

deployment
post-production activities
assign 292
preferences 114
project
assigning agents 220
creating 214
deleting 222
editing 219
managing 214

preferences 114

resources
managing 340

role
assigning users 370
described 368
displaying 368
displaying privileges 369

special event
assigning 261
creating 256
deleting 259, 265
editing 259, 264

special functions
compiling historical data 356
entering historical data manually 361, 364
merging historical data 358
overview 355

split work shift
described 199

supervisor dashboard
using 304

schedule
copying selected intervals to other agents 313
creating 272
displaying an agent schedule 277
editing 276
editing agent schedule 277
trading for different days 312
trading on the same day 310
viewing 282

schedule adherence
how it works 316

schedule request
creating 272

schedule trade
approving request 326
denying request 326
scheduling multimedia activities 87
selecting
date 117
server requests 394, 399
managing 394
setting preferences 114

server requests
394, 399
managing 394

server requests
managing 394

setting preferences
114

settling

split work shift
described 199

Supervisor dashboard
using 304

table
sorting a column 108
viewing table with many rows 110

team
adding agents 163
creating 160
deleting 165
editing 162

time zones
adding agents 157
adding CSQs 155
multiple 90
overview 154

trading schedules
overview 310

trading schedules

user
assigning role 386
assigning views 387
creating 381, 382
deleting 388
editing 385
managing 381

viewing 282
V

view
  assigning CSQ mappings 379
  assigning CSQs 373
  assigning exceptions 378
  assigning teams 374, 375
  assigning users 373
  assigning work conditions 376
  assigning work shifts 377
  creating 371
  deleting 380
  managing 371

W

what-if scenario
  managing distribution scenarios 347
  managing resource list 344
  managing resources 340
work conditions
  associating work shifts 195
  creating 189
  deleting 196
  editing 193
  overview 48
work shift
  associating work conditions 187
  creating 179
  deleting 188
  displaying agents 186
  displaying assigned 206
  editing 185
work shift rotation
  assigning to an agent 200
  copying 204
  creating 198, 201
  displaying 174